Copyright © 2009 ERDAS, Inc.

All rights reserved.

Printed in the United States of America.

The information contained in this document is the exclusive property of ERDAS, Inc. This work is protected under United States copyright law and other international copyright treaties and conventions. No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, or by any information storage or retrieval system, except as expressly permitted in writing by ERDAS, Inc. All requests should be sent to the attention of:

Manager, Technical Documentation
ERDAS, Inc.
5051 Peachtree Corners Circle
Suite 100
Norcross, GA 30092-2500 USA.

The information contained in this document is subject to change without notice.

**Government Reserved Rights.** MrSID technology incorporated in the Software was developed in part through a project at the Los Alamos National Laboratory, funded by the U.S. Government, managed under contract by the University of California (University), and is under exclusive commercial license to LizardTech, Inc. It is used under license from LizardTech. MrSID is protected by U.S. Patent No. 5,710,835. Foreign patents pending. The U.S. Government and the University have reserved rights in MrSID technology, including without limitation: (a) The U.S. Government has a non-exclusive, nontransferable, irrevocable, paid-up license to practice or have practiced throughout the world, for or on behalf of the United States, inventions covered by U.S. Patent No. 5,710,835 and has other rights under 35 U.S.C. § 200-212 and applicable implementing regulations; (b) If LizardTech’s rights in the MrSID Technology terminate during the term of this Agreement, you may continue to use the Software. Any provisions of this license which could reasonably be deemed to do so would then protect the University and/or the U.S. Government; and (c) The University has no obligation to furnish any know-how, technical assistance, or technical data to users of MrSID software and makes no warranty or representation as to the validity of U.S. Patent 5,710,835 nor that the MrSID Software will not infringe any patent or other proprietary right. For further information about these provisions, contact LizardTech, 1008 Western Ave., Suite 200, Seattle, WA 98104.

ERDAS, ERDAS IMAGINE, IMAGINE OrthoBASE, Stereo Analyst and IMAGINE VirtualGIS are registered trademarks; IMAGINE OrthoBASE Pro is a trademark of ERDAS, Inc.

SOCET SET is a registered trademark of BAE Systems Mission Solutions.

Other companies and products mentioned herein are trademarks or registered trademarks of their respective owners.
Table of Contents

Table of Contents ................................................................. V
List of Figures ................................................................. xv
List of Tables ........................................................................ xix
Preface ................................................................................... xxii

About This Manual ............................................................. xxii
Example Data .......................................................................... xxii
Documentation ......................................................................... xxii
Conventions Used in This Book ............................................... xxii

Introduction ........................................................................... 1

Introduction to LPS Project Manager ....................................... 3

Introduction ........................................................................... 3
Using LPS Project Manager ................................................... 3
LPS Project Manager Functionality ......................................... 5
  Triangulation ....................................................................... 5

Tour Guide Examples ............................................................ 6
  Frame Camera Tour Guide ................................................... 6
  Digital Camera Tour Guide .................................................. 7
  SPOT Pushbroom Sensor Tour Guide ..................................... 7

Appendix Example ................................................................. 8
  Batch Processing .................................................................. 8

About LPS Project Manager .................................................... 8
  Menu Bar ............................................................................. 9
  Toolbar ............................................................................... 9
  Keyboard Shortcuts ............................................................ 11

Next ....................................................................................... 11

Photogrammetric Theory ....................................................... 13

Introduction to Photogrammetry ............................................. 15

Introduction ........................................................................... 15
  What is Photogrammetry? ................................................... 15
  Types of Photographs and Images ....................................... 18
  Why use Photogrammetry? .................................................. 19
Photogrammetry vs. Conventional Geometric Correction . . . 19
Single Frame Orthorectification vs. Block Triangulation . . . . 20

Image and Data Acquisition ........................................... 22
Photogrammetric Scanners ........................................... 24
Desktop Scanners ..................................................... 25
Scanning Resolutions .................................................. 25
Coordinate Systems ..................................................... 27
Terrestrial Photography ................................................ 29

Interior Orientation .................................................... 31
Principal Point and Focal Length .................................... 31
Fiducial Marks .......................................................... 32
Lens Distortion ............................................................ 33

Exterior Orientation ..................................................... 35
Rotation Matrix ........................................................ 37
The Collinearity Equation .............................................. 40

Photogrammetric Solutions ........................................... 42
Space Resection ......................................................... 43
Space Forward Intersection .......................................... 43
Bundle Block Adjustment .............................................. 44
Least Squares Adjustment ............................................. 48
Self-calibrating Bundle Adjustment ................................ 51
Automatic Gross Error Detection ..................................... 52

GCPs ................................................................. 52
GCP Requirements ..................................................... 54
Processing Multiple Strips of Imagery ............................... 55

Tie Points ............................................................. 55
Automatic Tie Point Collection ....................................... 56

Image Matching Techniques ....................................... 57
Area-based Matching .................................................. 58
Feature-based Matching .............................................. 60
Relation-based Matching ............................................. 61
Image Pyramid .......................................................... 61
LPS Project Manager Pyramid Layers ............................... 62

Satellite Photogrammetry ............................................. 62
SPOT Interior Orientation ............................................ 64
SPOT Exterior Orientation ............................................ 65
Collinearity Equations and Satellite Block Triangulation ....... 69

Orthorectification ....................................................... 70
Cell Size ............................................................... 73

LPS Project Manager Tour Guides ................................. 75
Frame Camera Tour Guide ............................................. 77

Introduction .......................................................... 77
Before You Begin ...................................................... 78
Create a New Project ................................................. 78
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare the Block File</td>
<td>78</td>
</tr>
<tr>
<td>Select Geometric Model</td>
<td>80</td>
</tr>
<tr>
<td>Define Block Properties</td>
<td>80</td>
</tr>
<tr>
<td>Add Imagery to the Block</td>
<td>84</td>
</tr>
<tr>
<td>Add Frames</td>
<td>85</td>
</tr>
<tr>
<td>Compute Pyramid Layers</td>
<td>86</td>
</tr>
<tr>
<td>Define the Camera Model</td>
<td>87</td>
</tr>
<tr>
<td>Enter Specific Camera Information</td>
<td>88</td>
</tr>
<tr>
<td>Add Fiducial Marks</td>
<td>89</td>
</tr>
<tr>
<td>Measure Fiducials of the Images</td>
<td>90</td>
</tr>
<tr>
<td>Enter Exterior Orientation Information</td>
<td>96</td>
</tr>
<tr>
<td>Edit the Remaining Images in the Project</td>
<td>97</td>
</tr>
<tr>
<td>Measure GCPs and Check Points</td>
<td>99</td>
</tr>
<tr>
<td>Collect Point ID 1002</td>
<td>102</td>
</tr>
<tr>
<td>Collect Point ID 1003</td>
<td>106</td>
</tr>
<tr>
<td>Set Automatic (x, y) Drive Function</td>
<td>109</td>
</tr>
<tr>
<td>Collect Point ID 1004</td>
<td>110</td>
</tr>
<tr>
<td>Collect Point ID 1005</td>
<td>112</td>
</tr>
<tr>
<td>Collect Point ID 1006</td>
<td>114</td>
</tr>
<tr>
<td>Input Check Points</td>
<td>116</td>
</tr>
<tr>
<td>Collect Point ID 2001</td>
<td>116</td>
</tr>
<tr>
<td>Collect Point ID 2002</td>
<td>118</td>
</tr>
<tr>
<td>Perform Automatic Tie Point Generation</td>
<td>121</td>
</tr>
<tr>
<td>Check Tie Point Accuracy</td>
<td>123</td>
</tr>
<tr>
<td>Perform Aerial Triangulation</td>
<td>125</td>
</tr>
<tr>
<td>Find Information in the Triangulation Report</td>
<td>126</td>
</tr>
<tr>
<td>Save the Triangulation Report</td>
<td>129</td>
</tr>
<tr>
<td>Update the Exterior Orientation</td>
<td>130</td>
</tr>
<tr>
<td>Ortho Resample the Imagery</td>
<td>131</td>
</tr>
<tr>
<td>View the Orthoimages</td>
<td>135</td>
</tr>
<tr>
<td>Display Graphic View</td>
<td>135</td>
</tr>
<tr>
<td>Use the Viewer</td>
<td>136</td>
</tr>
<tr>
<td>Magnify Areas of Overlap</td>
<td>137</td>
</tr>
<tr>
<td>Use the Swipe Utility</td>
<td>138</td>
</tr>
<tr>
<td>Save and Close the Block File</td>
<td>139</td>
</tr>
<tr>
<td>Conclusions</td>
<td>140</td>
</tr>
<tr>
<td>Reference Images</td>
<td>141</td>
</tr>
</tbody>
</table>

**Digital Camera Tour Guide** ........................................... 145  

**Introduction** .......................................................... 145  

**Before You Begin** ...................................................... 145  

**Create a New Project** .................................................. 146  
<table>
<thead>
<tr>
<th>Subtopic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare the Block File</td>
<td>146</td>
</tr>
<tr>
<td>Select Geometric Model</td>
<td>148</td>
</tr>
<tr>
<td>Define Block Properties</td>
<td>149</td>
</tr>
<tr>
<td>Import Exterior Orientation Parameters</td>
<td>150</td>
</tr>
<tr>
<td>Add Imagery to the Block</td>
<td>153</td>
</tr>
<tr>
<td>Compute Pyramid Layers</td>
<td>156</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Define the Camera Model</td>
<td>157</td>
</tr>
<tr>
<td>Enter Specific Camera Information</td>
<td>157</td>
</tr>
<tr>
<td>Save the Camera Information</td>
<td>158</td>
</tr>
<tr>
<td>Check Camera Information of the Other Images</td>
<td>160</td>
</tr>
<tr>
<td>Enter Interior Orientation Information</td>
<td>160</td>
</tr>
<tr>
<td>Enter Exterior Orientation Information</td>
<td>161</td>
</tr>
<tr>
<td>Perform Automatic Tie Point Collection</td>
<td>162</td>
</tr>
<tr>
<td>Check Tie Point Accuracy</td>
<td>166</td>
</tr>
<tr>
<td>Perform Aerial Triangulation</td>
<td>167</td>
</tr>
<tr>
<td>Check Project Graphic Status</td>
<td>171</td>
</tr>
<tr>
<td>Ortho Resample the Imagery</td>
<td>174</td>
</tr>
<tr>
<td>View the Orthoimages</td>
<td>177</td>
</tr>
<tr>
<td>Use LPS</td>
<td>177</td>
</tr>
<tr>
<td>Use a Viewer</td>
<td>178</td>
</tr>
<tr>
<td>Magnify Areas of Overlap</td>
<td>179</td>
</tr>
<tr>
<td>Use the Swipe Utility</td>
<td>180</td>
</tr>
<tr>
<td>Save and Close the Block File</td>
<td>182</td>
</tr>
<tr>
<td>Conclusions</td>
<td>183</td>
</tr>
</tbody>
</table>

SPOT Pushbroom Sensor Tour Guide ..................................... 185

Introduction ................................................................. 185

Before You Begin ......................................................... 186

Create a New Project ...................................................... 186

- Prepare the Block File                                     | 186 |
- Choose Camera Model                                       | 188 |
- Add Imagery to the Block                                  | 190 |
- Generate Pyramid Layers                                   | 191 |
- Define the Sensor Model                                   | 192 |

Start the Point Measurement Tool ..................................... 193

- Specify the Horizontal Reference Source                   | 194 |

Collect GCPs ........................................................................ 197

- Collect Point ID 1                                        | 198 |
- Collect Point ID 2                                        | 200 |
- Set Automatic (x, y) Drive Function                       | 202 |
- Collect Point ID 3                                        | 202 |
- Collect Point ID 4                                        | 203 |
- Collect Point ID 5                                        | 204 |
- Collect Point ID 6                                        | 205 |
- Collect Point ID 7                                        | 206 |
- Collect Point ID 8                                        | 207 |
- Collect Point ID 9                                        | 208 |

Collect the Last Two Control Points .................................... 208

- Set the Horizontal Reference                              | 209 |
- Collect Point ID 11                                       | 210 |
- Collect Point ID 12                                       | 212 |
- Set the Vertical Reference Source                         | 214 |
- Set Type and Usage                                       | 216 |
- Save the Block File                                       | 217 |

Add a Second Image to the Block ....................................... 217
Generate Pyramid Layers .......................... 218
Define the Sensor Model ......................... 218

**Start the Point Measurement Tool** ............ 219

**Collect Ground Control Points** ................. 220
Collect Point ID 1 ............................. 220
Collect Point ID 2 ............................. 221
Collect Point ID 5 ............................. 221
Collect Point ID 6 ............................. 222
Collect Point ID 8 ............................. 222
Collect Point ID 9 ............................. 223
Collect Point ID 12 ........................... 223

**Perform Automatic Tie Point Collection** ....... 224
Check Tie Point Accuracy ......................... 226

**Perform Triangulation** .......................... 227

**Ortho Resample the Imagery** .................... 231

**View the Orthoimages** .......................... 233
Use LPS ........................................ 233
Use a Viewer ..................................... 234
Magnify Areas of Overlap ......................... 235
Use the Swipe Utility ............................ 236

**Save and Close the Block File** ................. 237

**Conclusions** ................................ 238

**SPOT Example Data** ............................. 239
Project Location .................................. 239
Imagery .......................................... 239
DEM ............................................. 239
Projection ........................................ 239
Spheroid ......................................... 239
Zone Number ...................................... 239
Datum ............................................. 239
Horizontal Units .................................. 239
Vertical Units .................................... 239
Sensor Information ................................ 239
GCP Map Coordinates .................. 240
GCP Pixel Coordinates .................. 240

**Stereo Point Measurement Tool Tour Guide** .... 243

**Introduction** .................................. 243

**Before You Begin** ............................... 243

**Open a Project** ................................ 243

**Image Selection** ................................. 245

**Check Device Setup** ............................. 247

**Select Points** .................................. 249
Point ID 1001 .................................... 249
Point ID 1002 .................................... 252
Point ID 1003 .................................... 255
Point ID 1004 .................................... 257
Point ID 1005 .................................... 258
# Table of Contents

 editing exterior information for multiple images ........ 313
 editing statistical and status information ........ 315

## Measuring GCPs, Check Points, and Tie Points ........ 323

### Introduction ........................................ 323

### Point Measurement Views ............................ 324
  - Image Enhancement ................................ 324

### Defining the Usage of GCPs ....................... 326
  - Importing Ground Coordinates Using the CellArray ........ 327
  - Exporting Ground Coordinates Using the CellArray ........ 328

### Defining the Statistical Quality of GCPs .......... 329
  - Creating GCPs from Stereo Images .................. 330
  - Collecting Horizontal Reference GCPs ............... 331
  - Collecting Vertical Reference GCPs ................ 332
  - Collecting GCPs on Multiple Images ................ 333
  - Collecting GCPs on Multiple Strips ................ 334

### Automatic Tie Point Collection .................... 337

### Introduction ........................................ 337

### Minimum Input Requirements ...................... 338
  - Performing Automatic Tie Point Collection: An Alternative Solution ................ 339
  - Optimizing Automatic Tie Point Collection .......... 343
  - Performing Automatic Tie Point Collection on Color Imagery 346
  - Troubleshooting Tips ............................... 346

### Block Triangulation ................................. 349

### Introduction ........................................ 349

### Aerial Triangulation ................................. 349
  - Convergence Value .................................. 350
  - Accuracy Estimates ................................. 350

### Optimizing Aerial Triangulation Using Statistical Information ........................................ 351
  - Assigning Statistical Weights to Image/Photo-coordinates 352
  - Assigning Statistical Weights to GCPs ............... 352
  - Assigning Statistical Weights to Exterior Orientation 353

### SCBA .................................................. 355
  - Fixed For All Images ................................ 356
  - Same Weighted Corrections For All ............... 356
  - Different Weighted Corrections .................... 357
  - Same Unweighted Corrections For All ............. 357
  - Different Unweighted Corrections ................ 357
  - Optimizing the SCBA ................................ 358
  - Estimating AP for SCBA ............................ 359

### Automated Gross Error Checking .................... 362
  - Understanding the Aerial Triangulation Report ....... 363
  - Update Results ..................................... 364
  - Accept Results ..................................... 364
# Table of Contents

**Aerial Triangulation Report** ........................................... 364
  - Triangulation Report Unit Definition .......................... 365
  - Image Coordinates and Interior Orientation Results ...... 365
  - Aerial Triangulation Results .................................... 367
  - Optimizing the Aerial Triangulation Results ................ 376
  - Graphically Analyzing Aerial Triangulation Results ...... 377

**Using LPS for Camera Calibration** ................................. 379
  - Calibration Certificate ......................................... 380
  - No Calibration Certificate ...................................... 381
  - Locating k1 and k2 in the Triangulation Report .......... 381
  - Using Lens Distortion Parameters ............................. 382

**Triangulation of SPOT, IRS-1C, and Generic Pushbroom Imagery** ................................................. 383
  - Assigning Statistical Weights to GCPs ........................ 384
  - Advanced Options ............................................... 385

**Triangulation Report** ................................................ 386
  - Triangulation Report Unit Definition ........................ 386
  - Automated Error Checking Model .............................. 387
  - Iterative Triangulation Results ................................ 388
  - Exterior Orientation Results ................................... 389
  - GCP Results ...................................................... 391
  - Image Coordinate Information .................................. 391
  - Optimizing the Triangulation Results ....................... 392

**Refinement Summary Report** ..................................... 393
  - Adjustment Report Unit Definition ............................. 393
  - Calculated Point Coordinates .................................. 393
  - Point Residuals .................................................. 394
  - Image Accuracy ................................................... 394
  - Summary RMSE ..................................................... 395

**Orthorectification** .................................................. 397

**Introduction** .......................................................... 397

**Ortho Resampling** .................................................. 397
  - General Tab .......................................................... 398
  - Adding Images ...................................................... 398
  - Advanced Tab ........................................................ 399

**Ortho Calibration** ................................................... 401

**Appendices** ........................................................... 403

**Batch Processing** ..................................................... 405

**Introduction** .......................................................... 405
**Set Up/Start the Scheduler** ....................................... 405
**Execute Multiple Files/Single Command** ....................... 407
**Other Batch Applications** .......................................... 409
References ............................................. 411
  Introduction ........................................ 411
  Works Cited ........................................ 411

Photogrammetric Glossary ......................... 419
  Abbreviations and Acronyms ....................... 419
  File Types ......................................... 420
  Symbols ............................................ 420
  Terms .............................................. 421

Index .................................................. 441
### List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Topography</td>
<td>15</td>
</tr>
<tr>
<td>2</td>
<td>Analog Stereo Plotter</td>
<td>16</td>
</tr>
<tr>
<td>3</td>
<td>LPS Project Manager Point Measurement Interface</td>
<td>17</td>
</tr>
<tr>
<td>4</td>
<td>Satellite</td>
<td>18</td>
</tr>
<tr>
<td>5</td>
<td>Exposure Stations Along a Flight Path</td>
<td>22</td>
</tr>
<tr>
<td>6</td>
<td>Exposure Station</td>
<td>23</td>
</tr>
<tr>
<td>7</td>
<td>A Regular Rectangular Block of Aerial Photos</td>
<td>24</td>
</tr>
<tr>
<td>8</td>
<td>Overlapping Images</td>
<td>24</td>
</tr>
<tr>
<td>9</td>
<td>Pixel Coordinates vs. Image Coordinates</td>
<td>27</td>
</tr>
<tr>
<td>10</td>
<td>Image Space and Ground Space Coordinate System</td>
<td>28</td>
</tr>
<tr>
<td>11</td>
<td>Terrestrial Photography</td>
<td>30</td>
</tr>
<tr>
<td>12</td>
<td>Internal Geometry</td>
<td>31</td>
</tr>
<tr>
<td>13</td>
<td>Pixel Coordinate System vs. Image Space Coordinate System</td>
<td>32</td>
</tr>
<tr>
<td>14</td>
<td>Radial vs. Tangential Lens Distortion</td>
<td>34</td>
</tr>
<tr>
<td>15</td>
<td>Elements of Exterior Orientation</td>
<td>35</td>
</tr>
<tr>
<td>16</td>
<td>Omega, Phi, and Kappa</td>
<td>36</td>
</tr>
<tr>
<td>17</td>
<td>Roll, Pitch, and Yaw</td>
<td>36</td>
</tr>
<tr>
<td>18</td>
<td>Primary Rotation Omega About the X-axis</td>
<td>38</td>
</tr>
<tr>
<td>19</td>
<td>Secondary Rotation Phi about the Y Omega-axis</td>
<td>39</td>
</tr>
<tr>
<td>20</td>
<td>Tertiary Rotation Kappa About the Z Omega Phi-axis</td>
<td>39</td>
</tr>
<tr>
<td>21</td>
<td>Space Forward Intersection</td>
<td>44</td>
</tr>
<tr>
<td>22</td>
<td>Photogrammetric Configuration</td>
<td>46</td>
</tr>
<tr>
<td>23</td>
<td>Photogrammetric Configuration</td>
<td>46</td>
</tr>
<tr>
<td>24</td>
<td>GCP Configuration</td>
<td>55</td>
</tr>
<tr>
<td>25</td>
<td>GCPs in a Block of Images</td>
<td>55</td>
</tr>
<tr>
<td>26</td>
<td>Tie Point Distribution for Triangulation</td>
<td>56</td>
</tr>
<tr>
<td>27</td>
<td>Tie Points in a Block</td>
<td>56</td>
</tr>
<tr>
<td>28</td>
<td>Image Pyramid for Matching at Coarse to Full Resolution</td>
<td>62</td>
</tr>
<tr>
<td>29</td>
<td>Perspective Centers of SPOT Scan Lines</td>
<td>63</td>
</tr>
<tr>
<td>30</td>
<td>Image Coordinates in a Satellite Scene</td>
<td>64</td>
</tr>
<tr>
<td>31</td>
<td>Interior Orientation of a SPOT Scene</td>
<td>65</td>
</tr>
<tr>
<td>32</td>
<td>Inclination of a Satellite Stereo Scene (View from North to South)</td>
<td>67</td>
</tr>
<tr>
<td>33</td>
<td>Nadir and Off-nadir</td>
<td>68</td>
</tr>
<tr>
<td>34</td>
<td>Velocity Vector and Orientation Angle of a Single Scene</td>
<td>68</td>
</tr>
<tr>
<td>35</td>
<td>Ideal Point Distribution Over a Satellite Scene for Triangulation</td>
<td>70</td>
</tr>
<tr>
<td>36</td>
<td>Orthorectification</td>
<td>71</td>
</tr>
<tr>
<td>37</td>
<td>Digital Orthoimage - Finding Gray Values</td>
<td>72</td>
</tr>
<tr>
<td>38</td>
<td>Geometric Relationship</td>
<td>77</td>
</tr>
<tr>
<td>39</td>
<td>Reference Sketch and Detail View of Point ID 1002</td>
<td>103</td>
</tr>
<tr>
<td>40</td>
<td>Reference Sketch and Detail View of Point ID 1003</td>
<td>106</td>
</tr>
<tr>
<td>41</td>
<td>Reference Sketch and Detail View of Point ID 1004</td>
<td>110</td>
</tr>
<tr>
<td>42</td>
<td>Reference Sketch and Detail View of Point ID 1005</td>
<td>112</td>
</tr>
<tr>
<td>43</td>
<td>Reference Sketch and Detail View of Point ID 1006</td>
<td>114</td>
</tr>
<tr>
<td>44</td>
<td>Reference Sketch and Detail View of Point ID 2001</td>
<td>117</td>
</tr>
</tbody>
</table>
Figure 45: Reference Sketch and Detail View of Point ID 2002. .................................. 119
Figure 46: Reference Image of col90p1 ........................................................................ 141
Figure 47: Reference Image of col91p1 ........................................................................ 142
Figure 48: Reference Image of col92p1 ........................................................................ 143
Figure 49: Imported Orientation Information ................................................................ 145
Figure 50: Reference Images: xs_ortho.img and NAPP_2m-ortho.img ......................... 185
Figure 51: Location of Point ID 1 .................................................................................. 198
Figure 52: Location of Point ID 2 .................................................................................. 200
Figure 53: Location of Point ID 3 .................................................................................. 202
Figure 54: Location of Point ID 4 .................................................................................. 203
Figure 55: Location of Point ID 5 .................................................................................. 204
Figure 56: Location of Point ID 6 .................................................................................. 205
Figure 57: Location of Point ID 7 .................................................................................. 206
Figure 58: Location of Point ID 8 .................................................................................. 207
Figure 59: Location of Point ID 9 .................................................................................. 208
Figure 60: Location of Point ID 11 ............................................................................... 211
Figure 61: Location of Point ID 12 ............................................................................... 212
Figure 62: A Block Containing a Strip of Imagery ......................................................... 266
Figure 63: A Block Containing Several Strips of Imagery ............................................ 266
Figure 64: The LPS Project Manager Dialog ................................................................. 267
Figure 65: LPS CellArray .............................................................................................. 268
Figure 66: Model Setup Dialog ..................................................................................... 268
Figure 67: Projection, Spheroid, and Datum .................................................................. 273
Figure 68: The Projection Chooser ............................................................................... 273
Figure 69: The Projection Chooser—Unique Parameters ............................................. 274
Figure 70: Block Property Setup Dialog ...................................................................... 274
Figure 71: Photogrammetric Information in Block Property Setup Dialog ............... 275
Figure 72: Photographic Directions Used for Aerial and Terrestrial Imagery .......... 277
Figure 73: Average Flying Height of an Aircraft Above Ground Level ................. 278
Figure 74: Examples that Specify Average Flying Height .......................................... 279
Figure 75: Import Parameters for Exterior Orientation ............................................. 281
Figure 76: Import Options for Exterior Orientation .................................................... 282
Figure 77: Preview the Contents of the Input ASCII File ........................................... 283
Figure 78: The LPS Project Manager CellArray with Imported Data ....................... 284
Figure 79: LPS Project Manager .................................................................................... 285
Figure 80: Image File Name Dialog ............................................................................. 289
Figure 81: The LPS CellArray with Added Imagery .................................................... 290
Figure 82: Compute Pyramid Layers Dialog ............................................................... 292
Figure 83: Frame Editor Dialog .................................................................................... 295
Figure 84: LPS CellArray with Off-line Image .............................................................. 296
Figure 85: Image File in the Image File Name Dialog .................................................. 297
Figure 86: Camera Information Dialog ....................................................................... 298
Figure 87: Fiducials Tab ............................................................................................... 300
Figure 88: Radial Lens Distortion Tab ......................................................................... 301
Figure 89: Interior Orientation Tab of the Frame Editor ............................................ 303
Figure 90: Fiducial Marks within the Frame Editor ..................................................... 304
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>91</td>
<td>Fiducial Orientation of an Aerial Photograph</td>
<td>305</td>
</tr>
<tr>
<td>92</td>
<td>Fiducial Orientation Conventions</td>
<td>305</td>
</tr>
<tr>
<td>93</td>
<td>Data Strip on a Photograph</td>
<td>307</td>
</tr>
<tr>
<td>94</td>
<td>Set Resampling Method Dialog</td>
<td>308</td>
</tr>
<tr>
<td>95</td>
<td>Data Scaling Dialog</td>
<td>309</td>
</tr>
<tr>
<td>96</td>
<td>Contrast Adjust Dialog</td>
<td>309</td>
</tr>
<tr>
<td>97</td>
<td>Interior Orientation Tab for Nonmetric Cameras</td>
<td>311</td>
</tr>
<tr>
<td>98</td>
<td>Exterior Information Tab for the Frame Editor</td>
<td>312</td>
</tr>
<tr>
<td>99</td>
<td>Exterior Orientation Parameter Editor Dialog</td>
<td>313</td>
</tr>
<tr>
<td>100</td>
<td>CellArray Formula Dialog</td>
<td>316</td>
</tr>
<tr>
<td>101</td>
<td>Frame Editor for Pushbroom Sensor Models</td>
<td>316</td>
</tr>
<tr>
<td>102</td>
<td>Sensor Information Formula Dialog for Pushbroom Sensor Models</td>
<td>317</td>
</tr>
<tr>
<td>103</td>
<td>Model Parameters Tab for the Sensor Information Dialog</td>
<td>317</td>
</tr>
<tr>
<td>104</td>
<td>Frame Attributes Tab for Pushbroom Sensor Models</td>
<td>319</td>
</tr>
<tr>
<td>105</td>
<td>Sensor Tab for IKONOS Sensor Model</td>
<td>320</td>
</tr>
<tr>
<td>106</td>
<td>Chipping Tab for IKONOS Sensor Model</td>
<td>320</td>
</tr>
<tr>
<td>107</td>
<td>Point Measurement Tool</td>
<td>323</td>
</tr>
<tr>
<td>108</td>
<td>Set Resampling Method Dialog</td>
<td>324</td>
</tr>
<tr>
<td>109</td>
<td>Set Data Scaling Dialog</td>
<td>325</td>
</tr>
<tr>
<td>110</td>
<td>Contrast Adjustment Dialog</td>
<td>325</td>
</tr>
<tr>
<td>111</td>
<td>Set Band Combinations Dialog</td>
<td>325</td>
</tr>
<tr>
<td>112</td>
<td>Viewing Properties Dialog</td>
<td>329</td>
</tr>
<tr>
<td>113</td>
<td>Formula Dialog of the LPS CellArray</td>
<td>330</td>
</tr>
<tr>
<td>114</td>
<td>GCP Reference Source Dialog from the Point Measurement Tool</td>
<td>331</td>
</tr>
<tr>
<td>115</td>
<td>A Configuration of GCPs Located on Three Images</td>
<td>333</td>
</tr>
<tr>
<td>116</td>
<td>A Configuration of GCPs Located on Six Images</td>
<td>334</td>
</tr>
<tr>
<td>117</td>
<td>Automatic Tie Point Generation Properties Dialog</td>
<td>338</td>
</tr>
<tr>
<td>118</td>
<td>GCP Configuration for Six Images</td>
<td>339</td>
</tr>
<tr>
<td>119</td>
<td>Location of the Perspective Center for Six Images</td>
<td>339</td>
</tr>
<tr>
<td>120</td>
<td>Kappa as a Function</td>
<td>348</td>
</tr>
<tr>
<td>121</td>
<td>General Tab of the Aerial Triangulation Dialog</td>
<td>350</td>
</tr>
<tr>
<td>122</td>
<td>Point Tab of the Aerial Triangulation Dialog</td>
<td>352</td>
</tr>
<tr>
<td>123</td>
<td>Exterior Tab of the Aerial Triangulation Dialog</td>
<td>354</td>
</tr>
<tr>
<td>124</td>
<td>Interior Tab of the Aerial Triangulation Dialog</td>
<td>356</td>
</tr>
<tr>
<td>125</td>
<td>Advanced Options Tab of the Aerial Triangulation Dialog</td>
<td>359</td>
</tr>
<tr>
<td>126</td>
<td>A GCP Configuration for a Large Block of Images</td>
<td>377</td>
</tr>
<tr>
<td>127</td>
<td>Project Graphic Status Window</td>
<td>378</td>
</tr>
<tr>
<td>128</td>
<td>General Tab of the Triangulation Dialog</td>
<td>384</td>
</tr>
<tr>
<td>129</td>
<td>Point Tab of the Triangulation Dialog</td>
<td>385</td>
</tr>
<tr>
<td>130</td>
<td>Advanced Options Tab of the Triangulation Dialog</td>
<td>385</td>
</tr>
<tr>
<td>131</td>
<td>Tie Points Contained within a GCP Configuration</td>
<td>392</td>
</tr>
<tr>
<td>132</td>
<td>Ortho Resampling Dialog—General Tab</td>
<td>398</td>
</tr>
<tr>
<td>133</td>
<td>Add Single Output to Ortho Resampling CellArray</td>
<td>399</td>
</tr>
<tr>
<td>134</td>
<td>Add Multiple Outputs to Ortho Resampling CellArray</td>
<td>399</td>
</tr>
<tr>
<td>135</td>
<td>Ortho Resampling Dialog—Advanced Tab</td>
<td>400</td>
</tr>
<tr>
<td>136</td>
<td>Ortho Calibration Dialog</td>
<td>401</td>
</tr>
</tbody>
</table>
List of Tables

Table 1: LPS Menu Bar ................................................................. 9
Table 2: LPS Project Manager Toolbar ........................................... 9
Table 3: Scanning Resolutions ...................................................... 26
Table 4: GCP Map Coordinates .................................................... 240
Table 5: GCP Pixel Coordinates ................................................... 240
Table 6: LPS Workflow .............................................................. 286
Table 7: Perspective Center Coordinates ....................................... 340
Table 8: Photography Scale and Associated Data (Feet) .................. 340
Table 9: Photography Scale and Associated Data (Meters) ............... 342
Preface

About This Manual

The *LPS Project Manager User’s Guide* contains theory that explains the photogrammetric applications of the core module of LPS, LPS Project Manager; tour guides that help you begin to use the program; practical applications of the software; and appendices that give you additional information.

This manual serves as a handy reference while using LPS Project Manager. A comprehensive index is included so that you can easily locate specific information as needed.

Example Data

Data sets are provided with the LPS Project Manager and LPS Automatic Terrain Extraction software so that your results match those in the tour guides. This data is loaded, optionally, during the software installation process into /examples/LPS. The example data sets are further divided by the example they pertain to: /frame, /digital, /spot, and /laguna_beach.

Documentation

This manual is part of a suite of on-line documentation that you receive with ERDAS IMAGINE software. There are two basic types of documents, digital hardcopy documents which are delivered as PDF files suitable for printing or on-line viewing, and On-Line Help Documentation, delivered as HTML files.

The PDF documents are found in `<IMAGINE_HOME>/help/hardcopy`. Many of these documents are available from the Erdas Start menu. The on-line help system is accessed by clicking on the Help button in a dialog or by selecting an item from a Help menu.

Conventions Used in This Book

In ERDAS IMAGINE, the names of menus, menu options, buttons, and other components of the interface are shown in bold type. For example:

“In the Select Layer To Add dialog, select the **Fit to Frame** option.”

When asked to use the mouse, you are directed to click, double-click, Shift-click, middle-click, right-click, hold, drag, etc.

- click — designates clicking with the left mouse button.
- double-click — designates clicking twice with the left mouse button.
• Shift-click — designates holding the Shift key down on your keyboard and simultaneously clicking with the left mouse button.

• middle-click — designates clicking with the middle mouse button.

• right-click — designates clicking with the right mouse button.

• hold — designates holding down the left (or right, as noted) mouse button.

• drag — designates dragging the mouse while holding down the left mouse button.

The following paragraphs are used throughout the ERDAS IMAGINE documentation:

⚠️ These paragraphs contain strong warnings or important tips.

🌟 These paragraphs give you software-specific information.

💡 These paragraphs provide information about Erdas products.

📚 These paragraphs lead you to other areas of this book or other manuals for additional information.

NOTE: Notes give additional instruction.

Blue Box
Introduction
Introduction to LPS Project Manager

Introduction

Welcome to LPS Project Manager, which is the primary component of LPS. Provided in one easy-to-use environment is a comprehensive digital photogrammetry package that allows for the fast and accurate triangulation and orthorectification of images collected from various types of cameras and satellite sensors.

LPS Project Manager drastically reduces the cost and time associated with triangulating and orthorectifying aerial photography, satellite imagery, digital, and video camera imagery when collecting geographic information. The product addresses issues and problems related to:

- Collecting ground control points (GCPs) in the field or office.
- Measuring GCPs and tie points on multiple images.
- Performing quality control in order to verify the overall accuracy of the final product.
- Accommodating photography and satellite imagery from various camera and satellite sensor types, including standard aerial, digital, video, amateur 35 mm cameras (including terrestrial and oblique photography), and SPOT pushbroom sensors.
- Integrating data from airborne global positioning system (GPS) and other photogrammetric sources.
- Using photography scanned from desktop scanners.
- Triangulating multiple images automatically.
- Extracting DTMs automatically from imagery.

Using LPS Project Manager

Due to the large geometric distortion associated with raw aerial photography and satellite imagery, measurements made on data sources that have not been rectified for the purpose of collecting geographic information are not reliable. Generally, the geometric distortion is caused by various systematic and nonsystematic errors such as camera and sensor orientation, terrain relief, Earth curvature, film and scanning distortion, and measurement errors (Wolf 1983, Konecny and Lehmann 1984, Kraus 1984, Wang, Z. 1990, Jensen 1996).
To rectify image data, various geometric modeling methods such as polynomial transformation, multisurface (radial basis) functions, finite element analysis (rubber sheeting), and collinearity equations can be applied (Yang 1997). While the choice of the proper modeling method depends on data sources and data availability, the collinearity equation based orthorectification produces the most reliable solution for raw image data by incorporating the sensor or camera orientation, relief displacement, and the Earth’s curvature in its modeling process.

Orthorectification in LPS Project Manager generates planimetrically true orthoimages in which the displacement of objects due to sensor or camera orientation, terrain relief, and other errors associated with image acquisition and processing has been removed. The orthoimage has the geometric characteristics of a map and the image qualities of a photograph. The objects on an orthoimage are in their true orthographic positions. Therefore, orthoimages are geometrically equivalent to conventional line and symbol planimetric maps. Any measurement taken on an orthoimage reflects a measurement taken on the ground.

Orthoimages serve as the ideal information building blocks for collecting geographic information required for a geographic information system (GIS). They can be used as reference image backdrops to maintain or update an existing GIS. Using the IMAGINE Vector™ module, ground features can be collected and subsequently attributed to reflect the spatial and nonspatial characteristics associated with a feature. Using ERDAS IMAGINE, multiple orthoimages can be mosaicked to form seamless orthoimage base maps.

LPS Project Manager uses the self-calibrating bundle block adjustment method in its triangulation process. By doing so, the internal geometry of each image and the relationships between overlapping images are determined. When multiple images are involved in a data block, such a modeling method can significantly ease the need of acquiring many GCPs.

Image tie points are the common points in overlapping areas of two or more images. They connect the images in the block to each other and are necessary input for the triangulation. LPS Project Manager automates the identification and measurement of tie points so that your work and time for manual measurement are drastically reduced.

In addition to orthoimages, digital elevation models (DEM)s and topographic features are two other major geographic information components of a GIS. In order to extract a DEM and topographic features from imagery, the image orientations need to be known. The triangulation results of LPS Project Manager determine the image position and orientations required for the purpose of DEM extraction and stereo feature collection.
LPS Project Manager Functionality

First, LPS Project Manager allows you to easily model various camera and sensor types, referred to as sensor modeling. LPS Project Manager’s sensor modeling capabilities establish the internal characteristics (that is, geometry) associated with a specific camera or sensor, and correct for systematic error.

Second, LPS Project Manager allows you to model the position and orientation of a camera or sensor at the time of data collection, which dramatically improves the accuracy of the resulting orthoimages.

Third, LPS Project Manager automatically measures the image positions of ground feature points appearing on multiple images, which is referred to as automatic tie point collection. Once the image positions of the tie points are established, the corresponding ground coordinates can be determined using aerial triangulation techniques. (If many tie points were automatically collected, a rough DEM can be interpolated using the tie points as mass points.)

Fourth, LPS Project Manager gives you the flexibility to orthorectify images from a variety of camera and satellite sensor types. Additionally, it allows you to process multiple orthos sequentially.

Triangulation

Triangulation, or block triangulation, is the process of establishing a mathematical relationship between the images contained in a project, the camera or sensor model, and the ground. The information resulting from triangulation is required as input for the orthorectification process.

Classical aerial triangulation using optical-mechanical analog and analytical stereo plotters was primarily used for collection of ground points using the control point extension technique. This involved the manual measurement of tie points for the subsequent determination of their corresponding ground coordinates. These points were then identified as being GCPs for other applications. With the advent of digital photogrammetry, classical aerial triangulation has been extended to provide greater functionality.

LPS Project Manager uses a technique known as bundle block adjustment for aerial triangulation. Bundle block adjustment provides three primary functions:

- The ability to determine the position and orientation of each image in a project as they existed at the time of photographic or image exposure. The resulting parameters are referred to as exterior orientation parameters.
• The ability to determine the ground coordinates of any tie points measured on the overlap areas of multiple images. The highly precise ground point determination of tie points is useful for generating GCPs from imagery in lieu of ground surveying techniques.

• The ability to distribute and minimize the errors associated with the imagery, image measurements, GCPs, and so forth. The bundle block adjustment processes information from an entire block of imagery in one simultaneous solution (that is, a bundle) using statistical techniques to automatically identify, distribute, and remove error.

Tour Guide Examples

The following tour guide examples are used to highlight the unique capabilities available within LPS Project Manager. Each example provides a representative workflow of a real-world scenario that may be encountered for jobs associated with triangulation and orthorectification. Of particular significance is the ability of LPS Project Manager to accommodate data from various sources including different types of cameras and satellite sensors, airborne GPS, and various reference sources for collecting GCPs. Each tour guide example exemplifies the data flexibility provided by LPS Project Manager.

Frame Camera Tour Guide

This example involves performing aerial triangulation and orthorectification on three overlapping aerial photographs that have a photo scale of 1:40000. A calibration report is provided that defines the internal geometry of the camera as it existed when the photographs were captured.

Several GCPs are measured on the overlapping images in order to better establish the relationship between the images, the camera, and the ground. Once the GCPs have been measured, automatic tie point collection tools are used to measure the corresponding image positions of tie points on overlapping images.

Additionally, a United States Geological Survey (USGS) DEM is provided to account for the effect of topographic relief during the orthorectification process. Orthorectification is performed for each image sequentially.

See the tour guide Frame Camera Tour Guide
This example involves performing aerial triangulation and orthorectification on three overlapping digital camera images that have an image scale of 1:45000. The images were taken using a Kodak DCS 420 digital camera. The ground resolution of the imagery is approximately 0.40 meters. The only camera calibration information provided is the focal length and the pixel size of the Charge Coupled Device (CCD).

Airborne GPS and inertial navigation system (INS) data is available for each image. This information defines the position and orientation associated with each image as they existed during capture. This information can be referred to as exterior orientation. For this reason, GCPs are not required for this data set. In scenarios where exterior orientation is available, GCPs are not required. Additionally, since digital camera imagery does not have fiducial marks, the interior orientation is done automatically.

Automatic tie point collection tools are used to measure the corresponding image positions of tie points on overlapping images. Aerial triangulation is performed to adjust the exterior orientation parameters and determine the XYZ coordinates of the tie points. If so desired, the tie points can be converted to GCPs. This is referred to as control point extension. Lastly, orthorectification is performed for each image sequentially using a constant elevation value.

See the tour guide Digital Camera Tour Guide.

This example involves performing triangulation and orthorectification on two overlapping SPOT panchromatic images. The images are captured using a pushbroom sensor. The ground resolution of the images is 10 meters. LPS Project Manager automatically uses the ephemeris information associated with the image to define the geometry of the sensor as it existed when the imagery was captured.

Using an existing SPOT XS orthorectified image (20-meter resolution), a 2-meter orthophoto, and a DEM, GCPs are measured. The SPOT ortho and aerial orthophoto are used for the collection of horizontal GCPs. A DEM is used for the vertical component (Z) of a GCP. This is done automatically once the horizontal components of the GCPs have been measured.

Automatic tie point collection tools are used to measure the corresponding image positions of tie points on overlapping images. Triangulation is performed to define the position and orientation of the sensor as they existed when the imagery was captured, and to determine the XYZ coordinates of the tie points. Using a DEM, the two SPOT images are sequentially orthorectified.
Appendix Example
An appendix is provided to detail the batch process.

Batch Processing
This appendix explains how you can set up your system for Batch processing. You can then set parameters for multiple output DTMs and load them into the Batch Wizard for execution at a later time. The Batch Wizard works in conjunction with the Microsoft Scheduler, which is located in the Services category of the Control Panel.

See "Batch Processing" for more information.

About LPS Project Manager
Before you begin working with LPS Project Manager, it may be helpful to go over some of the icons and menu options located on the interface. You use these menus and icons throughout the tour guides.
Menu Bar
The menu bar across the top of the main LPS dialog has the following options, most of which are associated with LPS Project Manager and LPS Automatic Terrain Extraction:

Table 1: LPS Menu Bar

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Process</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Add Frame...</td>
<td>Automatic Tie Point Generation</td>
<td>Configure SOCET Set Access...</td>
<td>Help for LPS ...</td>
</tr>
<tr>
<td>Open...</td>
<td>Frame Editor...</td>
<td>Triangulate</td>
<td>Create New DTM</td>
<td>Help for LPS Project Manager...</td>
</tr>
<tr>
<td>Save</td>
<td>Compute Pyramid Layers...</td>
<td>Block Triangulation</td>
<td>Terrain Prep Tool...</td>
<td>About LPS ...</td>
</tr>
<tr>
<td>Save As...</td>
<td>Update Pyramid Layer Status</td>
<td>Triangulation Report...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import SOCET SET Project...</td>
<td>Delete Selected Image(s)</td>
<td>Project Graphic Status...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export To SOCET SET Project...</td>
<td>Point Measurement...</td>
<td>DTM Extraction...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Register SOCET SET Project(s)...</td>
<td>Block Properties...</td>
<td>DTM Extraction Report...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>Auto. Tie Point Generation Properties...</td>
<td>Interactive Terrain Editing...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Recent Files&gt;</td>
<td>Triangulation Properties...</td>
<td>Ortho Rectification</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>DTM Extraction Properties...</td>
<td>Resampling...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calibration...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mosaic...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Feature Collection</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Analyst for IMAGINE</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Analyst for ArcGIS</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRO600 for LPS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Toolbar
The following icons are located in the LPS dialog toolbar:

Table 2: LPS Project Manager Toolbar

<table>
<thead>
<tr>
<th>New Block File</th>
<th>Click to start creating a new block file. A File Selector opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Open Existing Block File</strong></td>
<td>Click to open a block file that already exists. A File Selector dialog opens.</td>
</tr>
<tr>
<td><strong>Save Block Information</strong></td>
<td>Click to save any changes you have made to the block file.</td>
</tr>
<tr>
<td><strong>Add Frame</strong></td>
<td>Click to add a new image to the project file. A File Selector dialog opens.</td>
</tr>
<tr>
<td><strong>Frame Editor</strong></td>
<td>Click to specify interior orientation, exterior orientation, and fiducial coordinates for each image in the Frame Editor dialog.</td>
</tr>
<tr>
<td><strong>Point Measurement</strong></td>
<td>Click to measure check and GCPs in your block images. Views, a tool palette, and two CellArrays™ open within a single dialog.</td>
</tr>
<tr>
<td><strong>Auto Tie</strong></td>
<td>Click to run automatic tie point generation, which includes the following tasks: block configuration, tie point extraction, point transfer, gross error detection, and tie point selection.</td>
</tr>
<tr>
<td><strong>Triangulation</strong></td>
<td>Click to perform triangulation on your block images, which estimates the position of each image in a block at the time of image capture, the coordinates of tie points, the interior orientation parameters, and additional parameters.</td>
</tr>
</tbody>
</table>
| **DTM Extraction**   | This icon starts the LPS Automatic Terrain Extraction application. Click to extract a single DTM or multiple DTMs from images in the block file. You can choose from the following types of output DTMs: DEM, ASCII, TerraModel TIN, 3D Shape file, or SOCET SET TIN. For more information, please refer to the LPS Automatic Terrain Extraction User’s Guide.  

**NOTE:** You must have a licensed version of SOCET SET on your system to generate SOCET SET TIN files. |
| **DTM Editing**      | This icon starts the Terrain Editor application. Click to edit the elevation of various kinds of DTMs including: DEMs and TINs. |
### Keyboard Shortcuts

You can access some LPS Project Manager and LPS Automatic Terrain Extraction options using the keyboard.

- Display the **File** menu by typing **Alt-f**.
- Display the **Edit** menu by typing **Alt-e**.
- Display the **Process** menu by typing **Alt-p**.
- Display the **Help** menu by typing **Alt-h**.

### Next

In the next section of this document, you can learn about photogrammetric theory.
Photogrammetric Theory
Introduction to Photogrammetry

Introduction

What is Photogrammetry?

Photogrammetry is the “art, science and technology of obtaining reliable information about physical objects and the environment through the process of recording, measuring and interpreting photographic images and patterns of electromagnetic radiant imagery and other phenomena” (American Society of Photogrammetry 1980).

Photogrammetry was invented in 1851 by Colonel Aimé Laussedat, and has continued to develop over the last 150 years. Over time, the development of photogrammetry has passed through the phases of plane table photogrammetry, analog photogrammetry, analytical photogrammetry, and has now entered the phase of digital photogrammetry (Konecny 1994).

The traditional, and largest, application of photogrammetry is to extract topographic information (e.g., terrain models) from aerial images. Figure 1 illustrates rugged topography. Photogrammetric techniques have also been applied to process satellite images and close-range images in order to acquire topographic or non-topographic information of photographed objects. Topographic information includes spot height information, contour lines, and elevation data. Planimetric information includes the geographic location of buildings, roads, rivers, and so forth.

Figure 1: Topography

Prior to the invention of the airplane, photographs taken on the ground were used to extract the relationships between objects using geometric principles. This was during the phase of plane table photogrammetry.

Figure 1: Topography
In analog photogrammetry, starting with stereo measurement in 1901, optical or mechanical instruments were used to reconstruct three-dimensional geometry from two overlapping photographs. Figure 2 depicts a typical analog stereo plotter. The main product during this phase was topographic maps.

**Figure 2: Analog Stereo Plotter**

In analytical photogrammetry, the computer replaced some expensive optical and mechanical components. The resulting devices were analog/digital hybrids. Analytical aerotriangulation, analytical plotters, and orthophoto projectors were the main developments during this phase. Outputs of analytical photogrammetry can be topographic maps, but also can be digital products, such as digital maps and DEMs.

Digital photogrammetry is photogrammetry applied to digital images that are stored and processed on a computer. Digital images can be scanned from photographs or directly captured by digital cameras. Many photogrammetric tasks can be highly automated in digital photogrammetry (e.g., automatic DEM extraction and digital orthophoto generation). Digital photogrammetry is sometimes called softcopy photogrammetry. The output products are in digital form, such as digital maps, DEMs, and digital orthoimages saved on computer storage media. Therefore, they can be easily stored and managed by you. With the development of digital photogrammetry, photogrammetric techniques are more closely integrated into remote sensing and GIS.

Digital photogrammetric systems employ sophisticated software to automate the tasks associated with conventional photogrammetry, thereby minimizing the extent of manual interaction required to perform photogrammetric operations. LPS Project Manager (**Figure 3**) is a photogrammetric system.
Photogrammetry can be used to measure and interpret information from hardcopy photographs or images. Sometimes the process of measuring information from photography and satellite imagery is considered metric photogrammetry, such as creating DEMs. Interpreting information from photography and imagery is considered interpretative photogrammetry, such as identifying and discriminating between various tree types (Wolf 1983).
The types of photographs and images that can be processed with LPS Project Manager include aerial, terrestrial, close-range, and oblique. Aerial or vertical (near vertical) photographs and images are taken from a high vantage point above the Earth’s surface. In those photographs, the camera axis is commonly directed vertically (or near vertically) down. Aerial photographs and images are commonly used for topographic and planimetric mapping projects, and are commonly captured from an aircraft or satellite. Figure 4 illustrates a satellite. Satellites use onboard sensors to collect high resolution images of the Earth’s surface.

Figure 4: Satellite

Terrestrial or ground-based photographs and images are taken with the camera stationed on or close to the Earth’s surface. Terrestrial and close-range photographs and images are commonly used for applications involved with archeology, geomorphology, civil engineering, architecture, and industry.

Oblique photographs and images are similar to aerial photographs and images, except the camera axis is intentionally inclined at an angle with the vertical. Oblique photographs and images are commonly used for reconnaissance and corridor mapping applications.

Digital photogrammetric systems use digitized photographs or digital images as the primary source of input. Digital imagery can be obtained in various ways, including:

- digitizing existing hardcopy photographs
- using digital cameras to record imagery
Why use Photogrammetry?

Raw aerial photography and satellite imagery have large geometric distortion that is caused by various systematic and nonsystematic factors. The photogrammetric modeling based on collinearity equations eliminates these errors most efficiently, and creates the most reliable orthoimages from raw imagery. Photogrammetry is unique in terms of considering the image-forming geometry, utilizing information between overlapping images, and explicitly dealing with the third dimension: elevation.

See “The Collinearity Equation” for information about the collinearity equation.

In addition to orthoimages, photogrammetry can also reliably and efficiently provide other geographic information such as a DEM, topographic features, and line maps. In essence, photogrammetry produces accurate and precise geographic information from a wide range of photographs and images. Any measurement taken on a photogrammetrically processed photograph or image reflects a measurement taken on the ground. Rather than constantly go to the field to measure distances, areas, angles, and point positions on the Earth’s surface, photogrammetric tools allow for the accurate collection of information from imagery. Photogrammetric approaches for collecting geographic information save time and money, and maintain the highest accuracy.

Photogrammetry vs. Conventional Geometric Correction

Conventional techniques of geometric correction such as polynomial transformation are based on general functions not directly related to the specific distortion or error sources. They have been successful in the field of remote sensing and GIS applications, especially when dealing with low resolution and narrow field of view satellite imagery such as Landsat and SPOT data (Yang 1997). General functions have the advantage of simplicity. They can provide a reasonable geometric modeling alternative when little is known about the geometric nature of the image data.
Because conventional techniques generally process the images one at a time, they cannot provide an integrated solution for multiple images or photographs simultaneously and efficiently. It is very difficult, if not impossible, for conventional techniques to achieve a reasonable accuracy without a great number of GCPs when dealing with large-scale imagery, images having severe systematic and/or nonsystematic errors, and images covering rough terrain. Misalignment is more likely to occur when mosaicking separately rectified images. This misalignment could result in inaccurate geographic information being collected from the rectified images. Furthermore, it is impossible for a conventional technique to create a 3D stereo model or to extract the elevation information from two overlapping images. There is no way for conventional techniques to accurately derive geometric information about the sensor that captured the imagery.

The photogrammetric techniques applied in LPS Project Manager overcome all the problems of conventional geometric correction by using least squares bundle block adjustment. This solution is integrated and accurate.

For more information, see “Bundle Block Adjustment”.

LPS Project Manager can process hundreds of images or photographs with very few GCPs, while at the same time eliminating the misalignment problem associated with creating image mosaics. In short: less time, less money, less manual effort, and more geographic fidelity can be obtained using the photogrammetric solution.

**Single Frame Orthorectification vs. Block Triangulation**

**Single Frame Orthorectification**

Single frame orthorectification techniques orthorectify one image at a time using a technique known as space resection. In this respect, a minimum of three GCPs is required for each image. For example, in order to orthorectify 50 aerial photographs, a minimum of 150 GCPs is required. This includes manually identifying and measuring each GCP for each image individually. Once the GCPs are measured, space resection techniques compute the camera/sensor position and orientation as it existed at the time of data capture. This information, along with a DEM, is used to account for the negative impacts associated with geometric errors. Additional variables associated with systematic error are not considered.
Single frame orthorectification techniques do not use the internal relationship between adjacent images in a block to minimize and distribute the errors commonly associated with GCPs, image measurements, DEMs, and camera/sensor information. Therefore, during the mosaic procedure, misalignment between adjacent images is common since error has not been minimized and distributed throughout the block.

**Block Triangulation**

Block (or aerial) triangulation is the process of establishing a mathematical relationship between the images contained in a project, the camera or sensor model, and the ground. The information resulting from aerial triangulation is required as input for the orthorectification, DEM creation, and stereopair creation processes. The term aerial triangulation is commonly used when processing aerial photography and imagery. The term block triangulation, or simply triangulation, is used when processing satellite imagery. The techniques differ slightly as a function of the type of imagery being processed.

Classic aerial triangulation using optical-mechanical analog and analytical stereo plotters is primarily used for the collection of GCPs using a technique known as control point extension. Since collecting GCPs is time consuming, photogrammetric techniques are accepted as the ideal approach for collecting GCPs over large areas using photography rather than conventional ground surveying techniques. Control point extension involves the manual photo measurement of ground points appearing on overlapping images. These ground points are commonly referred to as tie points. Once the points are measured, the ground coordinates associated with the tie points can be determined using photogrammetric techniques employed by analog or analytical stereo plotters. These points are then referred to as ground control points (GCPs).

With the advent of digital photogrammetry, classic aerial triangulation has been extended to provide greater functionality. LPS Project Manager uses a mathematical technique known as bundle block adjustment for aerial triangulation. Bundle block adjustment provides three primary functions:

- Bundle block adjustment determines the position and orientation for each image in a project as they existed at the time of photographic or image exposure. The resulting parameters are referred to as exterior orientation parameters. In order to estimate the exterior orientation parameters, a minimum of three GCPs is required for the entire block, regardless of how many images are contained within the project.
• Bundle block adjustment determines the ground coordinates of any tie points manually or automatically measured on the overlap areas of multiple images. The highly precise ground point determination of tie points is useful for generating control points from imagery in lieu of ground surveying techniques. Additionally, if a large number of ground points is generated, then a DEM can be interpolated using the 3D surfacing tool in ERDAS IMAGINE.

• Bundle block adjustment minimizes and distributes the errors associated with the imagery, image measurements, GCPs, and so forth. The bundle block adjustment processes information from an entire block of imagery in one simultaneous solution (i.e., a bundle) using statistical techniques (i.e., adjustment component) to automatically identify, distribute, and remove error.

Because the images are processed in one step, the misalignment issues associated with creating mosaics are resolved.

Image and Data Acquisition

During photographic or image collection, overlapping images are exposed along a direction of flight. Most photogrammetric applications involve the use of overlapping images. By using more than one image, the geometry associated with the camera/sensor, image, and ground can be defined to greater accuracies and precision.

During the collection of imagery, each point in the flight path at which the camera exposes the film, or the sensor captures the imagery, is called an exposure station (see Figure 5 and Figure 6).

**Figure 5: Exposure Stations Along a Flight Path**

![Figure 5: Exposure Stations Along a Flight Path](image-url)
Each photograph or image that is exposed has a corresponding image scale (SI) associated with it. The SI expresses the average ratio between a distance in the image and the same distance on the ground. It is computed as focal length divided by the flying height above the mean ground elevation. For example, with a flying height of 1000 m and a focal length of 15 cm, the SI would be 1:6667.

**NOTE:** The flying height above ground is used to determine SI, versus the altitude above sea level.

A strip of photographs consists of images captured along a flight line, normally with an overlap of 60%. All photos in the strip are assumed to be taken at approximately the same flying height and with a constant distance between exposure stations. Camera tilt relative to the vertical is assumed to be minimal.

The photographs from several flight paths can be combined to form a block of photographs. A block of photographs consists of a number of parallel strips, normally with a sidelap of 20-30%. Block triangulation techniques are used to transform all of the images in a block and their associated ground points into a homologous coordinate system.

A regular block of photos is commonly a rectangular block in which the number of photos in each strip is the same. **Figure 7** shows a block of 4 × 2 photographs. **Figure 8** illustrates two overlapping images.
Photogrammetric Scanners

Photogrammetric scanners are special devices capable of producing high image quality and excellent positional accuracy. Use of this type of scanner results in geometric accuracies similar to traditional analog and analytical photogrammetric instruments. These scanners are necessary for digital photogrammetric applications that have high accuracy requirements.

Photogrammetric scanners usually scan only film because film is superior to paper, both in terms of image detail and geometry. These scanners usually have a Root Mean Square Error (RMSE) positional accuracy of 4 microns or less, and are capable of scanning at a maximum resolution of 5 to 10 microns (5 microns is equivalent to approximately 5,000 pixels per inch).
The required pixel resolution varies depending on the application. Aerial triangulation and feature collection applications often scan in the 10- to 15-micron range. Orthophoto applications often use 15- to 30-micron pixels. Color film is less sharp than panchromatic; therefore, color ortho applications often use 20- to 40-micron pixels. The optimum scanning resolution also depends on the desired photogrammetric output accuracy. Scanning at higher resolutions provides data with higher accuracy.

**Desktop Scanners**

Desktop scanners are general-purpose devices. They lack the image detail and geometric accuracy of photogrammetric quality units, but they are much less expensive. When using a desktop scanner, you should make sure that the active area is at least 9 × 9 inches, which enables you to capture the entire photo frame.

Desktop scanners are appropriate for less rigorous uses, such as digital photogrammetry in support of GIS or remote sensing applications. Calibrating these units improves geometric accuracy, but the results are still inferior to photogrammetric units. The image correlation techniques that are necessary for automatic tie point collection and elevation extraction are often sensitive to scan quality. Therefore, errors attributable to scanning errors can be introduced into GIS data that is photogrammetrically derived.

**Scanning Resolutions**

One of the primary factors contributing to the overall accuracy of block triangulation and orthorectification is the resolution of the imagery being used. Image resolution is commonly determined by the scanning resolution (if film photography is being used), or by the pixel resolution of the sensor.

In order to optimize the attainable accuracy of a solution, the scanning resolution must be considered. The appropriate scanning resolution is determined by balancing the accuracy requirements versus the size of the mapping project and the time required to process the project.

*Table 3* lists the scanning resolutions associated with various scales of photography and image file size.
Table 3: Scanning Resolutions

<table>
<thead>
<tr>
<th>Photo Scale 1 to</th>
<th>12 microns (2117 dpi)</th>
<th>16 microns (1588 dpi)</th>
<th>25 microns (1016 dpi)</th>
<th>50 microns (508 dpi)</th>
<th>85 microns (300 dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ground Coverage (meters)</td>
<td>Ground Coverage (meters)</td>
<td>Ground Coverage (meters)</td>
<td>Ground Coverage (meters)</td>
<td>Ground Coverage (meters)</td>
</tr>
<tr>
<td>1800</td>
<td>0.0216</td>
<td>0.0288</td>
<td>0.045</td>
<td>0.09</td>
<td>0.153</td>
</tr>
<tr>
<td>2400</td>
<td>0.0288</td>
<td>0.0384</td>
<td>0.060</td>
<td>0.12</td>
<td>0.204</td>
</tr>
<tr>
<td>3000</td>
<td>0.0360</td>
<td>0.0480</td>
<td>0.075</td>
<td>0.15</td>
<td>0.255</td>
</tr>
<tr>
<td>3600</td>
<td>0.0432</td>
<td>0.0576</td>
<td>0.090</td>
<td>0.18</td>
<td>0.306</td>
</tr>
<tr>
<td>4200</td>
<td>0.0504</td>
<td>0.0672</td>
<td>0.105</td>
<td>0.21</td>
<td>0.357</td>
</tr>
<tr>
<td>4800</td>
<td>0.0576</td>
<td>0.0768</td>
<td>0.120</td>
<td>0.24</td>
<td>0.408</td>
</tr>
<tr>
<td>5400</td>
<td>0.0648</td>
<td>0.0864</td>
<td>0.135</td>
<td>0.27</td>
<td>0.459</td>
</tr>
<tr>
<td>6000</td>
<td>0.0720</td>
<td>0.0960</td>
<td>0.150</td>
<td>0.30</td>
<td>0.510</td>
</tr>
<tr>
<td>6600</td>
<td>0.0792</td>
<td>0.1056</td>
<td>0.165</td>
<td>0.33</td>
<td>0.561</td>
</tr>
<tr>
<td>7200</td>
<td>0.0864</td>
<td>0.1152</td>
<td>0.180</td>
<td>0.36</td>
<td>0.612</td>
</tr>
<tr>
<td>7800</td>
<td>0.0936</td>
<td>0.1248</td>
<td>0.195</td>
<td>0.39</td>
<td>0.663</td>
</tr>
<tr>
<td>8400</td>
<td>0.1008</td>
<td>0.1344</td>
<td>0.210</td>
<td>0.42</td>
<td>0.714</td>
</tr>
<tr>
<td>9000</td>
<td>0.1080</td>
<td>0.1440</td>
<td>0.225</td>
<td>0.45</td>
<td>0.765</td>
</tr>
<tr>
<td>9600</td>
<td>0.1152</td>
<td>0.1536</td>
<td>0.240</td>
<td>0.48</td>
<td>0.816</td>
</tr>
<tr>
<td>10800</td>
<td>0.1296</td>
<td>0.1728</td>
<td>0.270</td>
<td>0.54</td>
<td>0.918</td>
</tr>
<tr>
<td>12000</td>
<td>0.1440</td>
<td>0.1920</td>
<td>0.300</td>
<td>0.60</td>
<td>1.020</td>
</tr>
<tr>
<td>15000</td>
<td>0.1800</td>
<td>0.2400</td>
<td>0.375</td>
<td>0.75</td>
<td>1.275</td>
</tr>
<tr>
<td>18000</td>
<td>0.2160</td>
<td>0.2880</td>
<td>0.450</td>
<td>0.90</td>
<td>1.530</td>
</tr>
<tr>
<td>24000</td>
<td>0.2880</td>
<td>0.3840</td>
<td>0.600</td>
<td>1.20</td>
<td>2.040</td>
</tr>
<tr>
<td>30000</td>
<td>0.3600</td>
<td>0.4800</td>
<td>0.750</td>
<td>1.50</td>
<td>2.550</td>
</tr>
<tr>
<td>40000</td>
<td>0.4800</td>
<td>0.6400</td>
<td>1.000</td>
<td>2.00</td>
<td>3.400</td>
</tr>
<tr>
<td>50000</td>
<td>0.6000</td>
<td>0.8000</td>
<td>1.250</td>
<td>2.50</td>
<td>4.250</td>
</tr>
<tr>
<td>60000</td>
<td>0.7200</td>
<td>0.9600</td>
<td>1.500</td>
<td>3.00</td>
<td>5.100</td>
</tr>
<tr>
<td>B/W File Size (MB)</td>
<td>363</td>
<td>204</td>
<td>84</td>
<td>21</td>
<td>7</td>
</tr>
<tr>
<td>Color File Size (MB)</td>
<td>1089</td>
<td>612</td>
<td>252</td>
<td>63</td>
<td>21</td>
</tr>
</tbody>
</table>

The Ground Coverage column refers to the ground coverage per pixel. Thus, a 1:40,000 scale black and white photograph scanned at 25
microns (1016 dpi) has a ground coverage per pixel of 1 m \times 1 m. The resulting file size is approximately 85 MB, assuming a square 9 \times 9 inch photograph.

**Coordinate Systems**

Conceptually, photogrammetry involves establishing the relationship between the camera or sensor used to capture the imagery, the imagery itself, and the ground. In order to understand and define this relationship, each of the three variables associated with the relationship must be defined with respect to a coordinate space and coordinate system.

**Pixel Coordinate System**

The file coordinates of a digital image are defined in a pixel coordinate system. A pixel coordinate system is usually a coordinate system with its origin in the upper-left corner of the image, the x-axis pointing to the right, the y-axis pointing downward, and the units in pixels, as shown by axes \( c \) and \( r \) in Figure 9. These file coordinates \((c, r)\) can also be thought of as the pixel column and row number, respectively.

![Figure 9: Pixel Coordinates vs. Image Coordinates](image)

**Image Coordinate System**

An image coordinate system or an image plane coordinate system is usually defined as a two-dimensional (2D) coordinate system occurring on the image plane with its origin at the image center. The origin of the image coordinate system is also referred to as the principal point. On aerial photographs, the principal point is defined as the intersection of opposite fiducial marks as illustrated by axes \( x \) and \( y \) in Figure 9. Image coordinates are used to describe positions on the film plane. Image coordinate units are usually millimeters or microns.
Image Space Coordinate System

An image space coordinate system is identical to an image coordinate system, except that it adds a third axis (z) to indicate elevation. The origin of the image space coordinate system is defined at the perspective center $S$ as shown in Figure 10. The perspective center is commonly the lens of the camera as it existed when the photograph was captured. Its x-axis and y-axis are parallel to the x-axis and y-axis in the image plane coordinate system. The z-axis is the optical axis, therefore the z value of an image point in the image space coordinate system is usually equal to $-f$ (the focal length of the camera). Image space coordinates are used to describe positions inside the camera and usually use units in millimeters or microns. This coordinate system is referenced as image space coordinates $(x, y, z)$ in this chapter.

Figure 10: Image Space and Ground Space Coordinate System

Ground Coordinate System

A ground coordinate system is usually defined as a 3D coordinate system that utilizes a known geographic map projection. Ground coordinates $(X,Y,Z)$ are usually expressed in feet or meters. The Z value is elevation above mean sea level for a given vertical datum. This coordinate system is referenced as ground coordinates $(X,Y,Z)$ in this chapter.
Geocentric and Topocentric Coordinate System

Most photogrammetric applications account for the Earth's curvature in their calculations. This is done by adding a correction value or by computing geometry in a coordinate system that includes curvature. Two such systems are geocentric and topocentric.

A geocentric coordinate system has its origin at the center of the Earth ellipsoid. The Z-axis equals the rotational axis of the Earth, and the X-axis passes through the Greenwich meridian. The Y-axis is perpendicular to both the Z-axis and X-axis, so as to create a three-dimensional coordinate system that follows the right hand rule.

A topocentric coordinate system has its origin at the center of the image projected on the Earth ellipsoid. The three perpendicular coordinate axes are defined on a tangential plane at this center point. The plane is called the reference plane or the local datum. The x-axis is oriented eastward, the y-axis northward, and the z-axis is vertical to the reference plane (up).

For simplicity of presentation, the remainder of this chapter does not explicitly reference geocentric or topocentric coordinates. Basic photogrammetric principles can be presented without adding this additional level of complexity.

Terrestrial Photography

Photogrammetric applications associated with terrestrial or ground-based images utilize slightly different image and ground space coordinate systems. Figure 11 illustrates the two coordinate systems associated with image space and ground space.
The image and ground space coordinate systems are right-handed coordinate systems. Most terrestrial applications use a ground space coordinate system that was defined using a localized Cartesian coordinate system.

The image space coordinate system directs the z-axis toward the imaged object and the y-axis directed north up. The image x-axis is similar to that used in aerial applications. The \( X_L, Y_L, \) and \( Z_L \) coordinates define the position of the perspective center as it existed at the time of image capture. The ground coordinates of Ground Point \( A (X_A, Y_A, \) and \( Z_A) \) are defined within the ground space coordinate system \( (X_G, Y_G, \) and \( Z_G) \).

With this definition, the rotation angles \( \omega \) (Omega), \( \varphi \) (Phi), and \( \kappa \) (Kappa) are still defined as in the aerial photography conventions. In LPS Project Manager, you can also use the ground \( (X, Y, Z) \) coordinate system to directly define GCPs. Thus, GCPs do not need to be transformed. Then the definition of rotation angles \( \omega', \varphi', \) and \( \kappa' \) is different, as shown in Figure 11.
**Interior Orientation**

Interior orientation defines the internal geometry of a camera or sensor as it existed at the time of image capture. The variables associated with image space are defined during the process of defining interior orientation. Interior orientation is primarily used to transform the image pixel coordinate system or other image coordinate measurement system to the image space coordinate system.

*Figure 12* illustrates the variables associated with the internal geometry of an image captured from an aerial camera, where $o$ represents the principal point and $a$ represents an image point.

![Internal Geometry Diagram](image)

The internal geometry of a camera is defined by specifying the following variables:

- principal point
- focal length
- fiducial marks
- lens distortion

**Principal Point and Focal Length**

The principal point is mathematically defined as the intersection of the perpendicular line through the perspective center of the image plane. The length from the principal point to the perspective center is called the focal length (*Wang, Z. 1990*).
The image plane is commonly referred to as the focal plane. For wide-angle aerial cameras, the focal length is approximately 152 mm, or 6 in. For some digital cameras, the focal length is 28 mm. Prior to conducting photogrammetric projects, the focal length of a metric camera is accurately determined or calibrated in a laboratory environment.

This mathematical definition is the basis of triangulation, but difficult to determine optically. The optical definition of principal point is the image position where the optical axis intersects the image plane. In the laboratory, this is calibrated in two forms: principal point of autocollimation and principal point of symmetry, which can be seen from the camera calibration report. Most applications prefer to use the principal point of symmetry since it can best compensate for any lens distortion.

### Fiducial Marks

One of the steps associated with calculating interior orientation involves determining the image position of the principal point for each image in the project. Therefore, the image positions of the fiducial marks are measured on the image, and then compared to the calibrated coordinates of each fiducial mark.

Since the image space coordinate system has not yet been defined for each image, the measured image coordinates of the fiducial marks are referenced to a pixel or file coordinate system. The pixel coordinate system has an \( x \) coordinate (column) and a \( y \) coordinate (row). The origin of the pixel coordinate system is the upper left corner of the image having a row and column value of 0 and 0, respectively. **Figure 13** illustrates the difference between the pixel and image space coordinate system.

**Figure 13: Pixel Coordinate System vs. Image Space Coordinate System**
Using a 2D affine transformation, the relationship between the pixel coordinate system and the image space coordinate system is defined. The following 2D affine transformation equations can be used to determine the coefficients required to transform pixel coordinate measurements to the corresponding image coordinate values:

\[
\begin{align*}
x &= a_1 + a_2 X + a_3 Y \\
y &= b_1 + b_2 X + b_3 Y
\end{align*}
\]

The \( x \) and \( y \) image coordinates associated with the calibrated fiducial marks and the \( X \) and \( Y \) pixel coordinates of the measured fiducial marks are used to determine six affine transformation coefficients. The resulting six coefficients can then be used to transform each set of row (\( y \)) and column (\( x \)) pixel coordinates to image coordinates.

The quality of the 2D affine transformation is represented using a root mean square (RMS) error. The RMS error represents the degree of correspondence between the calibrated fiducial mark coordinates and their respective measured image coordinate values. Large RMS errors indicate poor correspondence. This can be attributed to film deformation, poor scanning quality, out-of-date calibration information, or image mismeasurement.

The affine transformation also defines the translation between the origin of the pixel coordinate system (\( x_a \)-file and \( y_a \)-file) and the image coordinate system (\( x_o \)-file and \( y_o \)-file). Additionally, the affine transformation takes into consideration rotation of the image coordinate system by considering angle \( \Theta \) (theta). A scanned image of an aerial photograph is normally rotated due to the scanning procedure.

The degree of variation between the \( x \)- and \( y \)-axis is referred to as nonorthogonality. The 2D affine transformation also considers the extent of nonorthogonality. The scale difference between the \( x \)-axis and the \( y \)-axis is also considered using the affine transformation.

For more information, see “Fiducial Orientation”.

**Lens Distortion**

Lens distortion deteriorates the positional accuracy of image points located on the image plane. Two types of lens distortion exist: radial and tangential lens distortion. Lens distortion occurs when light rays passing through the lens are bent, thereby changing directions and intersecting the image plane at positions deviant from the norm. Figure 14 illustrates the difference between radial and tangential lens distortion.
Radial lens distortion causes imaged points to be distorted along radial lines from the principal point $o$. The effect of radial lens distortion is represented as $\Delta r$. Radial lens distortion is also commonly referred to as symmetric lens distortion.

Tangential lens distortion occurs at right angles to the radial lines from the principal point. The effect of tangential lens distortion is represented as $\Delta t$. Because tangential lens distortion is much smaller in magnitude than radial lens distortion, it is considered negligible. The effects of lens distortion are commonly determined in a laboratory during the camera calibration procedure.

The effects of radial lens distortion throughout an image can be approximated using a polynomial. The following polynomial is used to determine coefficients associated with radial lens distortion:

$$\Delta r = k_0 r + k_1 r^3 + k_2 r^5$$

where $\Delta r$ represents the radial distortion along a radial distance $r$ from the principal point (Wolf 1983). In most camera calibration reports, the lens distortion value is provided as a function of radial distance from the principal point or field angle. LPS Project Manager accommodates radial lens distortion parameters in both scenarios.

Three coefficients—$k_0$, $k_1$, and $k_2$—are computed using statistical techniques. Once the coefficients are computed, each measurement taken on an image is corrected for radial lens distortion.
Exterior Orientation

Exterior orientation defines the position and angular orientation of the camera that captured an image. The variables defining the position and orientation of an image are referred to as the elements of exterior orientation. The elements of exterior orientation define the characteristics associated with an image at the time of exposure or capture. The positional elements of exterior orientation include $X_0$, $Y_0$, and $Z_0$. They define the position of the perspective center ($O$) with respect to the ground space coordinate system ($X$, $Y$, and $Z$). $Z_0$ is commonly referred to as the height of the camera above sea level, which is commonly defined by a datum.

The angular or rotational elements of exterior orientation describe the relationship between the ground space coordinate system ($X$, $Y$, and $Z$) and the image space coordinate system ($x$, $y$, and $z$). Three rotation angles are commonly used to define angular orientation. They are omega ($\omega$), phi ($\phi$), and kappa ($\kappa$). Figure 15 illustrates the elements of exterior orientation. Figure 16 illustrates the individual angles ($\omega$, $\phi$, and $\kappa$) of exterior orientation.

**Figure 15: Elements of Exterior Orientation**
Introduction to Photogrammetry

Figure 16: Omega, Phi, and Kappa

- Omega is a rotation about the photographic x-axis
- Phi is a rotation about the photographic y-axis
- Kappa is a rotation about the photographic z-axis

Rotations are defined as being positive if they are counterclockwise when viewed from the positive end of their respective axis. Different conventions are used to define the order and direction of the three rotation angles (Wang, Z. 1990). The ISPRS recommends the use of the $\omega, \phi, \kappa$ convention. The photographic z-axis is equivalent to the optical axis (focal length). The $x', y', z'$ coordinates are parallel to the ground space YEScoordinate system.

GPS is often used in conjunction with airborne surveys. The aircraft carries a camera or scanner and one or more GPS receivers tied to an inertial navigation system. As each frame is exposed precise information is captured (or calculated in post processing) on the $x, y, z$ and roll, pitch, yaw of the aircraft (Figure 17). Each image in the aerial survey block has initial exterior orientation parameters which minimizes the need for control in a block triangulation process.

Figure 17: Roll, Pitch, and Yaw
Assuming:

• that the rotation angles omega/phi/kappa are defined as in Figure 16, and

• rotation angles roll/pitch/yaw are defined as in Figure 17 where roll rotates clockwise around the X-axis; pitch rotates counterclockwise around the Y-axis; and yaw rotates clockwise around the Z-axis, and

• the coordinate system of the object space and aviation device are conformal, and

• the X-axis of the plane is the fixed (principal) axis

then the following is true.

• Roll is the rotation angle around the x axis of the aircraft (direction of flight) corresponding to the negative omega.

• Pitch is the rotation angle around the y axis of the aircraft corresponding to phi.

• Yaw is the rotation angle around the z axis of the aircraft corresponding to the negative kappa.

Rotation Matrix

Using the three rotation angles, the relationship between the image space coordinate system (x, y, and z) and ground space coordinate system (X, Y, and Z; or x', y', and z') can be determined. A 3 x 3 matrix defining the relationship between the two systems is used. This is referred to as the orientation or rotation matrix, \( M \). The rotation matrix can be defined as follows:

\[
M = \begin{bmatrix}
    m_{11} & m_{12} & m_{13} \\
    m_{21} & m_{22} & m_{23} \\
    m_{31} & m_{32} & m_{33}
\end{bmatrix}
\]

The rotation matrix is derived by applying a sequential rotation of omega about the x-axis, phi about the y-axis, and kappa about the z-axis.
Derivation of the Rotation Matrix

To derive the rotation matrix $M$, three rotations are performed sequentially: a primary rotation $\omega$ around the x-axis, followed by a secondary rotation $\varphi$ around the y-axis, and a tertiary rotation $\kappa$ around the z-axis.

**Figure 18** illustrates the primary rotation $\omega$ about the x-axis.

**Figure 18: Primary Rotation Omega About the X-axis**

From **Figure 18** above,

$$
\begin{bmatrix}
X \\
y \\
z
\end{bmatrix} = \begin{bmatrix}
1 & 0 & 0 \\
0 & \cos \omega & -\sin \omega \\
0 & \sin \omega & \cos \omega
\end{bmatrix} \begin{bmatrix}
X_\omega \\
y_\omega \\
z_\omega
\end{bmatrix} = M_\omega \begin{bmatrix}
X_\omega \\
y_\omega \\
z_\omega
\end{bmatrix}
$$

**Equation 1**

Secondary rotation $\varphi$ about the $Y_\omega$-axis is depicted in **Figure 19**.
From Figure 19 above,

\[
\begin{bmatrix}
X_{\omega} \\
Y_{\omega} \\
Z_{\omega}
\end{bmatrix}
= \begin{bmatrix}
\cos\phi & 0 & \sin\phi \\
0 & 1 & 0 \\
-\sin\phi & 0 & \cos\phi
\end{bmatrix}
\begin{bmatrix}
X_{\omega\phi} \\
Y_{\omega\phi} \\
Z_{\omega\phi}
\end{bmatrix}
= M_\phi
\begin{bmatrix}
X_{\omega\phi} \\
Y_{\omega\phi} \\
Z_{\omega\phi}
\end{bmatrix}
\]

Equation 2

Figure 20 shows tertiary rotation \( \kappa \) around the \( \omega_{\omega\phi} \)-axis:

From Figure 20 above,

\[
Z_{\omega\phi} = Z_{\omega\phi\kappa}
\]
By combining Equation 1, Equation 2, and Equation 3, a relationship can be defined between the coordinates of an object point \( P \) relative to the \((X, Y, Z)\) and \((X_{\omega\phi\kappa}, Y_{\omega\phi\kappa}, Z_{\omega\phi\kappa})\) coordinate systems:

\[
\begin{bmatrix}
X_{\omega\phi} \\
Y_{\omega\phi} \\
Z_{\omega\phi}
\end{bmatrix} = \begin{bmatrix}
\cos \kappa & -\sin \kappa & 0 \\
\sin \kappa & \cos \kappa & 0 \\
0 & 0 & 1
\end{bmatrix}
\begin{bmatrix}
X_{\omega\phi\kappa} \\
Y_{\omega\phi\kappa} \\
Z_{\omega\phi\kappa}
\end{bmatrix}
= M_\kappa
\begin{bmatrix}
X_{\omega\phi\kappa} \\
Y_{\omega\phi\kappa} \\
Z_{\omega\phi\kappa}
\end{bmatrix}
\]

Equation 3

By combining Equation 1, Equation 2, and Equation 3, a relationship can be defined between the coordinates of an object point \( P \) relative to the \((X, Y, Z)\) and \((X_{\omega\phi\kappa}, Y_{\omega\phi\kappa}, Z_{\omega\phi\kappa})\) coordinate systems:

\[
P = M_\omega \times M_\phi \times M_\kappa \times P_{\omega\phi\kappa}
\]

Equation 4

In Equation 4, replace

\[
M_\omega \times M_\phi \times M_\kappa
\]

with \( M \), which is a \( 3 \times 3 \) matrix:

\[
M = \begin{bmatrix}
m_{11} & m_{12} & m_{13} \\
m_{21} & m_{22} & m_{23} \\
m_{31} & m_{32} & m_{33}
\end{bmatrix}
\]

where each entry of the matrix can be computed by:

\[
M_{11} = \cos \varphi \times \cos \kappa \\
M_{12} = -\cos \varphi \times \sin \kappa \\
M_{13} = \sin \varphi \\
M_{21} = \cos \omega \times \sin \kappa + \sin \omega \times \sin \varphi \times \cos \kappa \\
M_{22} = \cos \omega \times \cos \kappa - \sin \omega \times \sin \varphi \times \sin \kappa \\
M_{23} = -\sin \omega \times \cos \varphi \\
M_{31} = \sin \omega \times \sin \kappa - \cos \omega \times \sin \varphi \times \cos \kappa \\
M_{32} = \sin \omega \times \cos \kappa + \cos \omega \times \sin \varphi \times \sin \kappa \\
M_{33} = \cos \omega \times \cos \varphi
\]

The Collinearity Equation

The following section defines the relationship between the camera/sensor, the image, and the ground. Most photogrammetric tools utilize the following formulas in one form or another.
With reference to Figure 15, an image vector $a$ can be defined as the vector from the exposure station $O$ to the Image Point $p$. A ground space or object space vector $A$ can be defined as the vector from the exposure station $O$ to the Ground Point $P$. The image vector and ground vector are collinear, inferring that a line extending from the exposure station to the image point and to the ground is linear.

The image vector and ground vector are only collinear if one is a scalar multiple of the other. Therefore, the following statement can be made:

$$a = kA$$

In this equation, $k$ is a scalar multiple. The image and ground vectors must be within the same coordinate system. Therefore, image vector $a$ is comprised of the following components:

$$a = \begin{bmatrix} x_p - x_o \\ y_p - y_o \\ -f \end{bmatrix}$$

Here, $x_o$ and $y_o$ represent the image coordinates of the principal point.

Similarly, the ground vector can be formulated as follows:

$$A = \begin{bmatrix} X_p - X_o \\ Y_p - Y_o \\ Z_p - Z_o \end{bmatrix}$$

In order for the image and ground vectors to be within the same coordinate system, the ground vector must be multiplied by the rotation matrix $M$. The following equation can be formulated:

$$a = kMA$$

where,
The above equation defines the relationship between the perspective center of the camera/sensor exposure station and ground point \( P \) appearing on an image with an image point location of \( p \). This equation forms the basis of the collinearity condition that is used in most photogrammetric operations.

The collinearity condition specifies that the exposure station, ground point, and its corresponding image point location must all lie along a straight line, thereby being collinear. Two equations comprise the collinearity condition:

\[
\begin{bmatrix}
  x_p - x_o \\
  y_p - y_o \\
  -f
\end{bmatrix}
= k M
\begin{bmatrix}
  X_p - X_o \\
  Y_p - Y_o \\
  Z_p - Z_o
\end{bmatrix}
\]

One set of equations can be formulated for each ground point appearing on an image. The collinearity condition is commonly used to define the relationship between the camera/sensor, the image, and the ground.

**Photogrammetric Solutions**

As stated previously, digital photogrammetry is used for many applications, ranging from orthorectification, automated elevation extraction, stereopair creation, feature collection, highly accurate point determination, and control point extension.

For any of the aforementioned tasks to be undertaken, a relationship between the camera/sensor, the image(s) in a project, and the ground must be defined. The following variables are used to define the relationship:

- exterior orientation parameters for each image
- interior orientation parameters for each image
accurate representation of the ground

Well-known obstacles in photogrammetry include defining the interior and exterior orientation parameters for each image in a project using a minimum number of GCPs. Due to the time-consuming and labor intensive procedures associated with collecting ground control, most photogrammetric applications do not have an abundant number of GCPs. Additionally, the exterior orientation parameters associated with an image are normally unknown.

Depending on the input data provided, photogrammetric techniques such as space resection, space forward intersection, and bundle block adjustment are used to define the variables required to perform orthorectification, automated DEM extraction, stereopair creation, highly accurate point determination, and control point extension.

**Space Resection**

Space resection is a technique that is commonly used to determine the exterior orientation parameters associated with one image or many images based on known GCPs. Space resection uses the collinearity condition. Space resection using the collinearity condition specifies that, for any image, the exposure station, the ground point, and its corresponding image point must lie along a straight line.

If a minimum of three GCPs is known in the X, Y, and Z direction, space resection techniques can be used to determine the six exterior orientation parameters associated with an image. Space resection assumes that camera information is available.

Space resection is commonly used to perform single frame orthorectification, where one image is processed at a time. If multiple images are being used, space resection techniques require that a minimum of three GCPs be located on each image being processed.

Using the collinearity condition, the positions of the exterior orientation parameters are computed. Light rays originating from at least three GCPs intersect through the image plane, through the image positions of the GCPs, and resect at the perspective center of the camera or sensor. Using least squares adjustment techniques, the most probable positions of exterior orientation can be computed. Space resection techniques can be applied to one image or multiple images.

**Space Forward Intersection**

Space forward intersection is a technique that is commonly used to determine the ground coordinates X, Y, and Z of points that appear in the overlapping areas of two or more images based on known interior and exterior orientation parameters. The collinearity condition is enforced, stating that the corresponding light rays from the two exposure stations pass through the corresponding image points on the two images, and intersect at the same ground point. Figure 21 illustrates the concept associated with space forward intersection.
Space forward intersection techniques assume that the exterior orientation parameters associated with the images are known. Using the collinearity equations, the exterior orientation parameters along with the image coordinate measurements of point $p1$ on Image 1 and point $p2$ on Image 2 are input to compute the $X_p$, $Y_p$, and $Z_p$ coordinates of ground point $P$.

Space forward intersection techniques can also be used for applications associated with collecting GCPs, cadastral mapping using airborne surveying techniques, and highly accurate point determination.

**Bundle Block Adjustment**

For mapping projects having more than two images, the use of space intersection and space resection techniques is limited. This can be attributed to the lack of information required to perform these tasks. For example, it is fairly uncommon for the exterior orientation parameters to be highly accurate for each photograph or image in a project, since these values are generated photogrammetrically. Airborne GPS and INS techniques normally provide initial approximations to exterior orientation, but the final values for these parameters must be adjusted to attain higher accuracies.
Similarly, rarely are there enough accurate GCPs for a project of 30 or more images to perform space resection (i.e., a minimum of 90 is required). In the case that there are enough GCPs, the time required to identify and measure all of the points would be lengthy.

The costs associated with block triangulation and subsequent orthorectification are largely dependent on the number of GCPs used. To minimize the costs of a mapping project, fewer GCPs are collected and used. To ensure that high accuracies are attained, an approach known as bundle block adjustment is used.

A bundle block adjustment is best defined by examining the individual words in the term. A bundled solution is computed including the exterior orientation parameters of each image in a block and the X, Y, and Z coordinates of tie points and adjusted GCPs. A block of images contained in a project is simultaneously processed in one solution. A statistical technique known as least squares adjustment is used to estimate the bundled solution for the entire block while also minimizing and distributing error.

Block triangulation is the process of defining the mathematical relationship between the images contained within a block, the camera or sensor model, and the ground. Once the relationship has been defined, accurate imagery and geographic information concerning the Earth’s surface can be created.

When processing frame camera, digital camera, videography, and nonmetric camera imagery, block triangulation is commonly referred to as aerial triangulation (AT). When processing imagery collected with a pushbroom sensor, block triangulation is commonly referred to as triangulation.

There are several models for block triangulation. The common models used in photogrammetry are block triangulation with the strip method, the independent model method, and the bundle method. Among them, the bundle block adjustment is the most rigorous of the above methods, considering the minimization and distribution of errors. Bundle block adjustment uses the collinearity condition as the basis for formulating the relationship between image space and ground space. LPS Project Manager uses bundle block adjustment techniques.

In order to understand the concepts associated with bundle block adjustment, an example comprising two images with three GCPs whose X, Y, and Z coordinates are known is used. Additionally, six tie points are available. Figure 22 illustrates the photogrammetric configuration. Figure 23 illustrates the photogrammetric configuration in the LPS Project Graphic Status window.
46 Introduction to Photogrammetry

Figure 22: Photogrammetric Configuration

Figure 23: Photogrammetric Configuration
Forming the Collinearity Equations

For each measured GCP, there are two corresponding image coordinates (x and y). Thus, two collinearity equations can be formulated to represent the relationship between the ground point and the corresponding image measurements. In the context of bundle block adjustment, these equations are known as observation equations.

If a GCP has been measured on the overlap area of two images, four equations can be written: two for image measurements on the left image comprising the pair and two for the image measurements made on the right image comprising the pair. Thus, GCP A measured on the overlap area of image left and image right has four collinearity formulas:

\[
x_{a_1} - x_o = -f \left[ \frac{m_{11}(X_A - X_{a_1}) + m_{12}(Y_A - Y_{a_1}) + m_{13}(Z_A - Z_{a_1})}{m_{31}(X_A - X_{a_1}) + m_{32}(Y_A - Y_{a_1}) + m_{33}(Z_A - Z_{a_1})} \right]
\]

\[
y_{a_1} - y_o = -f \left[ \frac{m_{21}(X_A - X_{a_1}) + m_{22}(Y_A - Y_{a_1}) + m_{23}(Z_A - Z_{a_1})}{m_{31}(X_A - X_{a_1}) + m_{32}(Y_A - Y_{a_1}) + m_{33}(Z_A - Z_{a_1})} \right]
\]

\[
x_{a_2} - x_o = -f \left[ \frac{m'_11(X_A - X_{a_2}) + m'_12(Y_A - Y_{a_2}) + m'_13(Z_A - Z_{a_2})}{m'_31(X_A - X_{a_2}) + m'_32(Y_A - Y_{a_2}) + m'_33(Z_A - Z_{a_2})} \right]
\]

\[
y_{a_2} - y_o = -f \left[ \frac{m'_21(X_A - X_{a_2}) + m'_22(Y_A - Y_{a_2}) + m'_23(Z_A - Z_{a_2})}{m'_31(X_A - X_{a_2}) + m'_32(Y_A - Y_{a_2}) + m'_33(Z_A - Z_{a_2})} \right]
\]

One image measurement of GCP A on Image 1:

\[x_{a_1}, y_{a_1}\]

One image measurement of GCP A on Image 2:

\[x_{a_2}, y_{a_2}\]

Positional elements of exterior orientation on Image 1:

\[X_{o_1}, Y_{o_1}, Z_{o_1}\]
Positional elements of exterior orientation on Image 2:

\[ X_{o2}, Y_{o2}, Z_{o2} \]

If three GCPs have been measured on the overlap area of two images, twelve equations can be formulated (four equations for each GCP).

Additionally, if six tie points have been measured on the overlap areas of the two images, twenty-four equations can be formulated (four for each tie point). This is a total of 36 observation equations.

The previous scenario has the following unknowns:

- six exterior orientation parameters for the left image (that is, X, Y, Z, omega, phi, kappa)
- six exterior orientation parameters for the right image (that is, X, Y, Z, omega, phi, kappa)
- X, Y, and Z coordinates of the tie points. Thus, for six tie points, this includes eighteen unknowns (six tie points times three X, Y, Z coordinates)

The total number of unknowns is 30. The overall quality of a bundle block adjustment is largely a function of the quality and redundancy in the input data. In this scenario, the redundancy in the project can be computed by subtracting the number of unknowns, 30, from the number of knowns, 36. The resulting redundancy is six. This term is commonly referred to as the degrees of freedom in a solution.

Once each observation equation is formulated, the collinearity condition can be solved using an approach referred to as least squares adjustment.

Least squares adjustment is a statistical technique that is used to estimate the unknown parameters associated with a solution while also minimizing error within the solution. With respect to block triangulation, least squares adjustment techniques are used to:

- estimate or adjust the values associated with exterior orientation
- estimate the X, Y, and Z coordinates associated with tie points
- estimate or adjust the values associated with interior orientation
- minimize and distribute data error through the network of observations
Data error is attributed to the inaccuracy associated with the input GCP coordinates, measured tie point and GCP image positions, camera information, and systematic errors.

The least squares approach requires iterative processing until a solution is attained. A solution is obtained when the residuals, or errors, associated with the input data are minimized.

The least squares approach involves determining the corrections to the unknown parameters based on the criteria of minimizing input measurement residuals. The residuals are derived from the difference between the measured (i.e., user input) and computed value for any particular measurement in a project. In the block triangulation process, a functional model can be formed based upon the collinearity equations.

The functional model refers to the specification of an equation that can be used to relate measurements to parameters. In the context of photogrammetry, measurements include the image locations of GCPs and GCP coordinates, while the exterior orientations of all the images are important parameters estimated by the block triangulation process.

The residuals, which are minimized, include the image coordinates of the GCPs and tie points along with the known ground coordinates of the GCPs. A simplified version of the least squares condition can be broken down into a formula that includes a weight matrix $P$, as follows:

$$ V = AX - L $$

In this equation,

$V$ = the matrix containing the image coordinate residuals  
$A$ = the matrix containing the partial derivatives with respect to the unknown parameters, including exterior orientation, interior orientation, XYZ tie point, and GCP coordinates  
$X$ = the matrix containing the corrections to the unknown parameters  
$L$ = the matrix containing the input observations (i.e., image coordinates and GCP coordinates)
The components of the least squares condition are directly related to the functional model based on collinearity equations. The $A$ matrix is formed by differentiating the functional model, which is based on collinearity equations, with respect to the unknown parameters such as exterior orientation, etc. The $L$ matrix is formed by subtracting the initial results obtained from the functional model with newly estimated results determined from a new iteration of processing. The $X$ matrix contains the corrections to the unknown exterior orientation parameters. The $X$ matrix is calculated in the following manner:

$$X = (A^tPA)^{-1}A^tPL$$

In this equation,

- $X$ = the matrix containing the corrections to the unknown parameters $^t$
- $A$ = the matrix containing the partial derivatives with respect to the unknown parameters
- $^t$ = the matrix transposed
- $P$ = the matrix containing the weights of the observations
- $L$ = the matrix containing the observations

Once a least squares iteration of processing is completed, the corrections to the unknown parameters are added to the initial estimates. For example, if initial approximations to exterior orientation are provided from airborne GPS and INS information, the estimated corrections computed from the least squares adjustment are added to the initial value to compute the updated exterior orientation values. This iterative process of least squares adjustment continues until the corrections to the unknown parameters are less than a user-specified threshold (commonly referred to as a convergence value).

The $V$ residual matrix is computed at the end of each iteration of processing. Once an iteration is complete, the new estimates for the unknown parameters are used to recompute the input observations such as the image coordinate values. The difference between the initial measurements and the new estimates is obtained to provide the residuals. Residuals provide preliminary indications of the accuracy of a solution. The residual values indicate the degree to which a particular observation (input) fits with the functional model. For example, the image residuals have the capability of reflecting GCP collection in the field. After each successive iteration of processing, the residuals become smaller until they are satisfactorily minimized.

Once the least squares adjustment is completed, the block triangulation results include:
• final exterior orientation parameters of each image in a block and their accuracy

• final interior orientation parameters of each image in a block and their accuracy

• X, Y, and Z tie point coordinates and their accuracy

• adjusted GCP coordinates and their residuals

• image coordinate residuals

The results from the block triangulation are then used as the primary input for the following tasks:

• stereopair creation

• feature collection

• highly accurate point determination

• DEM extraction

• orthorectification

**Self-calibrating Bundle Adjustment**

Normally, there are more or less systematic errors related to the imaging and processing system, such as lens distortion, film distortion, atmosphere refraction, scanner errors, and so on. These errors reduce the accuracy of triangulation results, especially in dealing with large-scale imagery and high accuracy triangulation. There are several ways to reduce the influences of the systematic errors, like a posteriori compensation, test-field calibration, and the most common approach—self-calibration (Konecny 1994; Wang, Z. 1990).

The self-calibrating methods use additional parameters in the triangulation process to eliminate the systematic errors. How well it works depends on many factors such as the strength of the block (overlap amount, crossing flight lines), the GCP and tie point distribution and amount, the size of systematic errors versus random errors, the significance of the additional parameters, the correlation between additional parameters, and other unknowns.
There was intensive research and development for additional parameter models in photogrammetry in the ‘70s and the ‘80s, and many research results are available (e.g., Bauer and Müller 1972; Ebner 1976; Grün 1978; Jacobsen 1980 and Jacobsen 1982; Li 1985; Wang, Y. 1988; and Stojic, Chandler, Ashmore, and Luce 1998). Based on these scientific reports, LPS Project Manager provides four groups of additional parameters for you to choose in different triangulation circumstances. In addition, LPS Project Manager allows the interior orientation parameters to be analytically calibrated with its self-calibrating bundle block adjustment.

**Automatic Gross Error Detection**

Normal random errors are subject to statistical normal distribution. In contrast, gross errors refer to errors that are large and are not subject to normal distribution. The gross errors among the input data for triangulation can lead to unreliable results. Research during the ‘80s in the photogrammetric community resulted in significant achievements in automatic gross error detection in the triangulation process (e.g., Kubik 1982; Li 1983 and Li 1985; Jacobsen 1984; El-Hakim and Ziemann 1984; Wang, Y. 1988).

Methods for gross error detection began with residual checking using data-snooping and were later extended to robust estimation (Wang, Z. 1990). The most common robust estimation method is the iteration with selective weight functions. Based on the scientific research results from the photogrammetric community, LPS Project Manager offers two robust error detection methods within the triangulation process.

For more information, see “Automated Gross Error Checking”.

The effect of the automatic error detection depends not only on the mathematical model, but also depends on the redundancy in the block. Therefore, more tie points in more overlap areas contribute better gross error detection. In addition, inaccurate GCPs can distribute their errors to correct tie points; therefore, the ground and image coordinates of GCPs should have better accuracy than tie points when comparing them within the same scale space.

**GCPs**

The instrumental component of establishing an accurate relationship between the images in a project, the camera/sensor, and the ground is GCPs. GCPs are identifiable features located on the Earth’s surface whose ground coordinates in X, Y, and Z are known. A full GCP has associated with it X, Y, and Z (elevation of the point) coordinates. A horizontal GCP only specifies the X, Y coordinates, while a vertical GCP only specifies the Z coordinate.

The following features on the Earth’s surface are commonly used as GCPs:
• intersection of roads
• utility infrastructure (e.g., fire hydrants and manhole covers)
• intersection of agricultural plots of land
• survey benchmarks

Depending on the type of mapping project, GCPs can be collected from the following sources:

• theodolite survey (millimeter to centimeter accuracy)
• total station survey (millimeter to centimeter accuracy)
• ground GPS (centimeter to meter accuracy)
• planimetric and topographic maps (accuracy varies as a function of map scale, approximate accuracy between several meters to 40 meters or more)
• digital orthorectified images (X and Y coordinates can be collected to an accuracy dependent on the resolution of the orthorectified image)
• DEMs (for the collection of vertical GCPs having Z coordinates associated with them, where accuracy is dependent on the resolution of the DEM and the accuracy of the input DEM)

When imagery or photography is exposed, GCPs are recorded and subsequently displayed on the photograph or image. During GCP measurement in LPS Project Manager, the image positions of GCPs appearing on an image, or on the overlap area of the images, are collected.

It is highly recommended that a greater number of GCPs be available than are actually used in the block triangulation. Additional GCPs can be used as check points to independently verify the overall quality and accuracy of the block triangulation solution. A check point analysis compares the photogrammetrically computed ground coordinates of the check points to the original values. The result of the analysis is an RMSE that defines the degree of correspondence between the computed values and the original values. Lower RMSE values indicate better results.
**GCP Requirements**

The minimum GCP requirements for an accurate mapping project vary with respect to the size of the project. With respect to establishing a relationship between image space and ground space, the theoretical minimum number of GCPs is two GCPs having X, Y, and Z coordinates (six observations) and one GCP having a Z coordinate (one observation). This is a total of seven observations.

In establishing the mathematical relationship between image space and object space, seven parameters defining the relationship must be determined. The seven parameters include a scale factor (describing the scale difference between image space and ground space); X, Y, and Z (defining the positional differences between image space and object space); and three rotation angles (omega, phi, and kappa) defining the rotational relationship between image space and ground space.

In order to compute a unique solution, at least seven known parameters must be available. In using the two XYZ GCPs and one vertical (Z) GCP, the relationship can be defined. However, to increase the accuracy of a mapping project, using more GCPs is highly recommended.

The following descriptions are provided for various projects:

**Processing One Image**

When processing one image for the purpose of orthorectification (that is, a single frame orthorectification), the minimum number of GCPs required is three. Each GCP must have an X, Y, and Z coordinate associated with it. The GCPs should be evenly distributed to ensure that the camera/sensor is accurately modeled.

**Processing a Strip of Images**

When processing a strip of adjacent images, two GCPs for every third image are recommended. To increase the quality of orthorectification, measuring three GCPs at the corner edges of a strip is advantageous. Thus, during block triangulation a stronger geometry can be enforced in areas where there is less redundancy such as the corner edges of a strip or a block.

*Figure 24* illustrates the GCP configuration for a strip of images having 60% overlap. The triangles represent the GCPs. Thus, the image positions of the GCPs are measured on the overlap areas of the imagery.
Processing Multiple Strips of Imagery

Figure 25 depicts the standard GCP configuration for a block of images, comprising four strips of images, each containing eight overlapping images.

In this case, the GCPs form a strong geometric network of observations. As a general rule, it is advantageous to have at least one GCP on every third image of a block. Additionally, whenever possible, locate GCPs that lie on multiple images, around the outside edges of a block and at certain distances from one another within the block.

Tie Points

A tie point is a point whose ground coordinates are not known, but is visually recognizable in the overlap area between two or more images. The corresponding image positions of tie points appearing on the overlap areas of multiple images is identified and measured. Ground coordinates for tie points are computed during block triangulation. Tie points can be measured both manually and automatically.
Tie points should be visually defined in all images. Ideally, they should show good contrast in two directions, like the corner of a building or a road intersection. Tie points should also be distributed over the area of the block. Typically, nine tie points in each image are adequate for block triangulation. Figure 26 depicts the placement of tie points.

Figure 26: Tie Point Distribution for Triangulation

In a block of images with 60% overlap and 25-30% sidelap, nine points are sufficient to tie together the block as well as individual strips (see Figure 27).

Figure 27: Tie Points in a Block

Automatic Tie Point Collection

Selecting and measuring tie points is very time-consuming. In recent years, one of the major focal points of research and development in photogrammetry has been automated triangulation with automatic tie point collection as the main issue.

Another issue of automated triangulation is the automatic control point identification, which is still unsolved due to the complexity of the scenario. There are several valuable research results detailing automated triangulation (e.g., Agouris and Schenk 1996; Heipke 1996; Krzystek 1998; Mayr 1995; Schenk 1997; Tang, Braun, and Debitsch 1997; Tsingas 1995; Wang, Y. 1998).
After investigating the advantages and the weaknesses of the existing methods, LPS Project Manager was designed to incorporate an advanced method for automatic tie point collection. It is designed to work with a variety of digital images such as aerial images, satellite images, digital camera images, and close-range images. It also supports the processing of multiple strips including adjacent, diagonal, and cross-strips.

Automatic tie point collection within LPS Project Manager successfully performs the following tasks:

- Automatic block configuration. Based on the initial input requirements, LPS Project Manager automatically detects the relationship of the block with respect to image adjacency.
- Automatic tie point extraction. The feature point extraction algorithms are used here to extract the candidates of tie points.
- Point transfer. Feature points appearing on multiple images are automatically matched and identified.
- Gross error detection. Erroneous points are automatically identified and removed from the solution.
- Tie point selection. The intended number of tie points defined by the user is automatically selected as the final number of tie points.

The image matching strategies incorporated in LPS Project Manager for automatic tie point collection include the coarse-to-fine matching; feature-based matching with geometrical and topological constraints, which is simplified from the structural matching algorithm (Wang, Y. 1998); and the least square matching for the high accuracy of tie points.

**Image Matching Techniques**

Image matching refers to the automatic identification and measurement of corresponding image points that are located on the overlapping areas of multiple images. The various image matching methods can be divided into three categories including:

- area-based matching
- feature-based matching
- relation-based matching
Area-based Matching

Area-based matching is also called signal based matching. This method determines the correspondence between two image areas according to the similarity of their gray level values. The cross-correlation and least squares correlation techniques are well-known methods for area-based matching.

Correlation Windows

Area-based matching uses correlation windows. These windows consist of a local neighborhood of pixels. One example of correlation windows is square neighborhoods (for example, $3 \times 3$, $5 \times 5$, $7 \times 7$ pixels). In practice, the windows vary in shape and dimension based on the matching technique. Area correlation uses the characteristics of these windows to match ground feature locations in one image to ground features on the other.

A reference window is the source window on the first image, which remains at a constant location. Its dimensions are usually square in size (for example, $3 \times 3$, $5 \times 5$, and so on). Search windows are candidate windows on the second image that are evaluated relative to the reference window. During correlation, many different search windows are examined until a location is found that best matches the reference window.

Correlation Calculations

Two correlation calculations are described in the following sections: cross-correlation and least squares correlation. Most area-based matching calculations, including these methods, normalize the correlation windows. Therefore, it is not necessary to balance the contrast or brightness prior to running correlation. Cross-correlation is more robust in that it requires a less accurate a priori position than least squares. However, its precision is limited to one pixel. Least squares correlation can achieve precision levels of one-tenth of a pixel, but requires an a priori position that is accurate to about two pixels. In practice, cross-correlation is often followed by least squares for high accuracy.

Cross-correlation

Cross-correlation computes the correlation coefficient of the gray values between the template window and the search window according to the following equation:
In the above equations, 

\[ aap = \frac{\sum_{i,j} [g_1(c_1, r_1) - \bar{g}_1][g_2(c_2, r_2) - \bar{g}_2]}{\sqrt{\sum_{i,j} [g_1(c_1, r_1) - \bar{g}_1]^2 \sum_{i,j} [g_2(c_2, r_2) - \bar{g}_2]^2}} \]

with

\[ \bar{g}_1 = \frac{1}{n} \sum_{i,j} g_1(c_1, r_1) \quad \bar{g}_2 = \frac{1}{n} \sum_{i,j} g_2(c_2, r_2) \]

In the above equations,

\[ \rho \quad \text{the correlation coefficient} \]
\[ g(c,r) \quad \text{the gray value of the pixel (c,r)} \]
\[ c_1, r_1 \quad \text{the pixel coordinates on the left image} \]
\[ c_2, r_2 \quad \text{the pixel coordinates on the right image} \]
\[ n \quad \text{the total number of pixels in the window} \]
\[ i, j \quad \text{pixel index into the correlation window} \]

When using the area-based cross-correlation, it is necessary to have a good initial position for the two correlation windows. If the exterior orientation parameters of the images being matched are known, a good initial position can be determined. However, if the contrast in the windows is very poor, the correlation can fail.

**Least Squares Correlation**

Least squares correlation uses the least squares estimation to derive parameters that best fit a search window to a reference window. This technique has been investigated thoroughly in photogrammetry (Ackermann 1983; Grün and Baltsavias 1988; Helava 1988). It accounts for both gray scale and geometric differences, making it especially useful when ground features on one image look somewhat different on the other image (differences which occur when the surface terrain is quite steep or when the viewing angles are quite different).

Least squares correlation is iterative. The parameters calculated during the initial pass are used in the calculation of the second pass and so on, until an optimum solution is determined. Least squares matching can result in high positional accuracy (about 0.1 pixels). However, it is sensitive to initial approximations. The initial coordinates for the search window prior to correlation must be accurate to about two pixels or better.
When least squares correlation fits a search window to the reference window, both radiometric (pixel gray values) and geometric (location, size, and shape of the search window) transformations are calculated.

For example, suppose the change in gray values between two correlation windows is represented as a linear relationship. Also assume that the change in the window’s geometry is represented by an affine transformation.

\[
g_2(c_2, r_2) = h_0 + h_1 g_1(c_1, r_1)
\]
\[
c_2 = a_0 + a_1 c_1 + a_2 r_1
\]
\[
r_2 = b_0 + b_1 c_1 + b_2 r_1
\]

In the equations,

- \(c_1,r_1\) = the pixel coordinate in the reference window
- \(c_2,r_2\) = the pixel coordinate in the search window
- \(g_1(c_1,r_1)\) = the gray value of pixel \((c_1,r_1)\)
- \(g_2(c_2,r_2)\) = the gray value of pixel \((c_2,r_2)\)
- \(h_0, h_1\) = linear gray value transformation parameters
- \(a_0, a_1, a_2\) = affine geometric transformation parameters
- \(b_0, b_1, b_2\) = affine geometric transformation parameters

Based on this assumption, the error equation for each pixel is derived, as shown in the following equation:

\[
v = (a_1 + a_2 c_1 + a_3 r_1) g_c + (b_1 + b_2 c_1 + b_3 r_1) g_r - h_1 - h_2 g_1(c_1, r_1) + \Delta g
\]

with \(\Delta g = g_2(c_2, r_2) - g_1(c_1, r_1)\)

The values \(g_c\) and \(g_r\) are the gradients of \(g_2(c_2, r_2)\).

**Feature-based Matching**

Feature-based matching determines the correspondence between two image features. Most feature-based techniques match extracted point features (this is called feature point matching), as opposed to other features, such as lines or complex objects. The feature points are also commonly referred to as interest points. Poor contrast areas can be avoided with feature-based matching.

In order to implement feature-based matching, the image features must initially be extracted. There are several well-known operators for feature point extraction. Examples include the Moravec Operator, the Dreschler Operator, and the Förstner Operator (Förstner and Gülch 1987; Lü 1988).
After the features are extracted, the attributes of the features are compared between two images. The feature pair having the attributes with the best fit is recognized as a match. LPS Project Manager utilizes the Förstner interest operator to extract feature points.

**Relation-based Matching**

Relation-based matching is also called structural matching (Vosselman and Haala 1992; Wang, Y. 1994 and Wang, Y. 1995). This kind of matching technique uses the image features and the relationship between the features. With relation-based matching, the corresponding image structures can be recognized automatically, without any a priori information. However, the process is time-consuming since it deals with varying types of information. Relation-based matching can also be applied for the automatic recognition of control points.

**Image Pyramid**

Because of the large amount of image data, the image pyramid is usually adopted during the image matching techniques to reduce the computation time and to increase the matching reliability. The pyramid is a data structure consisting of the same image represented several times, at a decreasing spatial resolution each time. Each level of the pyramid contains the image at a particular resolution.

The matching process is performed at each level of resolution. The search is first performed at the lowest resolution level and subsequently at each higher level of resolution. Figure 28 shows a four-level image pyramid.
LPS Project Manager

Pyramid Layers

There are different resampling methods available for generating an image pyramid. Theoretical and practical investigations show that the resampling methods based on the Gaussian filter, which are approximated by a binomial filter, have superior properties concerning preserving the image contents and reducing the computation time (Wang, Y. 1994). Therefore, LPS Project Manager uses this kind of pyramid layer instead of those currently available under ERDAS IMAGINE, which are overwritten automatically by LPS Project Manager.

Satellite Photogrammetry

Satellite photogrammetry has slight variations compared to photogrammetric applications associated with aerial frame cameras. This document makes reference to the SPOT and IRS-1C satellites. The SPOT satellite provides 10-meter panchromatic imagery and 20-meter multispectral imagery (four multispectral bands of information).

The SPOT satellite carries two high resolution visible (HRV) sensors, each of which is a pushbroom scanner that takes a sequence of line images while the satellite circles the Earth. The focal length of the camera optic is 1084 mm, which is very large relative to the length of the camera (78 mm). The field of view is 4.1 degrees. The satellite orbit is circular, north-south and south-north, about 830 km above the Earth, and sun-synchronous. A sun-synchronous orbit is one in which the orbital rotation is the same rate as the Earth’s rotation.
The IRS-1C satellite utilizes a pushbroom sensor consisting of three individual CCDs. The ground resolution of the imagery ranges between 5 to 6 meters. The focal length of the optic is approximately 982 mm. The pixel size of the CCD is 7 microns. The images captured from the three CCDs are processed independently or merged into one image and system corrected to account for the systematic error associated with the sensor.

Both the SPOT and IRS-1C satellites collect imagery by scanning along a line. This line is referred to as the scan line. For each line scanned within the SPOT and IRS-1C sensors, there is a unique perspective center and a unique set of rotation angles. The location of the perspective center relative to the line scanner is constant for each line (interior orientation and focal length). Since the motion of the satellite is smooth and practically linear over the length of a scene, the perspective centers of all scan lines of a scene are assumed to lie along a smooth line. The scanning technique is illustrated in Figure 29.

**Figure 29: Perspective Centers of SPOT Scan Lines**

The satellite exposure station is defined as the perspective center in ground coordinates for the center scan line. The image captured by the satellite is called a scene. For example, a SPOT Pan 1A scene is composed of 6000 lines. For SPOT Pan 1A imagery, each of these lines consists of 6000 pixels. Each line is exposed for 1.5 milliseconds, so it takes 9 seconds to scan the entire scene. (A scene from SPOT XS 1A is composed of only 3000 lines and 3000 columns and has 20-meter pixels, while Pan has 10-meter pixels.)

**NOTE: The following section addresses only 10-meter SPOT Pan data.**
A pixel in the SPOT image records the light detected by one of the 6000 light-sensitive elements in the camera. Each pixel is defined by file coordinates (column and row numbers). The physical dimension of a single, light-sensitive element is $13 \times 13$ microns. This is the pixel size in image coordinates. The center of the scene is the center pixel of the center scan line. It is the origin of the image coordinate system. Figure 30 depicts image coordinates in a satellite scene.

**Figure 30: Image Coordinates in a Satellite Scene**

\[
\begin{array}{c}
\text{A} \\
\text{X}_F \\
\text{Y}_F \\
\text{6000 lines (rows)} \\
\text{6000 pixels (columns)} \\
\end{array}
\]

where,

- \(A\) = origin of file coordinates
- \(A-X_F, A-Y_F\) = file coordinate axes
- \(C\) = origin of image coordinates (center of scene)
- \(C-x, C-y\) = image coordinate axes

**SPOT Interior Orientation**

Figure 31 shows the interior orientation of a satellite scene. The transformation between file coordinates and image coordinates is constant.
Figure 31: Interior Orientation of a SPOT Scene

For each scan line, a separate bundle of light rays is defined, where,

\[ P_k = \text{image point} \]
\[ x_k = \text{x value of image coordinates for scan line } k \]
\[ f = \text{focal length of the camera} \]
\[ O_k = \text{perspective center for scan line } k, \text{ aligned along the orbit} \]
\[ PP_k = \text{principal point for scan line } k \]
\[ l_k = \text{light rays for scan line, bundled at perspective center } O_k \]

**SPOT Exterior Orientation**

SPOT satellite geometry is stable, and the sensor parameters, such as focal length, are well-known. However, the triangulation of SPOT scenes is somewhat unstable because of the narrow, almost parallel bundles of light rays.
Ephemeris data for the orbit are available in the header file of SPOT scenes. They give the satellite’s position in three-dimensional, geocentric coordinates at 60-second increments. The velocity vector and some rotational velocities relating to the attitude of the camera are given, as well as the exact time of the center scan line of the scene. The header of the data file of a SPOT scene contains ephemeris data, which provides information about the recording of the data and the satellite orbit.

Ephemeris data that can be used in satellite triangulation include:

- position of the satellite in geocentric coordinates (with the origin at the center of the Earth) to the nearest second
- velocity vector, which is the direction of the satellite’s travel
- attitude changes of the camera
- time of exposure (exact) of the center scan line of the scene

The geocentric coordinates included with the ephemeris data are converted to a local ground system for use in triangulation. The center of a satellite scene is interpolated from the header data.

Light rays in a bundle defined by the SPOT sensor are almost parallel, lessening the importance of the satellite’s position. Instead, the inclination angles (incidence angles) of the cameras onboard the satellite become the critical data.

Inclination is the angle between a vertical on the ground at the center of the scene and a light ray from the exposure station. This angle defines the degree of off-nadir viewing when the scene was recorded. The cameras can be tilted in increments of a minimum of 0.6 to a maximum of 27 degrees to the east (negative inclination) or west (positive inclination).

A stereo scene is achieved when two images of the same area are acquired on different days from different orbits, one taken East of the other. For this to occur, there must be significant differences in the inclination angles.

*Figure 32* illustrates the inclination.
In **Figure 32**,

- **C** = center of the scene
- **I-** = eastward inclination
- **I+** = westward inclination
- **O₁, O₂** = exposure stations (perspective centers of imagery)

The orientation angle of a satellite scene is the angle between a perpendicular to the center scan line and the North direction. The spatial motion of the satellite is described by the velocity vector. The real motion of the satellite above the ground is further distorted by the Earth’s rotation.

The scanner can produce a nadir view. Nadir is the point directly below the camera. SPOT has off-nadir viewing capability. Off-nadir refers to any point that is not directly beneath the satellite, but is off to an angle (that is, East or West of the nadir), as shown in **Figure 33**.
The velocity vector of a satellite is the satellite’s velocity if measured as a vector through a point on the spheroid. It provides a technique to represent the satellite’s speed as if the imaged area were flat instead of being a curved surface (see Figure 34).

In Figure 34,

- $O$ = orientation angle
- $C$ = center of the scene
- $V$ = velocity vector

Satellite block triangulation provides a model for calculating the spatial relationship between a satellite sensor and the ground coordinate system for each line of data. This relationship is expressed as the exterior orientation, which consists of:

- the perspective center of the center scan line (that is, $X$, $Y$, and $Z$),
- the change of perspective centers along the orbit,
the three rotations of the center scan line (that is, omega, phi, and kappa), and
the changes of angles along the orbit.

In addition to fitting the bundle of light rays to the known points, satellite block triangulation also accounts for the motion of the satellite by determining the relationship of the perspective centers and rotation angles of the scan lines. It is assumed that the satellite travels in a smooth motion as a scene is being scanned. Therefore, once the exterior orientation of the center scan line is determined, the exterior orientation of any other scan line is calculated based on the distance of that scan line from the center and the changes of the perspective center location and rotation angles.

Bundle adjustment for triangulating a satellite scene is similar to the bundle adjustment used for aerial images. A least squares adjustment is used to derive a set of parameters that comes the closest to fitting the control points to their known ground coordinates, and to intersecting tie points.

The resulting parameters of satellite bundle adjustment are:
- ground coordinates of the perspective center of the center scan line
- rotation angles for the center scan line
- coefficients, from which the perspective center and rotation angles of all other scan lines are calculated
- ground coordinates of all tie points

**Collinearity Equations and Satellite Block Triangulation**

Modified collinearity equations are used to compute the exterior orientation parameters associated with the respective scan lines in the satellite scenes. Each scan line has a unique perspective center and individual rotation angles. When the satellite moves from one scan line to the next, these parameters change. Due to the smooth motion of the satellite in orbit, the changes are small and can be modeled by low-order polynomial functions.

**Control for Satellite Block Triangulation**

Both GCPs and tie points can be used for satellite block triangulation of a stereo scene. For triangulating a single scene, only GCPs are used. In this case, space resection techniques are used to compute the exterior orientation parameters associated with the satellite as they existed at the time of image capture. A minimum of six GCPs is necessary. Ten or more GCPs are recommended to obtain a good triangulation result.
The best locations for GCPs in the scene are shown in Figure 35.

**Figure 35: Ideal Point Distribution Over a Satellite Scene for Triangulation**

**Orthorectification**

Orthorectification is the process of reducing geometric errors inherent within photography and imagery. The variables contributing to geometric errors include, but are not limited to:

- camera and sensor orientation
- systematic error associated with the camera or sensor
- topographic relief displacement
- Earth curvature

By performing block triangulation or single frame resection, the parameters associated with camera and sensor orientation are defined. Utilizing least squares adjustment techniques during block triangulation minimizes the errors associated with camera or sensor instability. Additionally, the use of self-calibrating bundle adjustment (SCBA) techniques along with Additional Parameter (AP) modeling accounts for the systematic errors associated with camera interior geometry. The effects of the Earth’s curvature are significant if a large photo block or satellite imagery is involved. They are accounted for during the block triangulation procedure by setting the proper option. The effects of topographic relief displacement are accounted for by utilizing a DEM during the orthorectification procedure.
The orthorectification process takes the raw digital imagery and applies a DEM and triangulation results to create an orthorectified image. Once an orthorectified image is created, each pixel within the image possesses geometric fidelity. Thus, measurements taken off an orthorectified image represent the corresponding measurements as if they were taken on the Earth’s surface (see Figure 36).

**Figure 36: Orthorectification**

An image or photograph with an orthographic projection is one for which every point looks as if an observer were looking straight down at it, along a line of sight that is orthogonal (perpendicular) to the Earth. The resulting orthorectified image is known as a digital orthoimage (see Figure 37).

Relief displacement is corrected by taking each pixel of a DEM and finding the equivalent position in the satellite or aerial image. A brightness value is determined for this location based on resampling of the surrounding pixels. The brightness value, elevation, and exterior orientation information are used to calculate the equivalent location in the orthoimage file.
In Figure 37,

- \( P \) = ground point
- \( P_1 \) = image point
- \( O \) = perspective center (origin)
- \( X, Z \) = ground coordinates (in DTM file)
- \( f \) = focal length

In contrast to conventional rectification techniques, orthorectification relies on the digital elevation data, unless the terrain is flat. Various sources of elevation data exist, such as the USGS DEM and a DEM automatically created from stereo image pairs. They are subject to data uncertainty, due in part to the generalization or imperfections in the creation process. The quality of the digital orthoimage is significantly affected by this uncertainty.

*LPS provides the necessary tools to ensure the creation of map-accurate DTMs, including DEMs. For more information, see LPS Automatic Terrain Extraction User's Guide.*

For different image data, different accuracy levels of DEMs are required to limit the uncertainty-related errors within a controlled limit. While the near-vertical viewing SPOT scene can use very coarse DEMs, images with large incidence angles need better elevation data such as USGS level-1 DEMs. For aerial photographs with a scale larger than 1:60000, elevation data accurate to 1 meter is recommended. The 1-meter accuracy reflects the accuracy of the \( Z \) coordinates in the DEM, not the DEM resolution or posting.
Cell Size

Resampling methods used are nearest neighbor, bilinear interpolation, and cubic convolution. Generally, when the cell sizes of orthoimage pixels are selected, they should be similar or larger than the cell sizes of the original image. For example, if the image was scanned 9K × 9K, one pixel would represent 0.025 mm on the image. Assuming that the SI of this photo is 1:40000, then the cell size on the ground is about 1 m. For the orthoimage, it is appropriate to choose a pixel spacing of 1 m or larger. Choosing a smaller pixel size oversamples the original image.

For SPOT Pan images, a cell size of 10 meters is appropriate. Any further enlargement from the original scene to the orthophoto does not improve the image detail. For IRS-1C images, a cell size of 6 meters is appropriate.
LPS Project Manager Tour Guides
Introduction

With LPS Project Manager, you have access to many different types of geometric models with which to create a block file. This tour guide takes you through the steps with the frame camera model.

The graphic in Figure 38 represents the geometric relationship between three images, control points, and check points. The control points are shown at the positions that coincide with the image features they are associated with. Initially, the input images are not in the coordinate system of the control points. The input images are usually in file (pixel) coordinates, which can be defined as an arbitrary grid of coordinate values.

Figure 38: Geometric Relationship
During triangulation, the control points are used to establish a mathematical relationship between the camera, the photographs, and the 3D ground surface. Once this mathematical relationship has been defined, orthorectification can be performed. During orthorectification, the input image grid coordinates are resampled into the map coordinate system of the control points.

**Before You Begin**

This tour guide uses frame camera images of Colorado Springs, Colorado. They are National Aerial Photography Program (NAPP) black and white aerial photographs at a 1:40000 photo scale. The DEM used in this example has a ground resolution of 30 meters.

*Approximate completion time for this tour guide is 1 hour, 15 minutes.*

In this tour guide, you are going to perform the following basic steps:

- Create a new project.
- Add imagery to the block file.
- Define the camera model.
- Measure GCPs and check points.
- Use the automatic tie point collection function.
- Triangulate the images.
- Orthorectify the images.
- View the orthoimages.
- Save the block file.

**Create a New Project**

In this section of the tour guide, you create a new project using frame camera images of Colorado Springs, Colorado.

**Prepare the Block File**

1. Click the LPS icon on the icon panel. The LPS Project Manager opens.
2. Click the Create New Block File icon .

The Create New Block File dialog opens.

3. Navigate to a folder where you have write permission.
4. Next to **File name**, type **frame_tour**, then press Enter on your keyboard.

   The *.blk extension, for a block file, is appended automatically.

5. Click **OK** to close the Create New Block File dialog.

**Select Geometric Model**

Once you have created a block file, the Model Setup dialog opens. Here, you select a geometric model that corresponds to the type of camera associated with the images.

1. Click the **Geometric Model Category** dropdown list and select **Camera**.

2. Click **Frame Camera** in the **Geometric Model** list.

3. Click **OK** to close the Model Setup dialog.

**Define Block Properties**

The Block Property Setup dialog opens.
1. Click the **Set** button in the **Horizontal Reference Coordinate System** section of the Block Property Setup dialog.

2. Click the **Standard** tab in the Projection Chooser dialog.

3. Click the **Categories** dropdown list and select **US State Plane - NAD27 - Old USGS (DO154) Zone Numbers**.

4. Click the **Projection** scroll bar, then select **COLORADO CENTRAL (3476)**.

5. Click **OK** to close the Projection Chooser dialog.

6. Click the **Horizontal Units** dropdown list and choose **Meters**.
In this example, the block file is in WGS84, so the vertical coordinate system is also WGS84 by default. If the vertical system is different, you must change it to match the block file.

**Ensure that the information you provide in the Reference Coordinate System section of the Block Property Setup dialog is accurate. You are unable to return to this stage of the block setup process to change projection information once it has been set.**

7. Click **Next** in the Block Property Setup dialog.

The **Set Frame-Specific Information** section displays.

8. Type **7000** in the **Average Flying Height (meters)** number field, then press Enter.
The average flying height is the distance between the camera at the time of exposure and the average ground elevation. The average flying height can be determined by multiplying the focal length by the image scale. You must supply an average flying height.

9. Click **OK** to close the Block Property Setup dialog.

Next, you choose the images that make up the block file.
The **LPS CellArray**

As you add images to the block file, they are listed in the LPS CellArray. Each image has a series of columns associated with it.

The **Row #** column enables you to select an image specifically for use with LPS Project Manager. For example, you may want to generate pyramid layers for one image alone.

The **Image ID** column provides a numeric identifier for each image in the block. You can change the **Image ID** by typing inside the cell.

The **Description** field provides space for you to supply additional information about the image, such as date of capture.

The **>** column lets you designate the image that is currently active.

The **Image Name** column lists the directory path and file name for each image. When the full path to the image is specified, the corresponding **Online** column is green.

The **Active** column displays an **X** designating which images are going to be used in the LPS Project Manager processes such as automatic tie point generation, triangulation, and orthorectification. By default, all images are active.

The final five columns’ status is indicated in terms of color: green means the process is complete; red means the process is incomplete. The color of the columns is controlled by a preference setting. You can change the colors by going to the **LPS** category of the Preference Editor, then to **Status On Color** and **Status Off Color**.

The **Pyr.** column shows the presence of pyramid layers.

The **Int.** column shows if the fiducial marks have been measured.

The **Ext.** column shows if the final exterior orientation parameters are complete.

---

**Add Imagery to the Block**

Now that you have provided general information about the block, you can add images and create pyramid layers.
Add Frames

1. In the Block Project Tree View on the left side of the LPS Project Manager, right-click images, then select Add from the drop-down menu.

The Image File Name dialog opens.

2. Navigate to /examples/LPS/frame and select col90p1.img.

3. Hold down the Shift key and select the last *p1.img file in the list, col92p1.img.

All three *p1.img images are selected and can be added to the block file at once.

4. Click OK to close the Image File Name dialog.
The three frame image files are loaded and display in the CellArray at the bottom of the LPS Project Manager. You can resize this portion of the LPS Project Manager so that the top window, the Project Graphic Status window, is enlarged.

5. Click the plus sign [+] next to the Images folder to see the list of images in the frame_tour.blk file.

The images in the Images folder display in the CellArray. As you work through the LPS Project Manager workflow, the color of the columns in the CellArray indicates completed tasks.

**Compute Pyramid Layers**

Next, you compute pyramid layers for the images in the block file. Pyramid layers are used to optimize image display and automatic tie point collection.
1. Click the Edit menu, then choose the Compute Pyramid Layers option.

The Compute Pyramid Layers dialog opens.

2. In the Compute Pyramid Layers dialog, confirm that the All Images Without Pyramids radio button is selected.

3. Click OK in the Compute Pyramid Layers dialog.

A progress bar displays at the bottom of the LPS Project Manager as pyramid layers are created. When complete, the images’ rows corresponding to the Pyr. column are all green.

Next, you define the camera model.

**Define the Camera Model**

When you define the camera model, you provide information about the position of the fiducials (interior orientation) as well as the camera position (exterior orientation) about the camera that collected the images.

**LPS Project Manager Pyramid Layers**

Pyramid layers generated by LPS Project Manager are based on a binomial interpolation algorithm and a Gaussian filter. Using this filter, image contents are preserved and computation times are reduced. Pyramid layers generated by LPS Project Manager overwrite those generated by ERDAS IMAGINE, which uses different methods in...
Enter Specific Camera Information

1. Select **Edit -> Frame Editor** from the menu bar, or click the Frame Properties icon .

The Frame Camera Frame Editor dialog opens, displaying information about the active image listed in the CellArray, indicated with the >, `col90p1.img`.

2. In the **Sensor Name** section, click the **New Camera** button.

The Camera Information dialog opens.

- **Type the camera name here**
- **Type details about the camera here**
3. Enter Zeiss RMK A 15/23 in the Camera Name text field.

4. Enter 153.124 in the Focal Length (mm) number field.

5. Enter -0.002 in the Principal Point xo (mm) number field.

6. Enter 0.002 in the Principal Point yo (mm) number field.

For the complete calibration report, see the ReadMe file, readme.doc, located in /examples/LPS/frame.

Add Fiducial Marks

1. Click the Fiducials tab in the Camera Information dialog.

   The options for fiducials display.

2. Type 8 in the Number of Fiducials number field, then press Enter on your keyboard.

   The CellArray is populated by the additional fiducials, which are listed in the Row # column.

3. Enter the following information in the Fiducials tab CellArray:

<table>
<thead>
<tr>
<th>Row #</th>
<th>Film X (mm)</th>
<th>Film Y (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-103.947</td>
<td>-103.952</td>
</tr>
<tr>
<td>2</td>
<td>103.945</td>
<td>103.924</td>
</tr>
</tbody>
</table>
You can also use the **Load** button on the Camera Information dialog to load fiducial measurements contained in an ASCII file.

4. Click **OK** to close the Camera Information dialog.

The Frame Camera Frame Editor dialog remains, displaying the new camera information in the **Sensor Name** field.

**Measure Fiducials of the Images**

In this section, you are going to measure the fiducial marks in each of the three images.

1. Click the **Interior Orientation** tab of the Frame Camera Frame Editor dialog.

   The tools for setting up the image's interior orientation information display. The image is identified in the title bar of the dialog.

<table>
<thead>
<tr>
<th>Row #</th>
<th>Film X (mm)</th>
<th>Film Y (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-103.937</td>
<td>103.927</td>
</tr>
<tr>
<td>4</td>
<td>103.958</td>
<td>-103.952</td>
</tr>
<tr>
<td>5</td>
<td>-112.996</td>
<td>-0.005</td>
</tr>
<tr>
<td>6</td>
<td>112.990</td>
<td>-0.015</td>
</tr>
<tr>
<td>7</td>
<td>0.003</td>
<td>113.001</td>
</tr>
<tr>
<td>8</td>
<td>0.026</td>
<td>-112.971</td>
</tr>
</tbody>
</table>
To change the color of the fiducial marks, click in the Color column, and select the color you would like from the Color menu.

2. Make sure the first Fiducial Orientation icon is selected.

**Understanding Fiducial Orientation**

To select the proper fiducial orientation, you should compare the axis of the photo-coordinate system, which is defined in the calibration report, with the orientation of the image.

The four possible fiducial orientations are, in order:

1. photo-coordinate system parallel to image orientation,
2. image rotated 90° relative to the photo-coordinate system,
3. image rotated 180° relative to the photo-coordinate system, and

5. Click the View icon.

A Main View opens on top of the Frame Camera Frame Editor dialog, with an OverView that shows the entire image and a Detail View that shows the part of the image that is within the Link Box in the Main View. It is usually easiest to measure points in the Detail View.
If changing the color of the Link Cursor makes it easier to collect fiducials, you may do so by right clicking in the view, selecting **Link Box Color**, and choosing a different color.

The approximate area of the first fiducial is identified by the Link Cursor in the Main View, and the area within the Link Box displays in the Detail View.
6. Click in the center of the Link Box in the Main View and drag it so that the cross-shaped fiducial mark is in the center.

The fiducial mark is centered in the Detail View. You can adjust its display (zoom in or out) by adjusting the size of the Link Box.

7. Click the Place Image Fiducial icon on the Interior Orientation tab.

Your cursor becomes a crosshair when placed over any one of the views.

8. Measure the first fiducial by clicking in its center in the Detail View.
The fiducial point is measured and reported in the **Image X** and **Image Y** columns of the CellArray, and the display automatically moves to the approximate location of the next fiducial. This is controlled by the Set Automatic Move tool, which is enabled by default.

You can click the Lock icon to lock the Place Image Fiducial icon. This means that you can use the icon repeatedly without having to select it each time you measure a fiducial in the image.
9. Measure the remaining fiducials, including side fiducials, using step 6 through step 8.

*NOTE:* Rather than plus signs (+), fiducials 5 through 8 display as dots in the Detail View. These are side fiducials.

When all eight fiducials are measured, the display returns to the first fiducial mark.

Your solution (displayed over the Solve button on the 666 Interior Orientation tab of the Frame Camera Frame Editor) should be less than a pixel.
LPS Project Manager returns to the first fiducial
All fiducials have been measured
RMSE is reported here

NOTE: If your solution is greater than 0.33 pixels, remeasure some of your fiducials. Frequently, the first few measurements are not quite as accurate as the later measurements. To remeasure, click in the row of the Point # you wish to change, click the Select icon , then reposition the fiducial mark in the Detail View.

**Enter Exterior Orientation Information**

1. Click the **Exterior Information** tab on the Frame Camera Frame Editor dialog.
2. Enter the following information in the Value number fields. These values correspond to the exterior orientation of the camera that captured the image col90p1.

<table>
<thead>
<tr>
<th>Value</th>
<th>Xo</th>
<th>Yo</th>
<th>Zo</th>
<th>Omeg a</th>
<th>Phi</th>
<th>Kapp a</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>666700.00</td>
<td>115900.00</td>
<td>8800.00</td>
<td>0.0000</td>
<td>0.0000</td>
<td>90.0000</td>
</tr>
</tbody>
</table>

3. Click the Set Status checkbox.

4. Confirm that the Set Status dropdown list is set to Initial.

Now, you need to measure fiducials and define the exterior orientation for the remaining images in the block file.

1. Click on the Sensor tab in the Frame Camera Frame Editor dialog.
This returns you to the beginning of the process. You complete this process two more times, once for each remaining image in the block file, measuring fiducials and providing exterior orientation for each.

2. Click the **Next** button on the Frame Camera Frame Editor dialog.

   The **Image File Name** on the **Sensor** tab changes to the next image, `col91p1`, in the CellArray. The image also displays in the views.

3. Note that the camera, **Zeiss RMK A 15/23**, is the same as that entered for the first image.

4. Click on the **Interior Orientation** tab.

5. Measure the fiducial marks in the second image, `col91p1`.

   *If you need to review the steps required to collect fiducial measurements, refer to Measure Fiducials of the Images on page 90.*

   Once you have finished measuring the eight fiducials in the `col91p1` image, the RMSE displays.

6. After fiducials for the second image have been measured, click the **Exterior Information** tab.

7. Enter the following information in the **Value** number fields:

<table>
<thead>
<tr>
<th>Val</th>
<th>Xo</th>
<th>Yo</th>
<th>Zo</th>
<th>Omeg</th>
<th>Phi</th>
<th>Kapp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>666700.0</td>
<td>119400.0</td>
<td>8800.0</td>
<td>0.0000</td>
<td>0.00</td>
<td>90.00</td>
</tr>
</tbody>
</table>

8. Click the **Set Status** checkbox.

9. Confirm that the **Set Status** dropdown list displays **Initial**.

10. Click the **Sensor** tab.

11. Click the **Next** button on the Frame Camera Frame Editor dialog to advance to the final image in the block file, `col92p1`.

12. Click the **Interior Orientation** tab.

13. Measure the fiducial marks in the third image, `col92p1`.
14. After fiducials for the third image have been measured, click the **Exterior Information** tab.

15. Enter the following information in the **Value** number fields, which corresponds to the position of the camera as it captured the last image in the block file, **col92p1**.

<table>
<thead>
<tr>
<th>Value</th>
<th>Xo</th>
<th>Yo</th>
<th>Zo</th>
<th>Omeg a</th>
<th>Phi</th>
<th>Kappa</th>
</tr>
</thead>
<tbody>
<tr>
<td>666800.00</td>
<td>122900.00</td>
<td>8800.00</td>
<td>0.0000</td>
<td>0.00</td>
<td>90.00</td>
<td></td>
</tr>
</tbody>
</table>

16. **Click the Set Status checkbox.**

17. Confirm the **Set Status** dropdown list displays **Initial**.

18. Click **OK** to close the Frame Camera Frame Editor dialog.

Note that the **Int.** column of the CellArray is green, indicating that the interior orientation information has been specified for each image in the block file.

An alternate method to the one presented here is to process each element completely (that is, identify all the sensors, measure all of the fiducials, then input all of the exterior orientation information), instead of proceeding image-by-image.

19. Click **File -> Save** to save the interior orientation information to the block file, or click the Save icon 🔄.

### Measure GCPs and Check Points

Now that you have measured the fiducials and provided interior orientation for each image that makes up the block, you are ready to use the Point Measurement tool to measure the position of GCPs, tie points, and check points in the images. This determines exterior orientation.
1. Select **Edit -> Point Measurement** from the menu bar.

   NOTE: You may be prompted to select either the classic Point Measurement Tool or the Stereo Point Measurement Tool. Use the Classic Point Measurement Tool for this exercise.

   You can also click the Point Measurement icon on the toolbar to open this dialog.

   The Point Measurement tool opens. It displays the first two images in the block file, **col90p1** and **col91p1**, in the **Left View** and the **Right View**, respectively.
To change the color of points, click the Viewing Properties icon to access the Viewing Properties dialog. In the Point Table Info section, click the Advanced radio button, click the Color checkbox, then click OK. This adds a Color column to the reference CellArray and the file CellArray. You can then left-click and choose the color you want.

The Point Measurement tool consists of a tool palette, a reference CellArray (which gives coordinate values), a file CellArray (which gives pixel values), and six views in two groups of three that display different views of two of the image files in a block file. In this case, the first two files in the block, col90p1 and col91p1, display. This is a single dialog that can be resized by dragging the corners and sides.

For information about the tools contained in the Classic Point Measurement tool, see the On-Line Help.
Collect Point ID 1002

The next series of steps takes you through the process of collecting a GCP.

**Real-World Application**

When you use LPS Project Manager in your own work, you might have a photo overview of an area along with other sources of information to locate GCPs. This type of application is simulated in this tour guide using a reference image, a reference sketch, and a Detail View of each control point.

GCPs are typically placed in areas such as road intersections, building corners, or landmarks. You should avoid placing control points on features that vary, such as forest lines and water features. You might use a 1:24000 topographic map, state surveys, or sketches drawn in the field to help you locate appropriate points.

In general, the process of collecting GCPs involves studying the topographic map for the location of a specific point, such as a road intersection. Once you have determined its location, you use LPS Project Manager to collect and record the position. Then, you check the reference image to see where that point is located. Control point collection can be a time-consuming process, but accurate collection is imperative to the successful triangulation and orthorectification of images in your block file.

Once you have collected some well distributed GCPs that are common to two or more images in the block file, you can perform triangulation. Triangulation ties the images together so that they can then be orthorectified and linked together.

1. Click the **Add** button in the upper right-hand corner of the Point Measurement tool to add a new **Point #**.

   This adds a new row to the reference CellArray in the lower portion of the Point Measurement tool.

   ![Point IDs are added sequentially, but can be edited]

2. Click in the **Point ID** column and type the new ID number, **1002**.
Specify the Type and Usage

1. Click in the Type column to access the dropdown list.

2. Select Full from the dropdown list.

A Full GCP has X, Y, and Z (elevation) coordinates.

3. Click in the Usage column to access the dropdown list.

4. Select Control from the dropdown list.

Control denotes a control point (versus a check point or tie point).

Next, you are going to use a reference image of the area as well as a sketch and Detail View of control point 1002 to collect it in the image.

Collect Point ID 1002 in col90p1

Figure 46 on page 141 shows you where points are located in the first image in the block, col90p1. You refer back to this graphic as you collect points. Point ID locations are indicated with boxes, and labeled accordingly.

Figure 39 is an example of the type of sketch produced in the field that you might use to locate the precise location of a point. BM, or benchmark, stands for the location of a point with known coordinates. Also included is a Detail View of Point ID 1002.

NOTE: Each one of the following points also has a reference sketch and Detail View to help you select the point.

Figure 39: Reference Sketch and Detail View of Point ID 1002

1. Make sure that the Select Point icon is active in the Point Measurement tool palette.

2. Using Figure 46 on page 141 as a guide, move the Link Cursor in the OverView until you can see the area where Point ID 1002 is located.
3. In the Main View, move the Link Cursor until the control point feature is visible in the Detail View. Resize the Link Box as necessary in the views.

4. Click the Create Point icon in the Point Measurement tool palette.

5. Using Figure 39 as a guide, click in the Detail View to place control point 1002.

The point is placed in the views corresponding to col90p1, and labeled 1002. The file CellArray reflects the coordinates of the point.

Collect Point ID 1002 in col91p1

Now that you know the approximate area in the reference image and the exact location in the Detail View, you are going to collect **Point ID 1002** in the second image of the block file, col91p1.
**Figure 47** on page 142 is a reference image that shows you where points are located in the second image in the block, *col91p1*. You refer back to this graphic as you collect points. **Point ID** locations are indicated with boxes, and labeled accordingly.

1. Using **Figure 47** on page 142 as a guide, apply the Select Point icon 🔄 and Create Point icon ✿ to collect **Point ID 1002** in the second image, *col91p1*.

2. Check your results against the following **X File** and **Y File** coordinates for **Point ID 1002**.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col90p1</td>
<td>952.625</td>
<td>819.625</td>
</tr>
<tr>
<td>col91p1</td>
<td>165.875</td>
<td>846.625</td>
</tr>
</tbody>
</table>

3. If your **X File** and **Y File** coordinates do not match those above within two pixels, type the correct values into the file CellArray.

**Enter Reference Coordinates for Point ID 1002**

Since you have successfully located **Point ID 1002** in the two images, *col90p1* and *col91p1*, you are ready to enter the reference control point coordinates. In this exercise, reference control points’ coordinates are provided for you.

*In SPOT Pushbroom Sensor Tour Guide, instead of typing in values, you are going to collect reference control points from a reference image displayed in a view.*

1. Click in the **X Reference** column corresponding to **Point ID 1002**.

2. Type the value **665228.955** in the **X Reference** column.

3. Click in the **Y Reference** column corresponding to **Point ID 1002**.

4. Type the value **115012.472** in the **Y Reference** column.

5. Click in the **Z Reference** column corresponding to **Point ID 1002**.

6. Type the value **1947.672** in the **Z Reference** column, then press Enter on your keyboard.
7. When you are finished, click the **Save** button in the Point Measurement tool.

Now, you are ready to place the second control point.

**Collect Point ID 1003**

1. Click the **Add** button in the upper right-hand corner of the Point Measurement tool to add a new **Point #**.

2. Click in the **Point ID** column and type the new ID number, **1003**.

**Specify the Type and Usage**

1. Click in the **Type** column to access the dropdown list and select **Full**.

2. Click in the **Usage** column to access the dropdown list and select **Control**.

**Collect Point ID 1003 in col90p1**

![Reference Sketch and Detail View of Point ID 1003](image)

1. Make sure that the **Select Point icon** is active in the Point Measurement tool palette.

2. Using **Figure 46** on page 141 as a guide, move the Link Cursor in the **OverView** until you can see the area where **Point ID 1003** is located.
3. In the Main View, move the Link Cursor until the control point feature is visible in the Detail View. Resize the Link Box as necessary in the views.

4. Click the Create Point icon \( \text{Create Point} \) in the Point Measurement tool palette.

5. Using **Figure 40** as a guide, click in the Detail View to place control point **1003**.

   The point is placed in the views and labeled **1003**. The file CellArray reflects the coordinates of the point.

**Collect Point ID 1003 in col91p1**

Now that you know the approximate area in the reference image and the exact location in the Detail View, you are going to collect **Point ID 1003** in the second image of the block file, **col91p1**. That image displays in the right three views (the **Right View** in the Point Measurement tool).

1. Check **Figure 47** on page 142 to locate the position of **Point ID 1003** in the reference image.

2. Use the Select Point \( \text{Select Point} \) and Create Point \( \text{Create Point} \) icons to collect **Point ID 1003** in the second image, **col91p1**.

**Collect Point ID 1003 in col92p1**

**Point ID 1003** is visible in all three images that make up the block file. Right now, you can only see the images **col90p1** and **col91p1** in the Point Measurement tool. Using the **Right View** dropdown list, you can display the third image in the block, **col92p1**, and collect the control point in that image.

**NOTE:** In a real-world scenario, the images you work with may be much larger than those provided for this example, and would load slowly in the views. Therefore, you may want to select all of the points located in the two images currently displayed in the **Right View** and **Left View** before loading another image. In the case of this tour guide, however, the images are small enough so that changing the displayed image does not take much time.

1. In the Point Measurement tool, click on the **Right View** dropdown list.

2. From the **Right View** dropdown list, click **col92p1**.

   The third image, **col92p1**, displays in the right three views.
3. Using Figure 48 on page 143, locate Point ID 1003 in the reference image.

4. Use the Select Point and Create Point icons to collect Point ID 1003 in the third image, col92p1.

5. Check your results against the following X File and Y File coordinates for Point ID 1003.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col90p1</td>
<td>1857.875</td>
<td>639.125</td>
</tr>
<tr>
<td>col91p1</td>
<td>1064.875</td>
<td>646.375</td>
</tr>
<tr>
<td>col92p1</td>
<td>286.875</td>
<td>639.125</td>
</tr>
</tbody>
</table>

6. If your X File and Y File coordinates do not match those above within two pixels, type the correct values into the file CellArray.

Enter Reference Coordinates for Point ID 1003

1. Click in the X Reference column corresponding to Point ID 1003 and type the value 664456.22.

2. Click in the Y Reference column corresponding to Point ID 1003 and type the value 119052.15.

3. Click in the Z Reference column corresponding to Point ID 1003 and type the value 1988.820, then press Enter on your keyboard.

4. When you are finished, click the Save button in the Point Measurement tool.

When you have finished, the Point Measurement tool looks like the following:
Set Automatic (x, y) Drive Function

LPS Project Manager provides some automatic functions to help you select GCPs more rapidly. One such function is the Automatic (x, y) Drive function. This function becomes available after you have selected two points, but is actually implemented after collection of the third point.

1. In the Point Measurement tool palette, click the Automatic (x, y) Drive icon .

The icon changes to .

Using the Automatic (x, y) Drive function, LPS Project Manager approximates the location of the point in the second and any subsequent images based on the location of the point in the first image.

All three images in the block file are listed in the file CellArray—you maneuver between images using the Left View and Right View dropdown lists
Collect Point ID 1004

**Point ID 1004** is located in the images col91p1 and col92p1. The last point you collected was in col92p1, which displays in the Right View. You are going to adjust the Left View to display col91p1 before you begin.

1. Click the Left View dropdown list and select col91p1.

The image col91p1 displays in the left three views; col92p1 displays in the right three views.

2. Click the Add button in the upper right-hand corner of the Point Measurement tool to add a new Point #.

3. Click in the Point ID column and type the new ID number, 1004.

Specify the Type and Usage

1. Click in the Type column to access the dropdown list and select Full.

2. Click in the Usage column to access the dropdown list and select Control.

Collect Point ID 1004 in col91p1

**Figure 41: Reference Sketch and Detail View of Point ID 1004**

1. Make sure that the Select Point icon is active in the Point Measurement tool palette.

2. Using Figure 47 on page 142 as a guide, move the Link Cursor in the OverView until you can see the area where Point ID 1004 is located.

3. In the Main View, move the Link Cursor until the control point feature is visible in the Detail View. Resize the Link Box as necessary in the views.

4. Click the Create Point icon in the Point Measurement tool palette.
5. Using Figure 41 as a guide, click in the Detail View to place the control point 1004.

The point is placed in the views and labeled 1004. The file CellArray reflects the coordinates of the point.

**Collect Point ID 1004 in col92p1**

Now that you know the approximate area in the reference image and the exact location in the Detail View, you are going to collect **Point ID 1004** in the third image in the block file, **col92p1**. That image is in the right three views (the **Right View** in the Point Measurement tool).

1. Check Figure 48 on page 143 to locate the position of **Point ID 1004** in the reference image.

2. Use the Select Point and Create Point icons to collect **Point ID 1004** in the third image, **col92p1**.

3. Check your results against the following **X File** and **Y File** coordinates for **Point ID 1004**.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col91p1</td>
<td>1839.52</td>
<td>1457.43</td>
</tr>
<tr>
<td>col92p1</td>
<td>1050.60</td>
<td>1465.23</td>
</tr>
</tbody>
</table>

4. If your **X File** and **Y File** coordinates do not match those above within two pixels, type the correct values into the file CellArray.

**Enter Reference Coordinates for Point ID 1004**

1. Click in the **X Reference** column corresponding to **Point ID 1004** and type the value **668150.61**.

2. Click in the **Y Reference** column corresponding to **Point ID 1004** and type the value **122404.68**.

3. Click in the **Z Reference** column corresponding to **Point ID 1004** and type the value **1972.056**, then press Enter on your keyboard.

4. When you are finished, click the **Save** button in the Point Measurement tool.
Collect Point ID 1005

The next control point, **Point ID 1005**, is located in all three of the images in the block file. It is usually best to select control points in the images’ order in the block file (that is, collect in *col90p1*, then *col91p1*, then *col92p1*). This order corresponds to the images’ order in the strip. First, you use the **Left View** and **Right View** dropdown lists to get the images back in order.

1. Click the **Left View** dropdown list and select *col90p1*.
2. Click the **Right View** dropdown list and select *col91p1*.
3. Click the **Add** button in the upper right-hand corner of the Point Measurement tool to add a new **Point #**.
4. Click in the **Point ID** column and type the new ID number, **1005**.

**Specify Type and Usage**

1. Click in the **Type** column to access the dropdown list and select **Full**.
2. Click in the **Usage** column to access the dropdown list and select **Control**.

Collect Point ID 1005 in *col90p1*

**Figure 42: Reference Sketch and Detail View of Point ID 1005**

1. Make sure that the Select Point icon is active in the Point Measurement tool palette.
2. Using **Figure 46** on page 141 as a guide, move the Link Cursor in the OverView until you can see the area where **Point ID 1005** is located.
3. In the Main View, move the Link Cursor until the control point feature is visible in the Detail View. Resize the Link Box as necessary in the views.
4. Click the Create Point icon in the Point Measurement tool palette.
5. Using Figure 42 as a guide, click in the Detail View to place control point 1005.

Note that, because you set the Automatic (x, y) Drive function, LPS Project Manager adjusts the images in the views to display the same approximate area in the second image, col91p1.

Collect Point ID 1005 in col91p1

1. Use the Select Point and Create Point icons to collect Point ID 1005 in the second image, col91p1.

Collect Point ID 1005 in col92p1

1. Click the Right View dropdown list and select col92p1.

2. Use the Select Point \( \mathcal{R} \) and Create Point \( \mathcal{C} \) icons to collect Point ID 1005 in the third image, col92p1.

3. Check your results against the following X File and Y File coordinates for Point ID 1005.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col90p1</td>
<td>1769.450</td>
<td>1508.430</td>
</tr>
<tr>
<td>col91p1</td>
<td>1007.250</td>
<td>1518.170</td>
</tr>
<tr>
<td>col92p1</td>
<td>224.670</td>
<td>1510.670</td>
</tr>
</tbody>
</table>

4. If your X File and Y File coordinates do not match those above within two pixels, type the correct values into the file CellArray.

Enter Reference Coordinates for Point ID 1005

1. Click in the X Reference column corresponding to Point ID 1005 and type the value 668338.22.

2. Click in the Y Reference column corresponding to Point ID 1005 and type the value 118685.9.

3. Click in the Z Reference column corresponding to Point ID 1005 and type the value 1886.712, then press Enter on your keyboard.

4. When you are finished, click the Save button in the Point Measurement tool.
Collect Point ID 1006

Point ID 1006 is also located in all three images that make up the block file.

1. Click the Right View dropdown list and select col91p1.
2. Click the Add button in the upper right-hand corner of the Point Measurement tool to add a new Point #.
3. Click in the Point ID column and type the new ID number, 1006.

Specify Type and Usage

1. Click in the Type column to access the dropdown list and select Full.
2. Click in the Usage column to access the dropdown list and select Control.

Collect Point ID 1006 in col90p1

Figure 43: Reference Sketch and Detail View of Point ID 1006

1. Make sure that the Select Point icon is active in the Point Measurement tool palette.
2. Using Figure 46 on page 141 as a guide, move the Link Cursor in the OverView until you can see the area where Point ID 1006 is located.
3. In the Main View, move the Link Cursor until the control point feature is visible in the Detail View. Resize the Link Box as necessary in the views.
4. Click the Create Point icon in the Point Measurement tool palette.
5. Using Figure 43 as a guide, click in the Detail View to place control point 1006.
Collect Point ID 1006 in col91p1

1. Use the Select Point and Create Point icons to collect **Point ID 1006** in the second image, **col91p1**.

Collect Point ID 1006 in col92p1

1. Click the **Right View** dropdown list and select **col92p1**.

2. Use the Select Point and Create Point icons to collect **Point ID 1006** in the third image, **col92p1**.

3. Check your results against the following **X File** and **Y File** coordinates for **Point ID 1006**.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col90p1</td>
<td>1787.875</td>
<td>2079.625</td>
</tr>
<tr>
<td>col91p1</td>
<td>1023.625</td>
<td>2091.390</td>
</tr>
<tr>
<td>col92p1</td>
<td>215.125</td>
<td>2083.790</td>
</tr>
</tbody>
</table>

4. If your **X File** and **Y File** coordinates do not match those above within two pixels, type the correct values into the file CellArray.

Enter Reference Coordinates for Point ID 1006

1. Click in the **X Reference** column corresponding to **Point ID 1006** and type the value **670841.48**.

2. Click in the **Y Reference** column corresponding to **Point ID 1006** and type the value **118696.89**.

3. Click in the **Z Reference** column corresponding to **Point ID 1006** and type the value **2014.0**, then press Enter on your keyboard.

4. When you are finished, click the **Save** button in the Point Measurement tool.

When you are finished selecting the control points and entering reference coordinates into the CellArrays, they look like the following.
Input Check Points

Next, you are going to input two check points into the reference CellArray and the file CellArray. Check points are input in the same way as control points. The only difference is the Check designation in the Usage column.

NOTE: Check points are additional GCPs that are used to quantify the accuracy of the triangulation. Check points are not needed to actually perform the triangulation.

Collect Point ID 2001

Like control points, it is best to select the check points in the same order as the images in the block file.

1. Click the Right View dropdown list and select col91p1.
2. Click the Add button in the upper right-hand corner of the Point Measurement tool to add a new Point #.
3. Click in the Point ID column and type the new ID number, 2001.

Specify Type and Usage

1. Click in the Type column to access the dropdown list and select Full.
2. Click in the Usage column to access the dropdown list and select Check.

Each Point ID has two or more sets of file (pixel) coordinates associated with it.
Collect Point ID 2001 in col90p1

Figure 44: Reference Sketch and Detail View of Point ID 2001

1. Make sure that the Select Point icon △ is active in the Point Measurement tool palette.

2. Using Figure 46 on page 141 as a guide, move the Link Cursor in the OverView until you can see the area where Point ID 2001 is located.

3. In the Main View, move the Link Cursor until the check point feature is visible in the Detail View. Resize the Link Box as necessary in the views.

4. Click the Create Point icon + in the Point Measurement tool palette.

5. Using Figure 44 as a guide, click in the Detail View to place check point 2001.

Collect Point ID 2001 in col91p1

The Automatic (x, y) Drive function is still active, so LPS Project Manager adjusts the display of the second image in the views accordingly.

1. Use the Select Point △ and Create Point + icons to collect Point ID 2001 in the second image, col91p1.

2. Check your results against the following X File and Y File coordinates for Point ID 2001.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col90p1</td>
<td>915.02</td>
<td>2095.71</td>
</tr>
<tr>
<td>col91p1</td>
<td>160.90</td>
<td>2127.84</td>
</tr>
</tbody>
</table>
3. If your X File and Y File coordinates do not match those above within two pixels, type the correct values into the file CellArray.

**Enter Reference Coordinates for Point ID 2001**

1. Click in the X Reference column corresponding to Point ID 2001 and type the value 670970.45.

2. Click in the Y Reference column corresponding to Point ID 2001 and type the value 114815.23.

3. Click in the Z Reference column corresponding to Point ID 2001 and type the value 1891.888, then press Enter on your keyboard.

4. When you are finished, click the Save button in the Point Measurement tool.

**Collect Point ID 2002**

Point ID 2002 is located in the last two images of the block file, col91p1 and col92p1.

1. Click the Right View dropdown list and select col92p1.

2. Click the Left View dropdown list and select col91p1.

   \*NOTE: The same image cannot be displayed in both the Right View and the Left View at the same time. This is why you are instructed to select from the Right View dropdown list first.

3. Click the Add button in the upper right-hand corner of the Point Measurement tool to add a new Point #.

4. Click in the Point ID column and type the new ID number, 2002.

**Specify Type and Usage**

1. Click in the Type column to access the dropdown list and select Full.

2. Click in the Usage column to access the dropdown list and select Check.
Collect Point ID 2002 in col91p1

Figure 45: Reference Sketch and Detail View of Point ID 2002

1. Make sure that the Select Point icon is active in the Point Measurement tool palette.

2. Using Figure 47 on page 142 as a guide, move the Link Cursor in the OverView until you can see the area where Point ID 2002 is located.

3. In the Main View, move the Link Cursor until the check point feature is visible in the Detail View. Resize the Link Box as necessary in the views.

4. Click the Create Point icon in the Point Measurement tool palette.

5. Using Figure 45 as a guide, click in the Detail View to place check point 2002.

Collect Point ID 2002 in col92p1

1. Use the Select Point and Create Point icons to collect Point ID 2002 in the third image, col92p1.

2. Check your results against the following X File and Y File coordinates for Point ID 2002.

<table>
<thead>
<tr>
<th>Image</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>col91p1</td>
<td>2032.030</td>
<td>2186.530</td>
</tr>
<tr>
<td>col92p1</td>
<td>1227.375</td>
<td>2199.125</td>
</tr>
</tbody>
</table>

3. If your X File and Y File coordinates do not match those above within two pixels, type the correct values into the file CellArray.
Enter Reference Coordinates for Point ID 2002

1. Click in the **X Reference** column corresponding to **Point ID 2002** and type the value 671408.73.

2. Click in the **Y Reference** column corresponding to **Point ID 2002** and type the value 123166.52.

3. Click in the **Z Reference** column corresponding to **Point ID 2002** and type the value 1983.762, then press Enter on your keyboard.

4. When you are finished, click **Save** in the Point Measurement tool.

When you are finished, the Point Measurement tool looks like the following:
Perform Automatic Tie Point Generation

The tie point generation process measures the image coordinate positions of the control points, which are present in two or more overlapping images.

1. In the Point Measurement tool palette, click the Automatic Tie Point Collection Properties icon.

The Automatic Tie Point Generation Properties dialog opens.
2. In the **General** tab, confirm that the **Images Used** radio button is set to **All Available**.

3. Confirm that the **Initial Type** radio button is set to **Exterior/Header/GCP**.

   This option tells LPS Project Manager to use the initial exterior orientation parameters to calculate image topology.

4. Confirm that the **Image Layer Used for Computation** is set to **1**.

5. Click the **Distribution** tab in the Automatic Tie Point Generation Properties dialog.

6. Click in the **Intended Number of Points Per Image** field and type **15**, then press Enter.

   The actual number of points generated by auto tie is greater than or less than 15. The number depends, in part, on the amount of overlap between the images.

7. Confirm that the **Keep All Points** checkbox is off (unchecked).

8. Click the **Run** button in the Automatic Tie Point Generation Properties dialog.
LPS Project Manager starts the automatic tie point generation process, indicated by a progress bar at the bottom of the Point Measurement tool. When complete, the tie points display in the views. The tie points have the Type designation None (no X, Y, and Z coordinates), and the Usage designation Tie in the reference CellArray. Their coordinates are added to the file CellArray in the X File and Y File columns.

After the tie point generation process, the Auto Tie Summary dialog opens to display tie point information for each image in the block file. You may use this dialog to see overall auto tie results for the entire block file.

9. Once you have finished reviewing the Auto Tie Summary dialog, click Close.

Check Tie Point Accuracy

You should always check a few of the tie points to ensure accuracy. If a point is not as accurate as you would like, you may adjust it with the Select Point tool, deactivate it by clicking to remove the X in the Active column, or delete it by selecting the row in the CellArray (>) column and clicking the Delete button.

1. In the reference CellArray, click the scroll bar and scroll to any point, such as Point ID 2020.

2. Click in the > column to display Point ID 2020.

The point displays in the views. This appears to be an acceptable tie point.
3. Click in the > column of other **Point IDs** to see where tie points were placed.

   **NOTE:** Since all tie points are not common to all images, there can be cases where the displayed images do not have corresponding tie points. In such cases, verify the tie point by opening a different adjacent image in one of the views. To do so, use the **Left View** or **Right View** dropdown list.

4. If the position of a tie point needs to be adjusted, click the Select Point icon and reposition it in the Detail View.

5. When you are finished reviewing the automatically generated tie points, click the **Save** button.

6. Click the **Close** button to close the Point Measurement tool.
Perform Aerial Triangulation

Now that you have obtained control, check, and tie points, LPS Project Manager has all the information it needs to perform aerial triangulation. This step in the process establishes the mathematical relationship between the images that make up the block file and calculates exterior orientation.

1. From the Edit menu, select Triangulation Properties.

The Aerial Triangulation dialog opens.

![Aerial Triangulation dialog](image)

You can also access the Aerial Triangulation dialog from the Point Measurement tool by clicking the Triangulation Properties icon.

2. Click the Point tab in the Aerial Triangulation dialog.

The Point options display. These control the statistical weights (the confidence in their accuracy) assigned to the GCP parameters. These are commonly defined by the precision of the GCPs (the reference source). For example, a weight of 1 meter is better accuracy than a weight of 5 meters.
3. In the **GCP Type and Standard Deviations** section, click the **Type** dropdown list and select **Same Weighted Values**.

4. Click the **Run** button to run the aerial triangulation.

A Triangulation Summary dialog generates and opens.

**Find Information in the Triangulation Report**

You may wish to consult the Triangulation Report for more detailed numbers corresponding to the triangulation. You can save the report as a text file for future reference.

1. In the Triangulation Summary dialog, click the **Report** button.

The Triangulation Report opens.
2. Resize the Triangulation Report so that it is all visible in the window.

Check the Results

1. Scroll down until you reach **The Output of Self-calibrating Bundle Block Adjustment** section of the report.

The standard error of the last iteration is the most important
2. Note the **standard error** of iteration number 3.

   This is the standard deviation of unit weight, and measures the global quality of that iteration.

3. Note the **exterior orientation parameters**.

   ![Image of exterior orientation parameters](image)

   These are the exterior orientation parameters associated with each image in the block file.

4. Note the **residuals of the control points** and the **residuals of the check points**.

   ![Image of residuals](image)

   The control point X, Y, and Z residuals define the accuracy in both the average residual and the geometric mean residual. The X, Y, and Z residuals of the check points serve as an independent check in defining the average quality of the solution.

5. Scroll down to the **residuals of image points** section of the Triangulation Report.
These are the photo or image coordinate residuals. They can be used to determine the less accurate points. The inaccurate points generally have large residuals.

**Save the Triangulation Report**

If you save the Triangulation Report, you can always refer back to it.

1. From the **File** menu of the Editor, select **Save As**.

   The Save As dialog opens.
2. Navigate to a folder in which you have write permission.

3. In the File name text field, type the name frame_report.txt, then press Enter.

4. Click OK in the Save As dialog.

5. When you are finished viewing the Triangulation Report, select File -> Close in the Editor.

The Triangulation Summary dialog is still open.

To open the Triangulation Report in ERDAS IMAGINE, click the Tools menu in the ERDAS IMAGINE menu bar. Then, select Edit Text Files. Use the Open icon to open the report in the IMAGINE Text Editor dialog.

Update the Exterior Orientation

1. In the Triangulation Summary dialog, click the Update button to update the exterior orientation parameters.

This replaces the Initial exterior orientation parameters you entered during the measurement of fiducials with the exterior orientation computed by LPS Project Manager based on control and tie points in the images making up the block file.

You also have the option to use check points to determine exterior orientation. That option is located in the Aerial Triangulation dialog, Advanced Options tab.

2. Click the Close button to close the Triangulation Summary dialog.

3. In the Aerial Triangulation dialog, click the Accept button to accept the triangulation parameters.

4. Click OK in the Aerial Triangulation dialog to close it.

The Project Graphic Status window and CellArray of the LPS Project Manager update to reflect the completion of the exterior orientation step. Notice that the Ext. column is now green.

5. Click the Images folder to see the graphic display of the block file in the Project Graphic Status window.
Ortho Resample the Imagery

The next step creates orthorectified images of your block file images. Orthorectified images have fewer relief displacements and geometric errors than nonorthorectified images, and thus are considered more accurate. The orthorectified images display objects in their real-world X, Y, and Z positions.

1. On the LPS Project Manager toolbar, click the Ortho Resampling icon.

The Ortho Resampling dialog opens on the General tab.
2. Click the **DTM Source** dropdown list, then select **DEM**.

   The DEM file is used to supply elevation information to create the orthorectified imagery.

3. Confirm that the **Vertical Units** are set to **Meters**.

4. Click the dropdown list associated with the **DEM File Name**, and select **Find DEM**.

5. In the File Selector, navigate to `/examples/LPS/frame` and select `colspr_dem.img` as the **DEM File**.

6. Click **OK** in the File Selector dialog.

7. Change the **Output Cell Sizes** for **X** and **Y** to **4.0**.

   This value is determined based on the ground resolution of the images. See [Table 3, Scanning Resolutions](#), on page 26 for additional information.

8. Click the **Advanced** tab at the top of the Ortho Resampling dialog.
9. Click the **Resample Method** dropdown list and select **Nearest Neighbor**.

10. Click the checkbox next to **Ignore Value**, and keep the value of 0.

By default, LPS Project Manager assumes you only want to generate an orthoimage for the first image in the block file. You can use the **Add Multiple** utility to add all of the images in your block file to the Ortho Resampling dialog.

11. Click the **Add Multiple** button located at the bottom of the dialog.

The Add Multiple Outputs dialog opens.

12. Click the checkbox next to **Use Current Cell Sizes**.
This ensures each output orthoimage has X and Y cell sizes of 4.0.

13. Click **OK** in the Add Multiple Outputs dialog.

14. Click **OK** in the Confirm Existing Ortho dialog.

15. Use the scroll bar at the bottom of the CellArray to see the parameters for each of the files in the block.

16. Click **OK** in the Ortho Resampling dialog.

   A status dialog opens, tracking the ortho resampling process.

17. When the status dialog reaches 100% complete, click the **OK** button to dismiss it.

   The presence of the status dialog is controlled by a preference. It is located in the User Interface & Session category of the Preference Editor: Keep Job Status Box.
View the Orthoimages

First, you can see the orthos display in the LPS Project Graphic Status window.

Display Graphic View

1. Click the Orthos folder in the Block Project Tree View.

You can also use the Project Graphic Status window to get information about points in the orthoimages.

2. Click on one of the points (a square, a triangle, or a circle) displayed in the Project Graphic Status window.
In this example, the point is a tie point and is located in the first two images in the block file. The residual values are acceptably low.

3. Click **Dismiss** to close the Point Data dialog.

Now that the images have been ortho resampled, you can check how well they fit together in a Viewer.

**Use the Viewer**

1. From the ERDAS IMAGINE icon panel, click the Viewer icon.

   ![Viewer Icon]

   **NOTE: If necessary, select the type of Viewer you want to work with: Classic Viewer or Geospatial Light Table.**

2. Click the Open icon to access the Select Layer To Add dialog.

3. Navigate to the location in which you saved the orthorectified images.

4. Click the image `orthocol90p1.img`, then Shift-click `orthocol92p1.img`.
5. In the Select Layer To Add dialog, click the **Raster Options** tab.

6. Deselect the **Clear Display** checkbox.

7. Click to select the **Fit to Frame** and **Background Transparent** checkboxes.

   ![Select multiple images to add to the Viewer](image.png)

   *The default settings of these options can be defined in the Viewer category of the Preference Editor.*

8. Click the **Multiple** tab and confirm that the **Multiple Independent Files** radio button is selected.

9. Click **OK** in the Select Layer To Add dialog.

10. From the **View** menu, select **Arrange Layers**.

    The images display in the Viewer. If you would like to rearrange the images in the Viewer, click and drag the images in the Arrange Layers dialog accordingly, then click **Apply**.

**Magnify Areas of Overlap**

Now, you can check the areas of overlap to see how well LPS Project Manager orthorectified the images. Take special note of features such as roads, rivers, and parcels of land.

1. In the Viewer, click the **Zoom In** icon.

2. Click on an area in the Viewer where two of the images obviously overlap.
3. Apply the Zoom In icon as many times as necessary to see the portion of overlap clearly in the Viewer.

You can see that LPS Project Manager successfully put images into the same reference coordinate space. In the following picture, the presence of two images is indicated by the side fiducial mark. Notice how the road on either side of the side fiducial matches very well.

Use the Swipe Utility

You can use the Swipe utility to see how well the images overlap.

1. Click the Utility menu on the Viewer menu bar.

2. Choose Swipe.

The Viewer Swipe dialog opens.
3. Right-click in the Viewer to access the Quick View menu.

4. Click Fit Image to Window.

5. Click the slider bar in the Viewer Swipe dialog and move it to the left and right to see how well the top image, \texttt{col92p1}, overlaps the others.

   \textbf{Tip:} You can also choose the \textbf{Horizontal} radio button from the Viewer Swipe dialog.

6. When you are finished, click Cancel in the Viewer Swipe dialog.

7. Click Close in the Arrange Layers dialog.

8. Once you are done examining the orthoimages, choose \textbf{File} \textbf{Close} from the Viewer menu bar.

\section*{Save and Close the Block File}

1. Now that you have verified the accuracy of the LPS Project Manager output orthoimages, in the LPS Project Manager, click the \textbf{File} menu, then select \textbf{Save}, or click the Save icon \includegraphics[width=1cm]{save_icon.png}.

   Notice that all of the columns are green—with the exception of the \textbf{DTM} column which is a separate process—indicating that all of the process steps have been executed. You can open the complete project any time you like.
The DTM column is still red, which indicates that DTMs were not generated from the images in the block file. Use LPS Automatic Terrain Extraction (ATE) to create DTMs. For more information, see Lps Automatic Terrain Extraction User's Guide.

2. To exit LPS Project Manager, choose File -> Close from the menu.

3. To exit LPS, choose File -> Exit from the menu.

4. If you want to exit ERDAS IMAGINE, select Session -> Exit IMAGINE.

Conclusions

In this example, you learned that using ground control can greatly improve the accuracy of your output orthoimages. The more accurate your ground control, the better quality of your output.

Next, you can see how to orthorectify imagery without ground control or a DEM.
Reference Images

Figure 46: Reference Image of col90p1
Figure 47: Reference Image of col91p1
Introduction

Using LPS Project Manager, you have access to many different types of geometric models with which to create and orthorectify a block of images. This tour guide takes you through the steps using the digital camera model.

This tour guide demonstrates the ability of LPS Project Manager to orthorectify imagery without ground control or a DEM to very high accuracy. In this case, because the data you use also has airborne GPS information (which details the exact position of the camera at the time of image acquisition), the need for collecting ground control is eliminated.

After defining the interior orientation and exterior orientation parameters, you can proceed directly to auto tie and orthorectification of the input images. Figure 49 shows the Import Options dialog you can use to load orientation information.

Before You Begin

The data you use with this tour guide comes from southeast Spain. The data is 1:45000 scale (ground pixel size of .40 meters) imagery that was collected using a Kodak DCS 420 digital camera.

Approximate completion time for this tutorial is 45 minutes.
In this tour guide, you are going to perform the following basic steps:

- Create a new project.
- Add imagery to the block file.
- Define the camera model.
- Perform automatic tie point collection.
- Perform aerial triangulation.
- Orthorectify the images.
- View the orthoimages.
- Save and close the block file.

Create a New Project

In this section of the tour guide, you create a new project using three digital camera images of southeast Spain. In this case, the images are .tif images, but you can also use other formats such as .jpg, .img, MrSid, raw and generic binary, and Grid.

Prepare the Block File

1. Click the LPS icon on the icon panel and the the LPS Project Manager opens.
2. Click the Create New Block File icon.

The Create New Block File dialog opens.

Click OK

3. Navigate to a folder in which you have write permission.
4. Next to **File name**, type **digital_tour**, then press Enter on your keyboard.

   The *.blk extension, which stands for block file, is appended automatically.

5. Click **OK** to close the Create New Block File dialog.

   The Model Setup dialog opens.

**Select Geometric Model**

1. Click the **Geometric Model Category** dropdown list and select **Camera**.

2. Click in the **Geometric Model** section and select the **Digital Camera**.

3. Click **OK** in the Model Setup dialog.

   The Block Property Setup dialog opens.

   Initially, the projection is Geographic (Lat/Lon), but you can change it by clicking the Set button.
Define Block Properties

1. In the **Horizontal Reference Coordinate System** section of the Block Property Setup dialog, click the **Set** button.

   The Projection Chooser dialog opens.

   ![Projection Chooser Dialog](image)

   The information you supply in the Custom tab is transferred to the Block Property Setup dialog.

2. Click the **Custom** tab in the Projection Chooser dialog.

3. Click the **Projection Type** dropdown list and select **UTM**.

4. Click the **Spheroid Name** dropdown list and select **WGS84**.

5. Confirm that the **Datum Name** dropdown list shows **WGS84**.

6. Type 30 in the **UTM Zone** field and press Enter, or use the increment nudgers to the right of the field.

7. Confirm that the **NORTH or SOUTH** dropdown list shows **North**.

8. Click **OK** in the (Edited) Projection Chooser dialog.

9. In the Block Property Setup dialog, confirm that the **Horizontal Units** are set to **Meters**.

   In this example, the block file is in WGS84, so the vertical coordinate system is also WGS84 by default. If the vertical system is different, you must change it to match the block file.
For more information about coordinate systems, see the On-Line Help.

10. Click the Next button in the Block Property Setup dialog.

Import Exterior Orientation Parameters

The **Set Frame-Specific Information** section of the Block Property Setup dialog opens.

When these images were acquired, the position of the aircraft was recorded using airborne GPS and INS technology. The airborne GPS provides position information (that is, X, Y, and Z) about where the camera/sensor is at the time of image capture. The INS provides orientation information (that is, Omega, Phi, and Kappa) about where the camera/sensor is at the time of image capture.
The accuracy of the measurements is within 2 meters in the X, Y, and Z direction. In omega, phi, and kappa, the accuracy of the measurements is within 0.1 degrees. With this information, there is no need to collect GCPs in the images making up the block file. Instead, you provide exterior orientation values.

1. Type the value **1248.168** in the **Average Flying Height (meters)** section.

   This value is derived by adding the Z values for each image in the block (that is, 1851.948, 1853.994, and 1853.561) and dividing by the number of files in the block. Then subtract the average elevation value (that is, 605 meters) from the average Z value.

2. Click the **Import Exterior Orientation Parameters** button.

   The Import ASCII File Name dialog opens.

   ![Select the .dat file for exterior orientation information](image)

3. Navigate to /examples/LPS/digital, select the file **airborne_GPS.dat**, then click **OK**.

   The Import Parameters dialog opens. In this dialog, you check to see if the map information matches that which you specified during the block setup.
If the projection information contained in the .dat file does not match what you have specified for the block, the projection, spheroid, datum, and units must be changed so that they do match. You can use the Set button in the Import Parameters dialog to specify the correct map projection.

4. Click OK in the Import Parameters dialog.

The Import Options dialog opens.

5. In the Field Definition tab of the Import Options dialog, click the Row Terminator Character dropdown list.

6. Select Return NewLine (DOS) from the dropdown list.

7. Click the Input Preview tab on the Import Options dialog and view the fields.
8. Click **OK** in the Import Options dialog.

Once you click **OK**, the image names along with their X, Y, Z, Omega, Phi, and Kappa values are noted, imported, and saved by LPS.

9. Click **OK** in the Block Property Setup dialog to complete block setup.

**Add Imagery to the Block**

The CellArray updates. The **Image Name** field is updated for you. This is based on the information contained in the .dat file, `airborne_GPS.dat`, that you selected during the Import Exterior Orientation process. You can resize the elements of this dialog to suit you.
To begin, the images need to be online. Online means that the image name is attached and linked to the corresponding image file, which may be located on the hard drive or the network.

1. Click on the Online cell associated with digcam1.tif.

   The Digital Camera Frame Editor dialog opens.
2. In the Digital Camera Frame Editor dialog, click the **Attach** button.

   The Image File Name dialog opens. Next, you attach the files in the block.

3. Navigate to `/examples/LPS/digital`.

4. Click the **Files of type** dropdown list and select **TIFF**.

5. Click the file **digcam1.tif**.

6. Hold down the Shift key on the keyboard, then click the last *.tif file in the list, **digcam3.tif**.

   All of the *.tif files are selected for inclusion in the block file.

7. Click **OK** in the Image File Name dialog to return to the Digital Camera Frame Editor dialog.
8. Click **OK** in the Digital Camera Frame Editor dialog.

You are returned to the LPS Project Manager. The cells in the **Online** column of the CellArray are now green, indicating that the files in /examples/LPS/digital have been matched with the three image files specified in the .dat file.

![Image of the Digital Camera Frame Editor dialog](image)

The color of the columns is controlled by two preferences: **Status On Color** and **Status Off Color** in the LPS category of the Preference Editor.

**Compute Pyramid Layers**

Next, you compute pyramid layers for the images in the block file. Pyramid layers are used to optimize image display and automatic tie point collection.

1. Click the **Edit** menu, then choose **Compute Pyramid Layers**.

The Compute Pyramid Layers dialog opens.

![Image of the Compute Pyramid Layers dialog](image)

2. In the Compute Pyramid Layers dialog, confirm that the **All Images Without Pyramids** radio button is selected.

3. Click **OK** in the Compute Pyramid Layers dialog.

A progress bar displays at the bottom of the LPS Project Manager as pyramid layers are created for each image. When complete, the cells corresponding to the **Pyr.** column are all green.
Define the Camera Model

Since you have specified projection, imported exterior orientation parameters, and identified the images to be used in the block file, now you need to define the camera model.

Enter Specific Camera Information

1. On the LPS Project Manager toolbar, click the Frame Properties icon \( \text{Frame Properties} \).

   The Digital Camera Frame Editor dialog opens. You attached the images here, and now you specify the camera that goes with each image.

2. Click the **New Camera** button in the Digital Camera Frame Editor dialog.

   The Camera Information dialog opens.
3. In the **Camera Name** section of the Camera Information dialog, type the name **Kodak DCS 420 Digital Camera**.

4. In the **Description** field, type **Project for Floodplain Mapping**.

5. In the **Focal Length** field, type **28.0**, then press Enter, or use the increment nudgers to the right of the field to change the value.

6. Confirm that the **Principal Point xo** and the **Principal Point yo** values are set to **0.0000**.

**Save the Camera Information**

1. Click the **Save** button to save the camera model information.

   The Camera Parameter File Name dialog opens.

You can save this camera information for use with other images.
2. Navigate to a folder where you have write permission.

3. Confirm that the **Files of type** section says **Camera File**.

4. Type the name **kodak_dcs420** in the **File name** field, then press Enter on your keyboard. The .cam extension is automatically appended for you.

5. Click **OK** in the Camera Parameter File Name dialog.

6. Click **OK** in the Camera Information dialog.

   You are returned to the Digital Camera Frame Editor dialog. The camera information you supplied is located in the **Sensor Name** section of the dialog.
Check Camera Information of the Other Images

1. Click the **Next** button to display the information for **digcam2**, which displays in the Image File Name section of the dialog.

2. Confirm that the **Sensor Name** dropdown list shows **Kodak DCS 420 Digital Camera**.

3. Click the **Next** button to display the information for **digcam3**.

4. Confirm that the **Sensor Name** dropdown list shows **Kodak DCS 420 Digital Camera**.

5. Click the **Previous** button twice to return to **digcam1**.

Enter Interior Orientation Information

1. In the Digital Camera Frame Editor, click the **Interior Orientation** tab.
2. Click in the **Pixel size in x direction** field, and type **9.0**.

3. Click in the **Pixel size in y direction** field, and type **9.0**, then press **Enter**.

4. Click to select the checkbox for **Apply to all Frames**.

These values come from the CCD of the camera that captured the images. The number is a function of illumination.

> For information about digital camera CCDs, see “Digital Camera”.

5. Click the **Next** button twice to see that the same interior orientation information is transferred to **digcam2** and **digcam3**.

6. Click the **Previous** button twice to return to **digcam1**.

**Enter Exterior Orientation Information**

1. Click the **Exterior Information** tab in the Digital Camera Frame Editor dialog.

The information is already supplied for you. It comes from the .dat file, **airborne_GPS.dat**, you selected when you imported the information in the GPS file.
2. Click the **Next** button to see the Exterior Information values for the second image in the block file, *digcam2*.

3. Click the **Next** button again to see the Exterior Information values for the third image in the block file, *digcam3*.

   Note that the values for each image are different. This is due to the altered position of the camera during each exposure.

4. Click **OK** to close the Digital Camera Frame Editor dialog.

   You are returned to the LPS Project Manager. Note that the **Int.** column for all of the files is green, indicating that the interior orientation has been supplied.

5. Click the Save icon to save your changes so far.

### Perform Automatic Tie Point Collection

Generally, at this point in the process you collect control points in overlapping areas of images in the block file that determine the approximate exterior orientation parameters. Because this data includes the GPS and INS information, there is no need to collect GCPs in order to obtain the exterior orientation information.

In a case such as this, the next step is to run the auto tie process. This process further defines the geometry between the files in the block.
1. On the LPS Project Manager toolbar, click the Point Measurement icon.

   NOTE: You may be prompted to select either the Classic Point Measurement Tool or the Stereo Point Measurement Tool. Use the Classic Point Measurement Tool for this exercise.

The Point Measurement tool opens on your screen. In the Left View you see the first image in the block file, digcam1. In the Right View, you see the second image in the block file, digcam2. You can use the Right View or Left View dropdown list to see the third image in the block file, digcam3, as well.
To change the color of points in the Point Measurement tool, click the Viewing Properties icon to access the Viewing Properties dialog. In the Point Table Info section, click the Advanced radio button, then the Color checkbox, then OK. This adds a Color column to the reference CellArray and the file CellArray.

2. In the Point Measurement tool palette, click the Auto Tie Properties icon.

The Automatic Tie Point Generation Properties dialog opens on the General tab.
3. In the Automatic Tie Point Generation Properties dialog, click the **Distribution** tab.

4. Type **50** in the **Intended Number of Points Per Image** field, then press **Enter**.

   This produces approximately 50 tie points per image.

5. Click **Run** in the Automatic Tie Point Generation Properties dialog.

   After the tie point generation process, the Auto Tie Summary dialog opens to display tie point information for each image in the block file. You may use this dialog to see overall auto tie results for the entire block file.
6. Once you have reviewed the contents of the Auto Tie Summary dialog, click **Close**.

For more information about automatic tie point collection see **Automatic Tie Point Collection**.

**Check Tie Point Accuracy**

At this point, tie points are recorded in the file CellArray with their image positions in X and Y. After you check their accuracy and run the aerial triangulation, the map coordinates, displayed in the reference CellArray, are available.

1. Click in the **Point #** row of a tie point to see its location in the images displayed in the views.

*NOTE: Since all tie points are not common to all images, there are cases where the displayed images do not have common tie points. In such cases, verify the tie point by opening a different adjacent image in one of the views. To do so, use the **Left View** or **Right View** dropdown list.*
2. Click other points to see the position of other tie points in the views.

3. Click the Save button in the Point Measurement tool.

4. Click the Close button in the Point Measurement tool.

   You are returned to the LPS Project Manager.

**Perform Aerial Triangulation**

Now that you have used auto tie to create tie points in the images, you can progress to the triangulation process.

1. In the LPS Project Manager, click **Edit -> Triangulation Properties.**

   The Aerial Triangulation dialog opens.
2. Click the checkbox for **Compute Accuracy for Unknowns**.

   This computes the accuracy of the adjusted exterior orientation parameters and the X, Y, and Z tie point coordinates.

3. Click the **Image Coordinate Units for Report** dropdown list and select **Microns**.

4. In the Aerial Triangulation dialog, click the **Exterior** tab.

5. Click the **Type** dropdown list and select **Same weighted values**.

6. Click in each of the **Xo**, **Yo**, and **Zo** fields and type **2.0**.

   This means that the X, Y, and Z values are accurate within 2 meters. The omega, phi, and kappa values are accurate within 0.1 degree.

7. Confirm that the **Omega**, **Phi**, and **Kappa** fields are set to **0.1**.

8. Click the **Advanced Options** tab.
9. Click the **Blunder Checking Model** dropdown list and select **Advanced robust checking**.

Advanced robust checking automatically identifies and removes poor tie points from the solution.

10. Click to deselect **Use Image Observations of Check Points in Triangulation**.

You do not have any check points displayed in the Classic Point Measurement tool at this time; therefore, this option is not applicable.

11. Click the **Run** button in the Aerial Triangulation dialog.

The Triangulation Summary dialog opens. The result, reported in the **Total Image Unit-Weight RMSE** section, is less than 1 micron, which equates to less than one-fourth of a pixel.

12. Click the **Report** button in the Triangulation Summary dialog.
The Triangulation Report opens, which contains all the information pertaining to the tie points used during the triangulation process. This report may be saved as a text file for future reference.

The Triangulation Report with IFS

The output image x, y units: microns
The output angle unit: degrees
The output ground X, Y, Z units: meters

The Input Image Coordinates
image ID = 1

<table>
<thead>
<tr>
<th>Point ID</th>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>203.64</td>
<td>-703.83</td>
</tr>
<tr>
<td>2</td>
<td>119.37</td>
<td>-634.99</td>
</tr>
<tr>
<td>3</td>
<td>2379.35</td>
<td>-620.67</td>
</tr>
<tr>
<td>4</td>
<td>-5964.95</td>
<td>-1107.32</td>
</tr>
<tr>
<td>5</td>
<td>-4969.94</td>
<td>-1103.66</td>
</tr>
<tr>
<td>6</td>
<td>-4635.14</td>
<td>-1445.83</td>
</tr>
<tr>
<td>7</td>
<td>-7124.72</td>
<td>-1114.60</td>
</tr>
<tr>
<td>8</td>
<td>1092.60</td>
<td>-1556.84</td>
</tr>
<tr>
<td>9</td>
<td>680.59</td>
<td>-1509.94</td>
</tr>
<tr>
<td>10</td>
<td>7489.48</td>
<td>-1785.28</td>
</tr>
<tr>
<td>11</td>
<td>2856.34</td>
<td>-2049.12</td>
</tr>
<tr>
<td>12</td>
<td>5070.14</td>
<td>-1392.12</td>
</tr>
<tr>
<td>13</td>
<td>-4490.59</td>
<td>-2363.63</td>
</tr>
<tr>
<td>14</td>
<td>-6651.14</td>
<td>-2494.97</td>
</tr>
<tr>
<td>15</td>
<td>-4207.40</td>
<td>-2561.31</td>
</tr>
<tr>
<td>16</td>
<td>-6977.30</td>
<td>-3192.39</td>
</tr>
<tr>
<td>17</td>
<td>-2631.34</td>
<td>-2596.40</td>
</tr>
<tr>
<td>18</td>
<td>-2544.56</td>
<td>-3114.27</td>
</tr>
<tr>
<td>19</td>
<td>-2752.30</td>
<td>-2167.59</td>
</tr>
<tr>
<td>20</td>
<td>472.97</td>
<td>-2999.10</td>
</tr>
<tr>
<td>21</td>
<td>225.54</td>
<td>-3206.14</td>
</tr>
<tr>
<td>22</td>
<td>824.71</td>
<td>-3268.74</td>
</tr>
<tr>
<td>23</td>
<td>3138.37</td>
<td>-2903.28</td>
</tr>
<tr>
<td>24</td>
<td>3307.61</td>
<td>-2957.41</td>
</tr>
<tr>
<td>25</td>
<td>-6065.03</td>
<td>-3799.62</td>
</tr>
<tr>
<td>26</td>
<td>-4657.34</td>
<td>-3341.90</td>
</tr>
<tr>
<td>27</td>
<td>-4164.39</td>
<td>-2925.46</td>
</tr>
<tr>
<td>28</td>
<td>-6754.71</td>
<td>-4273.91</td>
</tr>
<tr>
<td>29</td>
<td>-2250.00</td>
<td>-3406.85</td>
</tr>
<tr>
<td>30</td>
<td>-1724.90</td>
<td>-3644.96</td>
</tr>
<tr>
<td>31</td>
<td>-2952.41</td>
<td>-4284.51</td>
</tr>
<tr>
<td>32</td>
<td>-5568.43</td>
<td>-5905.09</td>
</tr>
<tr>
<td>33</td>
<td>440.95</td>
<td>-4052.61</td>
</tr>
<tr>
<td>34</td>
<td>947.53</td>
<td>-4206.40</td>
</tr>
<tr>
<td>35</td>
<td>1138.91</td>
<td>-4388.38</td>
</tr>
</tbody>
</table>

Use the scroll bars to see the entire report

See Aerial Triangulation Report on page 364 for a complete explanation of the Triangulation Report.

To improve the triangulation results, you can look through the Triangulation Report and identify the points with the most error. These commonly have relatively large residuals. Then, you can go back to the Point Measurement tool, deactivate those points by clicking in the Active column to remove the X, and run the triangulation again.

13. When you are finished looking at the report, select File -> Close.
14. Click the **Accept** button in the Triangulation Summary dialog.

15. Click the **Close** button to close the Triangulation Summary dialog.

16. Click **OK** in the Aerial Triangulation dialog to accept the triangulation.

   You are returned to the LPS Project Manager. The **Ext.** column is now green and the images display in the Project Overview window.

---

**Check Project Graphic Status**

The Project Graphic Status window offers you an easy way to evaluate the GCPs, check points, and tie points associated with images in the block file. You can also get information about each specific points in this dialog.

1. In the LPS Project Manager, click plus sign next to the **Images** folder in the Block Project Tree View.
2. In the **Display Mode** section of the LPS Project Manager, click the checkbox next to **Point IDs**.

   The **Point IDs** are listed below each of the **Tie Points** in the display.

3. Click the **Zoom In** icon and drag a box around an area containing tie points.

4. Click on the Select icon to deactivate the **Zoom In** icon.

5. Click on a **Tie Point** square to display the Point Data dialog.
6. When you are finished viewing information in the Point Data dialog, click the **Dismiss** button.

7. Click the **Image Space** radio button in the **Display Mode** section of the LPS Project Manager.

8. In the Block Project Tree View on the left side of the dialog, click **digcam2.tif** under the **Images** folder to display the points associated with that image.

   The active image is identified in both the Block Project Tree View and the CellArray. The tie points display for the identified image.
Select the image to display in the Image Space mode in the Block Project Tree View

9. Click the to select the next image in the block file, **digcam3**. The tie points redisplay in the Project Graphic Status window of the LPS Project Manager accordingly.

10. When you are finished, click the **Map Space** radio button in the **Display Mode** section of the LPS Project Manager.

**Ortho Resample the Imagery**

The final step in the process is to orthorectify the images in the block file.

1. In the CellArray of the LPS Project Manager, click on a red cell within the **Ortho** column, or select the Ortho Resampling icon from the toolbar.
The Ortho Resampling dialog opens. The Ortho Resampling dialog opens on the **General** tab. Here, you can set the parameters to be applied to each of the images in the block.

1. Click in the **Active Area** field and type **95**, or use the increment nudgers to the right of the field.

2. Confirm that the **DTM Source** dropdown list shows **Constant**.

3. In the **Constant Value** field, type **605.0**.

   Use of a constant value is appropriate in relatively flat areas; however, areas with large relief displacement benefit from a DTM source, such as a DEM.

4. In the **Output Cell Sizes** section, change both **X** and **Y** to **0.50**.

5. Click the **Advanced** tab.

6. Confirm that the **Resampling Method** is **Bilinear Interpolation**.

**Add Multiple Images**

In the CellArray of the Ortho Resampling dialog, you can add multiple images in your block file to be resampled. You can do so either in the **General** tab or the **Advanced** tab.
1. In the **Advanced** tab of the Ortho Resampling dialog, click the **Add Multiple** button.

   The Add Multiple Outputs dialog opens. It automatically adds the **ortho** output file prefix for you. This option adds all files in the block to the Ortho Resampling dialog CellArray.

2. Click the **Use Current Cell Sizes** checkbox so that all orthoimages have X and Y cell sizes of **0.50**.

3. Click **OK** in the Add Multiple Outputs dialog.

4. Click **OK** in the Confirm Existing Ortho dialog, which alerts you that the first image in the block file, **digcam1**, is already set for ortho resampling.

   The remaining images in the block file are added to the Ortho Resampling CellArray.
5. Click **OK** in the Ortho Resampling dialog to begin the process.

   A status dialog opens.

6. When the process is 100% complete, click **OK** in the status dialog to close it.

**View the Orthoimages**

Now that the resampling process is complete, indicated by the green cells in the **Ortho** column of the CellArray, you can check the orthoimages in an ERDAS IMAGINE Viewer.

**Use LPS**

1. Click the plus sign \([+]\) next to the **Orthos** folder in the Block Project Tree View of the LPS Project Manager.

2. Click on one of the orthos in the list to highlight it in the Block Tree View, CellArray, and the Project Graphic Status window.
To see the actual orthoimage, not just a graphical representation, you may use a Viewer.

**Use a Viewer**

1. Right-click on the ortho in the Block Tree View and select **View** from the **Ortho** quick view menu.
   
   *NOTE:* If necessary, choose the type of Viewer you want to work with: **Classic Viewer** or **Geospatial Light Table**.

2. From the Viewer menu bar, select **File -> Open -> Raster Layer**.

3. In the Select Layer To Add dialog, navigate to the location in which you saved the resampled images.
4. Click the first orthoimage in the block file, `orthodigcam1.img`.

5. Hold down the Shift key and select the last orthoimage, `orthodigcam3.img`.

6. Click the Raster Options tab.

7. Deselect Clear Display if it is selected with a check mark.

8. Select the Fit to Frame checkbox and the Background Transparent checkbox.

   The default settings of these options can be defined in the Viewer category of the Preference Editor.

9. Click the Multiple tab.

10. Make sure that the Multiple Independent Files radio button is selected, then click OK.

    The three orthoimages display in the Viewer.

   ![Viewer window](image)

   **Magnify Areas of Overlap** You can visually check the accuracy of the orthoimages by using the Zoom In tool.
1. In the Viewer containing the images, click the Zoom In icon 🕵️.

2. Click an area that interests you. You may have to apply the Zoom In tool more than once to see the details.

---

**Use the Swipe Utility**

You can also use the Swipe utility to see how well the images overlap.

1. Click the Utility menu on the Viewer menu bar.

2. Choose Swipe.

The Viewer Swipe dialog opens.
3. Right-click in the Viewer to access the **Quick View** menu.

4. Click **Fit Image To Window**.

5. Click the slider bar in the Viewer Swipe dialog and move it to the left and right to see how well the top orthoimage, `orthodigcam3.img`, overlaps the others.

   *If you like, you may click the **View** menu, then select **Arrange Layers**. You may change the order of the images as they display in the Viewer to see how they look with the Swipe utility.*

6. When you are finished, click **Cancel** in the Viewer Swipe dialog.

7. Click **File -> Close** in the Viewer containing the orthoimages.

   You are returned to the LPS Project Manager.

8. Click the plus sign `➕` next to the **Images** folder in the Block Project Tree View.

   In the LPS Project Manager, you can see that the CellArray columns are green (with the exception of the **DTM** column, which is specific to LPS Automatic Terrain Extraction), indicating that the process is complete.
Save and Close the Block File

1. In the LPS Project Manager, select **File -> Save**, or click the Save icon.

   ![Save icon]

   You can now refer to the complete block file whenever you like.

2. In the LPS Project Manager, select **File -> Close**.

3. To close LPS Project Manager, select **File -> Exit**.
Conclusions

Interior and exterior orientation information from airborne GPS and INS data is accurate enough to eliminate the need for ground control. Simply import the data, and LPS uses that information to create accurate orthoimages.

Next, you can learn how to select both horizontal and vertical reference points from images outside the block file.
Introduction

Using LPS Project Manager, you have access to many different types of geometric models with which to create a block file. This tour guide takes you through the steps with the SPOT pushbroom model.

This tour guide demonstrates the use of existing orthorectified imagery as a source for ground control measurements. In this case, two images (xs_ortho.img and NAPP_2m-ortho.img, in Figure 50) are used for that purpose.

Figure 50: Reference Images: xs_ortho.img and NAPP_2m-ortho.img

When you use images outside of the block file as reference sources, you must identify whether you are using them as horizontal (X, Y) or vertical (Z) reference sources. The benefit of using existing orthorectified imagery in the collection of your GCPs is that the GCPs you collect are more accurate than those collected from nonorthorectified imagery.

Other types of external reference sources you can use with LPS Project Manager include: geocorrected images, vector Arc coverages, annotation layers, ASCII text files, and digitizing tablets.
Before You Begin

The data you use with this tour guide comes from Palm Springs, California. You choose reference coordinates in two images: one a SPOT image, and one an orthorectified aerial photo. The block itself consists of two images, both SPOT panchromatic images with 10-meter resolution.

For more information about the data used in this tour guide, see “SPOT Example Data”.

This tour guide takes approximately 1 hour, 30 minutes to complete.

In this tour guide, you are going to perform the following basic steps:

• Create a new project.
• Select a horizontal reference source.
• Collect GCPs.
• Add a second image to the block file.
• Collect GCPs in the second image.
• Perform automatic tie point collection.
• Triangulate the images.
• Orthorectify the images.
• View the orthoimages.
• Save the block file.

Create a New Project

In this section of the tour guide, you create a new project using SPOT satellite images of Palm Springs, California.

Prepare the Block File

1. Click the LPS icon on the icon panel and the LPS Project Manager opens.
2. Click the New File icon to open the Create New Block File dialog.

3. Navigate to a folder in which you have write permission.

4. Click in the text field next to **File name**, and type **spot_tour**, then press Enter on your keyboard.

   The *.blk extension is appended automatically.
5. Click OK to close the Create New Block File dialog.

Choose Camera Model

The Model Setup dialog opens.

1. Click the Geometric Model Category dropdown list and choose Polynomial-based Pushbroom.

2. In the Geometric Model section click SPOT Pushbroom.

3. Click OK to close the Model Setup dialog.

The Block Property Setup dialog opens.

4. Click the Set button in the Horizontal Reference Coordinate System section of the Block Property Setup dialog.

The Projection Chooser dialog opens.
5. In the **Custom** tab, click the **Projection Type** dropdown list and choose **UTM**.

6. Click the **Spheroid Name** dropdown list and select **Clarke 1866**.

7. Click the **Datum Name** dropdown list and choose **NAD27 (CONUS)**.

8. Click in the **UTM Zone** field and type **11**.

9. Verify that the **NORTH or SOUTH** field is set to **North**.

10. Click **OK** in the (Edited) Projection Chooser dialog.

11. Make sure that the **Horizontal Units** are set to **Meters**.

The **Reference Coordinate System** section of the Block Property Setup dialog reflects the projection you selected. You do not need to make changes to the **Vertical** section.
Make sure that the reference system is correct. You cannot revise the projection system once you click OK to complete setup in the Block Property Setup dialog.

12. Click OK to close the Block Property Setup dialog.

Add Imagery to the Block

1. In the Block Project Tree View on the left side of the LPS Project Manager, click the Images folder.

2. Select Edit | Add Frame from the LPS Project Manager menu bar, or click the Add Frame icon. 

   The Image File Name dialog opens.

3. Navigate to /examples/LPS/spot, select spot_pan.img, then click OK.
The image loads into the LPS Project Manager and displays in the CellArray.

<table>
<thead>
<tr>
<th>Row #</th>
<th>Image ID</th>
<th>Description</th>
<th>Image Name</th>
<th>Active</th>
<th>Pyr.</th>
<th>Int.</th>
<th>Ext.</th>
<th>DTM</th>
<th>Ortho</th>
<th>Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td>file:///examples/wbhase/spot/spot_panimg</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

The image is listed in the Image Name section, but there are no pyramid layers at this time.

**Generate Pyramid Layers**

To conserve space in the /examples/LPS/spot folder, the pyramid layers associated with the SPOT image are not included. However, LPS Project Manager has a utility that enables you to quickly compute pyramid layers for your images. Pyramid layers make your image display more rapidly in the views.

1. Click in the red column labeled **Pyr.** for the **spot_pan** image.

   This cell controls the creation of pyramid layers for the image(s) in the block file.

   The Compute Pyramid Layers dialog displays.

   ![Compute Pyramid Layers Dialog](image)

   - **All Images Without Pyramids** is selected by default

   - Click **OK**

2. Confirm that the **All Images Without Pyramids** radio button is checked.

3. Click **OK** in the Compute Pyramid Layers dialog.

   A status bar displays at the bottom of the dialog, indicating the progress of pyramid layer creation. When complete, the **Pyr.** column for **spot_pan** is green, indicating that pyramid layers are present for this image.
Define the Sensor Model

Next, you are going to verify the parameters of the sensor. In this case, it is a SPOT pushbroom sensor. The parameters are supplied by the images you are going to be working with, contained in their header files.

Header Files

Header files precede image data on storage media, be it tape or CD. In general, header files contain the following information: number of columns (in pixels), number of rows (in pixels), data storage format, pixel depth (for example, 8-bit), number of bands, blocking factor, and number of header files and header records.

With sensor data, such as that obtained by the SPOT pushbroom sensor, data in the header file (also called ephemeris data) also includes the orientation of the sensor as it existed at the time of image capture. This information, x, y, z, omega, phi, kappa, can be read directly into LPS and used in the creation of block files. Moreover, you can also get information such as velocity vector and the exact time of the center scan line from the header file.

1. Select **Edit -> Frame Editor** from the menu bar, or click the Frame Properties icon.

The SPOT Pushbroom Frame Editor dialog opens, which displays information about the active image listed in the LPS CellArray, `spot_pan`.

2. In the **Sensor** tab of the SPOT Pushbroom Frame Editor dialog, click the **Edit** button.

The Sensor Information dialog displays.
3. Review the fields in the Sensor Information dialog.

   The data in the Sensor Information dialog corresponds to the SPOT pushbroom sensor that obtained the image named `spot_pan`. The information is derived from the header file of the image.

4. Click **OK** in the Sensor Information dialog to confirm that the information is correct.

5. Click **OK** in the SPOT Pushbroom Frame Editor dialog.

   You are returned to the LPS Project Manager. As you can see, the `Int.` column that corresponds to the SPOT image is now green, indicating that the sensor has been specified.

Start the Point Measurement Tool

1. In the dialog, click the Point Measurement icon 📈.

   *NOTE: You may be prompted to select either the Classic Point Measurement Tool or the Stereo Point Measurement Tool. Use the Classic Point Measurement Tool for this exercise.*

   The Point Measurement tool opens displaying three views, a tool palette, and two CellArrays: one for recording reference coordinates, and one for recording file coordinates.
Specify the Horizontal Reference Source

1. In the Point Measurement tool palette, click the Horizontal Reference Source icon.

The GCP Reference Source dialog opens.
NOTE: An existing image layer that has been orthorectified is going to be used for the collection of horizontal (X, Y) control points.

2. In the GCP Reference Source dialog, click the Image Layer radio button.

3. Click OK in the GCP Reference Source dialog.

   The Reference Image Layer dialog opens.

4. Navigate to /examples/LPS/spot and select the file xs_ortho.img.

5. Click OK in the Reference Image Layer dialog.

   The Reference Image Layer dialog closes, and you are returned to the Point Measurement tool.

6. In the Point Measurement tool, click the checkbox next to Use Viewer As Reference.
7. If you are prompted to create pyramid layers for the `xs_ortho.img` image, click **Yes**.

The Point Measurement tool automatically changes to display the new reference image, `xs_ortho`, in the **Left View** of the Point Measurement tool, and the original image, `spot_pan`, in the **Right View** of the Point Measurement tool. You are going to obtain reference coordinates by selecting points in `xs_ortho`, the reference image, that correspond to points also in the block image, `spot_pan`.

Now, you are ready to begin collecting control points.
Collect GCPs

In this section, you are going to use screen captures of the reference image, `xs_ortho`, and the first image in the block, `spot_pan`, to collect the GCPs and identify their X and Y coordinates.

**NOTE:** The GCPs displayed in this tour guide are shown in different colors to enable you to see them better. Therefore, **Color** columns have been added to the reference and file CellArrays. By default, GCPs are added to the views in green, and the **Color** column does not display.

💡

To change the color of points, click the Viewing Properties icon to access the Viewing Properties dialog. In the **Point Table Info** section, click the Advanced radio button, then the **Color** checkbox, then OK. This adds a **Color** column to the reference CellArray and the file CellArray.
Collect Point ID 1

1. Click the **Add** button in the Point Measurement tool.

   A row for **Point ID 1** is added to the reference CellArray.

2. Check **Figure 51** for the location of **Point ID 1** in **xs_ortho** displayed in the **Left View** of the Point Measurement tool.

3. Click the Select Point icon and use it to move the Link Cursors in the views until you see the road intersection.

   When you have found the road intersection and centered it in the views, you are ready to collect the control point.

4. Click the Create Point icon.
5. Move the cursor into the Detail View displaying the reference image, xs_ortho, and click the intersection.

NOTE: In the xs_ortho OverView, the Link Cursor is located in the upper right corner of the image. If you need more detailed information to find the intersection, it is located at the following ground coordinates in the reference image, xs_ortho: 566189.190, 3773586.979; and the following pixel coordinates in the first block image, spot_pan: 5239.468, 337.384.

A control point is placed on the intersection and labeled 1. The reference CellArray updates to include the X Reference and Y Reference coordinates of the point in the reference image, xs_ortho.

6. Check your control point coordinates. They should match those in the following table:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>566189.190</td>
<td>3773586.979</td>
</tr>
</tbody>
</table>

7. If your coordinates do not approximate (within 10 meters) those listed in step 6. above, type the correct coordinates in the reference CellArray, then press Enter on your keyboard.

📚 The Z Reference column is empty at this time. You are going to input Z values using a DEM later in the exercise, in “Set the Vertical Reference Source”.

Now, you are going to collect the point on the block image, spot_pan.

8. Check Figure 51 for the location of Point ID 1 spot_pan displayed in the Right View of the Point Measurement tool.

9. Click the Select Point icon and use it to move the Link Cursors in the views until you see the road intersection.

When you have found the road intersection and centered it in the views, you are ready to collect the control point.

10. Click the Create Point icon.

11. Move the cursor into the Detail View containing spot_pan and click the intersection.
A control point is placed on the intersection and labeled 1. The file CellArray updates to include the point in the spot_pan image, and the X File and Y File coordinates are updated.

12. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>5239.468</td>
<td>337.384</td>
</tr>
</tbody>
</table>

13. If your coordinates do not approximate (within two pixels) those listed in step 12. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

**Collect Point ID 2**

**Figure 52: Location of Point ID 2**

1. Click the **Add** button in the Point Measurement tool.
2. Check Figure 52 for the location of Point ID 2 in the xs_ortho views on the left side of the Point Measurement tool.

3. Click the Select Point icon and use it to move the Link Cursors in the views until you see the road intersection.

4. Click the Create Point icon.

5. Move the cursor into the Detail View containing the reference image, xs_ortho, and click the intersection.

   NOTE: In the xs_ortho OverView, the box is located in the lower right corner of the image. If you need more detailed information to find the point location, it can be found at the following ground coordinates in the reference image, xs_ortho: 555690.659, 3728387.770; and the following pixel coordinates in the first block image, spot_pan: 5191.590, 4969.546.

   A control point is placed on the intersection and labeled 2. The reference CellArray updates to include the X Reference and Y Reference coordinates of the point in the reference image, xs_ortho.

6. Check your control point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>555690.659</td>
<td>3728387.770</td>
</tr>
</tbody>
</table>

7. If your coordinates do not approximate (within 10 meters) those listed in step 6. above, type the correct coordinates in the reference CellArray, then press Enter on your keyboard.

8. Check Figure 52 for the location of Point ID 2 in spot_pan displayed in the Right View of the Point Measurement tool.

9. Click the Select Point icon and use it to move the Link Cursors in the views until you find the road intersection.

10. Click the Create Point icon.

11. Move the cursor into the Detail View containing spot_pan and click the intersection.

12. Check your point coordinates. They should approximate those in the following table:
13. If your coordinates do not approximate (within two pixels) those listed in step 12 above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

**Set Automatic (x, y) Drive Function**

LPS Project Manager provides an automatic function to enable you to select ground control points more rapidly. Next, you are going to activate the Automatic (x, y) Drive function. This function is only available after the first two points have been collected.

1. Click the Automatic (x, y) Drive icon. 

The icon changes to .

This icon allows LPS Project Manager to approximate the position of a GCP in the block image file, spot_pan, based on the position in the reference image, xs_ortho.

**Collect Point ID 3**

![Image chip from xs_ortho](image1.png) ![Image chip from spot_pan](image2.png)

**Figure 53: Location of Point ID 3**

1. Click the Add button in the Point Measurement tool.

A row for **Point ID 3** is added to the reference CellArray.

2. Using the following table, type the **X Reference** and **Y Reference** coordinates for the third control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>5191.590</td>
<td>4969.546</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>501918.953</td>
<td>3732595.411</td>
</tr>
</tbody>
</table>
LPS Project Manager adjusts the reference image in the views and places the control point at the coordinates you specify.

Because the Automatic (x, y) Drive icon is enabled, LPS Project Manager moves \textit{spot\_pan} to the same approximate area in the views. The placement improves with subsequent points.

3. Check Figure 53. Then, click the Select Point icon \textbf{-}, and move the Link Cursor until you can see the location of the point in \textit{spot\_pan}.

4. Click the Create Point icon \textbf{+} in the Point Measurement tool palette.

5. Move the cursor into the Detail View containing \textit{spot\_pan} and click the intersection.

6. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>230.925</td>
<td>5378.823</td>
</tr>
</tbody>
</table>

7. If your coordinates do not approximate (within two pixels) those listed in \textbf{step 6.} above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

**Collect Point ID 4**

**Figure 54: Location of Point ID 4**

\begin{itemize}
\item \textit{Image chip from xs\_ortho}
\item \textit{Image chip from spot\_pan}
\end{itemize}

1. Click the \textbf{Add} button in the Point Measurement tool.

2. Using the following table, type the \textbf{X Reference} and \textbf{Y Reference} coordinates for the fourth control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>515114.084</td>
<td>3759740.576</td>
</tr>
</tbody>
</table>
3. Check Figure 54. Then, click the Create Point icon in the Point Measurement tool palette.

4. Move the cursor into the Detail View containing spot_pan, and click the intersection.

5. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>869.542</td>
<td>2487.996</td>
</tr>
</tbody>
</table>

6. If your coordinates do not approximate (within two pixels) those listed in step 5. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

**Collect Point ID 5**

1. Click the **Add** button in the Point Measurement tool.

2. Using the following table, type the **X Reference** and **Y Reference** coordinates for the fifth control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>543537.306</td>
<td>3779981.255</td>
</tr>
</tbody>
</table>

3. Check Figure 55. Then, click the Create Point icon in the Point Measurement tool palette.

4. Move the cursor into the Detail View containing spot_pan, and click the intersection.

5. Check your point coordinates. They should approximate those in the following table:
If your coordinates do not approximate (within two pixels) those listed in step 5. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

### Collect Point ID 6

1. Click the **Add** button in the Point Measurement tool.
2. Using the following table, type the **X Reference** and **Y Reference** coordinates for the sixth control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>558640.300</td>
<td>3751516.718</td>
</tr>
</tbody>
</table>

3. Check Figure 56. Then, click the Create Point icon in the Point Measurement tool palette.
4. Move the cursor into the Detail View containing **spot_pan**, and click the intersection.
5. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>4999.412</td>
<td>2636.848</td>
</tr>
</tbody>
</table>

6. If your coordinates do not approximate (within two pixels) those listed in step 5. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.
Collect Point ID 7

1. Click the Add button in the Point Measurement tool.

2. Using the following table, type the X Reference and Y Reference coordinates for the seventh control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>532062.982</td>
<td>3724946.633</td>
</tr>
</tbody>
</table>

3. Check Figure 57. Then, click the Create Point icon in the Point Measurement tool palette.

4. Move the cursor into the Detail View containing spot_pan, and click the intersection.

5. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>3064.254</td>
<td>5673.794</td>
</tr>
</tbody>
</table>

6. If your coordinates do not approximate (within two pixels) those listed in step 5. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.
1. Click the **Add** button in the Point Measurement tool.

2. Using the following table, type the **X Reference** and **Y Reference** coordinates for the eighth control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>539381.670</td>
<td>3768419.388</td>
</tr>
</tbody>
</table>

3. Check **Figure 58**. Then, click the Create Point icon in the Point Measurement tool palette.

4. Move the cursor into the Detail View containing **spot_pan**, and click the intersection.

5. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>2890.880</td>
<td>1258.852</td>
</tr>
</tbody>
</table>

6. If your coordinates do not approximate (within two pixels) those listed in **step 5.** above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.
Collect Point ID 9

1. Click the **Add** button in the Point Measurement tool.

2. Using the following table, type the **X Reference** and **Y Reference** coordinates for the ninth control point into the reference CellArray.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>526013.661</td>
<td>3753709.856</td>
</tr>
</tbody>
</table>

3. Check **Figure 59**. Then, click the Create Point icon in the Point Measurement tool palette.

4. Move the cursor into the Detail View containing **spot_pan**, and click the intersection.

5. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>1978.138</td>
<td>2919.004</td>
</tr>
</tbody>
</table>

6. If your coordinates do not approximate (within two pixels) those listed in step 5. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

7. Click the **Save** button to save your points.

Collect the Last Two Control Points

The last two control points, **Point ID 11** and **Point ID 12**, use a different horizontal reference source than the previous control points. For them, you are going to use an image called **NAPP_2m-ortho.img**. This is an orthoimage of 1:40,000 scale photography with a 2-meter resolution.
Set the Horizontal Reference

1. In the Point Measurement tool palette, click the Horizontal Reference Source icon.

The GCP Reference Source dialog opens.

2. In the GCP Reference Source dialog, click the Image Layer radio button.

3. Click OK in the GCP Reference Source dialog.

The Reference Image Layer dialog opens.

4. Navigate to /examples/LPS/spot and select the file NAPP_2m-ortho.img.

5. Click OK in the Reference Image Layer dialog.
The Reference Image Layer dialog closes, and you are returned to the Point Measurement tool. The file, NAPP_2m-ortho, is automatically loaded into the Left View.

The new reference image is added to the Left View

Collect Point ID 11

To make the distinction between two different horizontal reference sources (xs_ortho and NAPP_2m-ortho) more clear, skip Point ID 10, and name the next control point Point ID 11.
1. Click the **Add** button in the Point Measurement tool.

2. Click in the **Point ID** column for **Point # 10**, and type 11.

   **Point ID 11** is the first of the points you collect from **NAPP_2m-ortho**.

3. Using the following table, type the **X Reference** and **Y Reference** coordinates for the next control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>545372.750</td>
<td>3741643.250</td>
</tr>
</tbody>
</table>

The control point is placed in the views displaying **NAPP_2m-ortho**.

4. Click the Create Point icon in the Point Measurement tool palette.
5. Move the cursor into the Detail View containing **spot_pan** and click the intersection.

6. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>3982.969</td>
<td>3817.813</td>
</tr>
</tbody>
</table>

7. If your coordinates do not approximate (within two pixels) those listed in **step 6.** above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

**Collect Point ID 12**

**Figure 61: Location of Point ID 12**

1. Click the **Add** button in the Point Measurement tool.

   Note that the **Point ID** column identifies the new point as **12**.
2. Using the following table, type the **X Reference** and **Y Reference** coordinates for the control point into the reference CellArray, then press Enter on your keyboard.

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X Reference</th>
<th>Y Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>540901.659</td>
<td>3746876.633</td>
</tr>
</tbody>
</table>

3. Click the Create Point icon 🕒 in the Point Measurement tool palette.

4. Move the cursor into the Detail View containing **spot_pan**, and click the intersection.

5. Check your point coordinates. They should approximate those in the following table:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_pan</td>
<td>3469.092</td>
<td>3367.939</td>
</tr>
</tbody>
</table>

6. If your coordinates do not approximate (within two) pixels those listed in step 5. above, type the correct coordinates in the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

7. In the Point Measurement tool, click **Save** to save your work to this point.

8. In the Point Measurement tool palette, click to deselect the **Use Viewer As Reference** checkbox.

   The reference file **NAPP_2m-ortho** closes, and **spot_pan** displays alone.
Set the Vertical Reference Source

To provide Z (elevation) values for all of the reference control points you selected in the reference images, `xs_ortho` and `NAPP_2m-ortho`, you are going to specify a DEM that contains height information, `palm_springs_dem.img`.

1. Click the Vertical Reference Source icon.

The Vertical Reference Source dialog opens, in which you select the DEM that is going to supply height information.

- Click the DEM radio button.
- Select a specific DEM file.
- Click OK.
The DEM must be in the same projection as that of the block file. If it is not, you can use the ERDAS IMAGINE reproject utility to put it in the correct projection. Select Image Interpreter -> Utilities -> Reproject Images, and enter the correct information in the dialog. You can then use the new DEM as a vertical reference source.

2. Click the DEM radio button.

3. Click the dropdown arrow and select Find DEM from the list.

4. In the Add DEM File Name dialog, navigate to /examples/LPS/spot and select the DEM palm_springs_dem.img.

5. Click OK in the File Selector.

   The DEM file you selected displays in the DEM section of the Vertical Reference Source dialog.


7. Right-click in the Point # column of the reference CellArray to access the Row Selection menu and select Select All.

8. Click on the Update Z Values on Selected Points icon.

   The Z Values of all the reference points are updated in the reference CellArray based on the values in the DEM you selected, palm_springs_dem.

9. Right-click in the Point # column and choose Select None.
Another function of LPS is the automatic Z value update. Before you even begin choosing control points, you can set a vertical reference source, then click the Automatic Z Value icon in the Point Measurement tool palette. The icon then changes to , indicating that the Z value is updated automatically each time you choose a point.

Set Type and Usage

Up until this point, the Type and Usage for each of the control points has been set to None and Tie, respectively. Follow the next series of steps for a quick application of new classes of Type and Usage with the Formula dialog in ERDAS IMAGINE.

For more information about the Formula dialog, see the On-Line Help.

1. Left-click the title bar of the column titled Type to select all of the column, which is highlighted in blue.

2. Right-click on Type to access the Column Options menu, then select Formula.

The Formula dialog opens.

3. In the Formula section of the Formula dialog, type Full.

4. Click Apply in the Formula dialog.

Each Type entry changes to indicate Full (X, Y, and Z coordinates).
5. Left-click in the column titled **Usage** to select all of the column, which is highlighted in blue.

6. In the **Formula** section of the Formula dialog, type **Control** (remove **Full**).

7. Click **Apply** in the Formula dialog.

   Each **Usage** entry changes to indicate **Control**.

8. Click **Close** in the Formula dialog.

9. Right-click in the **Usage** column to access the **Column Options** menu, then choose **Select None**.

When you are finished, your CellArray should look like the following (with the exception of the **Color** column).

All of the Point IDs have the correct Type and Usage description now

---

**Another way of assigning the same Type and Usage designations to all points is to right-click in the Point # column and choose Select All. Then, click the title of the Type or Usage column. Right-click, then select the designation you want for the points.**

---

**Save the Block File**

At this time, you should save the block file to preserve your work.

1. In the Point Measurement tool, click the **Save** button.

2. Click the **Close** button on the Point Measurement tool.

   You are returned to the LPS Project Manager.

**Add a Second Image to the Block**

Now that you have successfully collected reference coordinates in the reference images, **xs_ortho** and **NAPP_2m_ortho**, and file coordinates in the first block file, **spot_pan**, you can progress to the second image in the block, **spot_panb**.
1. Select **Edit -> Add Frame** from the LPS menu bar, or click the Add Frame icon.

   The Image File Name dialog opens.

2. Navigate to /examples/LPS/spot, select **spot_panB.img**, then click **OK**.

   The image is loaded into the LPS Project Manager and displays in the CellArray.

---

### Generate Pyramid Layers

Like the first image in the block file, you are going to create pyramid layers for **spot_panb** to make it display more quickly in the views.

1. Click **Row #2** to highlight the row corresponding to **Image ID 2, spot_panb**.

2. Click in the red column labeled **Pyr.** for the **spot_panb** image.

   The Compute Pyramid Layers dialog displays.

3. Click the **One Image Selected** radio button.

4. Click **OK** in the Compute Pyramid Layers dialog.

   A status bar displays at the bottom of the LPS Project Manager, indicating the progress of pyramid layer creation. When complete, the **Pyr.** column for **spot_panb** is green, indicating that pyramid layers are present for this image.

---

### Define the Sensor Model

Next, you are going to provide LPS Project Manager the parameters of the sensor, in this case a SPOT pushbroom sensor, that supplied the image you are working with.
1. Select **Edit -> Frame Editor** from the LPS Project Manager menu bar, or click the Frame Properties icon ![Frame Properties Icon](image).

The SPOT Pushbroom Frame Editor dialog opens, displaying information about the currently selected image (>) listed in the CellArray, **spot_panb**.

2. Click **OK** in the SPOT Pushbroom Frame Editor to accept the parameters.

   The **Int.** column in the LPS Project Manager CellArray becomes green. Remember, the header file of the image contains the necessary orientation information.

### Start the Point Measurement Tool

Now, you are going to open the Point Measurement tool so that you can locate the points you collected in the first image in the block, **spot_pan**, in the second image, **spot_panb**.

1. In the LPS Project Manager, click the Point Measurement icon ![Point Measurement Icon](image).

   **NOTE:** You may be prompted to select either the Classic Point Measurement Tool or the Stereo Point Measurement Tool. Use the Classic Point Measurement Tool for this exercise.

   The Point Measurement tool opens, displaying views, a Point Measurement tool palette, and two CellArrays: one for recording reference coordinates, and one for recording file coordinates. The image in which you are going to collect points, **spot_panb**, is in the **Right View**; the image **spot_pan** is in the **Left View**.
Collect Ground Control Points

Collect GCPs in `spot_panb` based on those you have already collected in `spot_pan`. In this portion of the tour guide, you are provided X File and Y File coordinates to speed the GCP collection process. However, if you would rather visually select the GCPs in `spot_panb`, we encourage you to do so.

Collect Point ID 1

1. In the reference CellArray, click on Point #1 to highlight the row.

   The image `spot_pan` automatically changes position to show Point ID 1.

2. Move the Link Cursor in the views displaying `spot_panb` until you can see the location of Point ID 1.

3. Click the Create Point icon in the Point Measurement tool palette.

Use the locations of the points in `spot_pan` to place the same points in `spot_panb`
4. Click the approximate point in the Detail View of spot_panb, displayed in the Right View.

A point is placed in the Detail View and labeled 1.

5. Check your results against the following table. If your results are not within two pixels, type the X File and Y File coordinates for the point in spot_panb into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>2857.270</td>
<td>753.852</td>
</tr>
</tbody>
</table>

⚠️ Make sure you enter X File and Y File coordinates on the appropriate row. The row corresponding to spot_panb is the second row in the file CellArray.

Collect Point ID 2

1. In the reference CellArray, click on Point #2 to highlight the row.

2. Move the Link Cursor as necessary in the views displaying spot_panb.

3. Click the Create Point icon in the Point Measurement tool palette.

4. Click the approximate point in the Detail View of spot_panb.

5. Check your results against the following table. If your results are not within two pixels, type the X File and Y File coordinates for the point in spot_panb into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>3003.782</td>
<td>5387.892</td>
</tr>
</tbody>
</table>

Next, you collect Point ID 5 in spot_panb. Point IDs 3 and 4 are not located on spot_panb.

Collect Point ID 5

1. In the reference CellArray, click on Point #5 to highlight the row.

2. Move the Link Cursor as necessary in the views displaying spot_panb.
3. Click the Create Point icon in the Point Measurement tool palette.

4. Click the approximate point in the Detail View of spot_panb.

5. Check your results against the following table. If your results are not within two pixels, type the X File and Y File coordinates for the point in spot_panb into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>1022.701</td>
<td>644.456</td>
</tr>
</tbody>
</table>

Collect Point ID 6

1. In the reference CellArray, click on Point #6 to highlight the row.

   Note that, because the Automatic (x, y) Drive function is still enabled, LPS locates the position of Point ID 6 for you. This occurs after three points (in this case, 1, 2, and 5) have already been identified in the images.

2. Click the Create Point icon in the Point Measurement tool palette.

3. Click the approximate point in the Detail View of spot_panb.

4. Check your results against the following table. If your results are not within two pixels, type the X File and Y File coordinates for the point in spot_panb into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>2736.125</td>
<td>3070.227</td>
</tr>
</tbody>
</table>

Next, you are going to collect Point ID 8 in spot_panb. Point ID 7 is not located in spot_panb.

Collect Point ID 8

1. In the reference CellArray, click on Point #8 to highlight the row.

2. Click the Create Point icon in the Point Measurement tool palette.

3. Click the approximate point in the Detail View of spot_panb.
4. Check your results against the following table. If your results are not within two pixels, type the **X File** and **Y File** coordinates for the point in **spot_panb** into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>937.482</td>
<td>1862.696</td>
</tr>
</tbody>
</table>

**Collect Point ID 9**

1. In the reference CellArray, click on **Point #9** to highlight the row.

2. Click the Create Point icon in the Point Measurement tool palette.

3. Click the approximate point in the Detail View of **spot_panb**.

4. Check your results against the following table. If your results are not within two pixels, type the **X File** and **Y File** coordinates for the point in **spot_panb** into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>221.445</td>
<td>3594.113</td>
</tr>
</tbody>
</table>

Next, you are going to collect **Point ID 12** in **spot_panb**.

**Collect Point ID 12**

1. In the reference CellArray, click on **Point #11**, which corresponds to **Point ID 12**, to highlight the row.

2. Click the Create Point icon in the Point Measurement tool palette.

3. Click the approximate point in the Detail View of **spot_panb**.

4. Check your results against the following table. If your results are not within two pixels, type the **X File** and **Y File** coordinates for the point in **spot_panb** into the file CellArray, then press Enter on your keyboard. The point changes location accordingly.

<table>
<thead>
<tr>
<th>Image Name</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>spot_panb</td>
<td>1499.230</td>
<td>3923.753</td>
</tr>
</tbody>
</table>
5. Right-click in the **Point #** column and choose **Select None**.

6. In the Point Measurement tool, click the **Save** button.

---

**Perform Automatic Tie Point Collection**

The tie point collection process measures the image coordinate positions of ground points appearing on the overlapping area of the two SPOT images: *spot_pan* and *spot_panb*.

1. In the Point Measurement tool palette, click the Automatic Tie Point Collection Properties icon.

   The Automatic Tie Point Generation Properties dialog opens on the **General** tab.
2. Check to confirm that the **Images Used** radio button is set to **All Available**.

3. Check to confirm that the **Initial Type** radio button is set to **Exterior/Header/GCP**.

4. Check to confirm that the **Image Layer Used for Computation** is set to **1**.

5. Click the **Distribution** tab in the Automatic Tie Point Generation Properties dialog.

6. Click in the **Intended Number of Points Per Image** field and type **40**, then press Enter.

7. Check to confirm that the **Keep All Points** checkbox is not checked. When this option is not selected, poor tie points are discarded.

8. Click the **Run** button in the Automatic Tie Point Generation Properties dialog.

   LPS starts the automatic tie point generation process, indicated by a progress meter at the bottom of the Point Measurement tool, and displays the tie points in the Point Measurement views when complete. The tie points have the **Type** designation **None**, and the **Usage** designation **Tie**. They are added to the reference CellArray with their corresponding **X File** and **Y File** values in the file CellArray.
Check Tie Point Accuracy

You should always check a few of the tie points to ensure accuracy. If a point is not as accurate as you would like, you can adjust it using the Select Point tool. Alternately, you can delete it by selecting the row in the reference CellArray and clicking the Delete button in the Point Measurement tool. You can also make it inactive by clicking in the Active column to remove the X.

1. In the reference CellArray, click the scroll bar and scroll to a point, such as Point ID 35.

2. Click in the > column to select Point ID 35.

The point displays in the views. This is an acceptable tie point.

3. Click in the > column of other Point IDs to see where LPS placed tie points.

4. When you are finished, click the Save button in the Point Measurement tool.
5. Click the **Close** button to close the Point Measurement tool. You are returned to the LPS Project Manager.

**Perform Triangulation**

Now that you have obtained control and tie points, LPS has all the information it needs to perform triangulation. This step establishes the mathematical relationship between the images that make up the block file, the sensor model, and the ground.

1. From the **Edit** menu of the LPS Project Manager, select **Triangulation Properties**.

The Triangulation dialog opens.

2. Change the **Iterations With Relaxation** value to 3.

3. Confirm that the **Image Coordinate Units for Report** is set to **Pixels**.

4. Click the **Point** tab in the Triangulation dialog.

   The **Point** options display. These control the GCP parameters.
5. In the **Ground Point Type and Standard Deviations** section, click the **Type** dropdown list and select **Same Weighted Values**.

6. Click in the **X**, **Y**, and **Z** number fields, and change each of the values to **15**.

   The value **15** is used because the resolution of the SPOT image, **xs_spot**, that you used as reference for **Point IDs 1 through 9** has 20-meter pixels. This value assures that the GCPs are accurate to approximately 15 meters.

7. Click the **Advanced Options** tab.

8. Confirm that the **Simple Gross Error Check Using** checkbox is enabled. The default value of **3.0 Times of Unit Weight** is acceptable.

9. Click the **Run** button to run the triangulation.

   A Triangulation Summary report opens.
10. In the Triangulation Summary dialog, click the **Report** button.

The report opens in a separate window. You can save this report as you would any text file, then refer to it as needed.

The Triangulation Report displays in a text editor

11. Resize the window and scroll through the report to see the information it contains.
For more information about the Triangulation Report, see Block Triangulation.

12. When you are finished viewing the report, select **File -> Close**.

13. Click the **Accept** button in the Triangulation Summary dialog to accept the results.

14. Click the **OK** button in the Triangulation dialog.

You are returned to the LPS Project Manager. Notice that the **Ext.** columns in the CellArray are now green, indicating that the exterior orientation information has been supplied.

15. In the LPS Project Manager, click the **File** menu and select **Save**.
Ortho Resample the Imagery

The next step creates orthorectified images wherein relief displacements and geometric errors have been adjusted and accuracy has been improved. The orthorectified images display objects in their real-world X and Y positions.

1. In the LPS Project Manager, click the Ortho Resampling icon.

The Ortho Resampling dialog opens.

1. In the General tab, click the DTM Source dropdown list and select DEM.

2. Click the DEM File Name dropdown list, and choose Find DEM.

3. If necessary, select the DEM from the /LPS/spot folder, then click OK in the File Selector.

4. Click in the Output Cell Sizes fields for both X and Y, and type 10.0.

5. Click the Advanced tab of the Ortho Resampling dialog.

6. Confirm that the Resampling Method is Bilinear Interpolation.

7. Click the Add button on the Advanced tab.
The Add Single Output dialog opens.

![Add Single Output dialog]

The Input File Name identifies the other image in the block file, `spot_pan.img`. It also automatically attaches the prefix ortho to the output file.

8. Click the checkbox next to Use Current Cell Sizes.

9. Click OK in the Add Single Output dialog.

The second image in the block file, and its corresponding orthoimage, is added to the Ortho Resampling dialog CellArray. It has the same parameters as the first image. You may use the scroll bar at the bottom of the dialog to confirm that all information is correct before proceeding to resampling.

![Ortho Resampling dialog]

The images display in the CellArray. Use the scroll bar to see all the parameters.
10. Click **OK** in the Ortho Resampling dialog to start the process.

A Status dialog opens, tracking the progress.

11. Once the status dialog shows that the process is 100% complete, click **OK** in the dialog.

**View the Orthoimages**

Now you can check how the orthoimages fit together in the LPS Project Graphic Status window and in a Viewer.

**Use LPS**

1. In the LPS Project Manager, click the plus sign \[+\] next to the **Orthos** folder in the Block Project Tree View.

2. Click on one of the orthos in the list to highlight it in the Block Tree View, CellArray, and the Project Graphic Status window.
To see the actual orthoimage, not just a graphical representation, you can use a Viewer. You can get details about the control and tie points displayed in the Project Graphic Status window by clicking on them with the Selector icon.

**Use a Viewer**

1. Right-click on the first ortho, `orthospot_panb.img`, and select **View** from the **Ortho** quick view menu.

2. Right-click inside the Viewer and select **Fit Image to Window** from the **Quick View** menu.

3. Select **File -> Open -> Raster Layer** and navigate to the location of the orthos.
4. Select `orthospot_pan.img`, then click the **Raster Options** tab.

5. In the **Raster Options** tab, make sure that **Clear Display** is not selected.

6. Select **Fit to Frame** and **Background Transparent** if they are not selected.

7. Click the **Multiple** tab and make sure that the radio button next to **Multiple Independent Files** is selected.

8. Click **OK** in the Select Layer to Add dialog.

The overlapped orthoimages display in the Viewer.

---

**Magnify Areas of Overlap**

Now, you can check the areas of overlap to see how well LPS Project Manager orthorectified the images. Take special note of features such as roads, rivers, and parcels of land.

1. In the Viewer, click the **Zoom In** icon 🕵️‍♂️.

2. Click on an area in the Viewer where the images obviously overlap.
3. Apply the Zoom In icon as many times as necessary to see the portion of overlap clearly in the Viewer.

You can see that LPS Project Manager successfully overlapped the images in the following picture. Geographic features of interest are well matched.

If you wish, you can click the View menu, then select Arrange Layers. You may change the order of the images’ display in the Viewer to see how they look with the Swipe utility.

**Use the Swipe Utility**

You can also use the Swipe utility to see how well the images overlap.

1. Click the Utility menu on the Viewer menu bar.
2. Choose Swipe.

The Viewer Swipe dialog opens.
3. Right-click in the Viewer to access the **Quick View** menu.

4. Click **Fit Image To Window**.

5. Click the slider bar in the Viewer Swipe dialog and move it to the left and right to see how well the top image, `orthospot_panb.img` overlaps the bottom image, `orthospot_pan.img`.

   *If you wish, you can click the View menu, then select **Arrange Layers**. You can change the order of the images' display in the Viewer to see how they look with the Swipe utility.*

6. When you are finished, click **Cancel** in the Viewer Swipe dialog.

7. When you are finished viewing the images, select **File -> Close** from the Viewer menu bar.

**Save and Close the Block File**

1. In the LPS Project Manager, click the **File** menu, then select **Save**.

   Notice that all of the columns are green (with the exception of the DTM column, which is specific to LPS Automatic Terrain Extraction), indicating that all of the process steps have been executed. You can open the complete block file any time.
2. From the **File** menu, select **Exit**.

3. To close ERDAS IMAGINE, select **Session -> Exit IMAGINE**.

**Conclusions**

As you have learned, you can easily select control points from images outside the block file. Points can be horizontal or vertical and come from many sources, including a reference image.

Next, you can learn about the DTM extraction capability of LPS. It is an automatic terrain extraction program designed to produce DTMs in various formats.
This section describes the data used in this chapter.

**Project Location**
Palm Springs, California, USA

**Imagery**
Image 1: spot_pan.img (35.5 MB), SPOT Panchromatic scene with 10-meter ground resolution

Image 2: spot_panB.img (35.5 MB), SPOT Panchromatic scene with 10-meter ground resolution

*NOTE: This image is named spot_panb.img (i.e., the "B" becomes lowercase) in the Windows environment.*

Image 3: xs_ortho.img (50.4 MB), SPOT orthorectified image with 20-meter ground resolution

Image 4: NAPP_2m-ortho.img (33.2 MB), NAPP orthorectified image with 2-meter ground resolution

*NOTE: The xs_ortho.img and NAPP_2m-ortho.img files are used as reference sources for collecting GCPs.*

**DEM**
palm_springs_dem.img with 75-meter ground resolution in X and Y

**Projection**
UTM

**Spheroid**
Clarke 1866

**Zone Number**
11

**Datum**
NAD27 (CONUS)

**Horizontal Units**
Meters

**Vertical Units**
Meters

**Sensor Information**

**spot_pan.img**

Side Incidence (degrees) = 16.8

Focal Length = 1082.0 mm

Pixel Size = 0.013 mm

Sensor Columns = 6000
spot_panB.img

Side Incidence (degrees) = -30.0

Focal Length = 1082.0 mm

Pixel Size = 0.013 mm

Sensor Columns = 6000

GCP Map Coordinates

GCPs are accurate to 15.0 meters (standard deviation) in the X, Y, and Z direction. The following table details the positions of the GCPs in map coordinates.

Table 4: GCP Map Coordinates

<table>
<thead>
<tr>
<th>Pt. ID</th>
<th>Map X</th>
<th>Map Y</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>566189.190</td>
<td>3773586.979</td>
<td>996.200</td>
</tr>
<tr>
<td>2</td>
<td>555690.659</td>
<td>3728387.770</td>
<td>229.080</td>
</tr>
<tr>
<td>3</td>
<td>501918.953</td>
<td>3732595.411</td>
<td>484.000</td>
</tr>
<tr>
<td>4</td>
<td>515114.084</td>
<td>3759740.576</td>
<td>1022.972</td>
</tr>
<tr>
<td>5</td>
<td>543537.306</td>
<td>3779981.255</td>
<td>1318.440</td>
</tr>
<tr>
<td>6</td>
<td>558640.300</td>
<td>3751516.718</td>
<td>325.973</td>
</tr>
<tr>
<td>7</td>
<td>532062.982</td>
<td>3724946.633</td>
<td>1331.120</td>
</tr>
<tr>
<td>8</td>
<td>539381.670</td>
<td>3768419.388</td>
<td>765.880</td>
</tr>
<tr>
<td>9</td>
<td>526013.661</td>
<td>3753709.856</td>
<td>427.760</td>
</tr>
<tr>
<td>11</td>
<td>545372.750</td>
<td>3741643.250</td>
<td>122.000</td>
</tr>
<tr>
<td>12</td>
<td>540901.659</td>
<td>3746876.633</td>
<td>224.000</td>
</tr>
</tbody>
</table>

GCP Pixel Coordinates

The following table details the image coordinate positions of the GCPs in pixels.

Table 5: GCP Pixel Coordinates

<table>
<thead>
<tr>
<th>Control Point</th>
<th>Images</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>spot_pan</td>
<td>5239.468</td>
<td>337.384</td>
</tr>
<tr>
<td></td>
<td>spot_panB</td>
<td>2857.270</td>
<td>753.852</td>
</tr>
<tr>
<td>2</td>
<td>spot_pan</td>
<td>5191.590</td>
<td>4969.546</td>
</tr>
</tbody>
</table>
### Table 5: GCP Pixel Coordinates (Continued)

<table>
<thead>
<tr>
<th>Control Point</th>
<th>Images</th>
<th>X File</th>
<th>Y File</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>spot_panB</td>
<td>3003.782</td>
<td>5387.892</td>
</tr>
<tr>
<td>3</td>
<td>spot_pan</td>
<td>230.925</td>
<td>5378.823</td>
</tr>
<tr>
<td>4</td>
<td>spot_pan</td>
<td>869.542</td>
<td>2487.996</td>
</tr>
<tr>
<td>5</td>
<td>spot_pan</td>
<td>3027.570</td>
<td>51.432</td>
</tr>
<tr>
<td></td>
<td>spot_panB</td>
<td>1022.701</td>
<td>644.456</td>
</tr>
<tr>
<td></td>
<td>spot_panB</td>
<td>2736.125</td>
<td>3070.227</td>
</tr>
<tr>
<td>7</td>
<td>spot_pan</td>
<td>3064.254</td>
<td>5673.794</td>
</tr>
<tr>
<td>8</td>
<td>spot_pan</td>
<td>2890.880</td>
<td>1258.852</td>
</tr>
<tr>
<td></td>
<td>spot_panB</td>
<td>937.482</td>
<td>1862.696</td>
</tr>
<tr>
<td>9</td>
<td>spot_pan</td>
<td>1978.138</td>
<td>2919.004</td>
</tr>
<tr>
<td></td>
<td>spot_panB</td>
<td>221.445</td>
<td>3594.113</td>
</tr>
<tr>
<td>11</td>
<td>spot_pan</td>
<td>3982.969</td>
<td>3817.813</td>
</tr>
<tr>
<td>12</td>
<td>spot_pan</td>
<td>3469.092</td>
<td>3367.939</td>
</tr>
<tr>
<td></td>
<td>spot_panB</td>
<td>1499.230</td>
<td>3923.753</td>
</tr>
</tbody>
</table>
Stereo Point Measurement Tool Tour Guide

Introduction

When you collect points from the images in a block file, you may select from the Classic Point Measurement Tool—as you have practiced in the previous tour guides—or you may use the Stereo Point Measurement Tool. This tour guide takes you through the process of collecting check points using the utilities provided by the Stereo Point Measurement Tool.

You may set a preference if you prefer to work with one or the other measurement tool consistently. Select the LPS category in the Preference Editor. Scroll to the bottom of the list and make your selection in the Point Measurement Tool section: Always Ask, Classic Point Measurement Tool, or Stereo Point Measurement Tool.

There is also a preference category specific to the Stereo Point Measurement Tool, LPS - Stereo Point Measurement. You may want to look at the settings in that category to see if the defaults are acceptable for your own standard workflow.

Before You Begin

The data used in this tour guide covers the campus of The University of Western Ontario in London, Ontario, Canada. The photographs were captured at a photographic scale of 1:6000, and scanned at a resolution of 25 microns. The resulting ground coverage is 0.15 meters per pixel.

Approximate completion time for this tour guide is 20 minutes.

In this tour guide, you are going to perform the following basic steps:

• Save the example block file as my_western_spmt.blk.

• Set up the system mouse as a digitizing device.

• Collect and save five points.

Open a Project

In this section of the tour guide, you prepare your own block file.

1. Click the LPS icon to open the LPS Project Manager workspace.
2. Click the Open icon , then navigate to the \<IMAGINE_HOME>\examples\western folder.

3. Select the file named western_spmt.blk, then click OK in the file selector.

4. Select File -> Save As to open the Save Block File As dialog.

5. Click in the File name window, then type my_western_spmt.blk. Click OK in the dialog. You will be working with this block file instead of the original one.

6. Click the Start Point Measurement Tool icon , or choose Edit -> Point Measurement... from the LPS Project Manager menu bar.

7. If you are prompted to select which version of the point measurement tool you want to use, select the radio button for Stereo Point Measurement Tool, then click OK.
If you are not prompted and the Classic Point Measurement Tool starts instead, check the preference setting in the LPS category called Point Measurement Tool. Set it to either Always Ask or Stereo Point Measurement Tool. Exit LPS, then you may restart the program, open the block file, and continue.

8. If the Loading Images Help dialog appears, click OK.

You will load images in the next section of the tour guide.

Whether or not this dialog displays is controlled by a preference in the LPS - Stereo Point Measurement category, named Display Help Dialog.

Image Selection

One of the first tasks you must perform when using the Stereo Point Measurement Tool is selecting which image in your block file will serve as the master image. This block file contains three images; the master image has been identified as 251.img.

1. In the Image Selection tab, located on the right-hand side of the Stereo Point Measurement Tool, check the Master field to confirm that the master image is indeed set to 251.img.
2. Decrease the **Overlap** percentage to **21**, by typing in the field or using the increment nudgers.

3. In the **Load As** section, confirm that the setting is **Mono**.

4. In the Image Selection CellArray, make sure that the second and third images in the block file, **252.img** and **253.img** have an **X** in the **Load** column.

5. Click the **Load** button to display the images in the Stereo Point Measurement Tool.

6. Click the **Image Adjustment** tab, then deselect **Dynamic Range Adjustment**.

7. Click the **Image Selection** tab again.
Check Device Setup

If you have a digitizing device, such as a TopoMouse, you should check the settings for that device before collecting points in the Stereo Point Measurement Tool. Similarly, if you plan to use your system mouse to collect points, you should check the existing button mappings before you begin collecting points.

1. Click the **Devices** button on the right-hand side of the Stereo Point Measurement Tool workspace.

2. In the Devices dialog, select the type of device you will be using to collect points. For this exercise, choose **System Mouse**.
3. Click the **Button Mappings** button to open the System Mouse Button Mapping dialog.

4. Select the **Point Measurement** category on the left side of the dialog.

5. In the **Commands/Buttons** window, select **Create/Edit Point**.

6. In the **Customize Button Assignment** section, click the dropdown list and choose **Left**.

7. Click **Assign** to use the left mouse button to add points in the Stereo Point Measurement Tool.

8. In the **Commands/Buttons** window, select **Correlate Point**.

9. In the **Customize Button Assignment** section, click the dropdown list and choose **Right**.

10. Click **Assign** to use the right mouse button to correlate points in the Stereo Point Measurement Tool.
11. Click **Close** in the System Mouse Button Mapping dialog.

12. Click **Close** in the Devices dialog.

For additional information about setting up digitizing devices, please refer to the On-Line Help: “Device Button Commands.”

**Select Points**

Now that your system mouse is set up to select points, you are ready to begin using the Stereo Point Measurement Tool.

**Point ID 1001**

1. Make sure that the Maintain Scale Factor, Manual Toggle Cursor Mode, Fixed Image Mode, and Automatic View Link icons are all selected in the tool palette.

2. In the Reference CellArray of the Stereo Point Measurement Tool, scroll down to the bottom of the list.

3. Click inside the > field for Point ID **1001** to make it the active point.

Set the right mouse button to correlate option—this makes point selection easier
4. Click on the Drive To icon ☰ to display the location of the point in each of the views.

5. Check the following screen shot to locate the approximate position of the point.

Begin collecting in the master image

Once you collect the point in the master image the software automatically makes the next image in the block file active for collection, and so on through the block file

5. Check the following screen shot to locate the approximate position of the point.
6. Click the Create Point icon \[ \text{\textbullet} \] in the tool palette.

7. Click inside the first view, which displays the master image, 251.img.

8. Press F3 on your keyboard to enter collection mode, then click to place point 1001 in the master image.

   Notice that the next image in the pair, 252.img, becomes active. You can tell which image is the active image because it has white text in the title bar of the view.

9. Right-click to correlate the cursor position with the point you selected in the master image, then click to place point 1001 the same point in the second image.

   When your cursor is in the approximate location of the point selected in the master image, a right-click results in a green cursor, which indicates that the location is accurate. If the cursor is not close enough to the point, a right-click results in a red cursor. In that case, reposition the cursor, and right-click again to find the correlation area. Repeat as necessary.

   Notice that after you select the point in the second image in the block, the final image in the pair becomes active, indicated by the white text in the title bar of the view.

10. Right-click to correlate the cursor position with the point you selected in the master image, then click to place point 1001 in the third image.

11. Once you have placed the point in all the images, press F3 on your keyboard to exit collection mode.

12. Compare your image point X and Y values to those in the following table. If they do not match within two pixels, change the values in the Stereo Point Measurement Tool to match the following:
13. Click the Save button in the Stereo Point Measurement Tool.

**Point ID 1002**

You’ll collect the next two points in stereo.

1. Click the Load As dropdown list and select Full.
2. Click the Load button in the Image Selection tab.
3. Click inside the > field for Point ID 1002 to make it the active point.

4. Click on the Drive To icon to display the location of the point in each of the views.

5. Check the following screen shot to locate the approximate position of the point.

When you select the Full option, you see both stereo and mono views at the same time.
6. Click the Create Point icon in the tool palette.

7. Click inside the view displaying the first image pair, 251.img / 252.img.

8. Press F3 on your keyboard to enter collection mode, then click to place point 1002 in each image in the first image pair.

When you collect points in stereo while the Load As option is set to Full, you may use the mono views below the stereo view to help you position the point in the same location in each image.

Notice that the next image pair, 251.img / 253.img, becomes active. You can tell which pair is the active pair because it has white text in the title bar of the view.
9. Right-click to correlate the cursor position with the point you selected in the master image, then click to place point 1002 in the second image pair, specifically, 253.img—you have already placed the point in 251.img, which accompanies 253.img in the stereo view.

10. Press F3 to exit collection mode.

11. Compare your image point X and Y values to those in the following table. If they do not match within two pixels, change the values in the Stereo Point Measurement Tool to match the following:

<table>
<thead>
<tr>
<th>Image</th>
<th>X File - PID 1002</th>
<th>Y File - PID 1002</th>
</tr>
</thead>
<tbody>
<tr>
<td>251</td>
<td>7401.106</td>
<td>3218.404</td>
</tr>
<tr>
<td>252</td>
<td>3679.477</td>
<td>3090.953</td>
</tr>
<tr>
<td>253</td>
<td>127.491</td>
<td>3101.026</td>
</tr>
</tbody>
</table>

Point ID 1003

1. Click inside the > field for Point ID 1003 to make it the active point.

2. Click on the Drive To icon 🌀 to display the location of the point in each of the views.

3. Check the following screen shot to locate the approximate position of the point.
4. Click the Create Point icon in the tool palette.

5. Click inside the view displaying the first pair, 251.img / 252.img.

6. Press F3 on your keyboard to enter collection mode, then click to place point 1003 in each image in the first image pair.

7. Right-click in the second image of the second image pair, 251.img / 253.img, to correlate the cursor position with the point you selected in the master image, then click to place point 1003 in the third image, 253.img.

8. Press F3 to exit collection mode.

9. Compare your image point X and Y values to those in the following table. If they do not match within two pixels, change the values in the Stereo Point Measurement Tool to match the following:
Point ID 1004

Switch back to mono view to collect the last two points.

1. Click the **Load As** dropdown list and select **Mono**.
2. Click the **Load** button in the **Image Selection** tab.
3. Click inside the > field for Point ID **1004** to make it the active point.
4. Click on the Drive To icon to display the location of the point in each of the views.
5. Check the following screen shot to locate the approximate position of the point.

6. Click the Create Point icon in the tool palette.
7. Click inside the view displaying the master image, **251.img**.
8. Press F3 on your keyboard to enter collection mode, then click to place point **1004** in the master image.
9. Right-click in the second view to correlate the cursor position with the point you selected in the master image, then click to place point **1004** in the second image, **252.img**.
10. Right-click in the third view to correlate the cursor position with the point you selected in the master image, then click to place point 1004 in the third image, 253.img. Then press F3 to exit collection mode.

11. Compare your image point X and Y values to those in the following table. If they do not match within two pixels, change the values in the Stereo Point Measurement Tool to match the following:

<table>
<thead>
<tr>
<th>Image</th>
<th>X File - PID 1004</th>
<th>Y File - PID 1004</th>
</tr>
</thead>
<tbody>
<tr>
<td>251</td>
<td>8579.676</td>
<td>4563.065</td>
</tr>
<tr>
<td>252</td>
<td>4859.108</td>
<td>4435.806</td>
</tr>
<tr>
<td>253</td>
<td>1299.713</td>
<td>4440.873</td>
</tr>
</tbody>
</table>

Point ID 1005

1. Click inside the > field for Point ID 1005 to make it the active point.

2. Click on the Drive To icon to display the location of the point in each of the views.

3. Check the following screen shot to locate the approximate position of the point.

4. Click the Create Point icon in the tool palette.

5. Click inside the view displaying the master image, 251.img.

6. Press F3 on your keyboard to enter collection mode, then click to place point 1005 in the master image.
7. Right-click in the second view to correlate the cursor position with the point you selected in the master image, then click to place point **1005** the same point in the second image, **252.img**.

8. Right-click in the third view to correlate the cursor position with the point you selected in the master image, then click to place point **1005** in the third image, **253.img**. Then press F3 to exit collection mode.

9. Compare your image point X and Y values to those in the following table. If they do not match within two pixels, change the values in the Stereo Point Measurement Tool to match the following:

<table>
<thead>
<tr>
<th>Image</th>
<th>X File - PID 1005</th>
<th>Y File - PID 1005</th>
</tr>
</thead>
<tbody>
<tr>
<td>251</td>
<td>8201.628</td>
<td>4981.529</td>
</tr>
<tr>
<td>252</td>
<td>4516.606</td>
<td>4851.847</td>
</tr>
<tr>
<td>253</td>
<td>990.204</td>
<td>4853.881</td>
</tr>
</tbody>
</table>

10. Click **Save** to save all the image points you have collected.

At this point, your Stereo Point Measurement Tool should look similar to the following:
Next Steps

Next, you may proceed to the last few steps in the photogrammetric workflow, including triangulation, and orthoimage generation if you wish. Otherwise, perform the following steps to save your work and close the Stereo Point Measurement Tool.

Please refer to Perform Aerial Triangulation on page 125 and Ortho Resample the Imagery on page 131 in the Frame Camera Tour Guide for additional information.

1. **Click Close** on the Stereo Point Measurement Tool.

Each check point now has image coordinates in addition to reference coordinates.
2. Click the Save icon to keep the changes you made to my_western_spmt.blk.

3. Select File -> Exit from the LPS Project Manager menu bar.

For more information about the Stereo Point Measurement Tool, please refer to the On-Line Help.
Practical Applications
Introduction

The chapters in this section give a detailed description of LPS Project Manager and the photogrammetric concepts used within the software to bridge the fundamental concepts of photogrammetry, and the practical tools of LPS Project Manager. Additional tips and tricks are provided to increase the production associated with block triangulation and orthorectification.

What is a Block?

Prior to performing any photogrammetric tasks within LPS Project Manager, a block must be created. Block is a term used to describe and characterize all of the information associated with a photogrammetric mapping project, including:

- projection, spheroid, and datum information,
- imagery used within a project,
- camera or sensor model information associated with the imagery,
- GCPs and their measured image positions, and
- geometric relationships between the imagery in a project and the ground.

LPS Project Manager supports the processing of various types of blocks, including:

- A block containing one image for applications associated with single frame orthorectification. Single frame orthorectification is the process of orthorectifying one image using several GCPs and an elevation model. The GCPs are used to determine camera/sensor orientation, and the DEM is used to represent topographic relief. Both factors being considered, the geometric distortions associated with an image can be removed.

- A block containing a strip of imagery (see Figure 62). A strip of imagery comprises two or more images adjacent to one another containing common overlap areas. Typically, adjacent images or photographs contain approximately 60% overlap.
A block containing several strips of imagery (see Figure 63). Adjacent strips of imagery commonly contain 20% to 30% sidelap. It is also common for adjacent strips to contain 60% sidelap, since this type of block configuration can provide greater accuracy and reliability during aerial triangulation. Additionally, LPS Project Manager can accommodate cross-strips.

LPS Project Manager provides a linear workflow for the creation of a block. The following steps are required to create the block:

- define a project name,
- define the sensor model,
- define the reference coordinate system,
- define the units,
- define the mapping sensor rotation systems,
- define the characteristics of the imagery (for example, aerial or ground-based), and
- import the exterior orientation information, which is the position and orientation of the camera/sensor at the time of exposure.
Once you click the LPS icon within the ERDAS IMAGINE icon bar, the linear workflow associated with creating a block is enabled. The first dialog is depicted in Figure 64.

Figure 64: The LPS Project Manager Dialog
You can create a new LPS Project Manager project by choosing File -> New, or open an existing LPS Project Manager project, by choosing File -> Open, from this dialog. In either case, you work with a block file (*.blk). The block file is a binary file containing all of the information associated with a block. Select the View IMAGINE HFA File Structure option within the ERDAS IMAGINE Tools menu to view the contents of the binary file.

In an existing block file is open, laguna.blk (which is located in the examples that come with LPS). If you open an existing block file, the LPS Project Manager’s CellArray is populated with information about the images contained in the block, as in Figure 65.

For information about height extraction, which is indicated by the DTM column in the LPS Project Manager CellArray, see LPS Automatic Terrain Extraction Tour Guide.

Geometric Model

LPS Project Manager supports the orthorectification of photography and imagery from various camera and satellite sensor types. In order to process the various types of photography and imagery, the appropriate camera or sensor model which defines the geometry of the sensor must be selected. Figure 66 shows the Model Setup dialog.
The geometric properties of a camera or sensor model define the internal and external characteristics associated with it. Internal characteristics include parameters which define the internal geometry of the camera or sensor as it existed when the imagery was captured. The external parameters define the original position and orientation of the camera or sensor when the imagery was captured.

Each camera and sensor type has different internal and external properties associated with it. LPS Project Manager estimates both the internal and external characteristics associated with a sensor model in order to accurately model the geometry of the camera or sensor model. This information is required for point determination and the creation of orthorectified images, DEMs, and stereopairs.

Frame cameras, digital cameras, videography, and nonmetric cameras have a perspective center. The perspective center is the optical center of a camera lens. All light rays that pass through a lens pass through the perspective center. The elements of exterior orientation define the position of the perspective center relative to the ground coordinate system. Cameras have one perspective center. Pushbroom sensors have multiple perspective centers, according to the number of scan lines in the image.

**Cameras**

The properties associated with cameras can include, but are not limited to, focal length, principal point, calibrated fiducial mark positions, and radial lens distortion. The following geometric models are supported within LPS Project Manager:

**Frame Camera**

This type of camera is commonly associated with aerial cameras having an approximate focal length of 6 inches (152 mm). The photographic format size from these cameras is 9 × 9 inches. Frame cameras have fiducial marks positioned within the camera body. The fiducial marks are exposed onto the film emulsion when the photography is captured. The fiducial marks are subsequently measured to determine the interior orientation of the camera. Frame cameras are considered metric cameras since they have been calibrated in a laboratory.
Digital Camera

This type of camera can be used for aerial and ground-based (terrestrial) mapping applications. The focal length for a digital camera may range in size from 10 mm to 50 mm or greater. Rather than using film to record an image, digital cameras make use of a CCD. A CCD contains an array of cells which record the intensity associated with a ground feature or object. The x and y pixel size of the CCD array must be defined. Digital cameras do not have fiducial marks, and for that reason they do not need to be measured. Digital cameras are considered nonmetric, noncalibrated cameras.

Video Camera (Videography)

This type of camera can be used for aerial and ground-based (terrestrial) mapping applications. The focal length for a video camera may range in size from 10 mm to 50 mm or greater. A video camera can use either film or a CCD to record an image. If a film video camera is used, the film scanning resolution must be used for interior orientation. If a CCD type is used, the x and y pixel size of the CCD array must be defined. Video cameras do not have fiducial marks, and for that reason they do not need to be measured. Video cameras are considered nonmetric, noncalibrated cameras.

Non-metric Camera (35 mm, Medium, and Large Format Cameras)

This type of camera can be used for aerial and ground-based (terrestrial) mapping applications. This type of camera may include amateur 35 mm cameras and medium to large format cameras (for example, 75 mm focal length). The focal length for a nonmetric camera may range in size from 10 mm to 152 mm or greater.

A nonmetric camera is a camera which has not been calibrated in a laboratory to define its internal geometry. The primary camera parameters which have not been calibrated include focal length, principal point, lens distortion, and fiducial marks. The minimum interior orientation input requirements include an approximate focal length, and the scanning resolution used to digitize the film.

DPPDB

DPPDB is the acronym for Digital Point Positioning Data Base. This type of camera is for data, designed by NIMA, which is classified. Not everyone has access to DPPDB data. It can be described as high-resolution stereo data with support files, which normally covers a 60 nautical mile range (Federation of American Scientists, 2000).
Pushbroom Sensors

Pushbroom data is collected along a scan line, with each scan line having its own perspective center. The following geometric models are supported:

Generic Pushbroom

This type of satellite pushbroom sensor can be used for satellites other than SPOT, IKONOS, and IRS-1C, which scan along a line to collect data. Sensor model parameters associated with the internal geometry of the sensor must be provided.

SPOT Pushbroom

The SPOT pushbroom sensor supports SPOT Panchromatic (10-meter ground resolution), and SPOT XS Multispectral (20-meter ground resolution) imagery. Sensor model properties associated with the satellite are automatically derived from the header file of the imagery and subsequently used in LPS Project Manager. The ERDAS IMAGINE Import tool can be used to import the SPOT imagery.

IRS-1C Pushbroom

The IRS-1C sensor model supports imagery collected from the IRS-1C pushbroom sensor model (5-meter ground resolution). Sensor model properties associated with the satellite are automatically derived from the header file of the imagery and subsequently used in LPS Project Manager. The ERDAS IMAGINE Import tool can be used to import the IRS-1C imagery.

Orbital Pushbroom

The Orbital Pushbroom model is a generic model, which is able to compute the transformation between image pixel (image space, which is the source image pixel location) and ground point (ground space, which is the ground point location) for pushbroom sensors such as QuickBird, EROS A1, ASTER, and SPOT. Generic modeling is based on the metadata information about the sensor orbit.

RPC

RPC (rational polynomial coefficient) files contain rational function polynomial coefficients that are generated by the data provider based on the position of the satellite at the time of image capture.
IKONOS

The IKONOS sensor model supports IKONOS imagery and its associated rational polynomial coefficient (RPC) and metadata files. The metadata files contain information regarding the images in the data set. RPC files contain the necessary information to determine interior and exterior orientation.

NITF RPC

The National Imagery Transmission Format (NITF) is the standard format for digital imagery and imagery-related products used by the Department of Defense and the intelligence community. NITF is designed to be a common format for exchange of imagery data between normally incompatible systems. The metadata files contain information regarding the images in the data set. RPC files contain the necessary information to determine interior and exterior orientation.

QuickBird RPC

QuickBird data, which is supplied by DigitalGlobe, in “Basic” and “Standard” formats can be used in LPS Project Manager for the creation of block files. QuickBird images are delivered with image support data (ISD) files that detail information such as ephemeris and RPCs. The RPC data, which accompanies QuickBird images in GeoTIFF or TIFF format, can be used to define the sensor.

Mixed Sensor

The Mixed Sensor model supports LPS Project Manager calibrated images, oriented images, and SOCET SET® support files. Images without geometric models already associated with them cannot be used with the Mixed Sensor geometric model. Using this model, the same block file may have multiple projections and the may also have images with different vertical datum and units.

NOTE: With the Mixed Sensor geometric model type, you cannot perform automatic tie point generation. Also, the triangulation process is used to check errors in GCPs only.

Once a sensor model has been selected for a block file, it cannot be changed within LPS Project Manager.

Reference Coordinate System

A reference coordinate system defines the projection, spheroid, and datum for the block project. LPS Project Manager supports the use of multiple projections (for example, UTM, State Plane, Geographic), spheroids (for example, Clarke 1866, GRS80, WGS84), and datums (for example, NAD 27, NAD 83).
Once the appropriate geometric model has been selected, the Block Property Setup dialog, shown in Figure 67, is provided, which allows for the specification of a projection, spheroid, and datum.

Figure 67: Projection, Spheroid, and Datum

A right-handed cartesian coordinate system is supported in the case that a projection, spheroid, and datum are not specified or required.

By selecting the Set Projection option within the Block Property Setup dialog, the Projection Chooser dialog opens, as shown in Figure 68.

Figure 68: The Projection Chooser

A standard set of existing projections is contained within the Categories dropdown list of the Standard tab. If a given projection/datum is not listed within the category list, the Custom tab can be selected to define a unique projection, spheroid, and datum, as shown in Figure 69.
Once a custom reference system has been defined, all of the projection information can be saved and reused for other mapping projects. If a reference system is saved, the corresponding system opens within the category list contained within the Standard tab of the Projection Chooser dialog. Additionally, existing reference systems contained within the category list can also be deleted and renamed.

Once a reference system has been selected, the respective projection/spheroid/datum information displays within the Block Property Setup dialog, as shown in Figure 70.

The Next and Previous buttons in the Block Property Setup dialog provide a linear project setup environment for the definition of an LPS Project Manager project. During any portion of the setup, the next or previous steps associated with defining the project can be accessed.
Defining Units

Once Next has been selected, the horizontal, vertical, and angular units associated with a block project can be defined, as shown in Figure 70.

LPS Project Manager supports the following horizontal and vertical units: Meters, Feet, US Survey Feet, Indian Feet, International Feet, Centimeters, and Inches. Angular unit support includes Degrees, Radians, and Gons.

Defining Frame-specific Information

LPS Project Manager allows for the specification of additional information associated with photogrammetric components of the mapping project. This includes:

• rotation system type
• photographic direction of the imagery in the project
• average flying height
• import of exterior orientation parameters

After the units types have been selected in the Block Property Setup dialog, select the Next button. The dialog that allows for the specification of photogrammetric information opens, as shown in Figure 71.

Figure 71: Photogrammetric Information in Block Property Setup Dialog
Rotation System Support

LPS Project Manager accommodates the use of three rotation systems. A rotation system defines the axis used to characterize the orientation of a camera/sensor at the time of exposure. A rotation system is defined as having three rotation angles. These include an Omega rotation around the x-axis, Phi rotation around the y-axis, and Kappa rotation around the z-axis. The rotation angles define the angular relationships between the x, y, or z axes of a tilted image (defined by the photo/image coordinate system), and the X,Y, or Z axes of the ground (defined by the ground coordinate system).

Different countries around the world employ different conventions for rotation systems. The three options within the Rotation System dropdown list include:

**Omega, Phi, Kappa**

This convention is most commonly used throughout the world. Omega is a positive rotation around the x-axis, Phi is a positive rotation around the y-axis, and Kappa is a positive rotation around the z-axis. In this system, x is the primary axis, indicating that the first rotation in forming the rotation matrix is around the x-axis.

The positive axis is also known as the primary axis. The primary axis is the axis around which the first rotation occurs. Rotation follows the right-hand rule, which says that when the thumb of the right hand points in the positive direction of an axis, the curled fingers point in the direction of positive rotation for that axis.

**Phi(,+), Omega, Kappa**

This convention is most commonly used in Germany. Phi is a positive rotation about the y-axis, Omega is a positive rotation around the x-axis, and Kappa is a positive rotation around the z-axis. In this system, y is the primary axis, indicating that the first rotation in forming the rotation matrix is around the y-axis.

**Phi(-), Omega, Kappa**

This convention is most commonly used in China. Phi is a negative rotation around the y-axis, Omega is a positive rotation around the x-axis, and Kappa is a positive rotation around the z-axis. In this system, y is the primary axis, indicating that the first rotation in forming the rotation matrix is around the y-axis.

Since various rotation systems are supported, additional transformations from one rotation system to another are not required.
**Photographic Direction**

LPS Project Manager supports the processing of aerial, terrestrial (ground-based), and oblique imagery. A photographic direction is specified in order to define the type of imagery to be processed.

Aerial photography and imagery are captured with the optical axis of the camera having a Z direction. This type of imagery is most commonly used for topographic and planimetric mapping applications. Therefore, when utilizing aerial or vertical photography, the **Z-axis for normal images** option should be selected within the **Photo Direction** dropdown list.

Terrestrial or ground-based photography has the optical axis of the camera directed toward the Y-axis of the ground coordinate system. Therefore, when utilizing terrestrial photography, the **Y-axis for close range images** option should be selected. This type of photo direction is commonly used for applications involving close-range photography (for example, the distance between the imaged object and the camera station is minimal).

**Figure 72** illustrates the differences between aerial or vertical imagery, and terrestrial photography and imagery:

**Figure 72: Photographic Directions Used for Aerial and Terrestrial Imagery**

![Diagram showing photographic directions](image)

The photographic direction (vertical) for aerial photography is in the Z direction. The same photographic direction for terrestrial photography and imagery is in the Y direction. LPS Project Manager automatically translates all of the coordinates from one system to another.
**Average Flying Height**

The average flying height is the distance between the camera position at the time of exposure and the average ground elevation. Figure 73 graphically illustrates the average flying height:

**Figure 73: Average Flying Height of an Aircraft Above Ground Level**

- Exposure Stations

![Diagram of Average Flying Height](attachment:image.png)

Avg. Flying Height = 
Avg. Aircraft Altitude - Avg. Relative Terrain Elevation

The average flying height is an optional input requirement that specifies the altitude or height of the camera/sensor at the time of exposure. This distance is above ground, not above mean sea level. The specification of this value assists the automatic tie point collection algorithm when the exterior orientation parameters (for example, initial approximations or final values) have been entered.

If the average flying height is close to the exterior orientation Z coordinate values, the average flying height does not need to be specified. In other words, the average flying height does not need to be specified if the altitude of the aircraft over the average ground surface is similar to the altitude of the aircraft over mean sea level. Otherwise, it is recommended to specify the average flying height.

The average flying height is commonly provided by the photographic instrumentation used to capture the data. If the average flying height is not available (and the photo scale/image scale known), the average flying height can be determined by multiplying the focal length by the image scale.

The illustrations in Figure 74 define when the average flying height is not required.
The average flying height should be specified when the Z plane (defined by the type of datum) deviates substantially relative to the average ground level. This is primarily the case for mountainous areas with large variations of topographic relief displacement.

**NOTE:** The Average Flying Height is helpful when you use the Exterior Initial Type option for auto tie. If the Tie Points Initial Type option is selected for auto tie, the Average Flying Height does not influence results.

For more information about auto tie, see “Minimum Input Requirements”.

**Importing Exterior Orientation Parameters**

In cases where the position and orientation of the exposure stations (exterior orientation) for the images in a block are known, an ASCII file containing the respective information can be imported. The exterior orientation parameters define the position and rotation of a camera/sensor as they existed when the photography/imagery was captured. The positional elements are defined using the X, Y, and Z coordinates of the exposure station, and the rotational elements are defined as the degree of tilt in each image. This can be expressed using the three rotation angles (Omega, Phi, and Kappa). The exterior orientation parameters can be obtained from various sources, including:
280 Getting Started with LPS Project Manager

• Airborne GPS and INS data. The GPS component provides the X, Y, and Z coordinates of the exposure station to a given accuracy. The INS provides the Omega, Phi, and Kappa rotation angles. The INS attempts to stabilize the movement of the platform during collection. For these reasons, the Omega and Phi rotations associated with the INS are minimal, and at times negligible.

• Existing photogrammetric workstations. Exterior orientation parameters have been determined by using external systems including analog stereo plotters, analytical stereo plotters, digital photogrammetric workstations, softcopy systems, and aerial triangulation packages.

• Initial values approximated from topographic maps. In this scenario, only the X, Y, and Z coordinates of exterior orientation can be approximated.

**Why Import Exterior Orientation Parameters?**

Overall, the availability of the exterior orientation parameters advances the automation of the workflow associated with creating orthorectified images. Following are some examples of the usefulness of exterior orientation parameters.

• If exterior orientation parameters are available, the manual steps of measuring at least two GCPs or tie points on the overlap areas of each image in the project are not required to perform automatic tie point collection. Instead, LPS Project Manager uses the exterior orientation information to fully automate the measurement of points.

• If the values for exterior orientation are known to a high accuracy (that is, less than one meter), the process of performing aerial triangulation is not required. Thus, the LPS Project Manager workflow includes defining the block, adding imagery to the block, defining the camera, specifying interior orientation, and then performing orthorectification. Additionally, GCPs are not required.

• If the values of exterior orientation are known to a given level of accuracy, the initial approximations are useful for ensuring a high accuracy when estimating the adjusted exterior orientation information and the X, Y, and Z coordinates of ground coordinates.

• If the relative orientation parameters between the images in the block are known, these values can be used to perform automatic tie point collection.

• If the SCBA is being used to determine the interior orientation parameters associated with the camera, statistically constraining the imported exterior orientation parameters increases the accuracy of the final solution.
The **Import Exterior Orientation Parameters** button on the Block Property Setup dialog activates the ERDAS IMAGINE Import Options dialog. The ASCII file to be imported must have a *.dat file extension. The contents of the ASCII file must include (in no particular order or delimitation):

- Image ID
- Image Name
- X
- Y
- Z
- Omega
- Phi
- Kappa

Once a *.dat file has been selected, the Import Parameters dialog opens, shown in **Figure 75** wherein the reference coordinate system and units of the incoming exterior orientation parameters can be specified.

**Figure 75: Import Parameters for Exterior Orientation**

By clicking the **Set** button, the Projection Chooser opens. The reference coordinate system and the horizontal, vertical, and angular units of the information contained within the ASCII file can be defined. LPS Project Manager automatically transforms the values contained within the ASCII file to the appropriate projection, spheroid, and datum used by the block project.

Once the reference coordinate system and units have been specified and verified, the Import Options dialog opens, as shown in **Figure 76**.
The following properties associated with the input ASCII *.dat file can be defined:

- **Field Type.** Choose either **Delimited by Separator** or **Fixed Width**.

- **Delimited by Separator** is selected, the following **Separator Character** options are provided:
  - White Space
  - Tab
  - Colon
  - Comma
  - Semi-Colon
  - Vertical Bar (|)
  - Space

- Regardless of the **Field Type**, a **Row Terminator Character** must be specified. The options include:
  - New Line (UNIX)
  - Return New Line (DOS)
  - Return (MacOS)

- Depending on the nature of the input, an ASCII **Comment Character** can also be specified. ASCII files tend to use comment characters such as "#" or "***" to differentiate user-specified comments from pertinent exterior orientation data.
• Depending on the nature of the ASCII file, an ASCII header file may exist at the beginning of the *.dat file. If this is the case, you can exclude this information from being considered during the import by defining the **Number of Rows To Skip** during the import.

The ASCII importer is flexible with respect to the column formatting of the input exterior orientation data. The **Column Mapping** section of the Import Options dialog associates the **Input Field Number** with the **Output Column Name**. The **Input Field Number** defines the column number within the ASCII file, and the **Output Column Name** defines the associated exterior orientation parameter. Selecting the **View** option displays the original ASCII *.dat file using the ERDAS IMAGINE ASCII Editor. Within this environment, you have the option of modifying, verifying, and saving the original ASCII file.

The **Input Preview** tab, shown in **Figure 77**, allows for the verification of the **Input Field Number** and **Output Column Name** associations.

**Figure 77: Preview the Contents of the Input ASCII File**

If you wish to change the respective associations, the **Input Field Number** can be modified to reflect the input ASCII file. To import the exterior orientation parameters, select **OK**.

When the **OK** button within the Block Property Setup dialog has been selected, the CellArray updates. If the exterior orientation parameters were imported, the LPS Project Manager shown in **Figure 78** opens.
Since the imagery was already added to the block when the exterior orientation parameters were imported, the image names must now be attached to the corresponding image files. See “Attaching Multiple Images”.

⚠️ Once the OK button has been selected within the Block Property Setup dialog, the geometric model, projection information, units and average flying height information cannot be modified.

As an alternative approach, all of the images in a project can be added to the block within the LPS Project Manager, and the exterior orientation parameters imported using the Edit All Images option contained within the Exterior Information tab of the Frame Editor.
Project Setup for Sensor Models

The block property setup involves the following steps when the SPOT, IRS-1C, IKONOS, or Generic Pushbroom sensor models are selected within the Set Geometric Dialog:

- Define the reference coordinate system. (that is, projection, spheroid and datum). (See “Reference Coordinate System”.)
- Define the units. (See “Defining Units”.)

Once the block project has been defined, the LPS Project Manager opens.

The LPS Project Manager Toolbar

When a new LPS Project Manager block has been created or an existing block opened, the LPS Project Manager and CellArray open, as shown in Figure 79.

Figure 79: LPS Project Manager
Icons are located on the toolbar at the top of the LPS Project Manager that simulate the photogrammetric workflow associated with performing triangulation and creating orthorectified images. Each icon performs a given portion of the photogrammetric workflow.

LPS Automatic Terrain Extraction introduces an optional elevation extraction step in the photogrammetric workflow. You access the functionality by clicking the DTM Extraction icon on the toolbar. For more information, see LPS Automatic Terrain Extraction Tour Guide.

A photogrammetric workflow using LPS includes the following steps:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Add imagery to the block. This step involves adding one or multiple images to the project.</td>
</tr>
<tr>
<td>2.</td>
<td>Input parameters in the frame editor. This step defines the camera/sensor model properties used to collect the photography or imagery. If photography or imagery collected from a camera is used, additional dialogs are provided for defining the camera and performing interior orientation.</td>
</tr>
<tr>
<td>3.</td>
<td>Perform point measurement. GCPs, tie points, and check points can be measured on one image or multiple images. Additionally, reference sources can be defined and used for the collection of GCPs.</td>
</tr>
<tr>
<td>4.</td>
<td>Conduct automatic tie point collection. LPS Project Manager automatically measures the corresponding tie point positions of points appearing on more than one image.</td>
</tr>
<tr>
<td>5.</td>
<td>Run aerial triangulation. The aerial triangulation process simultaneously estimates the exterior orientation parameters of each camera/sensor station that existed at the time of image exposure, and the X, Y, and Z ground coordinates of tie points. The exterior orientation parameters are computed for each image in a block. Additionally, the camera’s interior orientation parameters can be estimated by using the SCBA. If satellite imagery is being used, this process is referred to as triangulation.</td>
</tr>
<tr>
<td>6.</td>
<td>Create DTM. Click this icon to start LPS Automatic Terrain Extraction, another component of the LPS.</td>
</tr>
<tr>
<td>7.</td>
<td>Edit DTM Click this icon to start Terrain Editor, another component of the LPS.</td>
</tr>
</tbody>
</table>
The digital photogrammetric workflow is linear. For example, when using frame cameras, automatic tie point collection cannot begin until fiducial marks have been measured for each image in the block. Using the icons located within the LPS Project Manager, moving through the various steps from left to right allows for the completion of the photogrammetric workflow.

Table 6: LPS Workflow

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>Perform orthorectification. This process creates orthophotos showing images of ground features in their true orthographic or planimetric positions. The orthorectification procedure reduces image distortions caused by topographic relief, sensor tilt, and systematic error in the imagery or the imaging device. Additionally, ortho calibration techniques can be used to create an orthorectified mathematical model associated with an image, without resampling the original image.</td>
</tr>
<tr>
<td>9.</td>
<td>Mosaic images. Click this icon to open the Mosaic Tool. Mosaicking is the process of joining georeferenced images together to form a larger image or set of images. The input images must all contain map and projection information; however, they need not be in the same projection or have the same cell sizes.</td>
</tr>
<tr>
<td>10.</td>
<td>Collect features. Click this icon to open a feature collection application such as Stereo Analyst, Stereo Analyst for ArcGIS, or PRO600. The options available to you depend on which applications you have installed and licensed. For example, if you do not have Stereo Analyst for ArcGIS loaded and licensed on your system, it does not appear on the list.</td>
</tr>
</tbody>
</table>
Adding Images to the Block

Introduction
An LPS Project Manager block file can contain a few or many images. In this section, you learn how to add images and how to improve their display in the view using LPS Project Manager pyramid layers.

Adding Images
A single image or multiple images can be added to the block by selecting the Add Frame icon or the Add Frame option from the Edit menu in the LPS Project Manager. Once the option has been selected, the Image File Name dialog opens, as shown in Figure 80.

Figure 80: Image File Name Dialog

Add Multiple Images
To add one image to the block, simply select the image and select OK. To add multiple images simultaneously, use the Shift and Ctrl (Control) keys on your keyboard. For example, to select a series of sequential images, hold down the Shift key, then click the first and last images in the series. Click OK to add the files to the block. To select multiple images that are not sequential in the file list, hold down the Ctrl key, then click the files you want to include. Click OK to add the files to the block.

LPS Project Manager supports the following raster DLLs: IMAGINE IMG, JPEG, TIFF, GIF, LAN, Generic Binary, and RAW. Using the supported raster DLLs, the image files do not need to be imported.

LPS CellArray
Once the images have been added, the LPS Project Manager displays the CellArray with corresponding image names and associated process information. The LPS CellArray is shown in Figure 81.
Each image has an associated **Row #**. Selecting a row within the **Row #** column selects that image for a subsequent operation within LPS Project Manager. This operation may include deleting the image or creating a pyramid layer for the image.

A right-click on a cell contained within the **Row #** column opens the **Row Selection** menu of the CellArray. The options include: **Select None**, **Select All**, **Invert Selection**, **Delete Selection**, **Criteria**, **Sort**, and **Goto**.

Refer to the ERDAS IMAGINE On-Line Help for a detailed explanation of these features.

The **Image ID** column of the CellArray defines a numeric identifier for each image in the block. The entry must be numeric and unique for each image. The values can be modified.

The **Description** column allows you to enter information about the individual image.

The **Image Name** column of the CellArray lists the directory path and image file name for each image. The entry cannot be modified and must correspond to the appropriate image file name and location.

The **Active** column of the CellArray denotes with an **X** which image(s) is used for automatic tie point collection, aerial triangulation, and orthorectification. Each image added to a project is automatically set to **Active**. By selecting a cell element within the **Active** column, the **X** disappears. Selecting the same cell element once again displays **X**.

Color coding schemes are used as project management and organization tools within LPS Project Manager. The default color schemes within the CellArray include red, indicating that an operation has not been performed for a specific image, and green, indicating that an operation has been performed for a specific image.
In order to change the default color codes, select the LPS category within the Preference Editor. The preferences controlling color are Status On Color and Status Off Color.

Five additional columns represent the tasks associated with a given process in LPS Project Manager. These include:

- **Pyr.** - Refers to the creation of pyramid layers. If pyramid layers have been generated for an image, the cell element is green. If a pyramid layer has not been generated for an image, the cell element is red. The color codes are based on the default settings.

Remember, LPS Project Manager pyramid layers are generated differently than ERDAS IMAGINE pyramid layers. For more information, see “Creating Pyramid Layers”.

- **Int.** - Refers to the completion of interior orientation. If using frame cameras, the fiducial marks must be measured in order to compute the interior orientation for the image. At this point, the cell element is green. If using digital, video, or nonmetric camera imagery, the x and y size of a pixel in the image must be specified for the color code to be green.

- **Ext.** - Refers to the availability of final exterior orientation parameters. If aerial triangulation has been successfully performed and the results accepted, the exterior orientation parameters associated with each image in the block have been computed. In this case, the respective cell elements are green. If exterior orientation parameters were imported from another photogrammetric system or airborne GPS system and accepted as fixed positions, the respective cell elements are green. Otherwise, the cell elements are red.

For information about height extraction, see LPS Automatic Terrain Extraction Tour Guide.

- **Ortho** - Refers to the generation of orthorectified images or ortho calibration. If an orthorectified image was created or ortho calibration performed, the respective cell element for each image is green. Otherwise, the cell element is red.
• **Online** - These cell elements indicate whether the image is currently online or off-line. If an image is online, the image name and directory path corresponds to the appropriate image file on the hard-disk. When imagery is added to a block, the respective cell elements are green. If existing imagery is moved from its directory as indicated within the **Image Name** column, the cell element is red. Using the **Attach** option within the Frame Editor dialog, images that have been moved from their original locations can be reattached. If exterior orientation parameters were imported during block setup, the CellArray elements within the **Online** column are red since the image name to image file association has not been made.

### Creating Pyramid Layers

The **Compute Pyramid Layers** option allows for the creation of hierarchical pyramid layers. Pyramid layers are used by LPS Project Manager to facilitate and optimize image zooming, panning, and roaming. Additionally, the pyramid layers are necessary for performing automatic tie point collection.

LPS Project Manager uses a different construction model for the creation of pyramid layers as compared to ERDAS IMAGINE *.rrd (Reduced Resolution Data) pyramid layers. LPS Project Manager pyramid layers are created using a binomial interpolation algorithm, whereas ERDAS IMAGINE pyramid layers are created using a user specified option of **Nearest Neighbor**, **Bilinear Interpolation**, or **Cubic Convolution**.

If the **Compute Pyramid Layers** option is selected from the **Edit** dropdown list, or a cell element within the **Pyr.** column is selected, the Compute Pyramid Layers dialog opens as shown in **Figure 82**.

**Figure 82: Compute Pyramid Layers Dialog**

The **One Image Selected** option creates pyramid layers for the image currently selected, as designated by the >, within the CellArray. You can select several images within the LPS CellArray for which pyramid layers are created (**All Selected Images** option). The third option, **All Images Without Pyramids**, creates pyramid layers for all the images in the block that do not have existing LPS Project Manager pyramid layers.
Once the pyramid layers are created for the images within the block, the **Pyr.** column within the LPS Project Manager CellArray is green (completed status).
Defining the Camera or Sensor Model

**Introduction**

Defining the camera or sensor model involves establishing the geometry of the camera/sensor as it existed at the time of photographic exposure or image acquisition. This includes defining both the internal and external information associated with a camera or sensor model.

**Interior and Exterior Orientation**

When using cameras having one perspective center, including frame cameras, digital cameras, videography, and nonmetric cameras, the internal geometry is referred to as interior orientation. When using satellite sensors such as SPOT, IRS-1C, and other generic pushbroom sensors use perspective center for each scan line, the process is referred to as internal sensor modeling.

Defining the external properties associated with a camera or sensor involves establishing the exterior orientation parameters associated with the camera/sensor as they existed at the time of photographic exposure or image acquisition.

Both the internal and external information associated with a camera/sensor can be defined within the Frame Editor dialog. By selecting either the Frame Editor icon on the LPS Project Manager toolbar or the **Frame Editor** option within the **Edit** menu, the Frame Editor dialog opens, as shown in **Figure 83**.

**Figure 83: Frame Editor Dialog**

Three tabs are provided within the Frame Editor dialog:

- **Sensor.** This tab allows for the definition of the image and the corresponding camera or sensor information associated with an image. The **Sensor** tab gives access to the following tasks:
  - specifying of the image file location
- viewing an image file  
  (Selecting the View option activates the ERDAS IMAGINE Viewer and displays the image within the Viewer.)
- editing an existing camera or sensor model
- creating a new camera or sensor model

- **Interior Orientation.** When using frame cameras, measuring fiducial marks establishes the position of the principal point (i.e., the origin of the image coordinate system). When using digital, video, or nonmetric cameras, interior orientation involves defining the x and y pixel size of the camera CCD, or scanning resolution used to digitize the film obtained from a camera not using a CCD.

- **Exterior Information.** This tab allows for the input of exterior orientation parameters for a given image or multiple images.

### Attaching One Image

If an image has been moved from its original location on a computer as defined when the image was added to LPS Project Manager, the image name can be associated with the corresponding image file and its new location. When a cell element within the Online column of the CellArray is red, the image is no longer online, as shown in [Figure 84](#).

*Figure 84: LPS CellArray with Off-line Image*

<table>
<thead>
<tr>
<th>Row</th>
<th>Image ID</th>
<th>Description</th>
<th>Image Name</th>
<th>Active</th>
<th>Par</th>
<th>Int</th>
<th>Ext</th>
<th>GDM</th>
<th>Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td>d:/data1/edite/whitebeam/digitized/gpw0001.tif</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td></td>
<td>d:/data1/edite/whitebeam/digitized/gpw0002.tif</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td></td>
<td>d:/data1/edite/whitebeam/digitized/gpw0003.tif</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

By selecting the Attach option within the Sensor tab of the Frame Editor dialog, the image file can be associated with the corresponding image name as it appears in the CellArray.
Attaching Multiple Images

For mapping projects containing two or more images, rather than attach each image separately, multiple images can be attached simultaneously. To attach multiple images in one directory, select the **Attach** option within the **Sensor** tab of the Frame Editor dialog. Use the Shift and Ctrl (Control) keys on the keyboard to select multiple files.

To attach files listed sequentially, hold down the Shift key, then click the first and last files in the list. To attach multiple files that are not listed sequentially, hold the Ctrl key and click to select each image. Once you have selected the files in this manner, click **OK** in the dialog. Once images have been attached, the cells within the CellArray are converted to green.

Defining or Editing Camera Information

This section is applicable to photography or imagery with one perspective center collected using frame, digital, video, or nonmetric cameras.

Selecting the **Edit Camera** button within the **Sensor** tab of the Frame Editor dialog provides the ability to edit an existing camera model. The camera model to be edited displays within the **Sensor Name** dropdown list. Selecting the **New Camera** button within the **Sensor** tab provides the ability to create a new camera model. Only those cameras appearing within the **Sensor Name** dropdown list can be edited.

*NOTE: More than one camera can be used within a block project.*
The Sensor Name dropdown list provides a list of existing cameras or sensors that are available for use within a block. Only those cameras or sensors that have been defined are displayed within the Sensor Name list.

Defining the properties associated with a camera creates a primary component of interior orientation. For aerial frame cameras, the interior orientation process involves defining the camera properties associated with a camera (for example, focal length, principal point, radial lens distortion, and location of the fiducial marks).

For nonmetric cameras, including digital, video, and amateur cameras, the process involves defining the camera properties (for example, focal length, principal point (optional), radial lens distortion (optional), and the x and y pixel size of the CCD if using digital or video cameras). If the cameras used photography at the time of exposure, the scanning resolution used to digitize the photography must be entered.

By selecting the New option within the Sensor Name list, the Camera Information dialog opens.

Figure 86: Camera Information Dialog

Within the Camera Information dialog, shown in Figure 86, the camera properties associated with using a frame, digital, video, or nonmetric camera can be defined. Within the General tab, the following parameters can be defined:

- **Camera Name.** The name of the new camera can be defined in this field.

- **Description.** A camera description can be assigned to a camera. It can be an alpha-numeric string of information.
• **Focal length (mm).** The focal length of a camera can be defined in millimeters. This is normally provided in a calibration report. A calibration report is provided when aerial photography has been flown and distributed for public use (e.g., USGS camera calibration reports). The focal length is required in order to continue photogrammetric processing.

• **Principal Point \( x_0 \) (mm).** This parameter defines the location of the principal point in the \( x \) direction, relative to the origin of the image or photo-coordinate system. The principal point location is the location where the optical axis of the camera intersects the image or photographic plane. The deformations existing within the camera body and lens cause the principal point to deviate from the image coordinate system origin, which is normally defined by the fiducials.

• **Principal Point \( y_0 \) (mm).** This parameter defines the location of the principal point in the \( y \) direction, relative to the origin of the image or photo-coordinate system.

The **Load** button allows you to open an existing camera file having a *.cam extension. Once a *.cam file has been opened, all of the respective parameters within the Camera Information dialog are populated. The *.cam file is an ASCII file with a fixed structure.

The **Save** option allows you to save all of the information associated with a camera to a camera file having a *.cam extension. The file is an ASCII file with a fixed file structure. It is recommended that the camera information be saved once the camera model has been defined, so that the camera can be reused in future photogrammetric projects. The **Save** button saves the existing contents contained within the Camera Information dialog to the block project and correspondingly to the *.cam file.

**Fiducials**

The **Fiducials** tab, shown in **Figure 87**, allows you to define the number of fiducials located on an image and enter their calibrated \( x \) and \( y \) image or photo-coordinate values.
By entering a number in the **Number of Fiducials** field, the appropriate number of rows is allocated to the CellArray. The **Film X (mm)** and **Film Y (mm)** columns within the CellArray represent the calibrated coordinates of the fiducial mark positions on the images.

Fiducial marks are physical features located within the camera body. When an image is captured or exposed, the fiducial marks also become captured within the image or film emulsion. Prior to capturing imagery/photography, the positions of the fiducial marks are precisely determined and measured in a laboratory. These positions are then provided in a calibration report.

**Importing Fiducial Marks Using the CellArray**

The calibrated fiducial mark coordinates can be imported into the fiducials CellArray using the following steps:

1. Enter the number of fiducial marks.
2. Select the **Film X (mm)** and **Film Y (mm)** columns using a left-click and drag. Both columns become highlighted.
3. Right-click to display the column CellArray options.
4. Select the **Import** option.
5. Specify the input ASCII file.
6. Ensure that the appropriate column name (that is, **Film X** and **Film Y**) is associated with the corresponding information in the ASCII file.
7. Click OK to import the fiducial coordinates.

**NOTE:** Fiducial mark coordinates can also be exported using the CellArray.

**Fiducials for Digital, Video, and Nonmetric Cameras**

Since fiducial marks are not present on digital, video, and nonmetric cameras, they are not required as input to define the camera model. LPS Project Manager utilizes the corners of the image to define the origin of the image/photo-coordinate system. This procedure is performed automatically.

**Radial Lens Distortion**

The **Radial Lens Distortion** tab allows for the entry and computation of radial lens distortion parameters associated with a camera. It is shown in **Figure 88**.

![Figure 88: Radial Lens Distortion Tab](image)

Radial lens distortion is defined as the distortion of an image point along a radial line from the principal point. The result is displacement of the image point from its true position. Radial lens distortion is caused by wear and tear of a lens and inaccurate optics.

Radial lens distortion can be measured using two techniques. The first defines lens distortion as a function of radial distance from the principal point, and the second defines the distance as a function of the field angle from the principal point. The radial distortion values required for use with both options are provided in most calibration reports.
If the radial distortion values provided are based on the radial distance or field angle, they can be defined within this environment. The **Add Point** button must be selected for each radial distortion entry. The number of points to be added depends on the number of distortion values available.

If an entry is incorrect, the **Delete Point** button allows for the deletion of a row within the CellArray.

Once the distortion values have been entered, the radial lens distortion coefficients can be computed by selecting the **Calculate Coeffs** button. The resulting three lens distortion coefficients are displayed under the **K0**, **K1**, and **K2** text fields.

Once the lens distortion coefficients have been calculated, the **Residual** column within the **Radial Lens Distortion** CellArray displays residuals, indicating the degree to which the radial distortion parameters correspond to the radial lens distortion model.

In some instances, the lens distortion coefficients may be available or previously computed. In this scenario, the three coefficients can be entered rather than recomputed.

Selecting **OK** accepts all of the camera information defined within the Camera Information dialog and creates a new camera/sensor model to be used within LPS Project Manager. The new camera model displays within the **Frame Editor Sensor Name** dropdown list. Additionally, once **OK** has been selected, the Camera Information dialog closes.

---

**For more information, see “Lens Distortion”**.

### Interior Orientation

Interior orientation for frame cameras varies in comparison to interior orientation for digital, video, and nonmetric cameras.

Interior orientation involves measuring the pixel coordinate positions of the calibrated fiducial marks on each image within a block (if using frame cameras). When using digital, video, or nonmetric camera imagery, the process involves defining the x and y pixel size of the CCD or scanning resolution used to digitize the film, if film was used.

The purpose of interior orientation is twofold:

- to define an image or photo-coordinate system within each image of the block, and

- to determine the origin and orientation of the image/photo-coordinate system for each image in the block.
The origin of the photo-coordinate system for each image is the principal point. The principal point position is determined mathematically by intersecting opposite fiducial mark positions. A 2D affine transformation is used to determine the relationship between the pixel coordinates of the measured fiducials and the film, or photo-coordinates of the calibrated fiducials.

Interior orientation is semi-automated for frame cameras. For example, if the positions of two fiducial marks are measured on an image, LPS Project Manager automatically adjusts to display each remaining fiducial mark. It is then the responsibility of the operator to measure the position of the fiducial mark. For digital, video, and nonmetric cameras, an automated procedure is used to determine the origin of the image/photo-coordinate system.

Frame Cameras

Upon selecting the Interior Orientation tab within the Frame Editor dialog, the Interior Orientation dialog opens as shown in Figure 89.

Figure 89: Interior Orientation Tab of the Frame Editor

In the CellArray, the image that currently has the symbol > assigned to it has the corresponding interior orientation information also displayed within the Interior Orientation tab. The Next and Previous buttons can be used to navigate throughout the block during interior orientation. The currently active image name displays within the upper left-hand corner of the Frame Editor title bar.

To display the image, the Viewer icon (first icon from the left) must be selected. The image displays within three views. The views include an OverView, a Main View, and a Detail View.

The primary window displays the area enclosed in greater detail within the OverView window Link Cursor. The magnify window displays the area enclosed in greater detail within the primary window Link Cursor. Figure 90 shows the configuration of the windows.
It is recommended that fiducial mark measurements be made on the Detail View to ensure sub-pixel accuracy.

**Fiducial Orientation**

Fiducial orientation defines the relationship between the image/photo-coordinate system of a frame and the actual image orientation as it appears within a view. The image/photo-coordinate system is defined by the camera calibration information. The orientation of the image is largely dependent on the way the photograph was scanned during the digitization stage.

*For information about scanners, see “Desktop Scanners”.*

**Figure 91** shows a common fiducial orientation as a function of the image/photo-coordinate system, and the raw image orientation. Assume the photograph is aerial and has the following fiducial mark coordinates:
The dark bar represents the data strip that is common to photography captured using frame cameras. The data strip is used as a reference in determining the manner in which the camera was calibrated. In this example, the corresponding image/photo-coordinate system X-axis is positive to the right, and the Y-axis is positive up.

The fiducial orientation to be used for the above scenario depends on the existing orientation of the image as it appears within a view. Figure 92 illustrates the fiducial orientation used for the various image orientation scenarios available.

Note: The black bar represents the image data strip. The numbered corners represent the fiducials.
In order to select the appropriate fiducial orientation, compare the axis of the photo-coordinate system (defined in the calibration report) with the orientation of the image. Based on the relationship between the photo-coordinate system and the image, the appropriate fiducial orientation can be selected. The following illustrations demonstrate the fiducial orientation used under the various circumstances:

- Photo-coordinate system parallel to image orientation.
- Image rotated 90° relative to the photo-coordinate system.
- Image rotated 180° relative to the photo-coordinate system.
- Image rotated 270° relative to the photo-coordinate system.

Selecting the inappropriate fiducial orientation results in large RMS errors during the measurement of fiducial marks for interior orientation and errors during the automatic tie point collection. If initial approximations for exterior orientation have been defined and the corresponding fiducial orientation does not correspond, the automatic tie point collection capability provides inadequate results. Ensure that the appropriate fiducial orientation is used as a function of the image/photo-coordinate system.

NOTE: Once the fiducial marks have been measured, do not change the fiducial orientation. To change the fiducial orientation you should delete the fiducial mark measurements, select the appropriate fiducial orientation, and remeasure fiducials.

How to Find the Data Strip

The data strip on a image may vary with respect to the type of frame camera used to capture the photography. Figure 93 displays a data strip contained within aerial photographs captured using a Wild camera.
The data strip commonly contains information associated with the type of camera (Wild, Zeiss, Jena), the number of the camera, and the approximate focal length of the camera (e.g., 152 mm).

If a data strip is not present within the photography, it is recommended that the first fiducial orientation used for photography be collected along a strip.

### Interior Orientation CellArray

The interior orientation CellArray displays the calibrated fiducial mark coordinates, their associated row and column pixel coordinates, fiducial mark color codes, and x and y fiducial mark residuals. Once a fiducial mark has been measured, the row and column pixel coordinates associated with a fiducial mark are displayed within the CellArray.

Once the appropriate fiducial orientation has been selected, LPS Project Manager automatically drives to display the approximate image location of the first fiducial mark. When the fiducial mark is measured, the image position of the second fiducial mark is approximated. The quality of the approximation increases drastically once the second fiducial mark has been measured.

### Importing Fiducial Mark Measurements

If the row and column pixel coordinates of the fiducial marks are available, an ASCII file containing their values can be imported.

The following steps can be used to import an ASCII file containing the fiducial mark coordinates:

1. Select the **Image X** and **Image Y** columns using a left-click and drag. Both columns become highlighted.
2. Right-click to display each column’s CellArray options.
3. Select the **Import** option.
4. Specify an ASCII file as input.

5. Ensure that the appropriate column name is associated with the corresponding information in the ASCII file.

**Image Enhancement**

To improve the quality of interior orientation, the image displayed within the view can be enhanced to optimize fiducial mark identification and measurement. The following options are provided for enhancing the display of an image:

- **Brightness and Contrast Controls.** These controls are located within the Interior Orientation tab. Changes to the brightness and contrast levels are applied to the Main View and Detail View in the Interior Orientation tab of the Frame Editor dialog.

- **Set Resampling Method.** A right-click within any of the three views (OverView, Main View, Detail View) displays the Set Resampling Method dialog, shown in Figure 94. Selecting the Set Resampling Method option provides three image resampling methods: Nearest Neighbor, Bilinear Interpolation, Cubic Convolution, and Bicubic Spline.

  Selecting the Nearest Neighbor option within Detail View is optimum for identifying and measuring the location of a fiducial mark to sub-pixel accuracy, since the individual pixels of the image are displayed.

  ![Figure 94: Set Resampling Method Dialog](image)

- **Data Scaling.** The distribution of grey levels for an image can be modified to enhance the display of fiducial marks. A right-click within any of the three views (OverView, Main View, Detail View) displays the Data Scaling dialog, shown in Figure 95. Adjusting the histogram adjusts the display of the image to ease fiducial mark identification and measurement.
• **General Contrast Options.** Sophisticated image enhancement tools are provided that allow for the variation of image display. A right-click within any of the three views (OverView, Main View, Detail View) displays the Contrast Adjust dialog, shown in Figure 96.

**Figure 96: Contrast Adjust Dialog**

The minimum number of fiducial mark measurements required to obtain a solution is three. Once three measurements have been made, the Solve button within the **Interior Orientation** tab can be selected to derive a solution. RMS is not provided since the degree of redundancy is not sufficient. If four fiducial marks have been measured, the redundancy is sufficient to determine the statistical quality of the solution. If all of the fiducial marks have been measured, the interior orientation solution is derived automatically without selecting the Solve button.

**Fiducial Mark Residuals**

If at least four fiducial mark positions have been measured, the corresponding residuals are displayed within the CellArray when the Solve option is selected. **Residual X** displays the x residual for a given fiducial mark, which is computed based on a mathematical comparison made between the original x fiducial mark position and the actual measured fiducial mark position in the x direction.
**Residual Y** displays the y residual for a given fiducial mark, which is computed based on a mathematical comparison made between the original y fiducial mark position and the actual measured fiducial mark position in the y direction.

The global RMSE displays in pixel and micron units. The RMSE represents the overall correspondence between the calibrated fiducial mark coordinates and their measured image coordinates. Values larger than 0.5 pixels, or half the scanning resolution of the image, infer systematic error and/or gross measurement errors associated with the image. The error can be attributed to:

- film deformation
- poor scanning quality
- mismeasured fiducial mark positions
- incorrect calibrated fiducial mark coordinates

**Deleting a Fiducial Mark Measurement**

To delete the pixel coordinate information associated with a measured fiducial mark, the fiducial mark measurement or measurements must be selected. A right-click within the **Point #** column of the CellArray displays its CellArray options. Select the **Delete Selection** option to delete the measured fiducial mark row and column information. Only the row and column pixel coordinates are deleted.

**Digital, Video, and Nonmetric Cameras**

Since fiducial marks are not present in digital, video, and nonmetric cameras, the interior orientation procedure does not require their measurement on the images. For digital and video cameras employing a CCD, the x and y pixel size of the CCD must be defined. You can do so in the Interior Orientation tab, shown in **Figure 97**.
Defining Exterior Information of an Image

Defining the external properties associated with a camera or sensor involves establishing the exterior orientation parameters associated with the camera/sensor as they existed at the time of photographic exposure or image acquisition. Specifically, the exterior orientation parameters define the position and orientation of the perspective center. Thus, each image in a block has different exterior orientation parameters associated with it.

The exterior information associated with an image includes:

- the six exterior orientation parameters of an image,
- the statistical weights associated with the exterior orientation parameters of an image, and
- the status of each exterior orientation parameter.

Selecting the Exterior Information tab within the Frame Editor dialog displays the exterior orientation information associated with an image. It is pictured in Figure 98.
The positional elements defining the perspective center consist of $X_0$, $Y_0$, and $Z_0$ coordinates. These coordinates are relative to the reference coordinate system, which is defined by the projection/spheroid/datum specified during block setup.

The rotational elements of exterior orientation consist of three rotation angles including Omega, Phi, and Kappa. The rotation information used by LPS Project Manager is defined during block setup. If the exterior orientation parameters were imported during block setup, the respective values are displayed within the value text fields of the **Exterior Information** tab. The **Next** and **Previous** options can be used to view the exterior orientation values of other images contained within the block.

The **Std.** fields allow for the specification of precisional quality concerning the input of exterior orientation parameters. The definition of statistical weight is optional. Defining statistical weight assists in the distribution and minimization of error throughout the block. These values are determined in the following manner:

- Evaluating the statistical output of existing aerial triangulation results of other software packages.
- If existing topographic maps have been used to derive initial approximations for exterior orientation, a statistical quality can be deduced from the scale and quality of the topographic map.
- If airborne GPS and INS data are used as input for exterior orientation, the statistical quality of the post-processed data can be used as input for the precisional quality of exterior orientation.

Once aerial triangulation has been performed and the **Update** button (within the Aerial Triangulation dialog) is selected, the **Value** fields within the tab are updated.
Exterior orientation parameters can have three status types: **Fixed**, **Initial**, and **Unknown**. The status type defines the manner in which the exterior orientation parameters are used during the aerial triangulation process.

- A **Fixed** status assumes that an exterior orientation value is fixed in position or orientation, and is not estimated or modified during aerial triangulation.

- An **Initial** status assumes that the exterior orientation value is an initial approximation to the actual value. This status uses a statistical weight if assigned. The statistical value that is assigned governs the amount of value fluctuation that occurs during the process of aerial triangulation.

- An **Unknown** status assumes that the exterior orientation parameters are completely unknown. Therefore, the aerial triangulation process estimates the parameters during aerial triangulation.

Rather than define the status for each exterior orientation parameter, the **Set Status** checkbox can be selected and used to set the status for each parameter automatically.

Selecting the **Next** or **Previous** button displays the exterior information for the next or previous image listed within the CellArray.

**Editing Exterior Information for Multiple Images**

Rather than edit the exterior orientation information for each image independently, functions are provided for editing multiple images simultaneously.

Selecting the **Edit All Images** button displays the Exterior Orientation Parameter Editor dialog, shown in **Figure 99**, containing all of the exterior information for each image in the block.

**Figure 99: Exterior Orientation Parameter Editor Dialog**
The Exterior Orientation Parameter Editor displays for each image:

- image name (cannot be edited)
- image ID (cannot be edited)
- X, Y, and Z coordinates of the perspective center
- Omega, Phi, and Kappa rotation angles
- standard deviation values for X, Y, and Z perspective center coordinates
- standard deviation values for Omega, Phi, and Kappa rotation angles
- status of X, Y, and Z perspective center coordinates (e.g., Initial, Fixed, Unknown)
- status of Omega, Phi, and Kappa rotation angles (e.g., Initial, Fixed, Unknown)

The status associated with the exterior orientation parameters can be changed by using the dropdown list activated with a left-click. Edits or modifications made within the editor are reflected within the Exterior Information tab. Once aerial triangulation has been performed and the Update button selected (within the Aerial Triangulation dialog), the results are updated within the Exterior Information tab and Exterior Orientation Parameter Editor.

### Importing Exterior Orientation Values and Information

Using the CellArray capabilities of the Exterior Orientation Parameter Editor, an ASCII file containing the exterior orientation parameters and statistical information along with status information can be imported. The following steps can be used:

1. Within the Exterior Orientation Parameter Editor, select the columns to be imported using a left-click and drag. The selected columns become highlighted.
2. Right-click to display the column CellArray options.
3. Select the Import option.
4. Specify the input ASCII file.
5. Ensure that the appropriate column name is associated with the corresponding information in the ASCII file.
Exporting Exterior Orientation Values and Information

Exporting Exterior Orientation Values and Information

Using the CellArray capabilities of the Exterior Orientation Parameter Editor, an ASCII file containing the exterior orientation parameters and statistical information along with status information can be exported. The following steps can be used:

1. Within the Exterior Orientation Parameter Editor, select the columns to be exported using a left-click and drag. The selected columns become highlighted.

2. Right-click to display the column CellArray options.

3. Select the Export option.

4. Specify the output ASCII file with a *.dat file extension.

5. Selecting the Options button within the Export Column Data dialog allows you to customize the output ASCII file.

Editing Statistical and Status Information

Editing Statistical and Status Information

The Exterior Orientation Parameter Editor is also useful in scenarios where the standard deviation and status for each exterior orientation parameter is the same for each image in a large block. In this case, the statistical or status information can be specified once and applied to each image in the block. The following steps are used:

1. Within the Exterior Orientation Parameter Editor select the Std. (Standard Deviation) or Sta. (Status) columns to be edited using a left-click and drag. The selected columns become highlighted.

2. Right-click to display the column CellArray options.

3. Select the Formula option. The dialog in Figure 100 opens.
4. For standard deviation (Std.) values, define the numerical value. For the status (Sta.), enter Fixed, Initial, or Unknown.

5. Click the Apply button to apply the value or status to each image in the block selected.

6. Select Close to return to the Exterior Orientation Parameter Editor.

Sensor Model Definition for SPOT, IRS-1C, and Generic Pushbroom Sensor Models

This section is applicable to imagery collected using the SPOT, IRS-1C, and generic pushbroom sensor models.

Selecting the Frame Editor option within the Edit menu or the Frame Editor icon on the LPS Project Manager toolbar displays the Frame Editor dialog for use with SPOT, IRS-1C, and generic pushbroom sensor models (Figure 101). The Frame Editor is used to define the properties associated with the internal and external parameters of the sensor models.

Figure 101: Frame Editor for Pushbroom Sensor Models
The Sensor tab allows for the attachment of an image name with the corresponding image file. The Attach button is used to attach image names to image files.

See “Attaching One Image” for more information.

If the SPOT sensor model was selected, the SPOT Pan (10-meter resolution imagery) and the SPOT Multispectral (20-meter resolution imagery), options are provided within the Sensor Name dropdown list. To edit the properties associated with the SPOT model, the Edit button can be selected, which opens the dialog depicted in Figure 102.

**Figure 102: Sensor Information Dialog for Pushbroom Sensor Models**

The default sensor model information displays—including the focal length of the sensor, pixel size of sensor, and the number of columns in the image. The information within the General tab was determined from the header file of the SPOT image. The Model Parameters tab displays the polynomial orders to be used during the triangulation process.

**Figure 103: Model Parameters Tab of the Sensor Information Dialog**
Uses of Model Parameters

Polynomial models are used to model the perspective center and rotation angles associated with the pushbroom sensor as they existed when the imagery was being collected. Since a pushbroom sensor has a perspective center for each scan line, the position and orientation of the sensor is different for each scan line. Thus, one-dimensional polynomial models are used to define the position and orientation of the sensor as they existed at the time of capture.

After triangulation has been performed, polynomial coefficients are calculated. The number of coefficients calculated is determined by the polynomial orders. If the polynomial order is defined as being 1 for each exterior orientation parameter, the total number of computed coefficients is 12 (that is, 6 for each set of exterior orientation parameters).

The larger the polynomial order specified, the greater the number of GCPs required to solve the triangulation solution. It is recommended that 10 or more evenly distributed GCPs be used. It is also recommended to use the default parameter setting in which the second order one-dimensional polynomial is used for perspective center X, Y, and Z and rotation angle Kappa. In Figure 103, the 0 order model (that is, single coefficient) is used for the rotation angles Omega and Phi.

If edits to an existing sensor model are made, the sensor model can be saved by selecting the Save option within the Sensor Information dialog. Additionally, a new sensor model can be created by selecting the New button within the Frame Editor dialog.

If the IRS-1C or Generic Pushbroom model were selected, the appropriate information associated with the image would be displayed within the Sensor Information dialog.

Defining Frame Attributes for SPOT, IRS-1C, and Generic Pushbroom Sensors

Selecting the Frame Attributes tab within the Frame Editor dialog allows for the definition of external sensor model parameters associated with an image, as depicted in Figure 104.
If a SPOT or IRS-1C image is being used, LPS Project Manager automatically reads the header information contained within the image to determine the external sensor model information. For both SPOT and IRS-1C, the side incidence angle and ground resolution information is provided. If the Generic Pushbroom model is being used, the additional options of defining the track incidence angles and scanning direction are also provided.

The side incidence angle is the angle between the vertical position of the satellite and the side viewing direction of the satellite when the sensor is scanning along the side. For SPOT imagery, the angle ranges between +27 to -27 degrees. The scanning direction is perpendicular to the direction of flight.

The track incidence angle is the angle between the vertical position of the satellite and the forward or backward viewing direction of the satellite. Track incidence angle is used for the German MOMS satellite imagery. For SPOT data, the track incidence angle is 0.

The sensor line defines the direction of the scan line which is used by the satellite to record the data. SPOT and IRS-1C use the x-direction as the scan line. Each scan line has associated with it a perspective center with six exterior orientation parameters including X, Y, Z, omega, phi, and kappa. LPS Project Manager computes the exterior orientation parameters of the scan lines based on measured GCPs.

**Sensor Model Definition for IKONOS Sensor Model**

In order to accurately create or extract geographic information from raw IKONOS imagery, the Image Geometry Model (IGM) must accompany the imagery. The IGM consists of several metadata files which contain RPCs. The RPCs are a series of coefficients that describe the relationship between the image as it existed when captured and the Earth’s surface. With the availability of RPCs, the IKONOS interior and exterior orientation is very accurate.
The Sensor tab on the Frame Editor dialog is where you provide LPS Project Manager with RPC information necessary to create the sensor model. **Figure 105** depicts the sensor setup of IKONOS imagery.

**Figure 105: Sensor Tab for IKONOS Sensor Model**

![Sensor Tab for IKONOS Sensor Model](image)

The software looks for the RPC file in the same directory as the .tif file you added to the block file. Also included is a place for you to supply the minimum and maximum elevation (in meters) of the IKONOS scene. This information improves the accuracy of the output orthoimage.

**Figure 106: Chipping Tab for IKONOS Sensor Model**

![Chipping Tab for IKONOS Sensor Model](image)

The chipping tab allows calculation of RPCs for an image chip rather than the full, original image from which the chip was derived. This is possible when you specify an affine relationship (pixel) between the chip and the full, original image.
Use of this tab is only required when the RPCs that accompany the image chip correspond to the full, original image and not the chip itself. Typically, this is not the case.

In the case of **Arbitrary Affine**, the formulas are as follows:

\[
\begin{align*}
x' &= ax + by + c \\
y' &= dx + ey + f
\end{align*}
\]

In the formulas, \(x'\) (x prime) and \(y'\) (y prime) correspond to pixel coordinates in the full, original image. The values \(x\) and \(y\) correspond to pixel coordinates in the chip you are currently working with. Values for the following variables are either obtained from the header data of the chip, or default to predetermined values:

- \(a\): A scale factor which is also used in rotation. In the absence of header data, this value defaults to 1.
- \(b\): A value used in rotation. In the absence of header data, this value defaults to 0.
- \(c\): An offset value. In the absence of header data, this value defaults to 0.
- \(d\): A value used in rotation. In the absence of header data, this value defaults to 0.
- \(e\): A scale factor that is also used in rotation. In the absence of header data, this value defaults to 1.
- \(f\): An offset value. In the absence of header data, this value defaults to 0.

In the case of **Scale and Offset**, the formulas are as follows:

\[
\begin{align*}
x' &= colscale^x x + coloffset \\
y' &= rowscale^x y + rowoffset
\end{align*}
\]
In the formulas, \( x' \) (x prime) and \( y' \) (y prime) correspond to the pixel coordinates for the full, original image. Otherwise, the values correspond to those used in the Arbitrary Affine, above, as follows:

- \( \text{colscale} \) = (Column Scale) This value corresponds to value \( e \), as defined above.
- \( \text{coloffset} \) = (Column Offset) This value corresponds to value \( f \), as defined above.
- \( \text{rowscale} \) = (Row Scale) This value corresponds to value \( a \), as defined above.
- \( \text{rowoffset} \) = (Row Offset) This value corresponds to value \( c \), as defined above.

The values for \( b \) and \( d \), as defined above, are set to 0.

The **Full Row Count** is the number of rows in the full, original image. If the header data is absent, this value corresponds to the row count of the chip. Likewise, the **Full Column Count** is the number of columns in the full, original image. If the header data is absent, this value corresponds to the column count of the chip.
Introduction

The Point Measurement tool, shown in Figure 107 is used to measure the GCPs, check points, and tie points appearing on one or more overlapping images. The Point Measurement tool serves several purposes including:

- collecting and entering GCP and check point coordinates
- measuring the image positions of GCPs, check points, and tie points
- defining the statistical quality of the GCPs
- launching processes associated with automatic tie point collection and aerial triangulation

Figure 107: Point Measurement Tool
The Point Measurement tool can be divided into three categories: Point Measurement views, Point Measurement CellArrays, and Point Measurement tools.

**Point Measurement Views**

The Point Measurement tool allows for the display of two images contained within a block. Each image has associated with it an OverView, Main View and Detail View. A Link Cursor located within the OverView and Main View is used to zoom in and out of an image area and roam around an image to identify the image positions of GCPs, check points, and tie points. Within the Point Measurement views, the image positions of GCPs, check points, and tie points can be measured. The Detail View is commonly used for image measurement.

**Image Enhancement**

To increase the quality of Point Measurement, the images displayed within the Point Measurement views can be enhanced to optimize GCP identification and measurement. The following options are provided for enhancing the display of an image:

- **Brightness and Contrast Controls.** Changes to the brightness and contrast levels can be applied to the Main View and Detail View in the Point Measurement tool.

- **Set Resampling Method.** A right-click within any of the three views: OverView, Main View, Detail View) displays the Set Resampling Method option (Figure 108). Selecting the Set Resampling Method option provides three image resampling methods including Nearest Neighbor, Bilinear Interpolation, Cubic Convolution, and Bicubic Spline.

  **Figure 108: Set Resampling Method Dialog**

  ![Set Resampling Method Dialog]

  Selecting the Nearest Neighbor option within the Detail View is optimum for identifying and measuring the location of a GCP to sub-pixel accuracy.

- **Data Scaling.** The distribution of grey levels for a image can be modified to enhance the display of the GCP locations. A right-click within any of the three views (OverView, Main View, Detail View) displays the Set Data Scaling dialog (Figure 109).
Adjusting the histogram adjusts the display of the image to enhance point identification and measurement.

- **General Contrast Options.** Sophisticated image enhancement tools are provided that allow for the variation of image display. A right-click within any of the three views (OverView, Main View, Detail View) displays the General Contrast option, as shown in Figure 110.

- **Band Combinations.** If using color or multispectral images comprising several bands of imagery, the band combinations can be used to assist in distinguishing and identifying GCPs. Figure 111 shows the interface.
Defining the Type of GCPs

The type of GCP defines the characteristics of the point and how the GCP is to be used by LPS Project Manager during the aerial triangulation procedure. The Type column within the Point Measurement tool reference CellArray displays one of the four different GCP types including: Full, Horizontal, Vertical, and None.

A Full control or check point has X, Y, and Z coordinates associated with it. Each control point can also have a standard deviation associated with it. A standard deviation value can be used to specify the quality of the GCP during the aerial triangulation procedure.

A Horizontal control or check point has X and Y coordinates associated with it. Each horizontal control point can also have a standard deviation associated with it. The Z coordinate for the control point is unknown and is estimated during the aerial triangulation process.

A Vertical control or check point has a Z coordinate associated with it. Each vertical control point can also have a standard deviation associated with it. The X and Y coordinates for this control point are unknown and are estimated during the aerial triangulation process.

A None specification is used for tie points. Its image positions are known and have been measured, but its X, Y, and Z coordinates are estimated during the aerial triangulation procedure.

To edit the Type designation for one point in the project, right-click the Type cell and select the appropriate designation.

To edit the Type designation for all of the points within a project, select the Type column within the Point Measurement tool reference CellArray and choose the Formula option. Within the Formula dialog, input the appropriate designation and select Apply. The Type designation is applied to all of the points simultaneously.

Defining the Usage of GCPs

The usage of a GCP defines whether the GCP is a control point, check point, or tie point.

A control point has either its X, Y, and Z coordinates known (Full), X and Y coordinates known (Horizontal), or Z coordinates known (Vertical). During the aerial triangulation procedure, the X, Y, and Z coordinates of a Full GCP can be fixed. If a standard deviation is assigned to Full GCPs, the values are modified during aerial triangulation. The Z coordinate of a horizontal control point is estimated during the aerial triangulation procedure. The X and Y coordinates of a vertical control point are estimated during the aerial triangulation procedure.
A check point is used to independently verify the quality of an aerial triangulation solution. During aerial triangulation, the X, Y, and Z coordinates of a check point are not used. The image coordinates are used to compute new X, Y, and Z coordinates. The newly computed coordinates of the check points are subtracted from the input values. The differences in coordinate values are residuals which are displayed within the X Residual, Y Residual, and/or Z Residual columns of the Point Measurement tool CellArray.

Display the X, Y, and Z residual columns by selecting the Viewing Properties icon. Then click the Advanced radio button and the Residual checkbox.

A tie point is the image/photo-coordinate position of an object appearing on two or more images with overlapping areas. The X, Y, and Z coordinates of a tie point are determined by LPS Project Manager during the aerial triangulation procedure. The resulting X, Y, and Z coordinates are then displayed within the X Reference, Y Reference, and Z Reference columns of the CellArray if the triangulation results are accepted. Once the coordinates of a tie point have been estimated, the point can be used as a control point for other applications (for example, geo correction). This approach in creating control points is also known as control point extension.

To edit the Usage designation for one point in the project, right-click the Usage cell and select the appropriate designation.

To edit the Usage designation for all of the points within a project, select the Usage column within the Point Measurement tool CellArray and choose the Formula option. Within the Formula dialog, input the appropriate designation and select Apply. The Usage designation is applied to all of the points which were selected simultaneously.

Importing Ground Coordinates Using the CellArray

1. Add the number of points to be imported by clicking the Add button within the Point Measurement tool.

2. Within the Point Measurement tool CellArray, select the appropriate columns to be imported. This may include:
   - Point ID
   - Description
   - Type
   - Usage
328 Measuring GCPs, Check Points, and Tie Points

- X, Y, Z
- Std X, Std, Y, Std Z

💡 **Hold the Shift key on the keyboard and left-click to select nonadjacent columns.**

3. Right-click to display the column CellArray options.

4. Select the **Import** option.

5. Select the **Import** ASCII file name.

6. To customize the import procedure, select the **Options** button within the Import Column Data dialog. Customize the import procedure as a function of delimiters, row terminator, and column mapping.

7. Select **OK** to import the GCP information contained within the ASCII file.

### Exporting Ground Coordinates Using the CellArray

1. Within the Point Measurement tool CellArray, select the appropriate columns to be exported. These may include:
   - Point ID
   - Description
   - Type
   - Usage
   - X, Y, Z
   - Std. Xo, Std. Yo, Std. Zo, etc.

💡 **Hold the Shift key on the keyboard and left-click to select nonadjacent columns.**

2. Right-click to display the column CellArray options.

3. Select the **Export** option.

4. Enter the **Output** ASCII file name. The ASCII file is stored as a *.dat file.

5. To customize the export procedure, select the **Options** button within the Export Column Data dialog. Customize the export procedure as a function of delimiters, row terminator, and column mapping.
6. Select OK to export the ground coordinate information to the specified ASCII file.

**Defining the Statistical Quality of GCPs**

The quality of GCPs obtained from various reference sources can be defined to optimize the distribution of error throughout the block during the triangulation procedure. A standard deviation can be assigned to the GCPs to indicate the quality of the GCPs. For example, if a GCP was digitized off a topographic map, and the accuracy of the topographic map was 20 meters in X, Y, and 10 meters in Z, the corresponding standard deviation of the GCP would be 20 meters for X and Y, and 10 meters for Z.

If the GCPs have different standard deviation values associated with them, the Point Measurement tool should be used to input the statistical information. If all of the GCPs have the same standard deviation values, the **Point** tab of the Aerial Triangulation dialog can be used to input the statistical information.

---

See “**Assigning Statistical Weights to GCPs**” for more information about assigning statistical weights.

---

The following steps are used to define the statistical quality of the GCPs:

1. Select the Viewing Properties icon within the Point Measurement tool.

   The dialog shown in **Figure 112** opens.

   ![Figure 112: Viewing Properties Dialog](image)

2. Select the **Advanced** radio button, and choose the **Std.** option. Select **OK**. The **X**, **Y**, and **Z Std.** columns are displayed within the Point Measurement tool CellArray.
3. Within the Point Measurement tool CellArray, select the appropriate Std. X, Y, Z (Standard Deviation) columns using a left-click and drag. The selected columns are highlighted.

4. Right-click to display the Column Options menu.

5. Select the Formula option. The dialog in Figure 113 opens.

   **Figure 113: Formula Dialog of the LPS CellArray**

6. Within the Formula dialog, input the appropriate standard deviation values. Selecting the Apply button applies the value to each GCP selected.

7. Select Close to return to the Point Measurement tool. Direct keyboard input can be used to specify the statistical quality of individual GCPs.

**Creating GCPs from Stereo Images**

Use this feature to create Ground Control Points from image points that you identify and which are contained in at least two images.

1. Click the Add button in the upper right-hand corner of the Point Measurement tool to add a new Point #.

   This adds a new row to the reference CellArray in the lower portion of the Point Measurement tool.

   ![Image showing Point IDs are added sequentially, but can be edited](image)

2. Click the Select Point icon in the Point Measurement tool palette.
3. Click in the first image on the easily identifiable point that you want to use as a GCP.

4. Click in the second image on the same point, then click the Create Ground Point icon. Notice that the CellArray updates the two selected points with the X,Y,Z coordinates, changes the Type to Full and the Usage to Control.

Collecting Horizontal Reference GCPs

LPS Project Manager supports the use of GCPs obtained from various reference sources. This includes existing orthorectified images, geo corrected images, vector Arc Coverages, annotation layers, ASCII text files, and digitizing tablets.

The Set Horizontal Reference Source option allows for the collection of horizontal GCPs. You select the reference source from the dialog depicted in Figure 114.

Figure 114: GCP Reference Source Dialog from the Point Measurement Tool

The following steps are used to collect GCPs from an existing orthorectified image:

1. Select the Set Horizontal Reference Source icon.

2. Select the Image Layer option in the GCP Reference Source dialog, then click OK.

3. Within the Reference Image Layer File Selector, specify the orthorectified image as the input file, and select OK. The horizontal reference source file name displays within the lower right portion of the Point Measurement tool.
4. Within the Point Measurement tool, click on the **Use Viewer As Reference Source** option.

5. The existing orthorectified image displays within the left portion of the Point Measurement views.

6. Select the **Add** button to begin collecting GCPs. The Detail View is ideal for the identification and measurement of horizontal reference GCPs. Once a point has been measured, the corresponding X and Y ground coordinates are displayed within the Point Measurement CellArray.

7. Identify and measure the corresponding image positions of the GCPs on the block of imagery.

   Ensure that the horizontal reference GCPs conform to the same projection, spheroid, and datum as the block.

### Collecting Vertical Reference GCPs

If horizontal GCPs have already been collected, the following steps are used to define the vertical (Z) component of existing horizontal GCPs:

1. Select the Set Vertical Reference Source icon 

2. If a DEM is available, select the **DEM** option and define the DEM file. If a DEM is not available and the area is relatively flat, select the **Constant** option. The vertical reference source file name display within the lower-right portion of the Point Measurement tool.

3. Within the Point Measurement tool CellArray, left-click within the **Point #** column to select the GCPs. Its vertical component is automatically updated.

4. Select the Update Z icon within the Point Measurement tool. The Z coordinates of the GCPs are updated and displayed within the CellArray.

   During the collection of horizontal GCPs, the vertical component of the GCPs can be automatically populated using the following steps:

1. Select the Set Vertical Reference Source icon 

2. If a DEM is available, select the **DEM** option and define the DEM file. If a DEM is not available and the area is relatively flat, select the **Constant** option. The vertical reference source file name displays within the lower-right portion of the Point Measurement tool.

3. Select the Automatic Z Update icon . An “x” displays within the icon once it has been selected .
4. The vertical component of a GCP is automatically added once a horizontal GCP has been measured. Ensure that the vertical reference GCPs conform to the same projection, spheroid, and datum as the block.

Collecting GCPs on Multiple Images

For projects comprising the use of three or more images within a strip, as illustrated by Figure 115, the following steps can be used for the collection of GCPs:

Figure 115: A Configuration of GCPs Located on Three Images

1. Within the Point Measurement tool, define Image 1 as the Left View and Image 2 as the Right View. The Left View and Right View image dropdown lists can be used to define which images are displayed within the Point Measurement tool.

2. Select the Automatic (X,Y) Drive icon to automatically display the image positions of GCPs on the overlap areas of two images. This capability is enabled when at least two GCPs have been measured on the overlap areas of two images. Once selected, the icon changes to the following:

3. Select the Add button six times. Enter the GCP coordinates of GCPs, or use the Set Horizontal Reference Source and Set Vertical Reference Source tools to define the GCP coordinates.

4. Identify and measure the image positions of GCP 1, 2, and 3 on Image 1 and Image 2.

5. Repeat step 3. and step 4. for GCPs 4, 5, and 6 on Image 1 and Image 2. The image positions of GCPs 4, 5, and 6 are automatically displayed prior to the collection of each point.

6. Within the Right View tools group, select the Apply Image Shift radio button.
7. Within the **Right View** tools group image dropdown list, select Image 3. Image 2 is automatically placed within the **Left View** of the Point Measurement tool.

8. Identify and measure the image positions of GCPs 4, 5, and 6 on Image 3.

**Collecting GCPs on Multiple Strips**

For projects comprising two or more strips within a block, as illustrated by **Figure 116**, the following steps can be used for the collection of GCPs:

**Figure 116: A Configuration of GCPs Located on Six Images**

1. Within the Point Measurement tool, define Image 1 as the **Left View** and Image 2 as the **Right View**. The **Left View** and **Right View** image dropdown lists can be used to define which images are displayed within the Point Measurement tool.

2. Select the Automatic (X,Y) Drive icon to automatically display the image positions of GCPs on the overlap area of two images. This capability is enabled when at least two GCPs have been measured on the overlap area of two images. Once selected, the icon changes to the following: 

3. Select the **Add** button six times. Enter the GCP coordinates of GCPs or use the Set Horizontal Reference Source icon and Set Vertical Reference Source icon to define the GCP coordinates.
4. Identify and measure the image positions of GCP 1, 2, and 4 on Image 1 and Image 2.

5. Within the **Right View** tools group, select the **Apply Image Shift** radio button.

6. Within the **Right View** tools group image dropdown list, select Image 3. Image 2 is automatically placed within the **Left View** of the Point Measurement tool.

7. Identify and measure the image positions of GCPs 4 and 5 on Image 3.

8. Deactivate the **Apply Image Shift** option within the **Right View** tools group.

9. Within the **Left View** tools group image dropdown list, select Image 4 and within the **Right View** tools group image dropdown list, select Image 5.

10. Select the **Apply Image Shift** radio button within the **Right View** tools group.

11. Identify and measure the image positions of GCP 2, 3, 5, and 6 on Image 4 and Image 5.

12. Within the **Right View** tools group image dropdown list, select Image 6. Image 5 is automatically displayed within the **Left View** of the Point Measurement tool.


Once a GCP, check point, or tie point has been measured, the image coordinates are displayed within the right portion of the Point Measurement tool CellArray.
Automatic Tie Point Collection

Introduction

Automatic tie point collection utilizes digital image matching techniques to automatically identify and measure the image positions of GCPs appearing on two or more images with overlap.

Rather than manually identify and measure tie points on the overlap areas of multiple images, LPS Project Manager automates the procedure. LPS Project Manager supports the processing of multiple strips of imagery, including adjacent, diagonal, and cross-strips.

The maximum number of tie points intended for each image is 500. If the Keep All Points option is used, the number of tie points collected for each image exceeds 500 points.

Automatic tie point collection successfully performs the following tasks:

- Automatic block configuration. Based on the initial input requirements, LPS Project Manager defines the extent of the block with respect to image adjacency.

- Automatic tie point extraction. Image feature points are automatically extracted using an interest operator.

- Point transfer. Ground points appearing on multiple images are automatically identified and matched.

- Gross error detection. Erroneous points are automatically identified and removed from the solution.

- Tie point selection. The intended number of tie points defined is automatically selected as the final number of tie points.

By selecting the Automatic Tie Point Generation Properties option within the Edit menu of the LPS Project Manager, or by selecting the Automatic Tie Point Generation Properties icon within the Point Measurement tool, the Automatic Tie Point Generation Properties dialog in Figure 117 opens.
**Minimum Input Requirements**

Since automatic tie point collection processes multiple images with overlap, LPS Project Manager requires information regarding image adjacency. The minimum input requirements are used to determine the block configuration with respect to which image is adjacent to which image, and which strip is adjacent to which strip in the block.

The minimum input requirement can be one of the following three:

- If processing frame camera, digital camera, videography, or nonmetric imagery, initial approximations to exterior orientation (X, Y, Z, Omega, Phi, Kappa) can be specified for each image in the block. These can be obtained from existing aerial triangulation results, airborne GPS and INS data, or calculated from an existing cartographic map (Omega and Phi can be assumed 0 if the degree of photographic or image tilt is minimal). If processing multiple strips of images captured with different direction of flight, the appropriate Kappa element must be specified. The **Exterior/Header/GCP** radio button is selected as the **Initial Type**.

- If processing SPOT, IRS-1C, or generic pushbroom imagery, the ephemeris information (containing orbit and track information) contained within the header file of the image is used.

- If processing IKONOS imagery, the interior and exterior orientation information is contained within the RPC file associated with each image.

- At least two GCPs must be measured on the overlap areas for the imagery in the block. The **Exterior/Header/GCP** radio button is selected as the **Initial Type**.

- At least two tie points must be measured on the overlap areas of the imagery in the block. Figure 118 illustrates the GCP or tie point configuration required to perform automatic tie point collection on six overlapping images comprising two strips. The **Tie Points** radio button is selected as the **Initial Type**.

![Figure 117: Automatic Tie Point Generation Properties Dialog](image)
Performing Automatic Tie Point Collection: An Alternative Solution

For scenarios where initial approximations to exterior orientation are unknown, GCPs are unavailable and measuring two tie points is unrealistic (too many images in the block), but an alternative solution can be used to provide the minimum input required to perform automatic tie point collection.

The procedure involves establishing a relative relationship between the images contained in the block and the ground. The relative relationship is defined by establishing the relative X, Y, and Z coordinates of the perspective center for each image.

In order to compute the relative X, Y, and Z coordinates for the perspective center, the minimum input information includes a focal length (inches or in millimeters) and scale of photography. **Figure 119** illustrates a sample block of images. Its relative X, Y, and Z perspective center coordinates can be determined. The circle appearing in the central portion of the individual images is the perspective center.

**Figure 119: Location of the Perspective Center for Six Images**
Assuming a 1:40000 scale photography (60% overlap and 30% sidelap), and a six inch (152 mm) focal length (9 × 9 inch image size), the relative X, Y, and Z coordinates of the individual perspective centers are given in Table 7.

Table 7: Perspective Center Coordinates

<table>
<thead>
<tr>
<th>Image</th>
<th>X (meters)</th>
<th>Y (meters)</th>
<th>Z (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>6096</td>
</tr>
<tr>
<td>2</td>
<td>3658</td>
<td>0</td>
<td>6096</td>
</tr>
<tr>
<td>3</td>
<td>7316</td>
<td>0</td>
<td>6096</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>6401</td>
<td>6096</td>
</tr>
<tr>
<td>5</td>
<td>3658</td>
<td>6401</td>
<td>6096</td>
</tr>
<tr>
<td>6</td>
<td>7316</td>
<td>6401</td>
<td>6096</td>
</tr>
</tbody>
</table>

The perspective center of Image 1 would serve as the origin of the X and Y coordinate system (for example, 0, 0). Every other X and Y perspective center coordinate is relative to Image 1. Assuming minimal photographic tilt, the Omega and Phi rotation angles are negligible. An ASCII file containing the approximate relative exterior orientation information can be imported into LPS Project Manager and used for automatic tie point collection. The information can be imported using the Edit All Images option contained within the Exterior Information tab of the Frame Editor dialog.

In the previous scenario, the X coordinate is considered the base between the exposure stations along a strip having 60% overlap (that is, 3658 meters). The X coordinate for Image 3 is doubled relative to its distance from Image 1. The Y coordinate is considered the base between the strips that have 30% sidelap. The Z coordinate is considered the average flying height (above sea level).

Table 8 provides the Base X (overlap with 60%), Base Y (sidelap with 30%), and average flying height for various scales of photography in feet.

Table 8: Photography Scale and Associated Data (Feet)

<table>
<thead>
<tr>
<th>Photo Scale 1 to...</th>
<th>Flying Height (feet)</th>
<th>Ground Coverage (feet)</th>
<th>Overlap 60% (feet)</th>
<th>Sidelap 30% (feet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1800</td>
<td>900</td>
<td>1350</td>
<td>540</td>
<td>945</td>
</tr>
</tbody>
</table>
Table 8: Photography Scale and Associated Data (Feet)

<table>
<thead>
<tr>
<th>Photo Scale 1 to...</th>
<th>Flying Height (feet)</th>
<th>Ground Coverage (feet)</th>
<th>Overlap 60% (feet)</th>
<th>Sidelap 30% (feet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2400</td>
<td>1200</td>
<td>1800</td>
<td>720</td>
<td>1260</td>
</tr>
<tr>
<td>3000</td>
<td>1500</td>
<td>2250</td>
<td>900</td>
<td>1575</td>
</tr>
<tr>
<td>3600</td>
<td>1800</td>
<td>2700</td>
<td>1080</td>
<td>1890</td>
</tr>
<tr>
<td>4200</td>
<td>2100</td>
<td>3150</td>
<td>1260</td>
<td>2205</td>
</tr>
<tr>
<td>4800</td>
<td>2400</td>
<td>3600</td>
<td>1440</td>
<td>2520</td>
</tr>
<tr>
<td>5400</td>
<td>2700</td>
<td>4050</td>
<td>1620</td>
<td>2835</td>
</tr>
<tr>
<td>6000</td>
<td>3000</td>
<td>4500</td>
<td>1800</td>
<td>3150</td>
</tr>
<tr>
<td>6600</td>
<td>3300</td>
<td>4950</td>
<td>1980</td>
<td>3465</td>
</tr>
<tr>
<td>7200</td>
<td>3600</td>
<td>5400</td>
<td>2160</td>
<td>3780</td>
</tr>
<tr>
<td>7800</td>
<td>3900</td>
<td>5850</td>
<td>2340</td>
<td>4095</td>
</tr>
<tr>
<td>8400</td>
<td>4200</td>
<td>6300</td>
<td>2520</td>
<td>4410</td>
</tr>
<tr>
<td>9000</td>
<td>4500</td>
<td>6750</td>
<td>2700</td>
<td>4725</td>
</tr>
<tr>
<td>9600</td>
<td>4800</td>
<td>7200</td>
<td>2880</td>
<td>5040</td>
</tr>
<tr>
<td>10800</td>
<td>5400</td>
<td>8100</td>
<td>3240</td>
<td>5670</td>
</tr>
<tr>
<td>12000</td>
<td>6000</td>
<td>9000</td>
<td>3600</td>
<td>6300</td>
</tr>
<tr>
<td>15000</td>
<td>7500</td>
<td>11250</td>
<td>4500</td>
<td>7875</td>
</tr>
<tr>
<td>18000</td>
<td>9000</td>
<td>13500</td>
<td>5400</td>
<td>9450</td>
</tr>
<tr>
<td>24000</td>
<td>12000</td>
<td>18000</td>
<td>7200</td>
<td>12600</td>
</tr>
<tr>
<td>30000</td>
<td>15000</td>
<td>22500</td>
<td>9000</td>
<td>15750</td>
</tr>
<tr>
<td>40000</td>
<td>20000</td>
<td>30000</td>
<td>12000</td>
<td>21000</td>
</tr>
<tr>
<td>50000</td>
<td>25000</td>
<td>37500</td>
<td>15000</td>
<td>26250</td>
</tr>
<tr>
<td>60000</td>
<td>30000</td>
<td>45000</td>
<td>18000</td>
<td>31500</td>
</tr>
</tbody>
</table>

Table 9 provides the Base X (overlap with 60%), Base Y (sidelap with 30%) and average flying height for various scales of photography in meters.
To compute the Base X and Base Y components for photographs containing different percentage overlap and sidelap, multiply the Ground Coverage by the appropriate percentage. For example, to compute Base Y having a sidelap of 10%, multiply 0.9 by the ground coverage. Similarly, to compute the Base X having a overlap of 30%, multiply 0.7 by the ground coverage.

<table>
<thead>
<tr>
<th>Photo Scale 1 to...</th>
<th>Flying Height (meters)</th>
<th>Ground Coverage (meters)</th>
<th>Overlap 60% (meters)</th>
<th>Sidelap 30% (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1800</td>
<td>274</td>
<td>411</td>
<td>165</td>
<td>288</td>
</tr>
<tr>
<td>2400</td>
<td>366</td>
<td>549</td>
<td>219</td>
<td>384</td>
</tr>
<tr>
<td>3000</td>
<td>457</td>
<td>686</td>
<td>274</td>
<td>480</td>
</tr>
<tr>
<td>3600</td>
<td>549</td>
<td>823</td>
<td>329</td>
<td>576</td>
</tr>
<tr>
<td>4200</td>
<td>640</td>
<td>960</td>
<td>384</td>
<td>672</td>
</tr>
<tr>
<td>4800</td>
<td>732</td>
<td>1097</td>
<td>439</td>
<td>768</td>
</tr>
<tr>
<td>5400</td>
<td>823</td>
<td>1234</td>
<td>494</td>
<td>864</td>
</tr>
<tr>
<td>6000</td>
<td>914</td>
<td>1372</td>
<td>549</td>
<td>960</td>
</tr>
<tr>
<td>6600</td>
<td>1006</td>
<td>1509</td>
<td>604</td>
<td>1056</td>
</tr>
<tr>
<td>7200</td>
<td>1097</td>
<td>1646</td>
<td>658</td>
<td>1152</td>
</tr>
<tr>
<td>7800</td>
<td>1189</td>
<td>1783</td>
<td>713</td>
<td>1248</td>
</tr>
<tr>
<td>8400</td>
<td>1280</td>
<td>1920</td>
<td>768</td>
<td>1344</td>
</tr>
<tr>
<td>9000</td>
<td>1372</td>
<td>2057</td>
<td>823</td>
<td>1440</td>
</tr>
<tr>
<td>9600</td>
<td>1463</td>
<td>2195</td>
<td>878</td>
<td>1536</td>
</tr>
<tr>
<td>10800</td>
<td>1646</td>
<td>2469</td>
<td>988</td>
<td>1728</td>
</tr>
<tr>
<td>12000</td>
<td>1829</td>
<td>2743</td>
<td>1097</td>
<td>1920</td>
</tr>
<tr>
<td>15000</td>
<td>2286</td>
<td>3429</td>
<td>1372</td>
<td>2400</td>
</tr>
<tr>
<td>18000</td>
<td>2743</td>
<td>4115</td>
<td>1646</td>
<td>2880</td>
</tr>
<tr>
<td>24000</td>
<td>3658</td>
<td>5486</td>
<td>2195</td>
<td>3841</td>
</tr>
<tr>
<td>30000</td>
<td>4572</td>
<td>6858</td>
<td>2743</td>
<td>4801</td>
</tr>
<tr>
<td>40000</td>
<td>6096</td>
<td>9144</td>
<td>3658</td>
<td>6401</td>
</tr>
<tr>
<td>50000</td>
<td>7620</td>
<td>11430</td>
<td>4572</td>
<td>8001</td>
</tr>
<tr>
<td>60000</td>
<td>9144</td>
<td>13716</td>
<td>5486</td>
<td>9601</td>
</tr>
</tbody>
</table>
This approach is not suited for areas having large variations in relief displacement (for example, mountainous regions).

Once the relative orientation parameters have been computed, an ASCII file containing the information can be imported, or the values can be entered directly within the Exterior Information tab of the Frame Editor.

**Optimizing Automatic Tie Point Collection**

Strategy parameters governing the operation of the automatic tie point collection procedure can be used to optimize the performance of automatic tie point collection. The factors governing the overall performance of automatic tie point collection include:

- image quality (poor scanning)
- image content (deserts, water bodies)
- topographic relief displacement
- input quality of the minimum input requirements

Six strategy parameters are provided including:

- search size (pixels)
- correlation size (pixels)
- least squares size (pixels)
- feature point density (10% to 900%)
- coefficient limit (0 to 0.99)
- initial accuracy (0% to 150%)

**Search Size**

Once all of the interest or feature points have been identified, LPS Project Manager calculates the approximate location of feature points on the overlapping areas of multiple images. Once an approximate location has been identified, LPS Project Manager searches for the corresponding image positions within a square search window. The size of the search window can be defined. For areas with large topographic relief displacement, a larger search size is recommended. If the default $21 \times 21$-pixel search window size is increased, an increase in computation time can be expected.
Correlation Size

Correlation size defines the size of the window to be used to compute the correlation between image points of common ground points appearing on multiple images. The default window size is $7 \times 7$. For areas containing minimal variation in topographic relief, grey level or color intensity (for example, desert, agricultural fields, grassy areas), a larger value (for example, $9 \times 9$ or greater) can be used. For areas containing large degrees of topographic relief and grey level or color intensity variation, a smaller window size is recommended (for example, $5 \times 5$). If the default values are modified, ensure the quality of the resulting tie points.

Least Squares Size

Least squares matching techniques are used to ensure that the quality of the corresponding matched points is accurate to approximately 0.1 to 0.2 pixels. The least square size defines the window size of the two windows appearing over the overlapping area of two images during the least squares matching process. A larger window size reduces the number of false matches, but may also increase the percentage of false matches. Similarly, a smaller window size may increase the number of false matches while maintaining a large percentage of good matches. For areas with minimal relief displacement, a larger window size can be specified. For areas containing large degrees of variation in image content (urban areas) or relief displacement (rugged and mountainous terrain), a smaller value is recommended.

Feature Point Density

During the automatic extraction of feature points, LPS Project Manager calculates interest or feature points which consist of points having large amounts of grey level variation within a local neighborhood of pixels. LPS Project Manager automatically determines the density of points located throughout the overlapping areas of the images. The default feature density is 100%. A value of 300% stipulates that LPS Project Manager automatically collects three times the number of points it normally collects. A value of 50% stipulates that LPS Project Manager automatically collects 50% fewer points than it normally collects. For images containing poor image contrast, a higher value is recommended. For images containing large amounts of detail (forested and urban areas), or that have a sharp image contrast, using a smaller value is recommended.
Correlation Limit

The correlation limit defines the correlation coefficient threshold used to determine whether or not two points are to be considered as possible matches. Once the correlation between two points appearing on two frames has been computed, the correlation limit is compared to the correlation coefficient. If the correlation coefficient is smaller than the correlation limit, the two points are not considered a match. A larger correlation limit may result in greater accuracy, although fewer points may be collected. If a smaller correlation limit results, it may increase the number of correlated points, but could introduce false match points into the solution.

Initial Accuracy

Initial accuracy defines the input quality of the input minimum requirements. If exterior orientation parameters or header information is used, the parameters should be accurate to 25% of the true value. A larger value increases the initial search area to identify and match corresponding image points in the initial estimation process. If GCPs or tie points are used as the Initial Type, the initial accuracy is considered as the relative elevation difference (that is, average elevation difference divided by the flying height). If the minimum input requirements are of poor precisional and relative quality, a larger value is recommended. Therefore, if accurate initial values are available, specify a low value. If inaccurate initial values are available, a larger value should be specified.

Avoid Shadow

When this option is enabled, tie points are not generated in areas of shadow, such as building and terrain shadows produced by the sun’s position at the time of image capture. Avoiding areas in shadow improves auto tie results. You should choose whether the images you are working with came from film (Negative) or photographs (Positive).
The shadow displacement can be estimated with the above equations. The shadow displacement is dependent on the object height $h$ and the time difference of two adjacent images $\Delta t = t1 - t2$. Since the airplane flies forward (west to east) on the first strip, and backward (east to west) on the second strip, the maximal time difference (the maximal shadow displacement) occurs between the first image of the first strip and the last image of the second strip.

In the above equations, $a$ is in degrees and can be estimated by the photographic time (in 24-hour mode), $a = (p\_time - 12) \times 15$. For example, if the time of flight is around 1:15 p.m., then $a = 13.25 - 12 \times 15 = 18.75$ degrees. If the airplane takes 2 minutes to fly one strip, then the maximal time difference will be 4 minutes (240 seconds). If we assume that the flight is around 1:15 p.m. in a suburban area where buildings are not higher than 10 meters, the strip is relatively long and takes two minutes to finish, then using the above equation yields the maximal shadow displacement will be 0.19 meters. If we assume the image scale is 1:10,000 and image is scanned with a pixel size of 0.030 mm, then this displacement has already reached 0.6 pixels. If the maximal shadow replacement exceeds a half pixel, we recommend using the Avoid Shadow option. If the maximal shadow replacement is less than one third of a pixel you probably do not need to use the Avoid Shadow option. If your block only has one strip, you do not need to use the Avoid Shadow option because there is usually almost no shadow displacement between two adjacent images inside a strip.

### Performing Automatic Tie Point Collection on Color Imagery

With color imagery, automatic tie point collection is performed on one image layer or band, defined by the Image Layer Used option within the Automatic Tie Generation Properties dialog.

Prior to performing automatic tie point collection on color imagery, it is highly recommended that the individual image layers be viewed to identify which layer or band contains the greatest amount of grey level variation.

Automatically collected tie points can be verified within the Point Measurement tool by viewing the image positions of the tie points on the overlap area of the two frames.

### Troubleshooting Tips

The following tips can be used in cases where the automatic tie point collection fails to successfully match image points appearing on multiple images:
• If exterior orientation parameters or GCPs were used as the Initial Type, manually measure two tie points within the overlapping areas of two images and Run the automatic tie point collection.

• If initial approximations for exterior orientation are used and the automatic tie point collection process fails to provide a solution, the Kappa element associated with the exterior orientation parameters should be checked and modified if required.

The following steps can be used to ensure that the appropriate Kappa element be defined:

• Ensure that the appropriate image/photo-coordinate system is defined. The image coordinate system defines the direction of the x and y image coordinate system. This system is defined by measuring the fiducial marks on the imagery and selecting the appropriate fiducial orientation.

Refer to “Interior Orientation” for more information.

• Define the direction of the X, Y, and Z ground coordinate axes. This involves determining the easting (X) and northing (Y) of the ground coordinate system. The Z coordinate is normally vertical.

• Determine the relationship between the image coordinate system and the ground coordinate system. Once the relationship has been determined, the appropriate Kappa value can be assigned to exterior orientation. The images in Figure 120 illustrate four different options for defining the Kappa element as a function of the relationship between the image/photo-coordinate system and the ground coordinate system.
• Once the appropriate Kappa estimates have been determined, the sign or magnitude of the initial Kappa value should be changed in order for the automatic tie point collection procedure to work.
Block Triangulation

Introduction

Block triangulation is the process of defining the mathematical relationship between the images contained within a block, the camera or sensor model that obtained the images, and the ground. Once the relationship has been defined, accurate and intelligent imagery and information concerning the Earth’s surface can be created.

Block triangulation simultaneously estimates:

- The position (X, Y, Z) and orientation (Omega, Phi, Kappa) of each image in a block as they existed at the time of image capture.
- The X, Y, and Z coordinates of tie points collected manually or automatically throughout the block of images (point determination and positioning). Once the X, Y, and Z coordinates of tie points are computed, they can be converted to control points.
- The interior orientation parameters associated with a camera or sensor model. This process is commonly referred to as SCBA.
- AP characterizing systematic error within the block of images and observations (lens distortion).

When processing frame camera, digital camera, videography, and nonmetric camera imagery, block triangulation is commonly referred to as aerial triangulation. When processing imagery collected with a pushbroom sensor, block triangulation is commonly referred to as triangulation.

Both aerial triangulation and triangulation techniques utilize bundle block adjustment as the functional model to define the relationship between image space and ground space. To edit and view the properties associated with block triangulation, select the Triangulation Properties option within the Edit menu or select the Triangulation Properties icon within the Point Measurement tool. To run the triangulation process, select the Triangulation icon on the LPS Project Manager toolbar, Point Measurement tool, or the Triangulate option within the Process menu in the LPS Project Manager.

Aerial Triangulation

Parameters governing the operation of aerial triangulation can be defined to optimize the results of using the estimated parameters.
The Aerial Triangulation dialog, shown in Figure 121, allows for the input and specification of parameters associated with performing aerial triangulation on frame camera, digital camera, videography, and nonmetric camera imagery.

**Figure 121: General Tab of the Aerial Triangulation Dialog**

![Aerial Triangulation Dialog](image)

### Convergence Value

The convergence value is used as a threshold to determine the level and extent of processing during the iterative aerial triangulation procedure. During the iterative process of determining the unknown parameters, the amount of change between successive iterations is determined and compared to the convergence value. If the amount of change between successive iterations is greater than the convergence value, the iterative process continues. If the amount of change between successive iterations is less than the convergence value, the iterative process of estimating the unknown parameters ends.

For large scale mapping (for example, 1:2000 photo scale), and projects requiring high accuracy, a value of 0.0001 meters can be used. For small scale mapping projects (for example, greater than 1:40000), a value of 0.01 can be used, otherwise the default setting of 0.001 meters is satisfactory.

For scenarios where the quality of ground control is poor and an aerial triangulation solution cannot be solved, relaxing the convergence value (for example, 0.01 meters) may provide a solution. In this case, the accuracy of the aerial triangulation results is compromised.

### Accuracy Estimates

Regardless of the project, computing the accuracy estimates for the unknown parameters is highly recommended. The accuracy estimates describe the quality of the estimated parameters. The accuracy estimates are computed by multiplying the standard deviation of unit weight by the variance of the individual parameters. The variance of the computed parameters is determined and contained within an output covariance matrix. Accuracy estimates are computed for:

- exterior orientation parameters for each image
• X, Y, and Z coordinates of the tie points
• interior orientation parameters if SCBA is performed
• AP if a functional model is selected

The accuracy estimates are contained with the aerial triangulation report.

For information about the aerial triangulation report, see “Aerial Triangulation Report”.

**Optimizing Aerial Triangulation Using Statistical Information**

During the bundle block adjustment procedure of aerial triangulation, LPS Project Manager uses a statistical technique referred to as least squares adjustment to estimate the unknown parameters associated with the block of imagery. The least squares adjustment procedure minimizes and distributes error throughout a block. In order to effectively minimize and distribute error, the least squares adjustment uses the input statistical properties associated with the input data to determine the extent and nature of error minimization and distribution.

The statistical properties associated with the input data reflect the quality (for example, precision) of the data. The quality of the input data is defined using standard deviation values. For example, if a survey field crew used a GPS to collect GCPs accurate to 0.05 meters, the statistical property associated with the GCPs would be 0.05 meters. During aerial triangulation, the assigned statistical weight is used to govern the amount of allowable error which can be attributed and distributed to the GCPs.

Standard deviations can be associated with the following observations:

• image/photo-coordinate positions of GCPs, check points, and tie points
• X, Y, and Z GCPs
• exterior orientation parameters for each image in the block
• interior orientation parameters
• AP
Assigning Statistical Weights to Image/Photo-coordinates

Statistical weights can be assigned to the x and y image/photo-coordinates representing the image position quality for GCPs, check points, and tie points. The Point tab within the Aerial Triangulation dialog, shown in Figure 122, is used to define the standard deviations associated with the image/photo-coordinates.

Figure 122: Point Tab of the Aerial Triangulation Dialog

If the quality of the measured image/photo-coordinates is weak, a larger value can be used. It is highly recommended that a value less than 1 pixel be used. During the iterative aerial triangulation procedure, the image/photo-coordinates fluctuate within the limits of the standard deviations. Once aerial triangulation has been completed, the image/photo-coordinate residuals can be examined to determine if the appropriate statistical weight has been used.

If the x and y image/photo-coordinates have different measurement accuracies, different statistical weights should be assigned.

Assigning Statistical Weights to GCPs

Statistical weights can be assigned to the X, Y, and Z coordinates representing the ground quality of the GCPs used in the block. The Point tab within the Aerial Triangulation dialog is used to define the standard deviations associated with the GCPs. Within the Point tab of the Aerial Triangulation dialog, several options are provided for defining the statistical quality of the GCPs. They include:

- **Fixed Values.** This option assumes that the GCPs are fixed in the X, Y, and Z direction. Statistical weight is not assigned to the GCPs. If this option is selected, large standard deviation values can be anticipated for the estimated exterior orientation parameters and the X, Y, and Z tie point positions. This can be attributed to the distribution of error into these parameters, since error was not allowed to propagate throughout the GCPs.
• **Same Weighted Values.** This option allows for the specification of a uniform statistical weight to the X, Y, and Z GCP coordinates. The statistical weight assigned can be determined as a function of the quality of the input GCP coordinates.

• **Different Weighted Values.** This option allows for the specification of unique statistical weights to the X, Y, and Z GCP coordinates within the Point Measurement tool. The statistical weights assigned can be determined as a function of the quality of the input GCP coordinates. The Viewing Properties dialog must be used to select the Std. option in order to input the standard deviation values of the input GCP coordinates.

It is advantageous to assign unique statistical weights to different GCPs when the quality of the individual GCPs varies. Consider the following example where four GCPs were surveyed using a total station to an accuracy of 0.1 meters and five additional GCPs were measured from a topographic map having an accuracy of 10 meters. Since the quality of the surveyed GCPs is greater, the influence of these points during aerial triangulation should be increased as compared to the influence of the remaining five GCPs. Thus, smaller standard deviation values can assigned to the surveyed GCPs.

**Assigning Statistical Weights to Exterior Orientation**

Statistical weights can be assigned to the exterior orientation parameters representing the position and orientation of the camera/sensor exposure station as they existed at the time of capture. It is highly advantageous to statistically weight the exterior orientation parameters if they have been imported from an external source (for example, airborne GPS, and the existing aerial triangulation results), or if the quality of the initial approximations is known. Statistically constraining the exterior orientation parameters ensures that the final estimated parameters do not deviate drastically from the user input values (assuming they are correct). The extent of the deviation or fluctuation is controlled by the specified standard deviation values.

The **Exterior** tab within the Aerial Triangulation dialog, depicted in **Figure 123**, is used to define the standard deviations associated with exterior orientation.
Several options are provided for defining the statistical quality of the exterior orientation parameters. This includes:

- **No Weight.** This specification does not assign a statistical weight to the exterior orientation parameters. A No Weight specification can be used if initial approximations to exterior orientation are unknown or of poor quality.

- **Same Weighted Values.** This option allows for the specification of a uniform statistical weight to the X, Y, Z, and Omega, Phi, Kappa parameters. The statistical weight assigned can be determined as a function of the quality of the initial approximations to exterior orientation. Consider the use of airborne GPS and INS data, which has a positional quality of 2 meters and has a rotational quality of 0.1 degrees. This option should be used if the quality of input exterior orientation parameters is uniform.

- **Different Weighted Values.** This option allows for the specification of unique statistical weights to the X, Y, Z, and Omega, Phi, Kappa parameters within the Exterior Information tab of the Frame Editor dialog. The statistical weights assigned can be determined as a function of the quality of the input exterior orientation parameters.

It is advantageous to assign unique statistical weights to the different exterior orientation parameters when the strength of the geometric network comprising the block of imagery varies.

Consider the example where sixteen images comprise a block having four horizontal strips with four images per strip. Aerial triangulation has already been performed on the block and, due to the lack of redundancy (that is, minimal control on the corner images) on the four corner images, the quality of the exterior orientation parameters for these images is less than the remaining images in the block.
To ensure that the error located within the four corner images does not negatively impact the quality of the remaining images, larger standard deviation values can be assigned to the corner images and smaller standard deviation values can be assigned to the remaining images. Smaller standard deviation values ensure that the exterior orientation parameters do not vary drastically as a result of the aerial triangulation procedure attempting to distribute and minimize error.

If the initial approximations for the exterior orientation parameters were imported from an external source and the accuracy of the values known, different statistical weights can be defined for exterior orientation parameters.

To increase the quality of the four corner images, additional GCPs can be measured.

**SCBA**

SCBA estimates the interior orientation parameters and AP associated with a camera/sensor. The interior orientation parameters that can be recovered include:

- focal length
- principal point in the x direction
- principal point in the y direction

SCBA is most commonly used in the following scenarios:

- When the interior parameters associated with a camera or sensor are unknown. This is commonly the case when using a nonmetric camera (for example, 35 mm amateur camera, and medium to large format cameras such as Hasselblad), digital camera, and videography using a CCD or film. Since these cameras were not designed for photogrammetric processing, camera calibration information is unknown.

- When the camera calibration parameters associated with a frame camera are outdated and incorrect.

Using SCBA, LPS Project Manager accounts for the geometric errors associated with using noncalibrated cameras for photogrammetric processing (for example, orthorectification, stereopair generation, and stereo feature collection).

The **Interior** tab of the Aerial Triangulation dialog, shown in Figure 124, is used to define whether or not the interior orientation parameters are estimated using the SCBA.
In order to perform SCBA within LPS Project Manager, the statistical weights associated with interior orientation can be assigned.

Several options are provided for defining the statistical properties associated with the interior orientation parameters. They include Fixed for All Images, Same Weighted Corrections for All, Different Weighted Corrections, Same Unweighted Corrections for All, and Different Unweighted Corrections.

**Fixed For All Images**

The interior orientation parameters are not estimated and are assumed fixed for each image in the block.

**Same Weighted Corrections For All**

This option allows for the use of the SCBA capabilities to estimate the interior orientation parameters associated with the camera (for example, the same camera) used to collect all of the photography or imagery in the block. Thus, one set of interior orientation parameters is used in the entire block. Statistical weights are assigned to the three interior orientation parameters. This option should be selected if the camera or sensor model was stable between successive exposure stations and the variation of interior orientation parameters is minimal. Statistical weights are used to control the fluctuation of the initial approximations for interior orientation during aerial triangulation. Use this option if few GCPs are available and the variation of interior orientation is small between successive exposure stations.
<table>
<thead>
<tr>
<th>Option</th>
<th>Details</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Different Weighted Corrections</td>
<td>This option estimates the interior orientation parameters associated with each image in the block (for example, different interior orientation parameters for each exposure station). Thus, each image has three unique interior orientation parameters associated with it. This option should be selected if the camera or sensor model was not stable between successive exposure stations and the variation of interior orientation parameters is large. If the internal geometry of the camera varies during successive exposure stations, this option should be used. Unique statistical weight is assigned to the interior orientation parameter for each image in the block. The assignment of unique weight is done internally by LPS Project Manager.</td>
<td></td>
</tr>
<tr>
<td>Same Unweighted Corrections For All</td>
<td>This option estimates the interior orientation parameters associated with the camera used to collect all of the photography or imagery in the block. Thus, one set of interior orientation parameters is used in the entire block. Statistical weights are not assigned to the three interior orientation parameters. This option should be selected if the internal geometry of the camera or sensor model was relatively stable between successive exposure stations and the variation of interior orientation parameters is minimal. Use this option if many GCPs are available. The variation of interior orientation is small between successive exposure stations, and the precision and accuracy of the interior orientation parameters are not known.</td>
<td></td>
</tr>
<tr>
<td>Different Unweighted Corrections</td>
<td>This option estimates the interior orientation parameters associated with each image in the block. Thus, each image has three unique interior orientation parameters associated with it. This option should be selected if the camera or sensor model was not stable between successive exposure stations and the variation of interior orientation parameters is large. If the internal geometry of the camera varies during successive exposure stations, this option should be used. Statistical weight is not assigned to the interior orientation parameter for each image in the block.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Because of the instability of digital, video, and nonmetric cameras, the internal geometry of the cameras is not stable during the collection of imagery. For example, the CCD contained within a digital camera tends to move within the camera body during collection. Thus, unique interior orientation parameters can be associated with each camera station. In this scenario, LPS Project Manager recovers the interior orientation parameters for each camera station. This is also applicable when using an amateur camera.
In order to evaluate the results of the SCBA, review the estimated interior orientation values and their corresponding accuracy values. If the accuracy value for the principal point is larger than the principal point values, the confidence with which the parameter can be accurately estimated is low. Similarly, if the new focal length estimate varies drastically from the initial input value (for example, several millimeters), recheck the initial input value and reexamine the SCBA.

The following tips can be used to optimize the results of the SCBA:

- Ensure that at least six **Full** GCPs are used in the overlap area of two images in the block.
- Rather than process each image in a block, apply the SCBA to several images containing an adequate number of GCPs. This minimizes the influence of weak geometry between many images.
- If results are inadequate, increase the number of GCPs in the overlapping areas of the images in the block.
- Since both the interior and exterior orientation parameters are being estimated in one solution, correlation exists between the interior and exterior orientation parameters. In other words, the reliability of estimating interior orientation is negatively impacted by the estimation of exterior orientation. To minimize the correlation between interior and exterior orientation, several options can be used. These include:
  - Use oblique imagery or photography. Oblique imagery minimizes the correlation between interior and exterior orientation because the optical axis of the camera is intentionally inclined away from the vertical direction of exterior orientation. Utilizing highly convergent (for example, 80% overlap or greater) imagery also achieves this effect.
  - Use GCPs having a large amount of variation in the Z direction. If performing SCBA with imagery exposed over flat areas, the correlation between interior and exterior orientation negatively impacts the results. Introducing variable GCPs in the Z direction minimizes the correlation between interior and exterior orientation.
- If initial approximations to either interior or exterior orientation are known, assign statistical weights to the corresponding values indicating their quality. By not statistically constraining the unknown parameters, the quality of the SCBA can decrease.
- At least six tie points are common to the overlap areas of each image in the block. The more tie points that are used, the better the output SCBA results.
Estimating AP for SCBA

Due to systematic errors associated with the camera or sensor model and atmospheric refraction, the quality of the aerial triangulation is negatively impacted. The systematic errors can be partly or even largely eliminated by using the SCBA with AP. Under favorable conditions, improved triangulation results can be obtained if AP is used. The favorable conditions include:

- Strong geometry between the images in a block. A block can be geometrically strengthened by using adjacent images containing at least 60% overlap and 60% sidelap. Utilizing cross-strips also improves the geometry of a block.

- Evenly distributed GCPs and tie points. Since additional unknown parameters are being estimated, the number of GCPs used in the block should also increase to maintain sufficient statistical redundancy. At least six GCPs in the overlap area of two frames should be used.

- Minimum correlation between the AP and the remaining unknown parameters associated with the block which may include exterior orientation, interior orientation, and tie point coordinates.

- The use of many evenly distributed tie points throughout the block.

The four AP models provided within LPS Project Manager allow for the modeling of various systematic error. Select the Advanced Options tab within the Aerial Triangulation dialog, shown in Figure 125, in order to select the AP models.

Figure 125: Advanced Options Tab of the Aerial Triangulation Dialog
Bauer’s Simple Model (3)

This model has three AP that come from the research results of Dr. H. Bauer. Two parameters mainly determine the extent of affine deformation and one parameter estimates symmetric lens distortion. Affine deformation is caused by the nonorthogonality of the image/photo-coordinate axis (for example, the x and y axis are not perpendicular, or $90^\circ$). This model also accounts for scale differential between x and y pixel size. The mathematical form is as follows:

\[
\begin{align*}
\Delta x &= a_1 x (r^2 - r_0^2) + a_2 x \\
\Delta y &= a_1 y (r^2 - r_0^2) - a_2 y + a_3 x
\end{align*}
\]

Jacobsen’s Simple Model (4)

This model has four AP that are simplified from the research results of Dr. K. Jacobsen. The four parameters compensate for the first and second order distortions associated with affine deformation and lens distortion.

\[
\begin{align*}
\Delta x &= a_1 x (r^2 - r_0^2) + a_2 x + a_3 y \\
\Delta y &= a_1 y (r^2 - r_0^2) - a_2 y + a_3 x + a_4 x^2
\end{align*}
\]

Ebner’s Orthogonal Model (12)

This model has twelve AP that are derived from the research of Dr. H. Ebner. The twelve parameters compensate for various types of systematic error including lens distortion, scanner error, affine deformation, and film deformation. Since a greater number of parameters are being estimated, an increased number of GCPs and tie points is required. The AP are orthogonal to the one another and to the exterior orientation parameters under circumstances where the ground surface is flat, and nine tie points are distributed evenly throughout the images in a block. In the following equations, $b$ is the average image base line.

\[
\begin{align*}
\Delta x &= a_1 x + a_2 y - a_3 \left(2x^2 - \frac{4b^2}{3}\right) + a_4 xy + a_5 \left(y^2 - \frac{2b^2}{3}\right) + a_6 x \left(y^2 - \frac{2b^2}{3}\right) \\
&\quad + a_9 \left(x^2 - \frac{2b^2}{3}\right) + a_{11} \left(x^2 - \frac{2b^2}{3}\right) \left(y^2 - \frac{2b^2}{3}\right)
\end{align*}
\]
Brown’s Physical Model (14)

This model has fourteen AP that are simplified from the research of Dr. D. C. Brown. The AP compensate for most of the linear and nonlinear forms of film and lens distortion. The AP are chosen according to the possible sources of physical errors such as film deformation, film plate flatness, lens distortion, etc.

\[
\Delta y = -a_1 y + a_2 x + a_3 xy - a_4 \left(2y^2 - \frac{4b_2}{3}\right) + a_6 \left(x^2 - \frac{2b_3}{3}\right) + a_9 y \left(x^2 - \frac{2b_3}{3}\right) \\
+ a_{10} y (y^2 - \frac{2b_3}{3}) + a_{12} \left(x^2 - \frac{2b_3}{3}\right) \left(y^2 - \frac{2b_3}{3}\right)
\]

\[
\Delta x = a_1 x + a_2 y + a_3 xy + a_4 y^2 + a_5 x^2 y + a_6 x y^2 + a_7 x^2 y^2 \\
+ a_{13} x^2 y^2 + a_{14} x (x^2 + y^2)
\]

\[
\Delta x = a_1 x + a_2 y + a_3 xy + a_4 y^2 + a_5 x^2 y + a_6 x y^2 + a_7 x^2 y^2 \\
+ a_{13} x^2 y^2 + a_{14} x (x^2 + y^2)
\]

If the Ebner or Brown AP model is selected, it is highly recommended that an increased number of control points and tie points be used in the solution.

Statistical constraints can be assigned to the estimated AP. LPS Project Manager automatically assigns statistical weights to the AP by selecting the Use Additional Parameters As Weighted Variables radio button. It is highly recommended to assign statistical weights to the AP in scenarios where minimal or poor geometry exists between images and the number of GCPs.

Lens Distortion Model (2)

The lens distortion model is designed to self-calibrate the lens distortion parameters automatically. This is especially effective for applications with amateur digital cameras to reduce total RMSE as well as ground RMSE.
Prior to LPS 9.0, this is the equation used:

\[
\Delta x = k_1 x (r^2 - r_0^2) + k_2 x (r^2 - r_0^2)^2
\]

\[
\Delta y = k_1 y (r^2 - r_0^2) + k_2 y (r^2 - r_0^2)^2
\]

Beginning with LPS 9.0, this is the equation used:

\[
\Delta x = k_1 x r^2 + k_2 x r^4
\]

\[
\Delta y = k_1 y r^2 + k_2 y r^4
\]

Starting with LPS 9.0, the \( r_0 \) parameter has been removed since LPS 9.0 so that \( k_1 \) and \( k_2 \) can be directly used in the camera editor or elsewhere without additional computation.

Automated Gross Error Checking

LPS Project Manager provides two error or blunder checking models which identify and remove errors from the photogrammetric network of observations. The input observations including the measured image/photo coordinates are analyzed to determine the erroneous input data contributing to the overall instability of output aerial triangulation results.

LPS Project Manager provides two blunder checking models:

- **Time Saving Robust Checking.** This option uses a robust iteration with selective weight functions to detect gross error in the input observations. This option does not cause a significant increase in the aerial triangulation processing time since the individual redundancy of each observation is not computed.

- **Advanced Robust Checking.** This option uses a robust iteration solution with selective weight functions based on the redundancy of each observation. The weight functions used in this option meet the requirements of a rigorous robust estimation function. Using this option with large blocks could cause a significant increase in processing time because of the computation of redundancy for each observation.

After each iteration of processing, the weight of each observation (that is, image coordinate measurements) is predicted for the next iteration of processing. The new weight is computed based on a weight function. The weight functions are models which compute a weight for an observation based on the observation residuals. During successive iterations, the weight for a bad observation decreases until it approaches 0. At this point, observations containing gross errors can be detected.
If blunders or errors have been identified, those observations are extracted from further aerial triangulation processing during the iterative least squares solution. Input observations containing error are listed within the output aerial triangulation report. Therefore, when the first least squares adjustment is completed, gross errors are identified and removed. The block triangulation is then repeated to derive the final solution.

Understanding the Aerial Triangulation Report

Once the aerial triangulation has been performed, a summary dialog and report are provided listing all of the aerial triangulation results. The information contained within the summary and the report can be used to determine the quality of the overall solution.

The aerial triangulation summary displays the following information:

- **Total RMS error of the solution.** The standard deviation of unit weight is a global indicator of the quality of the aerial triangulation solution. The value is based on the photo-coordinate residuals and the ground coordinate residuals. A general rule of thumb stipulates that the standard deviation of unit weight should be less than the pixel size of the original imagery. A smaller value indicates that the residuals within the network of observations have been minimized.

- **RMS errors of the GCPs in the X, Y, and Z direction.** These values reflect the amount of change between the original GCP coordinates and newly estimated values computed using the estimated unknown parameters. Large values indicate that the estimated unknown parameters do not conform with the original GCPs.

- **RMS error of the GCP photo-coordinates.** These values reflect the amount of change between the measured image/photo-coordinates of the GCPs and the newly estimated photo-coordinate values computed using the estimated unknown parameters.

- **RMS error of the check point coordinates.** These values reflect the amount of change between the original check point coordinates and the computed values derived by using the estimated unknown parameters (for example, exterior orientation) and the original measured image/photo-coordinates. The check point RMS values provide an independent check on the accuracy of the aerial triangulation results.

- **RMS error of the check point photo-coordinates.** These values reflect the amount of change between the measured image/photo-coordinates of the check points and the newly estimated photo-coordinate values computed using the estimated unknown parameters. The photo-coordinate residuals provide an indicator of the quality of the derived exterior orientation values.
**Update Results**

The **Update** option updates the exterior orientation parameters computed by LPS Project Manager. If the exterior orientation parameters were not known and triangulation was performed, the **Update** option updates all of the exterior orientation parameters and uses these values as initial approximations when a new aerial triangulation solution is solved.

The **Update** button should only be selected if the existing exterior orientation parameters are not satisfactory for use as initial approximations for performing aerial triangulation. The quality of the initial approximations for exterior orientation assists in providing better overall results for aerial triangulation.

Once **Update** has been selected, the corresponding exterior orientation parameters are used as the initial approximations for aerial triangulation. Selecting **Update** overwrites all of the existing exterior orientation values.

**Accept Results**

Block triangulation results should be accepted once the results associated with aerial triangulation have been accurately estimated. Once the **Accept** button has been selected, the computed exterior orientation parameters are used for orthorectification. Additionally, the X, Y, and Z ground coordinates associated with the tie points and GCPs are accepted and used.

**Aerial Triangulation Report**

The aerial triangulation report lists all of the input and output data used during the aerial triangulation process. The report can be divided into several categories including:

- triangulation report unit definition
- image coordinates and interior orientation results
- aerial triangulation results
- automated error checking results
- exterior orientation parameter results
- SCBA results
- control point residuals
- check point residuals
- control point, check point, and tie point coordinates, and accuracy estimates
The following explanations are provided to better understand the contents of the aerial triangulation report.

The units for the image coordinates, exterior orientation rotation angles, and GCPs are defined. The positional elements of exterior orientation use the same units as the GCPs. Image coordinate residuals are displayed in the units similar to input image coordinates. GCPs, tie points, and check points are displayed in ground units. The units listed are applicable to output with no specific unit specification.

The Triangulation Report With IMAGINE LPS Project Manager:

The output image x, y units: pixels
The output angle unit: degrees
The output ground X, Y, Z units: meters

If a Geographic Lat/Lon reference coordinate system is being used, the computed exterior orientation values are displayed in a topocentric coordinate system. The origin of the topocentric coordinate system can be internally defined by LPS Project Manager or user-specified.

Image Coordinates and Interior Orientation Results

The image coordinates representing the image positions of GCPs, check points, and tie points are displayed for each image in the block. The Image ID as specified in the LPS Project Manager CellArray is used to represent the individual images.

The Input Image Coordinates:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>952.625</td>
<td>819.625</td>
</tr>
<tr>
<td>1003</td>
<td>1857.875</td>
<td>639.125</td>
</tr>
<tr>
<td>1005</td>
<td>1769.450</td>
<td>1508.430</td>
</tr>
<tr>
<td>1006</td>
<td>1787.875</td>
<td>2079.625</td>
</tr>
<tr>
<td>2001</td>
<td>915.020</td>
<td>2095.710</td>
</tr>
<tr>
<td>2003</td>
<td>846.530</td>
<td>208.330</td>
</tr>
</tbody>
</table>
Six affine transformation parameters are displayed for each image. These coefficients are derived using a 2D affine transformation during interior orientation. The six coefficients represent the relationship between the file or pixel coordinate system of the image and the film or image space coordinate system. The file coordinate system has its origin in the upper left corner of the image (for example, 0, 0). The origin of the image space coordinate system for each image is the principal point. The intersection of opposite fiducial mark positions is used to define the principal point location.

The six transformation coefficients are calculated once interior orientation has been performed. The six transformation parameters define the scale and rotation differences between two coordinate systems.

Once the image position of a ground point has been measured automatically or manually, the six coefficients are used to transform the pixel coordinates of the GCP to image (or film) coordinates:

| Affine coefficients from file (pixels) to film (millimeters) |
|---------------|---------------|---------------|---------------|---------------|---------------|
| A0 | A1 | A2 | B0 | B1 | B2 |
| -114.3590 | 0.100015 | -0.001114 | 116.5502 | -0.001117 | -0.100023 |

Thus, the image coordinates and the six affine transformation coefficients are displayed for each image in the block:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>165.875</td>
<td>846.625</td>
</tr>
<tr>
<td>1003</td>
<td>1064.875</td>
<td>646.375</td>
</tr>
<tr>
<td>1005</td>
<td>1007.250</td>
<td>1518.170</td>
</tr>
<tr>
<td>1006</td>
<td>1023.625</td>
<td>2091.390</td>
</tr>
<tr>
<td>2001</td>
<td>160.900</td>
<td>2127.840</td>
</tr>
<tr>
<td>2002</td>
<td>2032.030</td>
<td>2186.530</td>
</tr>
<tr>
<td>1004</td>
<td>1839.520</td>
<td>1457.430</td>
</tr>
</tbody>
</table>
Aerial triangulation is performed using a bundle block adjustment. This approach utilizes an iterative least squares solution. The unknown parameters are either estimated or adjusted. These estimated or adjusted parameters include:

- exterior orientation parameters (X, Y, Z, Omega, Phi, Kappa) for each camera exposure station
- X, Y, and Z coordinates of the tie points
- interior orientation parameters (focal length, principal point xo, and principal point yo)
- AP

The corresponding accuracy estimates for each set of estimated or adjusted parameters are also provided if the **Compute Accuracy For Unknowns** radio button within the Aerial Triangulation dialog is selected.

Input parameters are adjusted if initial approximations have been provided and statistically weighted. For example, if initial approximations for exterior orientation are input and statistically weighted, a new set of adjusted values is computed after aerial triangulation has been performed.

Input parameters are estimated if they are unknown prior to executing the aerial triangulation. For example, tie point coordinates are commonly unknown prior to aerial triangulation. Their X, Y, and Z coordinates are estimated using the bundle block adjustment.

**Least Squares Iterative Results**

A global indicator of quality is computed for each iteration of processing. This is referred to as the standard error (also known as the standard deviation of image unit weight). This value is computed based on summation of image coordinate residuals and ground coordinate residuals for that particular iteration of processing.
The units for the standard error are defined within the **General** tab of the Aerial Triangulation dialog. For the first iteration of processing, the global standard error is larger since the input observations have not been adjusted (for example, GCPs, photo-coordinates, etc.).

After each iteration of processing, LPS Project Manager estimates the exterior orientation parameters of each camera/sensor station and X, Y, and Z tie point coordinates. The newly estimated exterior orientation parameters are then used along with the GCP and tie point coordinates to compute new x and y image coordinate values. The newly computed image coordinate values are then subtracted from the original image coordinate values. The differences are referred to as the x and y image coordinate residuals.

If the exterior orientation parameters are incorrect, then the newly computed image coordinate values are also incorrect. Incorrect estimates for exterior orientation may be attributed to erroneous GCPs, data entry blunders, or mismeasured image positions of GCPs or tie points. Any error in the photogrammetric network of observations is reflected in the image coordinate residuals.

The computed standard error for each iteration accumulates the effect of each image coordinate residual to provide a global indicator of quality. The lower the standard error, the better the solution.

**NOTE:** The number of iterations using the least squares adjustment continues until the corrections to the control points (i.e., GCPs, tie points, and check points) are less than the user-specified convergence value (for example, 0.001 default). After each iteration of processing, a new set of X, Y, and Z coordinates are computed for the GCPs, tie points, and check points. The new set of coordinates is differenced from the previous set of coordinates (that is, previous iteration). The differences between the coordinates are also referred to as corrections to the unknowns. If the differences are greater than the convergence value, the iterations continue.

### Automated Error Checking Results

LPS Project Manager provides two blunder checking models that automatically identify and remove erroneous image measurements from the block. The blunder checking models can be specified by selecting the appropriate model within the blunder checking model dropdown list contained in the **Advanced Options** tab of the Aerial Triangulation dialog.

The results of the blunder checking model are displayed as follows:
The x and y image coordinate residuals of the blunder points are displayed. LPS Project Manager notifies you if a point is excluded from the aerial triangulation solution. Vx and Vy represent the x and y image/photo-coordinate residuals, respectively.

### Exterior Orientation Parameters

The six exterior orientation parameters for each camera station are listed:

<table>
<thead>
<tr>
<th>image ID</th>
<th>Xs</th>
<th>Ys</th>
<th>Zs</th>
<th>OMEGA</th>
<th>PHI</th>
<th>KAPPA</th>
</tr>
</thead>
</table>

Point 1005 is excluded in the further adjustment:

The OUTPUT of SCBA:

<table>
<thead>
<tr>
<th>the no. of iteration</th>
<th>the standard error</th>
<th>the maximal correction of the object points</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.1438</td>
<td>40.30844</td>
</tr>
<tr>
<td>2</td>
<td>0.1447</td>
<td>0.74843</td>
</tr>
<tr>
<td>3</td>
<td>0.1447</td>
<td>0.00089</td>
</tr>
</tbody>
</table>
A corresponding accuracy estimate is provided for each exterior orientation parameter. The accuracy estimates are computed from the covariance matrix of the final solution. The accuracy estimates reflect the statistical accuracy of each parameter.

<table>
<thead>
<tr>
<th>image ID</th>
<th>mxs (m)</th>
<th>mys (m)</th>
<th>mz (m)</th>
<th>mOMEGA (rad)</th>
<th>mPHI (rad)</th>
<th>mKAPPA (rad)</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>2.7512</td>
<td>3.4383</td>
<td>1.8624</td>
<td>0.0266</td>
<td>0.0207</td>
<td>0.0112</td>
</tr>
<tr>
<td>91</td>
<td>2.7014</td>
<td>3.1999</td>
<td>1.5232</td>
<td>0.0252</td>
<td>0.0209</td>
<td>0.0109</td>
</tr>
<tr>
<td>92</td>
<td>2.7940</td>
<td>3.3340</td>
<td>2.4975</td>
<td>0.0263</td>
<td>0.0204</td>
<td>0.0115</td>
</tr>
</tbody>
</table>

The interior orientation parameters of photos:

<table>
<thead>
<tr>
<th>image ID</th>
<th>f (mm)</th>
<th>xo (mm)</th>
<th>yo (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>153.1240</td>
<td>-0.0020</td>
<td>0.0020</td>
</tr>
<tr>
<td>91</td>
<td>153.1240</td>
<td>-0.0020</td>
<td>0.0020</td>
</tr>
<tr>
<td>92</td>
<td>153.1240</td>
<td>-0.0020</td>
<td>0.0020</td>
</tr>
</tbody>
</table>

SCBA Results

If SCBA is performed, the focal length and principal point values are estimated. The output appears as follows:

The interior orientation parameters of photos:

<table>
<thead>
<tr>
<th>image ID</th>
<th>f (mm)</th>
<th>xo (mm)</th>
<th>yo (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>153.1220</td>
<td>-0.0097</td>
<td>-0.0039</td>
</tr>
</tbody>
</table>
In this case, it was assumed that the interior orientation parameters were common for each image in the block. For this reason, the interior orientation values are common for each image. Additionally, one set of accuracy estimates is computed.

If each camera station has a unique set of interior orientation parameters estimated, the output appears as follows:

The interior orientation parameters of photos:

<table>
<thead>
<tr>
<th>image ID</th>
<th>f(mm)</th>
<th>xo(mm)</th>
<th>yo(mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>153.1164</td>
<td>-0.0190</td>
<td>-0.0156</td>
</tr>
<tr>
<td>91</td>
<td>153.1230</td>
<td>-0.0135</td>
<td>0.0003</td>
</tr>
<tr>
<td>92</td>
<td>153.1288</td>
<td>-0.0018</td>
<td>0.0038</td>
</tr>
</tbody>
</table>

The accuracy of the interior orientation parameters:

<table>
<thead>
<tr>
<th>image ID</th>
<th>mf(mm)</th>
<th>mxo(mm)</th>
<th>myo(mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>0.0946</td>
<td>0.1020</td>
<td>0.0953</td>
</tr>
<tr>
<td>91</td>
<td>0.0936</td>
<td>0.0995</td>
<td>0.0954</td>
</tr>
<tr>
<td>92</td>
<td>0.0985</td>
<td>0.1031</td>
<td>0.0985</td>
</tr>
</tbody>
</table>

In this scenario, accuracy estimates are computed for each camera station.

Control Point Residuals

Once the bundle block adjustment is complete, new values for the control point coordinates are computed. The new control point coordinates are computed based on the estimated exterior orientation parameters and measured image coordinate values.
The control point residuals reflect the difference between the original control point coordinates and newly estimated control point coordinates. Relatively large residual values are indicative of error in the photogrammetric network of observations. Large error can be attributed to mismeasured control points, data entry error, and poor quality of control points. In the example below, the Z coordinate for control point 1004 is relatively larger than the remaining residuals, thus inferring a possible error.

The residuals of the control points:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>rX</th>
<th>rY</th>
<th>rZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>1.4390</td>
<td>5.6596</td>
<td>6.9511</td>
</tr>
<tr>
<td>1003</td>
<td>-3.0263</td>
<td>-0.5553</td>
<td>-2.2517</td>
</tr>
<tr>
<td>1004</td>
<td>3.0679</td>
<td>2.0052</td>
<td>-11.1615</td>
</tr>
<tr>
<td>1005</td>
<td>2.9266</td>
<td>-4.0629</td>
<td>-2.3434</td>
</tr>
<tr>
<td>1006</td>
<td>-2.0842</td>
<td>2.5022</td>
<td>2.6007</td>
</tr>
<tr>
<td>aX</td>
<td>0.4646</td>
<td>1.1098</td>
<td>-1.2410</td>
</tr>
<tr>
<td>aY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>aZ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mX</td>
<td>2.5904</td>
<td>3.4388</td>
<td>6.1680</td>
</tr>
<tr>
<td>mY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mZ</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The aX, aY, and aZ values reflect the average residual values for the X, Y, and Z control point coordinates, respectively. The mX, mY, and mZ values reflect the root mean square residual values for the X, Y, and Z control point coordinates, respectively.

Check Point Residuals

Check points are used to independently verify the quality of the bundle block adjustment. Once the exterior orientation parameters have been solved, the image coordinate values of the check points are used to compute the X, Y, and Z coordinates. The computed coordinates are subtracted from the original input coordinates to compute the check point residuals. Check points serve as the best source for determining the accuracy of the bundle block adjustment.

The residuals of the check points:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>rX</th>
<th>rY</th>
<th>rZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>-4.0786</td>
<td>0.0865</td>
<td>-1.9679</td>
</tr>
</tbody>
</table>
The aX, aY, and aZ values reflect the average residual values for the X, Y, and Z check point coordinates, respectively. The mX, mY, and mZ values reflect the root mean square residual values for the X, Y, and Z check point coordinates, respectively.

### Control, Check, and Tie Point Coordinates; and Accuracy Estimates

Once the bundle block adjustment is complete, new GCP, check point, and tie point coordinates are computed based on the estimated or adjusted exterior orientation parameters. The computation of X, Y, and Z coordinates for tie points is referred to as ground point determination. If the tie points are acceptable, they can be converted to control points within the Point Measurement tool. This process is referred to as control point extension.

**NOTE:** *If the Update or Accept buttons have been selected, the tie point coordinates are populated within the Point Measurement tool.*

<table>
<thead>
<tr>
<th>Point ID</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Overlap</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>665230.007</td>
<td>115015.735</td>
<td>1947.0091</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1003</td>
<td>664452.521</td>
<td>119050.097</td>
<td>1990.0849</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1004</td>
<td>668152.513</td>
<td>122406.101</td>
<td>1971.3625</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1005</td>
<td>668340.390</td>
<td>118681.554</td>
<td>1885.8520</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1006</td>
<td>670840.050</td>
<td>118698.603</td>
<td>2014.9514</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2001</td>
<td>670966.371</td>
<td>114815.316</td>
<td>1889.9201</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2002</td>
<td>671410.339</td>
<td>123163.505</td>
<td>1987.3377</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2003</td>
<td>662482.955</td>
<td>114550.158</td>
<td>1927.2971</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Overlap column specifies the number of images on which the point has been measured. This is also an indication for redundancy.

The accuracy of each control point, check point, and tie point is computed. The accuracy estimates are computed based on the respective diagonal elements of the covariance matrix for the final solution. The values reflect statistical accuracy.

The accuracy of object points:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>mX</th>
<th>mY</th>
<th>mZ</th>
<th>mP</th>
<th>Overlap</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>1.0294</td>
<td>1.0488</td>
<td>1.2382</td>
<td>1.9217</td>
<td>2</td>
</tr>
<tr>
<td>1003</td>
<td>0.8887</td>
<td>0.8731</td>
<td>1.1739</td>
<td>1.7117</td>
<td>3</td>
</tr>
<tr>
<td>1004</td>
<td>0.9693</td>
<td>0.9593</td>
<td>1.2219</td>
<td>1.8311</td>
<td>2</td>
</tr>
<tr>
<td>1005</td>
<td>0.7181</td>
<td>0.7063</td>
<td>0.9397</td>
<td>1.3775</td>
<td>3</td>
</tr>
<tr>
<td>1006</td>
<td>0.9534</td>
<td>0.9119</td>
<td>1.1841</td>
<td>1.7727</td>
<td>3</td>
</tr>
<tr>
<td>2001</td>
<td>1.8123</td>
<td>1.5641</td>
<td>3.1611</td>
<td>3.9653</td>
<td>2</td>
</tr>
<tr>
<td>2002</td>
<td>1.9436</td>
<td>1.5091</td>
<td>2.8482</td>
<td>3.7639</td>
<td>2</td>
</tr>
<tr>
<td>2003</td>
<td>1.9684</td>
<td>1.7646</td>
<td>3.0069</td>
<td>4.0037</td>
<td>2</td>
</tr>
<tr>
<td>2004</td>
<td>1.7427</td>
<td>1.3758</td>
<td>2.6308</td>
<td>3.4426</td>
<td>2</td>
</tr>
</tbody>
</table>

...  

2041 1.9419 1.6884 3.0368 3.9804 2

\[ \text{amX} \quad \text{amY} \quad \text{amZ} \]  
\[ 1.2681 \quad 1.1773 \quad 2.1932 \]

The total object points = 46
The amX, amY, and amZ values represent the average accuracy estimates for the X, Y, and Z control, check, and tie point coordinates.

The Overlap column specifies the number of images on which the point has been measured.

**Image Coordinate Residuals**

Once the bundle block adjustment is complete, image coordinate residuals are computed. The residuals are computed based on the fixed, estimated, adjusted exterior orientation parameters, GCP, check point, tie point coordinates, and their respective image measurements. During the iterative least squares adjustment, the values of the new image coordinates are dependent on the estimated or adjusted parameters of the bundle block adjustment. Therefore, errors in the fixed, estimated, or adjusted parameters are reflected in the image coordinate residuals.

LPS Project Manager computes the image coordinate residuals for each image measurement in the block.

<table>
<thead>
<tr>
<th>Point</th>
<th>Image</th>
<th>Vx</th>
<th>Vy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>90</td>
<td>-0.176</td>
<td>-0.040</td>
</tr>
<tr>
<td>1002</td>
<td>91</td>
<td>-0.001</td>
<td>-0.016</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Point</th>
<th>Image</th>
<th>Vx</th>
<th>Vy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1003</td>
<td>90</td>
<td>0.053</td>
<td>-0.001</td>
</tr>
<tr>
<td>1003</td>
<td>91</td>
<td>0.017</td>
<td>0.149</td>
</tr>
<tr>
<td>1003</td>
<td>92</td>
<td>0.045</td>
<td>0.050</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Point</th>
<th>Image</th>
<th>Vx</th>
<th>Vy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1004</td>
<td>91</td>
<td>0.103</td>
<td>-0.094</td>
</tr>
<tr>
<td>1004</td>
<td>92</td>
<td>-0.182</td>
<td>-0.010</td>
</tr>
</tbody>
</table>

...
Optimizing the Aerial Triangulation Results

The output results of aerial triangulation can be improved in the following manner:

- Increase the number and quality of GCPs within the block of images.
- Evenly distribute GCPs throughout the block.
- Place at least one full GCP on every third photo if processing 20 or more images. Ensure that the edges and corners of the block contain sufficient ground control (see Figure 126).

<table>
<thead>
<tr>
<th>Point</th>
<th>Image</th>
<th>Vx</th>
<th>Vy</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>90</td>
<td>-0.000</td>
<td>-0.016</td>
</tr>
<tr>
<td>2001</td>
<td>91</td>
<td>0.000</td>
<td>0.016</td>
</tr>
<tr>
<td>2002</td>
<td>91</td>
<td>0.000</td>
<td>0.017</td>
</tr>
<tr>
<td>2002</td>
<td>92</td>
<td>0.000</td>
<td>-0.017</td>
</tr>
<tr>
<td>2003</td>
<td>90</td>
<td>-0.000</td>
<td>-0.094</td>
</tr>
<tr>
<td>2003</td>
<td>91</td>
<td>0.002</td>
<td>0.095</td>
</tr>
<tr>
<td>2004</td>
<td>90</td>
<td>0.000</td>
<td>0.074</td>
</tr>
<tr>
<td>2004</td>
<td>91</td>
<td>-0.002</td>
<td>-0.074</td>
</tr>
</tbody>
</table>
Figure 126: A GCP Configuration for a Large Block of Images

- Increase the number of tie points on the overlapping areas of the images contained within a block. Studies have indicated that a greater number of tie points (approximately 200 per image) per overlap area drastically increases the quality of the aerial triangulation solution. This can be attributed to the increase in data redundancy, thus allowing for the minimization and distribution of error throughout the photogrammetric network of observations.

- Statistically constrain the exterior orientation parameters and GCPs if their precision and accuracy are known.

Graphically Analyzing Aerial Triangulation Results

By selecting either the **Project Graphic Status** option within the **Process** menu, a graphical representation of the information pertaining to the block displays. An example of this is presented in Figure 127.
The following information is graphically represented:

- image footprints of each image used in the block
- spatial location and distribution of GCPs, tie points, and check points
- image IDs for each image in the block
- point IDs for GCPs, tie points, and check points
- residual error vectors for the GCPs and check points

Two display modes are provided including:
• **Map space.** This display mode displays the observations and data pertaining to the entire block. This includes image footprints and all the measured GCPs, tie points, and check points. Ground coordinate residual error vectors are also displayed.

• **Image Space.** This display mode displays only one image at a time, and the photo-coordinate position of the measured GCPs, check points, and tie points. Photo-coordinate residual error vectors are also displayed. An image dropdown list is provided for selecting the image to be displayed.

**Residual Error Scaling**

The residual error vectors display the difference between the original GCP or check point values and the estimated positions determined by the aerial triangulation process. Based on the display, the nature and characteristics associated with systematic error in the block can be determined.

Residual error vectors with a consistent direction and magnitude infer systematic errors that can be attributed to inaccurate interior orientation information, film deformation, scanner error, camera instability, etc. Relatively large ground coordinate error vectors indicate poor GCP quality. Similarly, relatively large image/photo-coordinate error vectors indicate poor image/photo-coordinate quality.

By default, the residual error vectors for the GCPs, tie points, and check points are displayed at a 1:1 scale. The display scale is relative to the image footprints. In order to increase the magnitude of the display, select a **Residual Scaling %** within the provided list. By selecting a 1000% display scale, the residual error vectors are scaled 1000 times greater than the original value. This option is strictly used as a visualization tool.

**Using LPS for Camera Calibration**

LPS is a digital photogrammetric system. It is not camera calibration software although it can be used in an indirect way for camera calibration. In our triangulation module for frame camera, we have five groups of additional parameters for compensating systematic errors. One group consists of two lens distortion parameters. It can compensate the lens systematic errors greatly. But, normally, it will not be able to give the identical parameters as from the calibration report because of different number of parameters, different accuracy levels, etc.

For example, there are different ways to compute lens distortion parameters from the measured distortion values. The common and simple way is to compute the radial lens distortion parameters $k_0$, $k_1$, and $k_2$ using the following equation as used in LPS:
380 Block Triangulation

Where \( x \) and \( y \) are image coordinates from principal point and \( r \) is the radial distance from the principal point.

The following lens distortion model may also be used:

\[
\Delta x = k_0 x + k_1 x r^2 + k_2 x r^4 \\
\Delta y = k_0 y + k_1 y r^2 + k_2 y r^4
\]

Where \( r_0 \) is a constant and normally equal to half the length of maximum radial distance.

Therefore, depending upon which equation is used, different coefficients will be obtained.

Calibration Certificate

When using LPS to process images for photogrammetric purposes, the analyst usually has a camera calibration certificate from the manufacturer. Normally a calibration report includes the calibrated values of focal length and principal point.

Some reports also include lens distortion values. The distortion values are normally represented as corresponding to different field angles or radial distance.

In the LPS camera editor, once you input the measured lens distortion values from the calibration report, the software computes the lens calibration parameters \( k_0 \), \( k_1 \), and \( k_2 \). If you compute the coefficients using the equation above as used in LPS, you can enter the values for \( k_0 \), \( k_1 \), and \( k_2 \) directly instead of entering the distortion values.

If you use the coefficients calculated from third-party software, you must pay attention to the equation used as well as the sign of the coefficients.

In LPS triangulation adjustments you can choose an additional parameter group to compensate the systematic errors inherited in the image coordinates. One of these groups contains two lens distortion parameters \( k_1 \) and \( k_2 \). The algorithm employs the following equation:
The reason that we consider only $k_1$ and $k_2$ is because $k_0$ has the same effect as focal length, so cannot be self-calibrated with focal length simultaneously. Therefore $k_1$ and $k_2$ represent the most significant portion of lens distortion. Also, you would not get the exact values for $k_1$ and $k_2$ as from the manufacturer’s calibration certificate. How accurately the software can determine $k_1$ and $k_2$ is heavily dependent on the number and accuracy of GCPs.

No Calibration Certificate

Without precise laboratory calibration of the lens, many very accurate ground control points must be used to compute the coefficients $k_1$ and $k_2$ accurately. The accuracy for your ground controls should be better than 0.2 pixels when scaled to image space. For example, suppose your standard deviation of ground $X$, $Y$, and $Z$ is 5 cm, your image scale is 1:1000, your pixel size is 20 $\mu$m, then your ground $X$, $Y$, and $Z$ accuracy in the image space is about $5 \times 10 \times 1000 / 1000 / 20 = 2.5$ pixels. This is unacceptable. To be used for camera calibration, the standard deviation of your ground $X$, $Y$, and $Z$ in this example must be 5 mm or less.

Also you must ensure that there are no blunders in the coordinates of your image points or ground control points and that your image points accuracy is as high as 0.2 pixels. If you have not adjusted the focus of the camera during your flight for multiple images, you can define one camera and solve for $k_1$ and $k_2$ using multiple images. But if you have changed focus during the flight (i.e. the interior orientation is changed) you must compute $k_1$ and $k_2$ for each image separately. For computation of $k_1$ and $k_2$ for lens distortion purposes, the more accurate the GCPs, the better. As a rule of thumb, you should use at least 50 points of ground control.

The parameters $k_1$ and $k_2$ computed through self-calibration in triangulation are not automatically fed back into the camera definition. That is, they do not go back into the camera editor database, which is wholly separate from the triangulation process.

Locating $k_1$ and $k_2$ in the Triangulation Report

The values for $k_1$ and $k_2$ are found in the section of the Triangulation Report titled “THE OUTPUT OF SELF-CALIBRATING BUNDLE BLOCK ADJUSTMENT”. From the example below, $k_1$ is -1.4536E-008 and $k_2$ is 2.1057E-013.
The values and accuracy of the additional parameters

<table>
<thead>
<tr>
<th>No.</th>
<th>( \lambda_1 )</th>
<th>( m_1 )</th>
<th>( M_{\text{max}} )</th>
<th>( M_{\text{max}} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-1.4536E-005</td>
<td>-1.2857</td>
<td>1.2494</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2.1057E-013</td>
<td>0.4257</td>
<td>-0.4331</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>3656.23Mx</td>
<td>3591.72My</td>
<td>-0.9400</td>
<td>0.8163</td>
</tr>
</tbody>
</table>

Also, from this section the values for \( x_{\text{max}} \) (Mx) and \( y_{\text{max}} \) (My) are gathered for the computation of \( r_0 \), if necessary, as shown in the equation below.

---

You must select **Lens distortion model (2)** for Additional Parameter Model in the Advanced Options of the Triangulation Properties for these parameters to be displayed in the Triangulation Report.

---

**Using Lens Distortion Parameters**

There are two cases in which you may use the lens distortion parameters obtained from the Triangulation Report.

If your camera calibration certificate does not provide lens distortion parameters or if you do not have a camera calibration certificate, you can use the default values of zero and run triangulation.

Once you get the accurate \( k_1 \) and \( k_2 \) from the triangulation report for your camera, simply input these values into the corresponding fields of the camera editor interface and input zero for \( k_0 \).

You can use these two parameters for all images from the same camera used in the similar situation (i.e. same focal length, similar temperature and humility, etc.) in LPS and even in third-party software where you can input lens distortion parameters.

If you wish to improve the lens distortion parameters from your camera calibration certificate, you can enter the values provided in the certificate into the camera editor and run triangulation.

When you run triangulation you get another set of \( k_1 \) and \( k_2 \) which we will call \( k'_1 \) and \( k'_2 \). Now add \( k_1 \) and \( k'_1 \) to obtain a new \( k''_1 \); add \( k_2 \) and \( k'_2 \) to obtain a new \( k''_2 \). Input these derived \( k''_1 \) and \( k''_2 \) into the corresponding fields of the camera editor interface retaining the original \( k_0 \) from the camera calibration certificate.

If your camera focal length and principal point are not accurate, you can calibrate them in triangulation when you have enough accurate GCPs. After you get the values of focal length and principal point, you can input them in the camera editor and use them in other projects, too.
You can test if LPS handles this lens distortion issue correctly by putting back $k_1$ and $k_2$ into the camera editor then run triangulation again without selecting additional parameters and keeping all the other options the same as you did in a previous self-calibration triangulation. You should get the same triangulation results (same exterior orientation, same ground X, Y, and Z, and same residuals up to computation accuracy). The non-calibration report scenario has been tested with LPS 9.0, and found to yield the same triangulation results.

There is a small discrepancy encountered by putting back $k_1$ and $k_2$ from the triangulation report when using LPS 8.7.2 because of a non-zero $r_0$ used internally in the self-calibration parameters. In this case, you have to manually compute a $k_0$ from the $k_1$ and $k_2$ with non-zero $r_0$. The following equation is used.

$$r_0 = \frac{\sqrt{\frac{x_{max}^2 + y_{max}^2}{2}}}{2}$$

The values for $x_{max}$ and $y_{max}$ are found in the triangulation report as described above along with $k_1$ and $k_2$. Starting with LPS 9.0, the $r_0$ parameter has been removed so that $k_1$ and $k_2$ can be directly used in the camera editor or elsewhere without additional computation.

**Parameters governing the operation of triangulation for SPOT, IRS-1, and generic pushbroom sensor imagery can be defined to optimize the results of the estimated parameters (e.g., XYZ tie point coordinates and exterior orientation information).**

The Triangulation dialog, shown in Figure 128, allows for the input and specification of parameters associated with performing triangulation on SPOT, IRS-1C, and generic pushbroom imagery.
In the SPOT model, only full GCPs or GCPs that are measured on two or more images are used in triangulation. Horizontal and vertical GCPs are not used in triangulation.

The General tab within the Triangulation dialog defines the necessary information concerning the iterative least squares approach for estimating the unknown parameters of the solution.

The Maximum Normal Iterations option defines the maximum number of iterations to be used during the least squares adjustment with constrained GCPs. The normal iterative solution utilizes the normal weights for the exterior orientation parameters. The normal weights are determined automatically.

The Iterations With Relaxation option allows the use of a free-weighted iterative adjustment for determining the position and orientation associated with a pushbroom sensor. In this case, very small weights are used for the coefficients associated with exterior orientation. If a value of 0 is specified, a free-weighted adjustment is not used. It may be advantageous to use a free-weighted adjustment in scenarios where the satellite sensor has complicated geometry.

Assigning Statistical Weights to GCPs

To optimize the quality of the triangulation solution, GCPs can be assigned statistical weights defining the quality of the GCPs. The standard deviations associated with GCPs can be assigned within the Point tab of the Triangulation dialog, depicted in Figure 129.
The options provided are similar to those outlined for aerial triangulation. The standard deviations should reflect the quality of the GCPs. If small standard deviation values are entered, the quality of the estimated exterior orientation parameters and X, Y, Z tie point coordinates suffer.

As a test, it is common to set the standard deviation values to the ground resolution of the imagery being processed. For example, if SPOT imagery is being used, a standard deviation of 10 meters can be used as a test to determine the unknown parameters. Based on the output results, the standard deviation value can be varied until the residuals to the GCP and image coordinates are at a minimum while increasing the accuracy of the estimated parameters (i.e., exterior orientation and X, Y, Z tie point coordinates).

**Advanced Options**

In order to optimize the triangulation results, several advanced options are provided within the **Advanced Options** tab, shown in **Figure 130**.

**Figure 130: Advanced Options Tab of the Triangulation Dialog**
A Simple Gross Error Check model is provided to identify and remove the erroneous observations (for example, image coordinate measurements of GCPs) from the triangulation solution. The procedure multiplies the standard error (or standard deviation of unit weight) by a user-specified value (for example, times of unit weight). The resulting value is used as a threshold and compared to the residuals of the image coordinates. Image coordinates having residuals larger than the threshold value are discarded from the triangulation solution.

The remaining options are similar to those used within the Aerial Triangulation dialog.

For more information, see “Aerial Triangulation”.

**Triangulation Report**

The triangulation report lists all of the input and output data used during the triangulation process. The report can be divided into several categories including:

- triangulation report unit definition
- automated error checking model
- iterative triangulation results
- triangulation using a free-weighted adjustment
- exterior orientation results
- GCP residuals
- image coordinate information

The following explanations are provided to better understand the contents of the aerial triangulation report.

**Triangulation Report Unit Definition**

The units for the image coordinates, exterior orientation rotation angles, and GCPs are defined. The positional elements of exterior orientation use the same units as the GCPs. Image coordinate residuals are displayed in the units similar to input image coordinates.

The triangulation report with IMAGINE LPS Project Manager:

The output image x, y units: pixels
If a Geographic Lat/Lon reference coordinate system is being used, the computed exterior orientation values display in a topocentric coordinate system. The origin of the topocentric coordinate system is internally defined by LPS Project Manager and can be modified by you.

Automated Error Checking Model

LPS Project Manager provides an error checking model that automatically identifies and removes erroneous image measurements from the block. The error checking model can be specified by selecting the **Simple Gross Error Check Using** options within the **Advanced Options** tab of the Triangulation dialog. Once the radio button has been selected, the times of unit multiplier can be specified. This value is multiplied by the standard deviation of unit weight. If an image coordinate residual value is larger than the multiplied value, the image point is excluded from the triangulation.

The results of the gross error checking model are displayed as follows:

<table>
<thead>
<tr>
<th>image</th>
<th>pid</th>
<th>image_x</th>
<th>image_y</th>
<th>residual_x</th>
<th>residual_y</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>869.5420</td>
<td>2487.996</td>
<td>-1.8265</td>
<td>0.2271</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>2890.880</td>
<td>1258.852</td>
<td>1.1212</td>
<td>0.4837</td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>1978.138</td>
<td>2919.004</td>
<td>2.1869</td>
<td>0.1647</td>
</tr>
</tbody>
</table>

The x and y image coordinate residuals of the erroneous points are displayed. LPS Project Manager notifies you if a point is excluded from the triangulation solution. The pid designation defines the point id of a GCP.
Iterative Triangulation Results

The results for each iteration of processing are provided once the triangulation has been performed. A global indicator of quality is computed for each iteration of processing. This is referred to as the standard error (also known as the standard deviation of image unit weight). This value is computed based on the image coordinate residuals for that particular iteration of processing. The units for the standard error are defined within the General tab of the Triangulation dialog.

After each iteration of processing, LPS Project Manager estimates the position and orientation parameters of the satellite sensor and X, Y, and Z tie point coordinates. The newly estimated parameters are then used along with the GCP and tie point coordinates to compute new x and y image coordinate values. The newly computed image coordinate values are then subtracted from the original image coordinate values. The differences are referred to as the x and y image coordinate residuals.

If the position and orientation information associated with a satellite is incorrect, then the newly computed image coordinate values are also incorrect. Incorrect estimates for the unknown parameters may be attributed to erroneous GCPs, not enough GCPs, data entry blunders, or mismeasured image positions of GCPs or tie points. Any error in the input observations is reflected in the image coordinate residuals.

The computed standard error for each iteration accumulates the effect of each image coordinate residual to provide a global indicator of quality. The lower the standard error, the better the solution.

LPS Project Manager performs the first portion of the triangulation using the weighted iterative approach. In this scenario, the normal statistical weights associated with the exterior orientation coefficients are used. The solution continues until the corrections to the unknown parameters are less than the specified convergence value, or the specified number of normal iterations has been reached. The convergence value is specified within the General tab of the Triangulation dialog. The results of the normal-weighted iterative solution may appear as follows:

<table>
<thead>
<tr>
<th>No.</th>
<th>Total_RMSE</th>
<th>Max_Residual at image</th>
<th>pid</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.973941</td>
<td>4.1854</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>0.951367</td>
<td>4.0954</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>0.929783</td>
<td>4.0077</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>0.909040</td>
<td>3.9213</td>
<td>2</td>
</tr>
</tbody>
</table>
The standard error associated with each iteration is provided. The units of the standard error are the same as the image coordinate units. Additionally, the maximum image coordinate residual associated with a point is provided for each iteration of processing. Information pertaining to the point id and the image it is located on is also provided.

⚠️ It is highly recommended that the number of maximum normal iterations be set to 5. A lower number may produce inadequate results.

**Triangulation Using a Free-weighted Adjustment**

Once the weight-restrained iterative triangulation has been performed, LPS Project Manager also has the ability to process the triangulation using a free-weighted adjustment. In this case, very small weights are assigned to the coefficients of exterior orientation parameters. This can be referred to as iterations with relaxation.

If the **Iterations With Relaxation** option is set to a value greater than 0, a free-weighted least squares adjustment is used. The iterative solution continues until the corrections to the unknown parameters are less than the convergence value, or the specified number of iterations has been reached.

This approach may be advantageous when the sensor geometry is complicated. The results appear as follows:

<table>
<thead>
<tr>
<th>No.</th>
<th>Total_RMSE</th>
<th>Max_Residuals</th>
<th>at image</th>
<th>pid</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>0.200501</td>
<td>0.7890</td>
<td>1</td>
<td>11</td>
</tr>
</tbody>
</table>

The results for the free-weighted triangulation are displayed after the results of the normal-weighted triangulation.

**Exterior Orientation Results**

Once the triangulation solution has converged, the resulting coefficients associated with the exterior orientation parameters are displayed along with their corresponding precision estimates. The results are displayed for each image as follows:

Image parameter value and precision:
In the above example, the polynomial order specified for X, Y, and Z is two. Three coefficients were computed including \( a_0 \), \( a_1 \), and \( a_2 \). Just below each coefficient value is the associated quality. For the same example, the polynomial order specified for Omega, Phi, and Kappa is one. Thus, two coefficients were computed including \( a_0 \) and \( a_1 \). The polynomial coefficients can be used to compute the exterior orientation parameters associated with each scan line.
**GCP Results**

Once the triangulation solution has converged, ground point values for GCPs, tie points, and check points are computed. If you select the option Compute Accuracy for Unknowns in the Triangulation dialog, then the point values display with their corresponding accuracy. The results appear as follows:

<table>
<thead>
<tr>
<th>point id</th>
<th>X (accuracy)</th>
<th>Y (accuracy)</th>
<th>Z (accuracy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: 566190.7372</td>
<td>0.2989</td>
<td>0.2982</td>
<td>0.3002</td>
</tr>
<tr>
<td>2: 555691.3534</td>
<td>0.2977</td>
<td>0.2972</td>
<td>0.3000</td>
</tr>
<tr>
<td>3: 501918.8209</td>
<td>0.3004</td>
<td>0.3000</td>
<td>0.3007</td>
</tr>
</tbody>
</table>

The accuracy of each GCP displays in brackets. The GCP information displays as Point ID, Image Number, X (accuracy), Y (accuracy), and Z (accuracy). Incorrect points commonly have less accuracy (that is, larger accuracy value). A relative comparison of accuracy values can be used to identify suspect points.

**Image Coordinate Information**

Once the triangulation is complete, image coordinate residuals are computed. The residuals are computed based on the estimated exterior orientation parameters, GCP, check point, and tie point coordinates, and their respective image measurements. During the iterative least squares adjustment, the results from the previous iteration are compared to results of the most recent iteration. During this comparison, image coordinate residuals reflecting the extent of change between the original image coordinates and the new values are computed. The values of the new image coordinates are dependent on the estimated or adjusted parameters of the triangulation. Therefore, errors in the estimated parameters are reflected in the image coordinate residuals.

LPS Project Manager computes the image coordinate residuals for each image measurement in the block. The results appear as follows:

| image pid image_x image_y residual_residual_x residual_y |
|--------------|--------------|--------------|--------------|--------------|--------------|
| image pid image_x image_y residual_residual_x residual_y |
The information for each image coordinate displays as image number, point ID, image x coordinate, image y coordinate, image x residual, and image y residual. Relatively large residuals indicate erroneous points which can be attributed to image mismeasurement, data entry, and incorrect input data.

Optimizing the Triangulation Results

Optimizing the output results of triangulation can be improved by considering the following:

- Increase the number and quality of GCPs within the block of images. Ten or more GCPs are recommended for the overlap area of two images.
- Evenly distribute GCPs throughout the block.
- Increase the number of tie points on the overlapping areas of the images contained within the block. Ensure that the tie points are placed within the GCP configuration (that is, polygon defining the spatial coverage provided by the GCPs), as shown in Figure 131. The output quality of tie points outside of the photogrammetric network of GCPs is less accurate.

![Figure 131: Tie Points Contained within a GCP Configuration](image)
• If the quality of the GCPs or sensor information (that is, incidence angles) is weak, increase the value for the **Iterations With Relaxation** option.

### Refinement Summary Report

With IKONOS data, a separate report is provided, called the Refinement Summary report. Like other reports, you access it from the **Process | Report** option in the LPS Project Manager. The report can be divided into several categories including:

- adjustment report unit definition
- calculated point coordinates
- point residuals
- image accuracy
- RMSE for points

### Adjustment Report Unit Definition

The units for the image coordinates, ground units, and Z units are defined.

```
Adjustment Report With LPS Project Manager
Output image units: pixels
Output ground units: degrees
Output z units: meters
```

### Calculated Point Coordinates

All of the points in the block file are listed with their type (GCP, control, tie, check), point ID, and ground x, y, and z coordinates.

```
Calculated ground x, y and z coordinates: degrees meters

<table>
<thead>
<tr>
<th>type</th>
<th>pid</th>
<th>ground_x</th>
<th>ground_y</th>
<th>ground_z</th>
</tr>
</thead>
<tbody>
<tr>
<td>gcp</td>
<td>1</td>
<td>117.148842</td>
<td>36.328355274</td>
<td>0.941148842</td>
</tr>
<tr>
<td>gcp</td>
<td>2</td>
<td>117.085939</td>
<td>53.328371565</td>
<td>1.163.122553</td>
</tr>
<tr>
<td>gcp</td>
<td>3</td>
<td>117.163955</td>
<td>42.327498947</td>
<td>0.892.3812217</td>
</tr>
</tbody>
</table>
```
Point Residuals

The control point residuals reflect the difference between the original control point coordinates and the newly estimated control point coordinates.

Control and check point residuals: degrees meters
type pid residual_x residual_y residual_z
gcp 1 0.00006974 -0.00020760 3.90744640
    0.00006974 0.00010593 -3.90744640
    0.00006974 0.00010660 3.93122178

Image Accuracy

LPS Project Manager computes the image coordinate residuals for each image measurement in the block. The results appear as follows:

Image accuracy for control and check points for each scene:
image id 1:

pid type image_x image_y residual_x residual_y
1 gcp 4404.625 608.8740 5.1079 -2.4929
2 gcp 4746.631 2037.897 0 3.0527 2.6564
3 gcp 2006.136 739.3350 -3.0552 -0.1636

RMS Errors for 3 GCPs: x: 3.6350
                       y: 2.1054
                       total: 4.2007
Summary RMSE

RMSE is reported on a point type basis in both the ground and image space coordinate system.

Summary RMSE for GCPs and CHKs (number of observations in parenthesis):

<table>
<thead>
<tr>
<th></th>
<th>Control</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground X:</td>
<td>0.0001 (3)</td>
<td>0.0000 (0)</td>
</tr>
<tr>
<td>Ground Y:</td>
<td>0.0001 (3)</td>
<td>0.0000 (0)</td>
</tr>
<tr>
<td>Ground Z:</td>
<td>3.2004 (3)</td>
<td>0.0000 (0)</td>
</tr>
<tr>
<td>Image X:</td>
<td>3.7726 (6)</td>
<td>0.0000 (0)</td>
</tr>
<tr>
<td>Image Y:</td>
<td>2.2016 (6)</td>
<td>0.0000 (0)</td>
</tr>
</tbody>
</table>

image id 2:
pid | type | image_x | image_y | residual_x | residual_y |
-----|------|---------|---------|------------|------------|
1    | gcp  | 4401.625| 609.8740| 5.5169     | -3.0176    |
2    | gcp  | 4737.140| 2038.485| -2.5303    | 2.5398     |
3    | gcp  | 2006.525| 739.1730| -2.9866    | 0.4777     |

RMS Errors for 3 GCPs:  
x: 3.9055  
y: 2.2938  
total: 4.5293
Orthorectification

Introduction

The orthorectification (ortho resampling) process removes the geometric distortion inherent in imagery caused by camera/sensor orientation, topographic relief displacement, and systematic errors associated with imagery.

Orthorectified images are planimetrically true images that represent ground objects in their true, real-world X and Y positions. For these reasons, orthorectified imagery has become accepted as the ideal reference image backdrop necessary for the creation and maintenance of vector data contained within a GIS.

During triangulation, the effects of camera/sensor orientation have been considered. In using frame cameras, systematic errors caused by lens distortion have been considered by specifying the radial lens distortion parameters associated with the camera. If using nonmetric cameras for image collection, AP models can be used to account for residual systematic error associated with the lens and camera instability.

By defining a DEM or constant elevation value (ideal for use in areas containing minimal relief variation), the effects of topographic relief displacement can be considered.

Ortho Resampling

The final step in the LPS Project Manager workflow is orthorectification.

By selecting the Orthorectification icon on the LPS Project Manager toolbar or the Ortho Rectification -> Resampling option within the Process menu, the Ortho Resampling dialog opens, which is depicted in Figure 132.
General Tab

The following parameters can be defined and used for the orthorectification of each image in a block:

- By defining an **Active Area Used** percentage, the extent of the input image can be reduced while used to determine the default upper left and lower right output corners.

- A **DTM Source** can be specified and used for each image during orthorectification. It is highly recommended that the area coverage in the input DTM corresponds to the coverage provided by the images in a block. The DTM source could be one of the following: DEM, TIN, 3D Shape, ASCII, or a Constant value.

- Ground resolution can be defined in the X and Y direction (**Output Cell Sizes**).

- Upper left and lower right corners of the output orthoimage can be set using **ULX**, **ULY**, **LRX**, and **LRY**.

Adding Images

By default, the image in the LPS Project Manager that is currently the reference image, indicated by the > symbol in the CellArray, is loaded into the CellArray first. You then have the option of adding a single or multiple images to be processed.
To ensure that images added to the CellArray have the same parameters as the image currently displayed, set all parameters in each tab first, then add images.

In the case of adding a single image, you click the Add button and are prompted by the dialog depicted in Figure 133.

Figure 133: Add Single Output to Ortho Resampling CellArray

Here, you use a combination of the dropdown list and the File Selector to give your output orthoimage a name. Using the Use Current Cell Sizes option ensures that this orthoimage has the same cell size as the one already listed in the CellArray.

If you need to add multiple images, choose the Add Multiple button. You are prompted by the dialog shown in Figure 134.

Figure 134: Add Multiple Outputs to Ortho Resampling CellArray

You can use the CellArray to rapidly scan the settings applied to each of your output orthoimages. To change any singular image’s parameters, click in the > column to select the image, then make changes in the appropriate tab of the Ortho Resampling dialog.

Advanced Tab

The Advanced tab, shown in Figure 135, has options for Resampling Method, Ignore Value, Overlap Threshold, and Projection.
• **Resampling Method** includes Nearest Neighbor, Bilinear Interpolation, and Cubic Convolution.

⚠️ *It is recommended that the DEM Resampling Method within the LPS preferences be specified as Bilinear Interpolation.*

• **Overlap Threshold.** Any image that has less than the threshold percentage of overlap with the DTM is not orthorectified. Images with greater than the threshold percentage of overlap with the DTM result in orthorectified output for the intersection (overlap) areas only. By default, the value is 30%, but the threshold can be set as low as 0.5%.

For example, if the threshold value is 10% and the percentage of the overlap is 45% between the DTM and the image, the resulting orthoimage is the intersecting 45% of the original scene. If the percentage of the overlap is 5%, then orthorectification is not performed.

• **Ignore Value.** It is highly recommended to use this option if the imagery contains areas with 0 values in the background.

• **Projection** and **Units** of the output orthoimage can be reset.
Once the settings are accurate, you can proceed to the resampling process by clicking **OK**, or by clicking **Batch**, which can process the images at a later time.

For more information on **Batch**, see “**Batch Processing**”.

**Ortho Calibration**

Ortho calibration is the process of automatically creating an orthorectified mathematical model that associates the original image with the Earth’s surface. This process does not create a new image. Within an ortho-calibrated image, each pixel has orthorectified X and Y coordinates. This approach is ideal for retaining the original image quality while preserving disk space.

By selecting the **Ortho Rectification -> Calibration** option within the **Process** menu, the Ortho Calibration dialog opens, as shown in **Figure 136**.

**Figure 136: Ortho Calibration Dialog**

Using ortho calibration techniques is preferred if the available disk space is low, and/or the spectral quality of the original image is poor. Otherwise, the **Resampling** option of orthorectification is recommended.
Appendices
Batch Processing

Introduction
When you are working with a block file that contains many images you wish to use in the generation of DTMs, you can use the ERDAS IMAGINE Batch Wizard to automate the process. The following sections give you steps to follow in using Batch to create multiple DTMs.

The DTM Extraction dialog in LPS Automatic Terrain Extraction has a Batch button. This button is used to place the command in the Batch queue instead of actually performing the operation. Off-line processing allows unattended operation, enabling you to log off if you wish.

⚠️ On Microsoft Windows NT, you must have administrator privilege to schedule Batch jobs at a later time.

Set Up/Start the Scheduler
Before you can use the Batch Wizard to schedule jobs to run later, you must set up and run the Scheduler. This requirement means that the account that starts the Scheduler must remain logged-in for the scheduled job to run.

You must log in as an administrator or as a person with administrator privileges to set up and start the Scheduler. Once started, the Scheduler is available for use by any other person with administrative privileges.

1. From the Start menu, select Settings -> Control Panel.
2. On the Control panel, select the Administrative Tools option.

The Services dialog opens.
4. Scroll through the Services window and select Task Scheduler.

5. In the Services dialog, click the Properties icon.

6. Select Automatic as the Startup Type.

7. Click the Log On tab.

8. Click the This Account radio button. Enter your account name and password, confirm your password, click Apply, and then click OK.

9. If necessary, click the Start Services icon.

**NOTE:** The ability to run a Batch process at a later time is built using the Windows Scheduler, which is part of the `at` command. Refer to the Windows help to learn more about the use of the `at` command.

**NOTE:** (Microsoft Windows NT) If you are submitting jobs for processing later and you are using mapped network drives, then you need to ensure that these maps are in place when the Batch job runs. Typically, a mapped drive is only available to the current user unless the Reconnect at Logon option was checked on the Map Network Drive dialog when the drive was mapped.

If this option is not checked, then when the Batch process is run by the Scheduler, it is not able to find the drive. This is one of the reasons to make sure that the Scheduler service runs using your account name. This ensures that remembered network drivemaps are reestablished when the Batch process runs.
Execute Multiple Files/Single Command

You can use the Batch Wizard to set up multiple jobs with varying parameters. You may want to add a series of jobs to the batch list, each with different parameters.

*NOTE: The following steps assume you have completed setup through the actual application of automatic DTM extraction.*

1. Once you have set all of your parameters in the DTM Extraction and DTM Extraction Properties dialogs, click the **Batch** button.

The Batch Wizard opens.

![Batch Commands dialog](image)

*This option is selected by default*

1. Notice that the **Use commands as they are** option is selected by default.

2. Click the **Next** button to advance to the next frame.

![Batch Commands dialog](image)

*Select the time you want batch processing to begin*

*The name of the Batch job is created automatically, but you can change it if you wish*
3. Click the **Start Processing Later At** radio button.

4. Type or use the increment nudgers to the right of the fields to set the time at which you want the process to run.

   Notice that the **Name** field shows the prefix **atm**, followed by a number string. The **atm** prefix designates the Batch process as one from LPS Automatic Terrain Extraction.

5. Click the **Next** button to advance to the next frame.

6. Click in the **Enter Username** field and type your user name.

7. Click in the **Enter Password** field and type your password.

8. Type your password again in the **Confirm Password** field.

9. Confirm that the **Show job in Scheduled Tasks folder** checkbox is checked.

10. Click **Finish** to schedule the batch processing.

   The Scheduled Batch Job List dialog opens.
If you decide that you want to alter parameters of the job (for example, time) listed in the **Job Name** field, you can do so by selecting the job, then clicking the **Modify** button at the bottom of the Scheduled Batch Job List dialog. Similarly, if you want to delete a job, select the job, then click the **Delete** button at the bottom of the dialog.

If you wish to add other jobs to the scheduler, set the parameters you desire, then follow the same series of steps. The job is added to the Scheduled Batch Job List dialog.

**Other Batch Applications**

After you have processed a number of DTMs using Batch, you should check them for accuracy. Once you have verified the accuracy and performed any necessary post-processing, you can set up another Batch job to use those DTMs as input into the orthoresampling process.

Like the DTM Extraction dialog, the Ortho Resampling dialog also has a **Batch** button. Simply set the parameters for each output orthoimage, and add the process to the Batch job.

For more information about the Ortho Resampling dialog, see Orthorectification.
You cannot schedule an orthoresampling Batch job that uses a DTM generated by LPS Automatic Terrain Extraction to immediately follow the DTM extraction Batch job. Files must be pre-existing to be used as elevation control in the Ortho Resampling dialog. Instead, use Batch to process the DTM extractions, then set-up a separate Batch job to process the orthoimages.
References

Introduction

References and suggested readings are listed below.

Works Cited


Federal Geographic Data Committee (FGDC). Content Standards for Digital Orthoimagery. Federal Geographic Data Committee,


Wolf, P. R. “Definitions of Terms and Symbols used in Photogrammetry.” Manual of Photogrammetry. Ed. C. C. Slama. Falls Church, Virginia: American Society of Photogrammetry,


Abbreviations and Acronyms

A
AT. aerial triangulation.

B
b/h. eye-base to height ratio.

C
CCD. charge-coupled device.
CTS. conventional terrestrial system.

D
DEM. digital elevation model.
DPW. digital photogrammetric workstation.
DSM. digital stereo model.
DTM. digital terrain model.

E
ECI. earth centered inertial.
ECF. earth centered fixed.
ECR. earth centered rotating.

G
GCP. ground control point.
GIS. geographic information system.
GPS. global positioning system.

I
IERS. International Earth Rotation Service.
INS. inertial navigation system.

L
Lat/Lon. latitude/longitude.
LRX. lower right X.
LRY. lower right Y.

R
RMSE. root mean square error.
**SCBA.** self-calibrating bundle adjustment.

**SI.** image scale.

**TIN.** triangulated irregular network.

**ULX.** upper left X.

**ULY.** upper left Y.

**File Types**

* .aoi. An Area of Interest file. Used to hold a point, line, or polygon that is selected as a training sample or as the image area to be used in an operation.

* .blk. A block file. A block file can contain only one image. A block file that contains two or more images with approximately 60% overlap can be viewed in stereo in other applications such as Stereo Analyst.

* .cam. An ASCII file with a fixed structure. Provides camera information such as focal length and principal point.

* .dat. An ASCII file. In LPS Project Manager, exterior orientation parameters are often contained in a .dat file. Typically, this data comes from the airborne GPS or INS used during image capture.

See also Airborne GPS
Inertial Navigation System

* .img. An ERDAS IMAGINE image file. Data in the .img format are tiled data, which can be set to any size. A file containing raster image data. An .img file contains data such as sensor information, layer information, statistics, projection, pyramid layers, attribute data, etc.

* .shp. An ESRI shape file. Shape files are in vector format, and can store attribute data.

* .txt. An ASCII text file. Frequently used as an input GCP reference source for 2- and 3-dimensional control point and check point coordinates.

**Symbols**

κ. (Kappa) In a rotation system, Kappa is positive rotation about the Z-axis.

ω. (Omega) In a rotation system, Omega is positive rotation about the X-axis.
(Phi) In a rotation system, Phi is positive or negative rotation about the Y-axis.

See also  Phi (-), Omega, Kappa
         Phi(+), Omega, Kappa

Terms

Additional parameter (AP). In block triangulation, additional parameters characterize systematic error within the block of images and observations, such as lens distortion. In LPS Project Manager, four AP models can be used in the triangulation process, including: Bauer's Simple Model, Jacobsen's Simple Model, Ebner's Orthogonal Model, and Brown's Physical Model.

Adjusted stereopair. An adjusted stereopair is a pair of images displayed in a workspace that has a map projection associated and exterior orientation used to facilitate stereo viewing. A set of two remotely-sensed images that overlap, providing a 3D view of the terrain in the overlap area.

Aerial photographs. Photographs taken from positions above the Earth captured by aircraft. Photographs are used for planimetric mapping projects.

Aerial stereopair. Two photos with a common overlap area.

Aerial triangulation (AT). The process of establishing a mathematical relationship between images, the camera or sensor model, and the ground. The information derived is necessary for orthorectification, DEM generation, and stereopair creation. This term is used when processing frame camera, digital camera, videography, and nonmetric camera imagery.

See also  Triangulation

Affine transformation. A 2D plane-to-plane transformation that uses six parameters (coefficients) to account for rotation, translation, scale, and nonorthogonality in between the planes. Defines the relationship between two coordinate systems such as a pixel and image space coordinate system.

Air base. The distance between two image exposure stations.

See also  Base-height ratio
**Airborne GPS.** GPS stands for Global Positioning System. Airborne GPS is a technique used to provide initial approximations of exterior orientation, which defines the position and orientation associated with an image as they existed during image capture. GPS provides the X, Y, and Z coordinates of the exposure station.

See also  [Global positioning system](#)

**Airborne INS.** INS stands for Inertial Navigation System. Airborne INS data is available for each image, and defines the position and orientation associated with an image as they existed during image capture.

See also  [Inertial navigation system](#)

**Algorithm.** “A procedure for solving a mathematical problem (as of finding the greatest common divisor) in a finite number of steps that frequently involves repetition of an operation” ([Merriam-Webster n.d.](#)).

**American standard code for information interchange (ASCII).** A "basis of character sets. . .to convey some control codes, space, numbers, most basic punctuation, and unaccented letters a-z and A-Z” ([Howe 1995](#)).

**Analog photogrammetry.** In analog photogrammetry, optical or mechanical instruments, such as analog plotters, used to reconstruct 3D geometry from two overlapping photographs.

**Analytical photogrammetry.** The computer replaces some expensive optical and mechanical components by substituting analog measurement and calculation with mathematical computation.

**a priori.** Already or previously known.

**Area of interest (AOI).** A point, line, or polygon that is selected as a training sample or as the image area to be used in an operation. AOIs can be stored in separate .aoi files.

**Auto-correlation.** A technique used to identify and measure the image positions appearing within the overlap area of two adjacent images in a block file.

**Automated interior orientation.** Technique based on template matching used to identify and measure fiducial mark positions.

**Automated tie point collection.** LPS ATE’s ability to automatically measure tie points across multiple images.

See also  [Tie point](#)
**Average flying height.** The distance between the camera position at the time of exposure and the average ground elevation. Average flying height can be determined by multiplying the focal length by the image scale.

See also  
- Focal length
- Image scale

**Base-height ratio (b/h).** The ratio between the average flying height of the camera and the distance between where the two overlapping images were captured.

**Block.** A term used to describe and characterize all of the information associated with a photogrammetric mapping project, such as: projection, spheroid, and datum; imagery; camera or sensor model information; GCPs; and geometric relationship between imagery and the ground. A block file is a binary file.

**Block footprint.** A graphical representation of the extent of images in a block file. The images are not presented as raster images. Rather, they are displayed as vector outlines that depict the amount of overlap between images in the block file.

**Block of photographs.** Formed by the combined exposures of a flight. For example, a traditional frame camera block might consist of a number of parallel strips with a sidelap of 20-30%, and an overlap of 60%.

**Block triangulation.** The process of establishing a mathematical relationship between images, the camera or sensor model, and the ground. The information derived is necessary for orthorectification, DEM generation, and stereopair creation.

**Blunder.** A blunder is a gross error resulting from incorrect data entry, incorrect measurement of ground points on imagery, and faulty identification of GCPs and tie points. In LPS Project Manager, a blunder model identifies and removes errors from the photogrammetric network of observations.

**Break line.** A breakline is a polyline in the terrain model that models a change in terrain. Hard breaklines are used to model V-shaped changes in the terrain; soft breaklines are used to model U-shaped changes in the terrain.

**Bundle.** The unit of photogrammetric triangulation after each point measured in an image is connected with the perspective center by a straight light ray. There is one bundle of light rays for each image.

**Bundle attitude.** Defined by a spatial rotation matrix consisting of three angles: Omega (ω), Phi (φ), and Kappa (κ).
Bundle block adjustment. A mathematical technique (triangulation) that determines the position and orientation of each image as they existed at the time of image capture, determines the ground coordinates measured on overlap areas of multiple images, and minimizes the error associated with the imagery, image measurements, and GCPs. This is essentially a simultaneous triangulation performed on all observations.

Bundle location. Defined by the perspective center, expressed in units of the specified map projection.

Calibration certificate/report. In aerial photography, the manufacturer of the camera specifies the interior orientation in the form of a certificate or report. Information includes focal length, principal point offset, radial lens distortion data, and fiducial mark coordinates.

Camera coordinate system. A camera coordinate system has its origin defined at the perspective center. Its x-axis and y-axis are parallel to the x-axis and y-axis in the regular image plane coordinate system. The z-axis is the optical axis; therefore the z value of an image point in the camera coordinate system is usually equal to -f (focal length). Camera coordinates are used to describe the positions inside the camera and usually use units in millimeters or microns. This coordinate system is referenced as camera coordinates (x, y, and z).

Cartesian coordinate system. “A coordinate system consisting of intersecting straight lines called axes, in which the lines intersect at a common origin. Usually it is a 2-dimensional surface in which a “x,y” coordinate defines each point location on the surface. The “x” coordinate refers to the horizontal distance and the “y” to vertical distance. Coordinates can be either positive or negative, depending on their relative position from the origin. In a 3-dimensional space, the system can also include a “z” coordinate, representing height or depth. The relative measurement of distance, direction and area are constant throughout the surface of the system” (Natural Resources Canada 2001a).

CellArray. In ERDAS IMAGINE, the CellArray is used to maintain and edit data in a tabular format.

Cell size. The area that one pixel represents, measured in map units. For example, one cell in the image may represent an area 30’ × 30’ on the ground. Sometimes called pixel size.
**Charge-coupled device (CCD).** A device in a digital camera that contains an array of cells which record the intensity associated with a ground feature or object.

**Check point.** An additional ground point used to independently verify the degree of accuracy of a triangulation.

**Check point analysis.** The act of using check points to independently verify the degree of accuracy of a triangulation.

**Coefficient limit.** The limit for the cross-correlation coefficient. This value ranges from .10 to .99. A larger limit results in fewer points accepted and less error. A smaller limit results in more correlated points, but also possibly more errors.

**Collinearity.** A nonlinear mathematical model that photogrammetric triangulation is based upon. Collinearity equations describe the relationship among image coordinates, ground coordinates, and orientation parameters.

**Collinearity condition.** The condition that specifies that the exposure station, ground point, and its corresponding image point location must all lie along a straight line.

**Control point.** A point with known coordinates in a coordinate system, expressed in the units (e.g., meters, feet, pixels, film units) of the specified coordinate system.

**Control point extension.** The process of converting tie points to control points. This technique requires the manual measurement of ground points on photos of overlapping areas. The ground coordinates associated with the GCPs are then determined using photogrammetric techniques.

**Convergence value.** A threshold to determine the level and extent of processing during the iterative aerial triangulation procedure.

**Coordinate system.** “A system, based on mathematical rules, used to measure horizontal and vertical distance on a surface, in order to identify the location of points by means of unique sets of numerical or angular values” ([Natural Resources Canada 2001b](#)).

**Coplanarity condition.** The coplanarity condition is used to calculate relative orientation. It uses an iterative least squares adjustment to estimate five parameters ($B_y$, $B_z$, Omega, Phi, and Kappa). The parameters explain the difference in position and rotation between two images making up the stereopair.
**Correlation.** Regions of separate images are matched for the purposes of tie point or mass point collection.

**Correlation area.** In LPS Project Manager, the default correlation area is the total overlap area reduced by the shrink percentage.

**Correlation limit.** Defines the correlation coefficient threshold used to determine whether or not two points are to be considered as possible matches.

**Correlation size.** Defines the size of the window to be used to compute the correlation between image points of common ground points appearing on multiple images.

**Correlation threshold.** A value used in image matching to determine whether to accept or discard match points. The threshold is an absolute value threshold ranging from 0.100 to 1.000.

**Correlation windows.** Windows that consist of a local neighborhood of pixels. One example is square neighborhoods (for example, $3 \times 3$, $5 \times 5$, $7 \times 7$ pixels).

**Corresponding GCPs.** The GCPs that are located in the same geographic location as the selected GCPs, but are selected in different images.

**Cross-correlation.** A calculation that computes the correlation coefficient of the gray values between the template window and the search window.

See also  
- Search windows
- Template window

**Cross-strips.** Strips of image data that run perpendicular to strips collected along the flight line.
**Data strip.** A strip contained within aerial photographs. The strip commonly provides information such as the type of camera, the number of the camera, and the approximate focal length of the camera.

**Datum.** "A datum is a system of reference for specifying the horizontal and vertical spatial positions of points" (*Wolf and Dewitt 2000*).

See also **Reference plane**

**Degrees of freedom.** Also known as redundancy. In the bundle block adjustment process, the number of unknowns is subtracted from the number of knowns. The resulting number is the redundancy, or degree of freedom in a solution.

**Digital correlation.** The process of automatically matching an image of a ground point to its corresponding (conjugate) image on another photo using digital correlation techniques. Also referred to as image matching and stereocorrelation.

**Digital elevation model (DEM).** Continuous raster layers in which data file values represent elevation. DEMs are available from the USGS at 1:24,000 and 1:250,000 scale, and can be produced with terrain analysis programs such as IMAGINE OrthoMAX™ and LPS Project Manager.

**Digital image matching.** Also known as auto-correlation. The process of matching features common to two or more images for the purpose of generating a 3D representation of the Earth.

**Digital orthoimage/orthophoto.** An aerial photo or satellite scene that has been transformed by the orthogonal projection, yielding a map that is free of most significant geometric distortions.

**Digital photogrammetric workstation (DPW).** These include LPS Project Manager, PCI OrthoEngine, SOCET SET, Intergraph, Zeiss, and others.

See also **Digital photogrammetry**

**Digital photogrammetry.** Photogrammetry as applied to digital images that are stored and processed on a computer. Digital images can be scanned from photographs or can be directly captured by digital cameras.

**Digital stereo model (DSM).** Stereo models that use imaging techniques of digital photogrammetry that can be viewed on desktop applications.
**Digital terrain model (DTM).** A discrete expression of topography in a data array, consisting of a group of planimetric coordinates (X,Y) and the elevations of the ground points and breaklines.

**Digitizing.** Any process that converts nondigital data into numeric data, usually to be stored on a computer. In ERDAS IMAGINE, digitizing refers to the creation of vector data from hardcopy materials or raster images. The data are traced using a digitizer keypad on a digitizing tablet, or a mouse on a display device.

**Direction of flight.** The direction in which the craft is moving (e.g., east to west). Images in a strip are captured along the aircraft or satellite’s direction of flight. Images overlap in the same manner as the direction of flight.

**Earth centered inertial (ECI) system.** The ECI coordinate system is space fixed with its origin at the Earth’s center of mass. The Z-axis corresponds to the mean north celestial pole of epoch J2000.0. The X-axis is based on the mean vernal equinox of epoch J2000.0. The Y-axis is the cross-product of the Z-axis and the X-axis.

**Earth centered rotating (ECR) system.** The ECR or ECF (Earth centered fixed) coordinate system is Earth fixed with its origin at the center of mass of the Earth. It corresponds to the conventional terrestrial system (CTS) defined by the International Earth Rotation Service (IERS), which is the same as the U.S. Department of Defense World Geodetic System 1984 (WGS84) geocentric reference system.

See also **Geodetic coordinate system**

**Elements of exterior orientation.** Variables that define the position and orientation of a sensor as it obtained an image. It is the position of the perspective center with respect to the ground space coordinate system.

**Ephemeris.** Data contained in the header of the data file of an image, provides information about the recording of the data and the satellite orbit.

**Epipolar line.** The line traced on each image representing the intersection of the epipolar plane with the image plane.

**Epipolar plane.** The plane, in space, containing a ground point and both exposure stations.

**Epipolar-resampled imagery.** Two images resampled (rectified or warped) such that clear stereo viewing is possible. Each line of the images is an epipolar line in which changes of height are effected by moving along the line (x-parallax); anomalies in stereo viewing represent displacement of images between lines (y-parallax).
Epipolar stereopair. A stereopair in which Y-parallax has been removed.

Exclusion AOI. An AOI purposely excluded from processing. The exclusion can be due to poor registration, or interest in some other feature. Exclusion AOIs are collected in the same manner as inclusion AOIs. LPS Automatic Terrain Extraction makes use of exclusion AOIs for DTM extraction.

Exposure station. During image acquisition, each point in the flight path at which the camera exposes the film. The exposure station has elements that define its position and rotation: X, Y, Z, Omega, Phi, and Kappa.

See also Omega, Phi, Kappa

Exterior orientation. External sensor model information that describes the exact position and orientation of each image as they existed when the imagery was collected. The image’s position is defined as having 3D coordinates, and the orientation is defined as having three rotations that include Omega, Phi, and Kappa.

Exterior orientation parameters. The perspective center’s ground coordinates in a specified map projection and three rotation angles around the coordinate axes.

Eye-base to height ratio. The eye-base is the distance between a person’s eyes. The height is the distance between the eyes and the image datum. When two images of a stereopair are adjusted in the X and Y direction, the eye-base to height ratio is also changed. Change the X and Y positions to compensate for parallax in the images.

Fiducial. Four or eight reference markers fixed on the frame of an aerial metric camera and visible in each exposure. Fiducials are used to compute the transformation from pixel coordinates to image coordinates.

Fiducial center. The center of an aerial photo; the intersection point of lines constructed to connect opposite fiducials.

Fiducial orientation. Defines the relationship between the image/photo-coordinate system of a frame and the actual image orientation as it appears in a view.

Focal length. The distance between the optical center of the lens and where the optical axis intersects the image plane. Focal length of each camera is determined in a laboratory environment.

Focal plane. The plane of the film or scanner used in obtaining an aerial photo.
**Free-weighted iterative adjustment.** In LPS Project Manager, a free-weighted iterative adjustment does not assign statistical weights to the bundled adjustment used during aerial triangulation.

See also  [Aerial Triangulation](#)

**Full GCP.** A GCP with X, Y, and Z coordinates.

See also  [Ground Control Point](#)

**Functional model.** The mathematical form of photogrammetric equations consisting of unknown and observed parameters which are to be incorporated in a least squares adjustment approach.

**Geodetic coordinate system.** The geodetic coordinate system is based on the WGS84 reference frame with coordinates expressed in latitude, longitude, and height above the reference Earth ellipsoid. No ellipsoid is required by the definition of the ECR coordinate system, but the geodetic coordinate system depends on the selection of an Earth ellipsoid. Latitude and longitude are defined as the angle between the ellipsoid normal and its projection onto the equator and the angle between the local meridian and the Greenwich meridian, respectively.

**Geographic information system (GIS).** A unique system designed for a particular application that stores, enhances, combines, and analyzes layers of geographic data to produce interpretable information. A GIS may include computer images, hardcopy maps, statistical data, and any other data needed for a study, as well as computer software and human knowledge. GISs are used for solving complex geographic planning and management problems. A GIS consists of spatial data stored in a relational database with associated ancillary information.

**Global positioning system (GPS).** “A surveying method that uses a set of 24 satellites in geostationary position high above the Earth. Specially designed GPS receivers, when positioned at a point on Earth, can measure the distance from that point to three or more orbiting satellites. The coordinates of the point are determined through the geometric calculations of triangulation. GPS provides accurate geodetic data for any point on the Earth” ([Natural Resources Canada 2001c](#)).

**Ground control point (GCP).** An easily identifiable point for which the ground coordinates of the map coordinate system are known.

**Horizontal control.** A set of points with defined planimetric positions in a map coordinate system.

**Image.** A picture or representation of an object or scene on paper, or a display screen. Remotely sensed images are digital representations of the Earth.
**Image center.** The center of the aerial photo or satellite scene.

**Image coordinate space.** A 2D space where measurements are recorded in pixels.

**Image coordinate system.** A 2D coordinate system defined in the photographic plane. The axes are constructed by the intersection of opposing fiducials.

**Image scale (SI).** Expresses the ratio between a distance in the image and the same distance on the ground.

**Image space coordinate system.** A coordinate system composed of the image coordinate system with the addition of a Z axis defined along the focal axis.

**Incidence angles.** Angles specifying the position of sensors onboard a satellite. Also called inclination angles.

**Inclination.** The angle between a vertical on the ground at the center of the scene and a light ray from the exposure station, which defines the degree of off-nadir viewing when the scene was recorded.

**Inclusion AOI.** An AOI purposely included in processing, as in DTM extraction.

See also **Exclusion AOI**

**Inertial navigation system (INS).** A technique that provides initial approximations to exterior orientation. This data is provided by a device or instrument. The instrument collects data about the attitude of the airplane in which it is located. The information it collects includes pitch (tilting forward and backward), roll (tilting sideways), and heading (the direction of flight) (National Oceanic and Atmospheric Administration 2001).

See also **Omega, Phi, Kappa**

**Interior orientation.** Describes the internal geometry of a camera such as the focal length, principal point, lens distortion, and fiducial mark coordinates for aerial photographs.

**International Earth Rotation and Reference Systems Service (IERS).** The IERS provides celestial and terrestrial reference systems and frames that help “the astronomical, geodetic and geophysical communities” (International Earth Rotation and Reference Systems Service 2003). For more information, see the IERS web site at www.iers.org.
International Society of Photogrammetry and Remote Sensing (ISPRS). An organization “devoted to the development of international cooperation for the advancement of photogrammetry and remote sensing and their application.” For more information, visit the web site at http://www.isprs.org (International Society for Photogrammetry and Remote Sensing [1999?]).

**Iterations with relaxation.** During a free-weighted adjustment, each iteration of processing does not use the statistical weights associated with the GCPs in the block file.

**K**

**Kappa.** ($\kappa$) In a rotation system, Kappa is positive rotation around the Z-axis.

**Konrady coefficients.** Coefficients that define radial lens distortion. Expressed as K0, K1, and K2.

See also Radial lens distortion

**L**

**Latitude/longitude (lat/lon).** The coordinate components of a spherical map coordinate system.

**Least squares adjustment.** A technique by which the most probable values are computed for a measured or indirectly determined quantity based upon a set of observations. It is based on the mathematical laws of probability and provides a systematic method for computing unique values of coordinates and other elements in photogrammetry based on a large number of redundancy measurements of different kinds and weights.

**Least squares correlation.** Uses the least squares estimation to derive parameters that best fit a search window to a reference window.

**Least squares regression.** The method used to calculate the transformation matrix from the GCPs. This method is discussed in statistics textbooks.

**Lens distortion.** Caused by the instability of the camera lens at the time of data capture. Lens distortion makes the positional accuracy of the image points less reliable.

**Lower right X (LRX).** The X map or file coordinate of the lower right pixel in the file.

**Lower right Y (LRY).** The Y map or file coordinate of the lower right pixel in the file.

**M**

**Map coordinates.** A system of expressing locations on the Earth’s surface using a particular map projection, such as UTM, State Plane, or Polyconic.
Map coordinate system. A map coordinate system that expresses location on the Earth’s surface using a particular map projection such as Universal Transverse Mercator (UTM), State Plane, or Polyconic.

Mass points. Points whose 3D coordinates are known (X, Y, and Z), which are used in creating a DEM or DTM.

See also Digital elevation model
Digital terrain model

Metric photogrammetry. The process of measuring information from photography and satellite imagery.

Multiple points. Multiple points can be collected from a DSM to create a TIN or DEM. Like a single point, multiple points have X, Y, and Z coordinate values.

See also Triangulated irregular network
Digital elevation model

Nadir. The area on the ground directly beneath a scanner’s detectors.

Nadir line. The average of the left and right edge lines of a pushbroom image.

Nadir point. The intersection of the focal axis and the image plane.

Near vertical aerial photographs. Photographs taken from vertical or near vertical positions above the Earth captured by aircraft. Photographs are used for planimetric mapping projects.

Nonmetric camera. A camera that has not been calibrated in a laboratory to determine its internal geometry.

See also Focal length
Principal point
Lens distortion
Fiducial

Nonorthogonality. The deviation from perpendicularity between orthogonally defined axes.

Object space. “...the three-dimensional region that encompasses the physical features imaged in photographs” (Wolf and Dewitt 2000).

Off-nadir. Any point that is not directly beneath a scanner’s detectors, but off to an angle. The SPOT scanner allows off-nadir viewing.

Omega. (ω) In a rotation system, Omega is rotation around the X-axis.
**Omega, Phi, Kappa.** A rotation system that defines the orientation of a camera/sensor as it acquired an image. Omega, Phi, Kappa is used most commonly, where Omega is positive rotation around the X-axis, Phi is a positive rotation around the Y-axis, and Kappa is a positive rotation around the Z-axis. This rotation system follows the right-hand rule.

See also  
Phi(+), Omega, Kappa  
Phi(−), Omega, Kappa  
Right-hand rule

**Optical axis.** “...The line joining the centers of curvature of the spherical surfaces of the lens” (*Wolf and Dewitt 2000*).

**Orbital coordinate system.** The orbital coordinate system is centered on the satellite and its orientation is based on the satellite position in inertial space. The origin is the satellite center of mass with the Z-axis pointing from the satellite center of mass to the Earth center of mass. The Y-axis is the normalized cross-product of the Z-axis and the instantaneous (inertial) velocity vector. It corresponds to the direction of the negative of the instantaneous angular momentum vector direction. the X-axis is the cross-product of the Y-axis and Z-axis.

**Orientation.** The position of the camera or satellite as it captured the image. Usually represented by six coordinates: X, Y, Z, Omega, Phi, and Kappa.

**Orientation angle.** The angle between a perpendicular to the center scan line and the North direction in a satellite scene.

**Orientation matrix.** A three-by-three matrix defining the relationship between two coordinate systems (that is, image space coordinate system and ground space coordinate system).

**LPS Project Manager block file.** An LPS Project Manager block file has the .blk extension. LPS Project Manager block files contain at least one stereopair that is in a coordinate system. An LPS Project Manager block file may also contain two or more sets of stereo images used for feature extraction and viewing.

**Orthogonal axes.** Axes that intersect traditional frame camera images at right angles.

**Orthorectification.** Also called ortho resampling. The process of removing geometric errors inherent within photography and imagery caused by relief displacement, lens distortion, and the like.
Overlap. In a traditional frame camera, when two images overlap, they share a common area. For example, in a block or strip of photographs, adjacent images typically overlap by 60%.

Parallax. “The apparent angular displacement of an object as seen in an aerial photograph with respect to a point of reference or coordinate system. Parallax is caused by a difference in altitude or point of observation” (Natural Resources Canada 2001d).

Perspective center. The optical center of a camera lens. (1) A point in the image coordinate system defined by the x and y coordinates of the principal point and the focal length of the sensor. (2) After triangulation, a point in the ground coordinate system that defines the sensor’s position relative to the ground.

Phi. (ϕ) In a rotation system, Phi is rotation around the Y-axis.

Phi(-), Omega, Kappa. A rotation system in which Phi is a negative rotation about the Y-axis, Omega is a positive rotation about the X-axis, and Kappa is a positive rotation about the Z-axis. Y is the primary axis.

Phi(+), Omega, Kappa. A rotation system in which Phi is a positive rotation about the Y-axis, Omega is a positive rotation about the X-axis, and Kappa is a positive rotation about the Z-axis. Y is the primary axis. This system is most commonly used in Germany.

Photo direction. The direction of the optical axis looking down; Z. In close range photography, it is Y.

Photogrammetric quality scanners. Special devices capable of high image quality and excellent positional accuracy. Use of this type of scanner results in geometric accuracy similar to traditional analog and analytical photogrammetric instruments.

Photogrammetry. The “art, science and technology of obtaining reliable information about physical objects and the environment through the process of recording, measuring, and interpreting photographic images and patterns of electromagnetic radiant imagery and other phenomena” (American Society of Photogrammetry 1980).
**Pixel coordinate system.** The file coordinates of a digital image are defined in a pixel coordinate system. A pixel coordinate system is usually a coordinate system with its origin in the upper-left corner of the image—the x-axis pointing to the right, the y-axis pointing downward, and the units in pixels. These file coordinates \((c, r)\) can also be thought of as the pixel column and row number. This coordinate system is referenced as pixel coordinates \((c, r)\).

**Plane table photogrammetry.** Prior to the invention of the airplane, photographs taken on the ground were used to extract the geometric relationships between objects.

**Principal point.** The point in the image plane onto which the perspective center is projected.

**Principal point of autocollimation.** Part of the definition of principal point, the image position where the optical axis intersects the image plane. The principal point of autocollimation is near the principal point (Wolf 1983).

**Principal point of symmetry.** Part of the definition of principal point, the principal point of symmetry can best compensate for lens distortion. “The point about which [distortions] are symmetrical” (Wolf 1983).

**Principal point xo.** A parameter used to define the location of the principal point in the x direction, which is relative to the origin of the image or photo-coordinate system. The location in the x direction where the optical axis of the camera intersects the image or photographic plane.

**Principal point yo.** A parameter used to define the location of the principal point in the y direction, which is relative to the origin of the image or photo-coordinate system. The location in the y direction where the optical axis of the camera intersects the image or photographic plane.

**Radial lens distortion.** Imaged points are distorted along radial lines from the principal point. Also referred to as symmetric lens distortion.

**Rational functions.** Rational two-dimensional polynomials formed to handle the mapping of ground coordinates to an image space coordinate system after triangulation is complete.

\[
\text{line} = \frac{g(X, Y, Z)}{g'(X, Y, Z)} \\
\text{sample} = \frac{f(X, Y, Z)}{f'(X, Y, Z)}
\]

**Redundancy.** In a block of data, the amount of data that is duplicated, thus providing strong geometric fidelity.

See also Degrees of freedom
**Reference plane.** In a topocentric coordinate system, the tangential plane at the center of the image on the Earth ellipsoid, on which the three perpendicular coordinate axes are defined.

**Regular block of photos.** A rectangular block in which the number of photos in each strip is the same; this includes a single strip or a single stereopair.

**Residual.** “The difference between any measured quantity and the most probable value for that quantity” (Wolf and Dewitt 2000).

**Right-hand rule.** A convention in 3D coordinate systems (X, Y, Z) that determines the location of the positive Z-axis. If you place your right hand fingers on the positive X-axis and curl your fingers toward the positive Y-axis, the direction your thumb is pointing is the positive Z-axis direction (ERDAS 1999).

**Root mean square error (RMSE).** Used to measure how well a specific calculated solution fits the original data. For each observation of a phenomena, a variation can be computed between the actual observation and a calculated value. (The method of obtaining a calculated value is application-specific.) Each variation is then squared. The sum of these squared values is divided by the number of observations and then the square root is taken. This is the RMSE value.

**Rotation matrix.** A 3 \times 3 matrix used in the aerial triangulation functional model. Determines the relationship between the image space coordinate system and the ground space coordinate system.

\[
M = \begin{bmatrix}
m_{11} & m_{12} & m_{13} \\
m_{21} & m_{22} & m_{23} \\
m_{31} & m_{32} & m_{33}
\end{bmatrix}
\]

**Satellite body coordinate system.** A body coordinate system is fixed to the satellite with its origin at the satellite center of mass. The coordinate axes are defined by the satellite attitude control system. It is the orientation of this coordinate system relative to the orbital coordinate system that is captured in the attitude data.

See also **Orbital coordinate system**

**Search size.** The window size (in pixels) to search for corresponding points in two images during correlation.

**Search windows.** Candidate windows on the second image of an image pair that are evaluated relative to the reference window in the first image.
Self-calibrating bundle adjustment (SCBA). Bundle adjustment which also estimates the interior orientation parameters associated with a camera or sensor model.

Self-calibration. A technique used in block bundle adjustment to determine internal sensor model information.

Shrink percentage. In LPS Automatic Terrain Extraction, the percentage by which the output DTM is shrunk versus the original scale. The shrink percentage is applied to each side of the output DTM.

Side fiducial. Fiducials that are located at the sides of an image, rather than at the corners of an image.

See also Fiducial

Side incidence angle. The angle between the vertical position of the satellite and the side viewing direction of the satellite when the sensor is scanning along the side. For example, SPOT imagery side incidence angles can range from +27 to -27 degrees. The scanning direction is perpendicular to the direction of flight.

Sidelap. In a block of photographs consisting of a number of parallel strips, the sidelap (measured vertically) is usually 20-30% in traditional frame camera photos. Tie points are typically measured in the sidelap.

Softcopy photogrammetry.

See Digital photogrammetry

Space forward intersection. A technique used to determine the ground coordinates X, Y, and Z of points that appear in the overlapping areas of two or more images based on known interior orientation and exterior orientation parameters.

Space intersection. A technique used to determine the ground coordinates X, Y, and Z of points that appear in the overlapping areas of two images, based on the collinearity condition.

Space resection. A technique used to determine the exterior orientation parameters associated with one image or many images, based on the collinearity condition.
**Spatial resolution.** A measure of the smallest object that can be resolved by the sensor, or the area on the ground represented by each pixel.

**Standard deviation of unit weight.**

See **Root mean square error**

**Stereopair.** A set of two remotely-sensed images that overlap, providing a 3D view of the terrain in the overlap area.

**Strategy.** In LPS Automatic Terrain Extraction, a strategy is a set of correlation parameters defined for a specific area in a stereopair for the purpose of DTM extraction. An appropriate strategy can improve the likelihood of obtaining reliable image matching results.

**Strip of photographs.** In traditional frame camera photography, consists of images captured along a flight-line, normally with an overlap of 60% for stereo coverage. All photos in the strip are assumed to be taken at approximately the same flying height and with a constant distance between exposure stations. Camera tilt relative to the vertical is assumed to be minimal.

See also **Cross-strips**

**Tangential lens distortion.** Distortion that occurs at right angles to the radial lines from the principal point.

**Template window.** A small subset of an image that you want to try to locate in another image based on specific matching criteria. A template usually remains fixed in one image during the matching process.

**Terrestrial photographs.** Ground-based photographs and images taken with a camera stationed on or near the Earth’s surface. Photographs are usually used for archeology, geomorphology, and civil engineering.

**Tie point.** A point; its ground coordinates are not known, but can be recognized visually in the overlap or sidelap area between two images.

**Topocentric coordinate system.** A coordinate system that has its origin at the center of the image on the Earth ellipsoid. The three perpendicular coordinate axes are defined on a tangential plane at this center point. The x-axis is oriented eastward, the y-axis northward, and the z-axis is vertical to the reference plane (up).

**Transformation matrix.** A set of coefficients that is computed from GCPs, and used in polynomial equations to convert coordinates from one system to another. The size of the matrix depends upon the order of the transformation.
**Triangulated irregular network (TIN).** A specific representation of DTM$s in which elevation points can occur at irregular intervals forming triangles.

**Triangulation.** Process of establishing the geometry of the camera or sensor relative to objects on the Earth’s surface.

See also **Aerial triangulation**

**U**

**Upper left X (ULX).** The X map or file coordinate of the upper left pixel in the file.

**Upper left Y (ULY).** The Y map or file coordinate of the upper left pixel in the file.

**X**

**X-parallax.** The difference in position of a common ground point appearing on two overlapping images, which is a function of elevation. X-parallax is measured horizontally.

**Y**

**Y-parallax.** The difference in position of a common ground point appearing on two overlapping images, which is caused by differences in camera position and rotation between two images. Y-parallax is measured vertically.

**Z**

**Z.** The vertical (height) component of a point, floating cursor, or feature in a given coordinate system.

**Z-axis.** In the image space coordinate system, the Z-axis is the optical axis. The image space coordinate system directs the z-axis toward the imaged object. In object space, the Z axis is orthogonal to the X and Y axes and is directed out of the Earth’s surface.
Index

Symbols
.blk file 80, 148, 187
.cam file 159, 299
.dat file 151, 281
.rrd file 292

Numerics
2D affine transformation 33

A
Activate automatic x, y drive 109, 202
Active status 170
Add Frame icon 190, 218
Add images 289
to a block file 84–86, 153–156, 190–191, 217–218
to the LPS Project Manager 85
Add rows
to file CellArray 105, 108
to reference CellArray 102, 106, 110, 330
Additional Parameters (AP) 349
modeling 70
Advanced Options tab 169, 228
Aerial photographs 18
Aerial triangulation 21, 45, 125–131, 312, 349, 376
accuracy estimates 350
convergence value 350
options 125
report 363, 364
unit definition 365
results 367
statistical weights 352
using statistical information 351
Aerial Triangulation dialog 126, 168, 169
Advanced Options tab 169
Exterior tab 168
General tab 168
Point tab 126
Airborne GPS 6, 7, 44, 150
All Images Without Pyramids 218
Analog photogrammetry 16
Analytical photogrammetry 16
AP 70
Area based matching 58
Arrange layers of the block file 181, 236, 237
ASCII 151
ASCII File (*.dat) 151
AT 45
Attach 155
Attach Options tab 155
Attaching multiple images 297
Auto Locate 95
Auto Tie Properties icon 164
Automated gross error checking 362
Automatic (x, y) Drive icon 109, 202
Automatic block configuration 337
Automatic tie point
collection 5, 56, 121–125, 162–166, 224–226, 337
alternative solutions 339
color imagery 346
correlation limit 345
correlation size 344
feature point density 344
initial accuracy 345
least squares size 344
minimum input requirements 338
optimizing 338
search size 343
trouble shooting tips 346
extraction 337
generation options 121
Automatic Tie Point Collection Properties icon 121, 224
Automatic Tie Point Generation Properties dialog 122, 165, 338
Automatic Z Value icon 216
Average flying height 278

B
Background Transparent option
apply to ortho resampled images 137
Bauer’s Simple Model 360
Bilinear interpolation 292
Block 265
files
attach 155
of images 55
Block property setup 285
Block Property Setup dialog 82, 151, 273
Set Frame-Specific Information 82, 151
Set Reference System 82
Block triangulation 5, 21, 45, 349
Blunder checking models 362
Brown’s Physical Model 361
Bundle block adjustment 5, 21, 44, 45, 349

C
Calibration report 6, 300
Camera file (*.cam) 159
Camera Information dialog 88, 158, 298
General tab 88, 158
Camera Parameter File Name dialog 159
Cartesian coordinate system 30
CCD 7, 63
CellArray 289, 296, 300, 309, 313, 314
Change active status of a point 170
Change control point color 101
Change images in Left View 107, 163
Change images in Right View 107, 163
Charge coupled device (CCD) 7
Check orthoimages 177–181, 233–237
Check points 116
  measuring 323
Check tie point accuracy 123, 166–167, 226–227
Choose tie point properties 224
Choose triangulation parameters 227
Classical aerial triangulation 21
Clear Display option
  apply to ortho resampled images 137
Close a block file 139, 182
Coefficients 34
Collect ground control and tie points 99–121, 197–208
Collect ground control points by entering coordinates 220–224
Collinearity condition 42
Collinearity equations 47, 69
Color
  control points 101
  fiducial marks 91
Compute pyramid layers 86, 156–157
Compute Pyramid Layers dialog 87, 156, 191, 218
  All Images Without Pyramids option 218
Compute Pyramid Layers option 292
Contrast Adjust dialog 309
Control point color 101
Control point extension 5, 7, 21, 327, 373
Control points
  change active status of 170
  getting information about 173
  locating in Point Measurement tool 220
Convergence value 50
Coordinate system 27
  ground space 27
  image space 27
Coordinates
  update automatically 109, 202
Correlation calculations 58
Correlation windows 58
Create block
  coordinate system 266
  exterior orientation 266
  imagery 266
  project name 266
  rotation system 266
  sensor model 266
units 266
Create New Block File dialog 79, 147, 187
Create new camera model 157
Create orthoimages 231
Create Point icon 199, 203, 221
Creating pyramid layers 292
Cross-correlation 58
Cross-strips 266
Cubic convolution 292

D
Data Scaling dialog 308
Data strip 306
Datum 35
Define
  block properties 80–84, 149–150
  camera model 87–99, 157–162, 295
  frame-specific information 275
  geometric model 268
  LPS project 267
  or edit camera information 297
  sensor model 192–193, 218–219, 295
Degrees of freedom 48
DEM 4, 214
Desktop scanners 25
Detail View 164, 194, 303, 308, 309, 324
Dialog
  Aerial Triangulation 126, 168, 169
  Automatic Tie Point Generation Properties 122, 165
  Block Property Setup 82, 151
  Camera Information 88, 158
  Camera Parameter File Name 159
  Compute Pyramid Layers 87, 156, 191, 218
  Create New Block File 79, 147, 187
  Formula 216
  Frame Editor 88, 91, 92, 94, 96, 97, 155, 160, 161, 162, 219
  Frame Editor dialog 98
  GCP Reference Source 195
  Image File Name 85, 155
  Import ASCII File Name 151
  Import Options 152, 153
  Import Parameters 152
  Model Setup 80, 148, 188
  Ortho Resampling 132
  Point Data 173
  Point Measurement 100, 109, 121, 124, 164, 167, 194, 196, 198, 201, 211, 212, 220, 226
  Projection Chooser 81, 149
  Select Layer To Add 235
  Sensor Information 193
  SPOT Pushbroom Frame Editor 192
  Triangulation 125, 227, 228
  Triangulation Report 170
  Triangulation Summary 126, 169, 229
Vertical Reference Source 215
Viewer Swipe 181, 237
Different weighted values 353
Digital
camera 270, 310
elevation model (DEM) 4
elevation model as reference 214
orthophoto 72
photogrammetric systems 18
photogrammetric workflow 287
photogrammetry 16
Direction of flight 22
Display footprints 171, 172
Display Mode 172
Point IDs 172
DLL 289

E
Ebner's Orthogonal Model 360
Elements of exterior orientation 35
Elevation information 214
Enter exterior orientation information 96–97, 161–162
Enter fiducial coordinates 89–90
Enter interior orientation information 90–96, 160–161
Enter Reference Control Points 105, 108, 111, 113, 115, 118, 120
Enter specific camera information 88–89, 157–158
Ephemeris data 66
Epipolar 428
Error reporting 229
Exposure station 22, 63
Exterior information for multiple images
  editing 313
  importing 314
Exterior information of an image
  defining of 311
Exterior Information tab 97, 296, 312
  perspective center values 97
  rotation angles 97
Exterior orientation 35
  parameters 5
  SPOT 65
Exterior orientation parameters 21
Exterior Orientation tab 162
Exterior tab 168

F
Feature
  based matching 60
  point matching 60
Fiducial marks 32, 299, 301
  change color 91
  deleting a measurement 310
  enter in Camera Information dialog 89
importing 300
importing measurements 307
remeasure 96
residuals 309
side fiducials 95
Fiducial orientation 304
Fiducial Orientation icon 91
Field Definition tab 152
File CellArray 164, 196, 201, 211
   Check Points 121
   Control Points 109, 116
   Tie Points 124
File coordinates 198
Fixed values 352
Flight path 22
Focal length 31
Focal plane 32
Footprints 171, 172
Formula dialog 216
Frame camera 269, 303
Frame Camera Model results (Viewer) 137, 138
Frame Camera Model steps 77–140
Frame Editor dialog 88, 91, 92, 94, 96, 97, 98, 155, 160, 161, 162, 219, 295
   Exterior Information tab 97
   Exterior Orientation tab 162
   Interior Orientation tab 91, 161
   Interior Orientation tab (fiducial collection) 92, 94, 96
   moving between images 98
   Sensor tab 88, 98, 155, 160, 219
Frame Editor icon 88, 219
Frame Properties icon 157
Full GCP 52
Functional model 49

G
GCP Reference Source dialog 195
GCPs 52, 323
   configuration 55
   defining 326
   full 326
   horizontal 326
   horizontal reference 329, 331
   multiple images 333
   multiple strips 334
   requirements 54
   statistical quality of 329
   statistical weights 352
   usage 326
   vertical 326
   vertical reference 332
General Contrast options 309
General tab 88, 125, 158, 168, 193
Generate multiple orthoimages 133
Generate pyramid layers 191–192, 218
Generate tie points 224
Geocentric coordinate system 29
Geometric model 188
GPS 50
Gray values 72
Gross error detection 337
Gross errors 52
Ground control points (GCPs)
  measuring 323
Ground coordinate system 28
Ground coordinates 327
  exporting 328
  importing 327
Ground point determination 373
Ground space 27
Ground-based photographs 18

H
Header file 66
High Resolution Visible sensors (HRV) 62
Horizontal GCP 52
Horizontal Reference Source icon 194, 209
HRV 62

I
Icon
  Add Frame 190, 218
  Auto Tie Properties 164
  Automatic (x, y) Drive 109, 202
  Automatic Tie Point Collection Properties 121, 224
  Automatic Z Value 216
  Create Point 199, 203, 221
  Fiducial Orientation 91
  Frame Editor 88, 219
  Frame Properties 157
  Horizontal Reference Source 194, 209
  Lock 94
  LPS 78, 146, 243
  Measurement 93, 100, 163, 193, 219
  Open 136, 215
  Ortho Resampling 131, 231
  Select 96
  Select Point 198, 199, 203
  Update Z Values 215
  Vertical Reference Source 214
  Viewer 91, 178
  Viewing Properties 101, 197
  Zoom In 137, 180, 235
IKONOS RPC 272
Image coordinate system 27
Image enhancement 308
Image File Name dialog 85, 155
Attach Options tab 155
Raster Options tab 85
Image Layer 195
Image matching 57
Image pyramid 61
Image scale (SI) 23, 73
Image space 27, 32, 174
Image space coordinate system 28
Images
  selecting in Point Measurement tool 107
Import ASCII file 151
Import ASCII File Name dialog 151
Import Exterior Orientation parameters 150–153
Import Options dialog 152, 153
  Field Definition tab 152
  Input Preview tab 153
Import Parameters dialog 152, 281
Importing exterior orientation parameters 279
Incidence angles 66
Inclination 66, 67
Inclination angles 66
Inertial Navigation System (INS) 7
Information about control points 173
Input check points 116
Input Preview tab 153
INS 7, 44, 50, 150
Interior orientation 31, 295, 302
  SPOT 64
Interior Orientation (fiducial collection) 92, 94, 96
Interior Orientation CellArray 307
Interior Orientation tab 91, 161, 296, 308
Interior Orientation tab (fiducial collection) 92, 94, 96
Internal sensor modeling 295
Interpretative photogrammetry 17

J
Jacobsen’s Simple Model 360

K
Kappa 36, 276
Keep All Points option 337
Keyboard shortcuts 11

L
Least squares
  adjustment 45, 48, 351
  condition 49
  correlation 59
  matching techniques 344
  results 367
  size 343
Left View 163, 164
Lens distortion 33
Link Cursor
  moving in a Viewer 203
Lock icon 94
LPS icon 78, 146, 243
LPS Project Manager toolbar 285

M
Magnify orthoimage 235–237
Main View 164, 194, 303, 308, 309, 324
Mass points 5
Measurement icon 93, 100, 163, 193, 219
Metric photogrammetry 17
Microns 168
Model Parameters tab 317
Model Setup dialog 80, 148, 188
Select a geometric model 188
Moving between images in the Frame Editor 98

N
Nadir 67
Nearest neighbor 292
Negative inclination 66
New LPS project 268
New sensor
  defining information 88
NITF RPC 272
Non-metric cameras 269, 270, 310
Nonorthogonality 33
Normal random errors 52
Number of tie points per image
  choosing 122

O
Oblique imagery 358
Oblique photographs 18
Observation equations 47
Off-nadir 67
Omega 36, 276
Open icon 136, 215
Options for orthorectification 231
Orbital pushbroom 271
Orientation 37
Orientation angle 68
Ortho calibration 291, 401
Ortho resampling 397
Ortho Resampling dialog 132
Ortho Resampling icon 131, 231
Ortho resampling options 131
Orthoimage generation 231
Orthoimages (Viewer results) 179, 180, 235, 236
Orthorectification 70, 397
Orthorectify imagery 131–135, 174–177, 231–233
OverView 164, 194, 303, 308, 309, 324
Perform aerial triangulation 167–174, 227–231
Perspective Center 97
Phi 36, 276
Photogrammetric configuration 46
Photogrammetric scanners 24
Photogrammetry 15
Photographic direction 277
Pixel coordinate system 27, 32
Pixel size in x 161
Pixel size in y 161
Plane table photogrammetry 15
Point Data dialog 173
Point IDs in image space 173
Point Measurement CellArray 335
Point Measurement tool 100, 109, 121, 124, 164, 167, 194, 196, 198, 201, 211, 212, 220, 226
  File CellArray 100
  Check Points 121
  Control Points 109
  Tie Points 124
  File CellArray (Tie Points) 167, 226
  Opening 219
  Reference CellArray 100, 102, 330
  Check Points 121
  Control Points 109
  Tie Points 124
  Reference CellArray (Control Points) 106, 108, 111
  Reference CellArray (Tie Points) 167, 226
Point Measurement Tool Palette 100, 194
Point Measurement views 324
Point tab 126
Point transfer 337
Points per image 165
Positive inclination 66
Prepare a block file 78–80, 146–148, 186–190
Principal point 31
Principal point of autocollimation 32
Principal point of symmetry 32
Processing a strip of images 54
Processing one image 54
Project Graphic Status window 171, 172, 174
Project name 266
Project setup
  generic pushbroom sensor models 285
    IRS-1C 285
    SPOT 285
Projection Chooser dialog 81, 149, 273
Pushbroom sensors
  generic pushbroom 271
  IRS-1C pushbroom 271
  Orbital pushbroom 271
  SPOT pushbroom 271
Pyramid layers 86, 156, 191
Q
QuickBird RPC 272

R
Radial lens distortion 33, 34
  Definition 301
  Radial Lens Distortion tab 301
Raster Options tab 85, 235
  Check Points 121
  Control Points 109, 116
  Tie Points 124
  Type 103, 106, 110, 112, 114, 116, 118, 217
  Usage 103, 106, 110, 112, 114, 116, 118, 217
  Z Reference 215
Reference CellArray (Control Points) 106, 108, 111
Reference Control Points 105, 108, 111, 113, 115, 118, 120
Reference coordinate system 272
Reference coordinates 198, 209
Reference image 209
Reference plane 29
Reference window 58
Relation based matching 61
Remeasure fiducial marks 96
Report
  Triangulation Report 229
  Triangulation Summary report 126
Report coordinates 168
Resolution 25
Right hand rule 29
Right View 163, 164
Right View dropdown list 107
Right-hand rule 276
RMSE 24, 33
RMSE solution 95, 229
Root Mean Square Error (RMSE) 24, 33
Rotation
  angles 97
  matrix 37
  system 276
RPC 271
  IKONOS 272
  NITF 272
  QuickBird 272

S
Same weighted values 353
Satellite photogrammetry 62
Satellite scene 64
Save a block file 139, 182
Save camera information 158–160
Save the block file 217
Scan line 63
Scanning resolutions 25, 26
SCBA 70
  estimating AP 359
  optimizing 358
  statistical weights 356
Scene 63
Search window 58
Select a geometric model 80, 148–149
Select check points 116
Select Geometric Model 188
Select icon 96
Select Layer To Add dialog 235
  Raster Options tab 235
Select Point icon 198, 199, 203
Self-calibrating bundle adjustment (SCBA) 70, 355
Sensor Information dialog 193
  General tab 193
Sensor tab 88, 98, 155, 160, 192, 219, 295
Set Data Scaling dialog 325
Set Frame-Specific Information 82, 151
Set horizontal reference 209–210
Set Projection option 273
Set Reference System 82
Set Resampling Method dialog 324
Set Type 216–217
Set Usage 216–217
Set vertical reference source 214–216
SI 73
Side fiducials 95
Signal based matching 58
Simple Gross Error check 228
Single frame orthorectification 20, 265
Softcopy photogrammetry 16
Solve RMSE 95
Space forward intersection 43
Space resection 20, 43
SPOT exterior orientation 65
SPOT interior orientation 64
SPOT Pushbroom Frame Editor dialog 192
  192
  Sensor tab 192
SPOT Pushbroom model steps 185–238
Standard error 367, 388
Stereo measurement 16
Strip of imagery 265
Sub-pixel accuracy 304
Symmetric lens distortion 34

T
Tab
  Advanced Options 169, 228
  Attach Options 155
  Exterior 168
Exterior Information 97
Exterior Orientation 162
Field Definition 152
General 88, 125, 158, 168, 193, 227
Input Preview 153
Interior Orientation 91
Interior Orientation (fiducial collection) 92, 94, 96
Interior Orientation tab 161
Point 126
Raster Options 85, 235
Sensor 88, 98, 155, 160, 192
Sensor tab 219
Tangential lens distortion 33, 34
Terrestrial photography 18, 29
Tie point
  accuracy 123
Tie points 5, 21, 55, 167
  as mass points 5
  distribution 56
  measuring 323
  number per image 165
  selection 337
Topocentric coordinate system 29
Total Image Unit-Weight RMSE 169
Total station 353
Triangulation 349, 383
  unit definition 386
Triangulation dialog 125, 227, 228
  Advanced Options tab 228
  General tab 125, 227
Triangulation report 169, 229, 386
  error checking model 387
  exterior orientation 389
  GCP results 391
  image coordinate information 391
  iterative results 388
  optimizing results 392
Triangulation Report dialog 170
Triangulation reporting 229
Triangulation Summary dialog 126, 169, 229
Type 216
  update with Formula dialog 216
Type of point 103, 106, 110, 112, 114, 116, 118

U
Units in microns 168
Update Z Values icon 215
Usage 216
  check points 116
  update with Formula dialog 216
Usage of point 103, 106, 110, 112, 114, 116, 118
Use the Point Measurement tool 193–197, 219–220
Use the Swipe tool 180–181, 236–237
V
V residual matrix 50
Velocity vector 68
Vertical GCP 52
Vertical Reference Source dialog 215
   DEM option 215
Vertical Reference Source icon 214
Video camera (videography) 270, 310
Viewer icon 91, 178, 303
Viewer Swipe dialog 181, 237
Viewers 303, 309
Viewing Properties dialog 329
Viewing Properties icon 101, 197

W
Weight function 362

X
X coordinates
   update automatically 109, 202
X matrix 50
X pixel size 161
X Reference coordinates 105, 108, 111, 113, 115, 118, 120

Y
Y coordinates
   update automatically 109, 202
Y pixel size 161
Y Reference coordinates 105, 108, 111, 113, 115, 118, 120

Z
Z value
   automatic update 216
   source 214
   updating 215
Zoom In icon 137, 180, 235